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SAFETY PRECAUTIONS 
 
For your safety from the Voice Sense QWERTY, please read safety 
precautions carefully. 
 
1. The input voltage of the AC adapter is 100V - 240V, and the output is 

DC 5V / 2A. 
 

2. When the Voice Sense QWERTY is shipped, the battery may be 
separate from the unit to avoid damage. The battery may not be fully 
charged when it is shipped. Before you use the Voice Sense 
QWERTY, you should make sure the battery is fully charged. When 
you use the Voice Sense QWERTY for the first time, you may need to 
open the package, take the battery, and insert it into the battery slot at 
the rear panel of the unit. It is possible that the dealer or distributor 
from whom you purchased the Voice Sense QWERTY from has 
already done this for you. 
 

3. When you use the Voice Sense QWERTY with the battery for the first 
time, the battery status may not be displayed accurately. In order to 
avoid this, connect the Voice Sense QWERTY to the AC adapter for 
about six hours with turn on. If you want to use the Voice Sense 
QWERTY immediately after opening the box, you will need to connect 
the AC adapter to the unit for more than six hours to fully charge the 
battery. 
 

4. Do not keep discharge battery a long time. If you want to keep the 
discharge battery, it means the battery life will decrease. 
 

5. If you want or need to take the battery out of the unit, turn the power 
off, and then take the battery out of the unit. Before putting the battery 
back in to the unit, make certain that the power switch is turned off. 
 

6. When you are using the Voice Sense QWERTY on battery power only 
(without the AC adapter), the status of the remaining battery power 
will be announced when the battery power is low. When the battery’s 



III 
 

charge falls below 15 percent, connect the AC adapter to the unit for 
recharging. If the remaining battery power drops to five percent, and 
the unit is not connected to the AC adapter, the Voice Sense 
QWERTY will shut down one minute after the announcement of the 
battery’s status. The amount of battery life per charge will vary 
depending on the options you have set. 
 

7. Your Voice Sense QWERTY needs to be handled with care. The 
Voice Sense QWERTY is a very delicate machine. You should make 
sure to handle the unit in a proper manner. Also, the Voice Sense 
QWERTY is very sensitive to dust.  Make sure to keep the Voice 
Sense QWERTY away from dusty environments. 
 

8. You will need to register your Voice Sense QWERTY in order to 
ensure further maintenance, service, and upgrade information. 
Please visit www.himsintl.com, to register your information. If you 
have any trouble when registering your information, please contact 
the dealer whom you purchased your Voice Sense QWERTY product 
from for help. 
 

9. Do not take apart the Voice Sense QWERTY by yourself. Do not have 
anyone else who is not authorized by HIMS take apart the Voice 
Sense QWERTY. If an unqualified person disassembles the unit, 
serious damage may occur to the Voice Sense QWERTY. If an 
unauthorized person disassembles the Voice Sense QWERTY, the 
unit will be excluded from any free maintenance, and the warranty will 
become void. If any liquid or external force damages the unit, it may 
also be excluded from free maintenance, even if the damage 
occurred during the warranty period. 

 
10. If you let your Voice Sense QWERTY remain for a long time at the 

closed or high temperature places like inside of car, the battery 
attached to the Voice Sense QWERTY may be defected or fired. So 
please don’t keep your Voice Sense QWERTY at those places. 
 

11. If you have any complaints or suggestions, please provide us with 
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your comments on our website. We will improve our product based on 
your comments and suggestions. Thank you for using the Voice 
Sense QWERTY, and we value any comments or suggestions you 
have for our product. 
 

12. This equipment has been tested and found to comply with the limits 
for a Class B digital device, pursuant to Part 15 of the FCC Rules. 
 
These limits are designed to provide reasonable protection against 
harmful interference in a residential installation. This equipment 
generates, uses and can radiate radio frequency energy and, if not 
installed and used in accordance with the instructions, may cause 
harmful interference to radio communications. However, there is no 
guarantee that interference will not occur in a particular installation. If 
this equipment does cause harmful interference to radio or television 
reception, which can be determined by turning the equipment off and 
on, the user is encouraged to try to correct the interference by one of 
the following measures: 
 

 Reorient or relocate the receiving antenna. 
 Increase the separation between the equipment and receiver. 
 Connect the equipment into an outlet on a circuit different from 

that to which the receiver is connected. 
 Consult the dealer or an experienced radio/TV technician for help. 
 

FCC Caution: To assure continued compliance, (example -use only 
shielded interface cables when connecting to computer or peripheral 
devices).  
Any changes or modifications not expressly approved by the party 
responsible for compliance could void the user’s authority to operate 
this equipment. This device complies with Part 15 of the FCC Rules. 
Operation is subject to the following two conditions:  
(1) This device may not cause harmful interference, and  
(2) This device must accept any interference received, including 
interference that may cause undesired operation. 
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IMPORTANT NOTE: 
FCC RF Radiation Exposure Statement: 
 
This equipment complies with FCC RF radiation exposure limits set 
forth for an uncontrolled environment. This equipment should be 
installed and operated with a minimum distance of 20 centimeters 
between the radiator and your body. This transmitter must not be co-
located or operating in conjunction with any other antenna or 
transmitter. 
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Congratulations on the purchase of your Voice Sense QWERTY!  The 
Voice Sense QWERTY is capable of doing everything that an ordinary 
PDA can do, and more – all without the need for a screen!  
 
I.  You will find the following items when you open the Voice 
Sense QWERTY package: 
 
1) Voice Sense QWERTY 
2) Battery 
3) Carrying Bag 
4) AC adapter 
5) USB Cable 
6) USB to Parallel Cable 
7) Earphone 
8) Sticker(2) 
9) User Manual (CD) 
10) Braille User Manual (Hot Keys List) 
11) External Battery Charger(Optional) 

 
II. How to use this manual 
 
Before using the Voice Sense QWERTY, you should read the entire 
manual to familiarize yourself with the functions of the Voice Sense 
QWERTY. Reading the entire manual will allow you to operate the Voice 
Sense QWERTY to its fullest potential. The Voice Sense QWERTY has 
many functions. Many of these functions operate in a similar manner, so 
it is important to become familiar with all of the functions of the Voice 
Sense QWERTY. 
 
You will see references to hot keys and shortcut keys. These keys refer 
to ways to access menus and functions quickly by using a combination 
of keystrokes. Please note that not all hot keys and shortcut keys will 
work while you are in the Voice Sense QWERTY. Some hot keys and 
shortcut keys require that you be within a program in order for specific 
hot keys and shortcut keys to work. 
 



VII 
 

This user manual uses a specific notation of how to press keys. When 
you see, “Fn-B” this means that you would press the “Space” and “B” 
simultaneously. This is a very important concept to understand when 
using this manual. 
 
In order to use the Voice Sense QWERTY, you will need to understand 
what a menu is, and how it works. You will also need to understand what 
a text box is, and how to type in information in a text box. You will want 
to read section 2.7 to help you understand basic concepts of menus. It is 
very important that you completely understand concepts such as this, so 
that you are able to use the Voice Sense QWERTY to its fullest potential. 
 
If you find that you are unable to find a solution to a problem within the 
manual, or if you need assistance with the Voice Sense QWERTY, 
please email us at hims@himsintl.com. Visit us on the web at 
www.himsintl.com; or, you can call us at +82-42-864-4460. 
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1. Introduction 
 
1.1 What is the Voice Sense QWERTY? 
 
The Voice Sense QWERTY is a note taker developed and manufactured 
by HIMS, for people who are blind and visually impaired. You can do the 
following with the Voice Sense QWERTY. 
 

1. Using the File Manager Program, you can copy, send, paste 
document and create new document or folder. 

2. You can use the Word Processor, and the keyboard of QWERTY 
type, to create Braille documents. 

3. You can open Microsoft (MS) Word documents. The Voice Sense 
QWERTY will import any document that was created in MS Word, 
and translate it into Braille. 

4. You can print your text documents using any compatible ink printer. 
5. You can emboss your Braille documents when you connect the unit 

to a Braille printer. 
6. Using the E-Mail Program, you can send email messages to 

sighted individuals. 
7. Using the Schedule Manager, you can enter your appointments on 

the Voice Sense QWERTY. The Voice Sense QWERTY will then 
alert you at the time of your appointments. 

8. With the Address Manager, you can input information about your 
contacts and the Voice Sense QWERTY can retrieve the 
information for those contacts. 

9. Using the Voice Sense QWERTY Web Browser, you can surf the 
Internet. 

10. Using the Voice Sense QWERTY Media Player, you can listen to 
music, or any other sounds that are recorded in mp3, wma, or a 
wave file format. 

11. Using the Voice Sense QWERTY FM Radio, you can listen to FM 
radio sound. 

12. You can record the voice and FM radio sound in mp3 or wav file 
format. 
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13. On the Calculator, you can calculate algebraic equations, 
including scientific calculations. 

14. You can copy any files from your personal computer to the Sense 
QWERTY, and vice versa. 

15. You can copy, move, and delete files on the Voice Sense 
QWERTY. 

16. You can adjust the volume, the speed, and the pitch of the 
speech. You can change as many of these features as you want on 
the Voice Sense QWERTY. 

17. You can use the Database Manager to create your own 
Database for keeping and storing important information. 

18. You can use MSN messenger to communicate in real time, with 
others who are running the MSN messenger program. 

 
1.2 Hardware 
 
In order to get the most out of your Voice Sense QWERTY, you will want 
to become familiar with the Voice Sense QWERTY by learning where 
the buttons and ports are located, as well as the function of each of 
these buttons and ports. 
 
This section explains the hardware configuration of the Voice Sense 
QWERTY. The dimensions of the Voice Sense QWERTY are 8.6 inches 
long by 4.9 inches wide by 0.7 inches high. On the bottom of the unit, 
there are rubber feet in order to prevent slipping while you are using the 
Voice Sense QWERTY. The input keys are keyboard of QWERTY type.  
 
The first thing you should do is place the Voice Sense QWERTY on a 
level surface that you can use to examine the Voice Sense QWERTY, 
such as a table or desk. When the Voice Sense QWERTY is placed on a 
level surface, the shape of the entire unit will resemble a small, thin 
rectangular box. The Voice Sense QWERTY has six sides. You should 
feel for the LCD and keyboard. The side that the LCD and keyboard are 
on should be facing up. The side that is now facing up is referred to as 
the top of the Voice Sense QWERTY. The side that is facing to your 
right is called the right side panel. The side facing to your left is called 
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the left side panel. The side that is facing away from you is called the 
rear panel. The side that is facing toward you is called the front panel, 
and the side that the Voice Sense QWERTY is sitting on is called the 
bottom panel. 
 
This section of the manual describes each side of the Voice Sense 
QWERTY and the basic function(s) of each button and port. We will 
discuss each of the panels in the following order:  top panel, right side 
panl, left side panel, rear panel,  front panel and bottom panel. 
 
1.2.1 Top Panel 
 
1.2.2.1 Keyboard 

 
Starting with the top of the Voice Sense QWERTY, you will find 
keyboard of QWERTY type that is located close to the front panel on the 
Voice Sense QWERTY. 
 
The Voice Sense QWERTY keyboard is composed of 77 keys 6 lines, 
the keyboard is composed of an array of keys, such as a computer 
keyboard, but there is part that consists to be different. General 
keyboard consists from “F1” to “F12”, but it is Voice Sense QWERTY 
keyboard consists from “F1” to “F11” in first line. So that can find easily 
position of “F1”, “F5”, “F9”, tactile point on frame. Next to “F11”, consist 
of “Left square bracket”, “Right square bracket”, “Insert”, “DEL” in a first 
line.  
 
Beginning from number 1 in second line, tactile point is situated so that 
can find position of number 5 and number 0. There is tactile point on 
second line right frame, there is backspace on left. There is tactile point 
on third line left frame, there is “Tab” on right. Tactile point is situated in 
left index finger and right index finger place in keyboard. “R” and “U” in 
third line, “F” and “J” in fourth line, “V” and “M” in fifth line are mark with 
dots. Through this, you can find position of keys. Tactile point that can 
find position in last line is situated on frame under “Ctrl”, “Alt”, “Down 
arrow key”. Right and left of down arrow key is “Left arrow key”and 
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“Right arrow key”, and there is “Up arrow key” on “Down arrow key”. 
Right and left of up arrow key is “Shift” and “/”.  
 
Most on left, there is “Fn” in last line. When do hotkey combination or list 
transfer, is used. For example, if combined “Fn” and “Up arrow key”, do 
“page up” function.  
 
You can attach the braille sticker to know easily where the keys are 
located. If you want to emboss braille by yourself, you can use the 
sticker without braille. Then, emboss the braille and attach on the 
keyboard. 
 
1.2.2.2 LCD 

 
Above the keyboard, you will find LCD in the center. The LCD displays 
the printed text, so that someone who has sight can see what you are 
typing.  
 
1.2.2.3 Speakers 

 
On both sides of the LCD, there are two speakers, which enable the 
Voice Sense QWERTY to emit sound. 
 
1.2.2 Right Side Panel 
 
Next, let's discuss the right side panel of the Voice Sense QWERTY. We 
will start from the front of the unit on the right side panel, and move our 
way toward the back.  
 
1.2.2.1 USB OTG Port 

 
Toward the front of the Voice Sense QWERTY on the right side panel, 
you will find the USB OTG port. If you connect the unit to a personal 
computer by using this USB port, you can transfer files that are stored in 
the Voice Sense QWERTY to your personal computer, and vice versa. 
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1.2.2.2 USB Port 
 
Continuing toward the back of the unit on the right side panel, you will 
find the USB port. You can connect a USB stick memory in this USB port, 
for auxiliary storage. 
 
1.2.2.3 AC Adapter Jack 

 
The last thing you will find on the right side panel of the unit is the AC 
adapter jack. The AC adapter will plug in to this hole, and then plug in to 
a standard AC electrical outlet, so that you can use the Voice Sense 
QWERTY with electricity, instead of using power from the battery. 
 
1.2.3 Left Side Panel 
 
Now, let's take a look at the left side panel of the unit.  
 
1.2.3.1 SD Slot 

 
If you move your finger to the left side of the Voice Sense QWERTY, you 
will find the SD port. You can insert SD card (secure digital card) in SD 
slot. 
 
1.2.4 Rear Panel 
 
Next, let's take a look at the rear panel of the Voice Sense QWERTY.  
 
1.2.4.1 Reset Button 

 
On the far rightof the rear panel, you will find a small button in round 
groove. This is the reset button. If your unit is not responding properly, 
you can press this button with your finger, which will reboot the unit via a 
hard reset. Pressing the reset button is a hardware reset.  
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When the reset button is pressed, the Voice Sense QWERTY will reboot. 
It will take about fifteen seconds for your unit to complete the reboot 
process. 
 
1.2.4.2 LAN Port 

 
On the left side of the rear panel, you will find the local area network 
(LAN) port. If you connect the Voice Sense QWERTY to an Ethernet 
interface through this port, you will be able to connect to the Internet, 
allowing you to browse websites as well as send and receive email. 
 
1.2.5 Front Panel 
 
Finally, let’s take a look at the front panel of the Voice Sense QWERTY.  
 
1.2.5.1 Internal Microphone 

 
On the far left of the front panel, you will find a internal microphone.You 
can record in the media program, using it. 
 
1.2.5.2 Key Lock Switch 

 
 To the right of internal microphone is key lock switch. This switch will be 
explained in more detail in the next section.  
 
1.2.5.3 Microphone Jack and Headphone Jack 

 
To the right of the key lock switch is microphone jack. You can plug in 
microphone. To the right of the microphone jack is headphone jack. You 
can plug in stereo headphone jack.  
 
1.2.5.4 Audio Mode Switch 

 
The audio mode switch is located on the right of headphone jack. This 
switch will be explained in more detail in the next section.  
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1.2.5.5 Media Buttons 
 
To the right of the slide switch is five buttons in different shapes. The five 
buttons are for playback audio and recording sounds. From left to right, 
there are previous button, record button, stop button, play/pause button 
and next button. 
These five buttons will be explained in the FM Radio, Daisy and Media 
program sections in this user manual. 
 
1.2.5.6 Power Switch 

 
To the right of the five buttons is power switch. This switch will turn the 
unit on and turn the unit off. To turn on the unit, push the switch to the 
right. To turn off the unit, push the switch to the left. 
 
1.2.6 Bottom Panel 
 
You will find in the center on the bottom panel of the Voice Sense 
QWERTY is rectangular hole that is for the detachable battery. How to 
use Battery will be explained in more detail in the below. 
 
Congratulations! You are now familiar with the very basic functions of the 
buttons and ports that are located on the Voice Sense QWERTY. The 
rest of the manual will discuss each function in greater detail to allow you 
to maximize the potential of your Voice Sense QWERTY. 
 
1.3 Voice Sense QWERTY Battery 
 
The battery is separated from the unit when the Voice Sense QWERTY 
is shipped. Insert the battery into this rectangular slot until you hear a 
click sound. When you hear this sound, you will know that the battery is 
inserted correctly.  
When you use the Voice Sense QWERTY with the battery, the battery 
status may not be displayed accurately. In order to avoid this, connect 
the Voice Sense QWERTY to the AC adapter for about seven hours with 
turn on.  
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To remove the battery from the unit, you have to use the latch that is 
found on the bottom of the unit. The latch is located on the left of battery. 
Using your left hand, pull the latch to the rear panel, and then use your 
right hand to pull the battery out of the slot. 
 
1.4 Hardware Specifications of the Voice Sense 
QWERTY 
 
1. Operating system: Windows CE 5.0. 
2. Flash memory: 4GB. 
3. RAM: 128MB. 
4. Memory extension: SD memory or USB stick memory. 
5. CPU: Intel PXA270. 
6. Battery: Lithium Ion (detachable), backup battery installed. 
7. Keyboard: keyboard of QWERTY type, 5 audio buttons. 
8. Additional button and switch: key lock switch, audio mode switch, 

reset button. 
9. Network: 10/100 based Ethernet. 
10. Wireless: WLAN b/g, Bluetooth. 
11. Interface: USB OTG, USB, SD slot 
12. Sound: Internal stereo speakers, stereo headphone jack. 
13. Voice recording: Internal microphone, External microphone jack. 
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2. Basic Functions of the Voice Sense 
QWERTY 
 
2.1 Power On/Off 
 
It is power switch to the right of front panel of Voice Sense QWERTY. 
This power switch will turn the unit on and turn the unit off. When you 
turn on and off power, push the power switch more than 1 second. 
To turn on the unit, push the switch to the right. To turn off the unit, push 
the switch to the left. 
 
2.2 Charging Battery and Check Battery Status 
 
It is very useful to know what the remaining battery power when the 
Voice Sense QWERTY is being operated only on battery power.  If the 
remaining battery power is not sufficient, the Voice Sense QWERTY will 
indicate that the battery power is low. In this case, you need to check the 
remaining battery power, especially when you are using the Voice Sense 
QWERTY without plugging it into an AC power supply. 
 
To check the battery power status, press “Fn-b”. You will find the 
following 2 items: 
1.  Battery power level 
2.  Power source (battery or AC supply) 
 
The battery power level represents the percentage of the remaining 
battery power. The power source indicates whether power is coming 
from the battery or the AC power supply. If the battery power level drops 
under 15 percent, the Voice Sense QWERTY will display the battery 
status on the LCD, and it will announce (through the speakers) that the 
battery has less than 15 percent of its power left. If the battery power 
level falls below five percent, the Voice Sense QWERTY will give you a 
warning indicating that your battery power level is under five percent, 
and the Voice Sense QWERTY will be automatically turned off in one 
minute, unless you connect the Voice Sense QWERTY to an AC power 
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supply. 
 
2.3 Controlling the Voice 
 
You can change the volume, rate, and pitch of speech used on the Voice 
Sense QWERTY.  
 
To change the volume,  
1. Press “F6” to raise the volume.  
2. Press “Shift-F6” to lower the volume.  
 
You can utilize “F5” to turn the voice on and off. 
 
To make changes in the reading rate,  
1. Press “F7” to make the reading faster.   
2. Press “Shift-F7” to make the reading rate slower.  
 
To make changes in pitch,  
1. Press “F8” for a higher pitch  
2. Press “Shift-F8” for a lower pitch. 
 
When any of the above combination keys are pressed, the Voice Sense 
QWERTY will announce the status of its volume, rate, or pitch. The 
changes you made with these combination keys will remain in effect 
even when you turn off the machine and turn it back on again. These 
changes can also be made in the “Global options” settings. Please refer 
to sections 3.10, 3.11, and 3.12 in this user manual. 
 
2.4 Switching Audio mode 
 
The audio buttons on the front panel will work for different function 
according to the location of Audio mode switch. 
If you push the audio mode switch to the left side, the Voice Sense 
QWERTY will say “radio mode” and the audio buttons will work for the 
FM radio program. If you set the audio mode switch to the center, the 
Voice Sense QWERTY will say “daisy mode” and the audio buttons will 
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work for the Daisy program. If you push the audio mode switch to the 
right side, the Voice Sense QWERTY will say “media mode” and the 
audio buttons will work for the Media program. 
 
So in order to use the audio buttons as you desire, you have to set the 
audio mode switch to the proper position. For example, when you are 
using Media program and the audio mode switch is located in the left 
side, the audio buttons on the front panel will work for FM radio program. 
The detailed function of the audio buttons will be explained in the FM 
radio, Daisy and Media program sections in this user manual. 
 
2.5 Switching Key lock  
 
You can disable or enable any specified keys on the Voice Sense 
QWERTY by using Key Lock switch on the front panel. 
If the key lock switch put on left, Voice Sense QWERTY will say “all keys 
locked.” In this case, you can’t use the all keys including the on/off 
switch. If the key lock switch put on center, Voice Sense QWERTY will 
say “top panel locked.” In this case, only you can use the buttons and 
switches in the front panel (audio mode switch, audio buttons and power 
switch). If the key lock switch put on right, Voice Sense QWERTY will 
say “unlocked”. In this case, you can use the all keys (audio buttons, 
function keys, audio mode switch and power switch). 
But, you can use the reset button, regardless of location of key lock 
switch. 
 
2.6 Execute and Exit Program 
 
You can execute program by pressing the “Enter” button. If you want to 
cancel the execution of any command, and return to the previous status, 
press “Alt-F4”. “Alt-F4” indicates that the user should press the “Alt” and 
“F4” simultaneously and then release them at the same time. “Alt-F4” is 
a very important command to remember, as it will allow you to back out 
of programs and menus, when you may have pressed keys that you did 
not mean to press. 
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2.7 Concept of the Menu and go to Menu 
 
The menu on the Voice Sense QWERTY is similar to the concept of a 
restaurant menu. For instance, a menu that is used at a restaurant will 
help you select your choice of food that will be served, while the menu 
on the Voice Sense QWERTY provides you with choices that you can 
select. If you have selected a menu item from the menu items list, and 
there are sub menus, the Voice Sense QWERTY will display those 
choices for that particular item. 
 
The below key is associated with “Menu”. 
1. Alt: This key calls up the menu while executing program. 
2. Enter: This key executes the menu. By pressing “Enter,” you will 

move to the sub menu. If there is no submenu, the Voice Sense 
QWERTY will execute the command from the menu. 

3. Fn-r: This key listens to the name of the menu again, press “Fn-r”. 
4. Win key: This key goes to the “Program menu” immediately. 
 
2.7.1 Move between “Program” menus 
 
Turn the unit on by pushing the power switch toward you. Press the “Win 
key” to go to the “program” menu immediately. The file manager, which 
is the first item of the “program” menu, will be spoken. The “program” 
menu is the top menu in the Voice Sense QWERTY. That is, the 
“program” menu is the parent directory for everything, as there are no 
directories or menus above the “program” menu. The items in the 
“program” menu are file manager, word processor, address manager, 
schedule manager, e-mail, media player, FM radio, web browser, daisy 
player, Bluetooth manager, msn messenger, database manager, utilities, 
global options, and help. The first item of the “program” menu is “File 
manager.” If “Down arrow key” is pressed, the next menu item is 
displayed on the LCD, and it is also spoken. If “Down arrow key” is 
pressed repeatedly, the “Help” menu will be displayed.  The “Help” 
menu is the last item on the “program” menu. 
 
Press “Ctrl-Fn-Right arrow key” when “File manager” is displayed. The 
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Voice Sense QWERTY will say “Help”. Then, press “Ctrl-Fn-Left arrow 
key”, and the Voice Sense QWERTY speaks “File manager.” It means 
that “Ctrl-Fn-Right arrow key” moves to the last item of the “program” 
menu, and “Ctrl-Fn-Left arrow key” moves to the first item of the 
“program” menu.  
 
2.7.2 Move the menu item in executing “Program” 
 
Moving among the menu items is very simple. 
Press “Alt” to call up the menu while executing “Program”, and “Up 
arrow key” to move to the previous item, and “Down arrow key” to move 
to the next item. Or just press an alphabet that follows the menu names.  
 
You can also move to the next menu item by pressing “Down arrow key”.  
You can move to the previous menu item by pressing “Up arrow key”. 
When you want to move to the first item of the menu, you can press 
“Ctrl-Fn-Left arrow key”. If you would like to move to the last item of the 
menu, you can press “Ctrl-Fn-Right arrow key”. The corresponding menu 
name will be spoken through the TTS (text to speech) engine.  
 
You may move to any menu or execute any menu by pressing an initial 
spelling of the menu. 
 
Sometimes, if a menu is executed by pressing “Enter,” the lower-level 
menu is displayed. In this case, when Voice Sense QWERTY connected 
to use with SyncBraille, the right direction arrow sign (->) is displayed 
after the name of the corresponding menu on the Braille display of 
SyncBraille. When this happens, the Voice Sense QWERTY will say, 
“pull down.” Or, if a menu is executed by pressing “Enter,” the dialog box 
is displayed. In this case, when the Voice Sense QWERTY connected to 
use with SyncBraille the ellipsis sign (…) will be displayed after the name 
of the corresponding menu on the Braille display of SyncBraille. The 
Voice Sense QWERTY will also speak the message, “common dialog.” 
 
If you want to move from the current menu to the upper level menu, 
press “ESC”. 
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2.8 Using the Shortcut key and Hotkey 
 
Shortcut keys are the alphabets in the parentheses that follow the menu 
names. And hotkeys are the combination of a couple of keys like “Alt” 
“Fn” or “Ctrl”. Or you can execute the menu item without calling up the 
menu by pressing “hotkey.” These are displayed after the shortcut keys. 
 
For example, if you are in the word processor, and press “Alt” and then 
press “Enter” on “File,” you will hear “New (n) pull down Ctrl-n”. The word 
“New” represents the function. The letter “n” is the letter that you would 
press while you are in the “File” menu in order to move directly to “New.”  
“Ctrl-n” is what you would press to access the function “New” from 
anywhere in the word processor. The “n” is the shortcut key and “Ctrl-n” 
is the hotkey. It is important to note that not all shortcut keys work from 
anywhere in the Voice Sense QWERTY; some commands will only work 
while you are in a specific program. For example, if you want to activate 
the “new document” option in the word processor. You cannot press 
“Ctrl-n” in the “program” menu to activate this option. You must be in the 
word processor program in order for “Ctrl-n” to activate the “new 
document” option. 
 
2.9 Control Symbols on the Voice Sense QWERTY 
 
The Voice Sense QWERTY has many control symbols. Those symbols 
appear when you set “Before” and “After” the “Control information” in the 
“Global options”. The default value is set to “Before.”  However, if you 
are in the web browser, the control symbols will be displayed even if you 
turn off the “Control information” option.   
The control symbol will appear in front and back of the menu name or 
item name. For example, you might see something like, “MN File (f) pull 
down.” 
 
The following table shows the names and the symbols of the control 
symbols that are displayed in front and back of menu names. 
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Name Symbol Comments 
Menu MN It means the menu that has 

submenus. 
Menu item MI It means the menu that does not 

have a submenu. 
List item LI The item name after this symbol 

represents the name of the item 
in any list. 
(Ex:  “LI database” or “LI 
sample.txt” in the “file list” of the 
file manager) 

Edit box EB The item name after this symbol 
represents the edit box name. 
You can find the edit box after 
the edit box name.  In the web 
browser, the symbol “EB” may 
be followed by an edit box 
without an edit box name.  Edit 
boxes that begin with the symbol 
“EB” are one line. 
(Ex:  “EB Last name: (cursor)” 
in the address manager program 
or “EB (cursor)”  

Multi edit box MEB This also represents the edit 
box.  But you can type in more 
than one line in the edit box. 
(Ex:  “MEB Subject: (cursor)” in 
the e-mail program) 

Computer edit 
box 

CE The edit box after this symbol 
should allow ASCII to be typed 
in. 
(Ex: “CE To: (cursor) “ in the 
email program) 

Combo box CB It represents the combo box in 
which you can choose an item 
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by pressing the up arrow key or 
the down arrow key. 
(Ex:  “CB Type: *.*” in the 
“Open dialog box” of the word 
processor program) 

Edit combo box ECB You can choose the desired item 
by pressing the up or down 
arrow key, or by directly typing in 
the item name. 
(Ex:  “ECB File name: (cursor) 
“ in the “Open dialog box” of the 
word processor program) 

Prompt button PB PB follows any question in which 
you have to choose “Yes” or 
“No.” You can toggle between 
“Yes” and “No” by pressing the 
“Space” or the “Backspace” 
button.  
(Ex:  When you exit from the 
word processor, “PB Save: Yes”) 

Static box ST ST is followed by the current 
status. 
(Ex:  “ST noname.hbl/insert 
mode/write” in the word 
processor program) 

Link LN It means there is a link in the 
web page. 

Anchor ANC It means there is an anchor in 
the web page. 

Radio button 
 

RB 
 

It represents a radio button, 
which allows you to choose an 
item by pressing the up arrow 
key, down arrow key, space, or 
Backspace.  Also it cycles 
between items when pressing 
this key. 
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(Ex: “RB Attribute: Write” in the 
“Information dialog box” of the 
file manager) 

Radio button 
select 

SRB It means that the radio button is 
selected. 

Radio button 
unselect 

URB It means that the radio button is 
not selected. 

Check box check SCHB It means that the check box is 
selected. 

Check box 
uncheck 

UCHB It means that the check box is 
not selected. 

 
Links, anchors, and check boxes are controls that are only used in the 
web browser. The symbols enable you to understand what type of box or 
menu you are working with. For example, if “MN,” “MI,” or “LI” are 
displayed in front of a list, you can move from one item to the next item 
or previous item by pressing the up or down arrow key. 
 
Note: If “ECB,” “EB,” “CB,” or “MEB” are displayed on the display, you 
will have to find the cursor and input the desired letters at the cursor 
position when the Voice Sense QWERTY is connected to use with S
yncBraille. If “BT” is displayed, you can press “Enter” to “push the 
button.” 
 
2.10 Basic Explanation of Disks, folders, and files 
 
The flash memory in the Voice Sense QWERTY is similar to a big 
bookshelf in a library. The piece of hardware in the Voice Sense 
QWERTY that is called the “disk” is similar to the idea of a bookshelf in a 
library. You can make partitions on a bookshelf in order to organize 
books into categories.  Each category can be compared to what are 
called “folders” on the Voice Sense QWERTY. The books in each 
section can be compared to what are called “files” on the Voice Sense 
QWERTY. You can save files into any folders at your convenience.  If 
you make the proper folder names for files you are saving, it will make it 
easier to find saved files when you need to access them later. 
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When the Voice Sense QWERTY is shipped from the factory, the name 
of the flash memory in the Voice Sense QWERTY is called “flashdisk.” 
You can create mailboxs on this “flashdisk” in any way that you prefer. 
 
You can also expand your memory space by using additional memory 
devices, through a SD card or USB stick memory. The USB stick 
memory is called “USB” and SD card is called “sd”. If you decide to add 
any of these memory devices, you will be able to create mailboxs, and 
save files on the additional memory devices. 
 
2.11 How to type the character 
 
For the Voice Sense QWERTY in word processor, the way you type the 
character in Braille document is different from other documents.  
It is same as Perkins type of notetaker which means dot 1-F, dot 2-D, dot 
3-S, dot 4-J, dot 5-K and dot 6-L. 
 
For example, let’s say you type “sea” in the Braille Document. Pressing 
“D-S-J” corresponds to “s” (dot 2-3-4), pressing “F-K” corresponds to “e” 
(dot 1-5) and pressing “F” corresponds to “a” (dot 1) 
 
2.12 How to use the Virtual Cursor 
 
You will need to check any list items, status information or any message 
in detail when you are using Voice Sense QWERTY. If you use the 
Virtual Cursor, you can move by word or move by letter when you read 
list items, status information or any message. There are many display 
items that as no real cursors. For example, there is no real cursor in the 
file list of the File Manager, program list in the Program menu or power 
status information. The Virtual Cursor is used to check any items that do 
not have real cursor by moving the virtual cursor by word or by letter. 
 
Followings are the Virtual Cursor keys; 
Move to beginning of the message: Alt-Shift-Left arrow key 
Move to end of the message: Alt-Shift-Right arrow key 
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Move to previous line: Alt-Shift-Up arrow key 
Move to next line: Alt-Shift-Down arrow key 
Move to previous word: Alt-Shift-q 
Move to next word: Alt-Shift-e 
Move to previous character: Alt-Shift-x 
Move to next character: Alt-Shift-v 
Read current word: Alt-Shift-w 
Read current character: Alt-Shift-c 
 
If you press “Alt-Shift-c”, the Voice Sense will read current character. 
And if you press this key again, it will read phonetic sign of the character.  
For example, if you press “Alt-Shift-c” on the alphabet ‘A’, Voice Se
nse will read ‘ei’ and if you press again, it read ‘alpha’. 
 
2.13 Using the Function key 
 
“Function key" is on the left side bottom of the keyboard. "Function key" 
called as "Fn". When do hotkey combination or list transfer, is used. For 
example, if combined “Fn” and “Up arrow key”, do “Page up” and 
combined “Fn” and “Down arrow key”, do “Page down” and combined 
“Fn” and “Right arrow key”, do “End” and combined “Fn” and “Left arrow 
key”, do “Home”.  
And press “Fn” and “Insert”, “Num lock on/off” function is executed. This 
function is executed, M(0), J(1), K(2), L(3), U(4), I(5), O(6), 7(7), 8(8), 
9(9), 0(*), ;(+), .(.), /(/) are inputted being changed by key in parenthesis. 
 
2.14 Multi Tasking 
 
The Voice Sense QWERTY can do more than one task at the same time, 
which is called multi-tasking. For example, you can work with the word 
processor while you are listening to music, and you can put calculations 
into a document at the same time. This is called a Voice Sense 
QWERTY multi-task. If you want to work with the word processor while 
listening to music, you can first run the media player and play a music 
file. While playing music, you can press the “Win key” to open the Voice 
Sense QWERTY menu and run the word processor. 
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The Voice Sense QWERTY can run up to seven programs 
simultaneously. You cannot have more than seven multi-tasks. That is, 
you cannot run more than seven programs at the same time. If you try to 
run a program that you are already running, the new instance of the 
program will not start, and you will be taken to the instance of the 
program that is already running. For example, while you are working with 
a document called “A,” you decide to execute the “file manager.” Next, 
you move to a document called “B” by pressing the move keys in the “file 
list” of “file manager,” and you press “Enter.” Then, the word processor 
will not load again for opening the document “B,” but the document “B” 
will be opened in the word processor, which document “A” is also 
running on. If you want to switch documents, you need to open them in 
the word processor without running other programs. In this case, you 
can switch them with “tab” or “shift-tab”. Switching documents will be 
explained later in detail in section 4, which covers the word processor. 
 
2.14.1 Open the Task Name 
 
After you press “Win key” to call up the “program” menu, or after you 
press “Fn-F10” to open the Task Name, you can press “ESC” to return to 
the previously-running program.  
 
If you want to switch between programs while running more than one 
program,  

1) Press the “Fn” and “F10” at the same time to open the Task Name.  
2) The Task Name shows the names and numbers of the running 

programs, just like the file manager.  
3) You can cycle through the running programs on the Voice Sense 

QWERTY with the “Up arrow key”or the “Down arrow key.”  
4) Press the “enter” to run the program that you want after focusing 

on your selection. 
 
2.14.2 Switch the Executing Program 
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The combination of the “Alt” and “Tab” keys can switch between all of 
the executing programs immediately without opening the Task Name.  
If you are executing three programs and you are in the second program,  

1) Pressing the “Alt” and “Tab” at the same time will move you to the 
third program.  

2) If you press “Alt-Tab” again, you will be on the first program. 
 
In the above case, pressing “Alt-F4” will close the current executing 
program and move you to the previous program. However, if there is 
only one program executing, pressing “Alt-F4” will close the program and 
move you to the Voice Sense QWERTY “program” menu. Note that “Alt-
F4” is different from the “ESC”, which does not close programs. 
 
2.15 Print Spool 
 
The Voice Sense QWERTY has a print spool function. This function 
enables the Voice Sense QWERTY to do other tasks while printing to an 
ink-printer or Braille embosser. For example, if you send data to your 
printer or embosser, you will be immediately returned to where you were 
before the print command was executed.  
If you want to check the print spool dialog box after you have given the 
print command,  

1) Press “Fn-ctrl-p” or “Alt-shift-p”.  
2) Then, you will see the dialog box which has three controls. 
3) The first control is a list that gives you information about files that 

are being printed. There is also a “Cancel” button and a “Close” 
button. However, if you open up the dialog box without printing 
anything, you will see “no items” and the “Close” button. 

4) You can cycle through the three controls by pressing “Tab” or 
“Shift-Tab. In the information list, you can move item by item by 
pressing “Down arrow key” or “Up arrow key”.  

 
While printing, the information list will contain the following:  “executing 
program name,” “printing file name,” “printer type,” “the number of 
copies,” and either “printing” or “ready.”  
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For example, let’s assume that we are printing one copy of “sample.hbl” 
in the word processor. In the info list, you will see “program: word 
processor, file: sample.hbl, printer, copy: 1, printing.” If you are using a 
Braille embosser, you will see “embosser” instead of “printer.” If there is 
not anything printing and, (the printer is waiting), you will see “ready” 
instead of “printing.” If you print something out in the e-mail program, 
you will see “emailtemp.txt,” instead of the file name. When you are 
printing something from the address manager, or the schedule manager, 
you will see the message, “prn_(time).txt.” 
 
If you focus on any of the files in the info list, and press “Enter” on 
“Cancel” after pressing “tab”, you will cancel the printing of that file. If 
you press “tab” repeatedly, locate “Close,” and press “Enter” on “Close,” 
you will close the print spool dialog box. Pressing “Alt-F4” will also close 
the print spool. 
 

2.16 One-Handed Mode 
 
Voice Sense QWERTY provides a one-handed mode for users restricted 
to the use of one hand for key input. To turn on one-handed mode, 
Press “Fn-h”. Also turn off one-handed mode, press “Fn-h”, too. 
When function is executed, it explains about input method. 
 
When contents of file copy whole 

1) Press the “Ctrl”. Then, “Ctrl” is pressed down. 
2) And press “a”. Then, whole copy is executed. 
3) “Ctrl” that is pressed down is canceled.   

 
Check power status 

1) Press the “Fn”. Then, “Fn” is pressed down 
2) And press “b”. Then, power status is checked. 
3) “Fn” that is pressed down is canceled. 

 
Switch to next program 

1) Press the “Alt”. Then, “Alt” is pressed down. 
2) Press the “Shift”. Then, “Shift” is pressed down. 
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3) Press the “Tab”. Then, program is changed next program. 
4) “Alt” and “Shift” that is pressed down is canceled. 

 
The operation of the function keys, audio buttons remains the same as 
in two-handed mode.  
If one-handed mode is on, the Voice Sense QWERTY will advise this 
each time it is turned on, and will also advise what to do to return to the 
two-handed mode. 
 

2.17 Open Txt Help 
 
It opens txt help of current program in Voice Sense QWERTY. Press 
“Win key and “F1”. Then, txt help of current program is open. By 
pressing “Up arrow key” or “Down arrow key”, you can open the txt help 
of the program to read. By pressing “Win key-F1”, you can read each 
help mode of the program while executing. If you want to close txt help, 
press “Alt-F4”.  
 
2.18 Key Help Mode 
 
When you press each key on the keyboard, it describes key with voice  
to learn easily the position of keys In Voice Sense QWERTY. To execute 
the key help mode, press “Ctrl-ESC” regardless of location. Then, it will 
be announced “Key help mode on” with voice. For example, if you press 
“Shift”, it announces “Shift” with voice. And if you press “Tab”, it 
announces “Tab” with voice. If you want to close key help mode, press 
“Ctrl-ESC”. Then, it will be announced “Key help mode off” with voice, to 
return to the executing program. 
 
2.19 Using Typing Mode 
 
While typing in document, you can execute “Typing Mode”. 
 
In order to execute the “Typing Mode”, follow these steps: 

1) Press “Fn-Ctrl-t”, while typing in document. 
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2) It shows “Start typing mode” 
 
If you press “Ctrl-ESC” while executing the “Typing Mode”, it will be 
typed “Ctrl” and “ESC” instead of executing the “Key help mode”. 
In order to cancel the “Typing Mode”, follow these steps: 

1) Press “Fn-Ctrl-t” in the “Typing Mode”. 
2) It shows “End typing mode”. 

 
After canceling the “Typing Mode”, it will excute “Key help mode” when 
you press “Ctrl-ESC”. 
 
 
 
2.20 Common Combination Keys 
 
1. Call up the program menu: Win key 
2. Key help mode: Ctrl-ESCExecute the individual program in the 

program menu Win key-”shortcut key” (varies for each program) 
3. Call up the Task Name list: Fn-F10 
4. Switch to previous program: Alt-shift-tab 
5. Switch to next program: Alt-tab 
6. Call up the menu in the individual program: Alt 
7. Exit: Alt-F4 
8. Escape: ESC 
9. Move to the next control in a dialog box: Tab  
10. Move to the previous control in the dialog box: Shift-tab  
11. Move to the previous character: Left arrow key 
12. Move to the next character: Right arrow key 
13. Move to the previous line/item: Up arrow key 
14. Move to the next line/item: Down arrow key 
15. Move to the beginning of line/item: Fn-Left arrow key 
16. Move to the end of line/item: Fn-Right arrow key 
17. Move to the top of a document or to the first item: Ctrl-Fn-Left arrow 

key 
18. Move to the bottom of a document or to the last item: Ctrl-Fn-Right 

arrow key 
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19. Move to the previous page or to the first item of the previous 32-
item group: Fn-Up arrow key 

20. Move to the next page or to the first item of the next 32-item group: 
Fn-Down arrow key 

21. Read the current item again: Fn-r  
22. Say current time: Fn-t 
23. Check power status: Fn-b 
24. Call up the “Global options”: F10 
25. Online help: F1 
26. Checking your version: Fn-v only in the Voice Sense QWERTY 

“program” menu.” 
27. Display Networg Status: Fn-n in the Voice Sense QWERTY 

“program” menu 
28. Open txt help: Win key-F1 while executing program 
29. Scroll left: Up scroll button (This function executes when the Voice 

Sense QWERTY is connected to SyncBraille.) 
30. Scroll right: Down scroll button (This function executes when the 

Voice Sense QWERTY is connected to SyncBraille.) 
31. Move the cursor to each cell or move to an item: The corresponding 

cursor routing key. (This function executes when the Voice Sense 
QWERTY is connected to SyncBraille.) 
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3. Global options 
 
The “Global options” in the Voice Sense QWERTY has information on all 
of your settings. You can change your preferences regarding each option. 
Pressing the “F10”, you can open the “Global options” while you are 
anywhere in the Voice Sense QWERTY. You can navigate all of the 
items in the “Global options” with “Up arrow key” or “Down arrow key.” 
You can change the setting values with the “Space” or “Backspace” 
buttons. There are many shortcut keys which you can use to quickly 
move you to wherever you want to go in the “Global options”.  
 
The “Global options” is like a dialog box. To change and save the 
settings in the “Global options”, you must press “Enter” once you have 
selected the setting that you want to save. If you do not press “Enter” (or 
select “Confirm”) on the setting that you want, the setting will not be 
saved.  Once you press “Enter” to save the setting, the Voice Sense 
QWERTY will say, “Saved options,” and you will be returned to where 
you were before you entered the “Global options”. To cancel the change 
to the setting, press the “ESC”, or “Alt-F4”. The Voice Sense QWERTY 
will then speak the message, “Canceled saving options.”  When you are 
on an option, you can also use “Tab” or “Shift-Tab” to go to the “Confirm” 
and “Cancel” buttons. If you want to save your settings, press “Enter” on 
the “Confirm” button. If you do not want to save the changes you made 
to the settings, press “Enter” on the “Cancel” button. 
 
Before we go in to detail about each option, let’s first go through a brief 
overview of what you will find in the “Global options”. 
 
The “Global options” contains different settings that can be changed in 
the Voice Sense QWERTY. By pressing “F10”, you can open the “Global 
options” while you are anywhere in the Voice Sense QWERTY. The 
“Global options” has five groups. 
 
1. Braille setting: Braille cursor, eight dot mode, viewgrade, and 

message display time. 



27 
 

Note: This function will appear when the Voice Sense QWERTY is 
connected to SyncBraille. 

2. Voice setting: voice, punctuation level, keyboard echo, capitalization 
alert, numbers, voice volume, voice rate, voice pitch, and scroll voice. 
Note: “Voice” and “Scroll voice” will appear when the Voice Sense 
QWERTY connected to SyncBraille. 

3. Display setting: LCD, flip LCD dsplay and LCD font size. 
4. Print setting: printer port and print paper size 
5. General setting: audio alerts, play power on/off sound, skip empty 

lines, control information, show password, hot key information, 
announce shortcut keys, power saving mode, power saving kick in, 
check today's schedule, one-handed mode, spell check automatically, 
default document type, Automatically synchronize with time server, 
progress indicator, Bluetooth, wireless LAN, Ethernet port, and mass-
storage device mode. 

 
Let’s take a look at each function in the “Global options” in more detail, 
and look at the specific steps on how to change the various settings. It is 
very important to note that there are duplicate shortcut keys; therefore, 
pressing a shortcut key will move the focus to the next setting that has a 
matching shortcut key, and pressing the same shortcut key will move the 
focus to the next setting that has the same shortcut key. If there are no 
more settings that have the same shortcut key, the Voice Sense 
QWERTY will wrap around and move to the first match. Pressing “Up 
arrow key” or “Down arrow key” moves the focus to the previous setting 
or the next setting. Pressing “page up (Fn-Up arrow key)” or “page down 
(Fn-Down arrow key)” will move the focus to the beginning of the 
previous group of settings or to the beginning of the next group of 
settings. 
 
3.1 Braille Cursor 
 
Note: This function will appear when the Voice Sense QWERTY is 
connected to SyncBraille. 
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You can choose how you want the Braille cursor to show up on the 
Braille display. The shortcut key is “c”. By default the cursor is set to 
“Always up.” If you do not want the cursor set to “Always up,” you can 
press the “Space” to turn the cursor “Blinking,” and one more press the 
“Space” to turn the cursor “Off.” If you have changed the setting, press 
the “Enter” to save the setting. You can also “tab” or “shift-tab” to the 
“Confirm” button, and press “Enter.” If you do not want to save the 
setting, “tab” or “shift-tab” to the “Cancel” button, and then press “Enter.” 
You can also cancel saving the setting by pressing “Alt-F4” or “ESC”. 
 
Note that there are three types of cursors: 
1. “dots 7-8” 
2. blinking “dots 7-8” 
3. blinking “dots 1-2-3-4-5-6-7-8” 
The blinking “dots 7-8” will be displayed when you are in the “overwrite 
mode” in the word processor. The blinking “dots 1-2-3-4-5-6-7-8” will 
appear when you are using the “Start Selection” setting in the word 
processor and when you are in an edit box. In all other situations, the 
cursor will be displayed as “dots 7-8.” 
 
3.2 Eight Dot Mode 
 
Note: This function will appear when the Voice Sense QWERTY is 
connected to SyncBraille. 
 
You can choose to use a 6-dot-Braille or 8-dot-Braille display when 
using ASCII text mode. The shortcut key is “e”. By default the 8-dot-
Braille display is set to off. You can switch this option to 8-dot-Braille 
mode by pressing the “Space”. You can toggle this option on/off by 
pressing “Fn-F4” while you are using another program in the Voice 
Sense QWERTY, without having to pull up the “Global options”. If you 
have changed the setting, press the “Enter” to save the setting. You can 
also “tab” or “shift-tab” to the “Confirm” button, and press “Enter.” If you 
do not want to save the setting, “tab” or “shift-tab” to the “Cancel” button, 
and then press “Enter.” You can also cancel saving the setting by 
pressing “Alt-F4” or “ESC”. 
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3.3 View Grade 
 
Note: This function will appear when the Voice Sense QWERTY is 
connected to SyncBraille. 
 
You can choose what grade of Braille you want the Braille display to use 
when reading. Words situated in current cursor are output Computer 
Braille and remaining characters are output Uncontracted Braille or 
Contracted Braille.The shortcut key is “g”. The setting choices are 
“Uncontracted Braille”, “Contracted Braille”, and “Computer Braille”. You 
can switch between the settings by pressing the “Space”. You can press 
“Fn-g” to cycle through the three settings while you are using other 
programs without calling up the “Global options”. If you have changed 
the setting, press the “Enter” to save the setting. 
You can also “tab” or “shift-tab” to the “Confirm” button, and press 
“Enter.” If you do not want to save the setting, “tab” or “shift-tab” to the 
“Cancel” button, and then press “Enter.” You can also cancel saving the 
setting by pressing “Alt-F4” or “ESC.” 
 
3.4 Message Display Time 
 
Note: This function will appear when the Voice Sense QWERTY is 
connected to SyncBraille. 
 
You can choose when a Braille message will disappear from the Braille 
display. This setting will only work when the voice setting is set to “Off”. 
But “Stand by” and “Ignore” execute when the voice setting is set to “On”.  
The shortcut key is “m.” The setting options that you can choose from 
are “Stand by,” “Ignore”, and 1 to 10 seconds. The default is “3 
seconds.” The “Space” increases the option by one second and the 
“Backspace” decreases the option by one second. You can set the unit 
to standby mode by pressing the “Space” until you reach “Stand by.” In 
this mode, the message will remain until you press a key. The higher 
value you select, the longer the message remains. If you read the 
message before setting the number of seconds, you can clear the 
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message by pressing any key. If you choose “Ignore,” then messages 
will be ignored and won’t show on the display. If you have changed the 
setting, press the “Enter” to save the setting. You can also “Tab” or 
“Shift-Tab” to the “Confirm” button, and press “Enter.” If you do not want 
to save the setting, “Tab” or “Shift-Tab” to the “Cancel” button, and then 
press “Enter.” You can also cancel saving the setting by pressing “Alt-
F4” or “ESC.” 
 
3.5 Voice 
 
Note: This function will appear when the Voice Sense QWERTY is 
connected to SyncBraille. 
 
This menu will allow you to turn the Voice Sense QWERTY voice on or 
off. The shortcut key is “v”. By default the voice is set to on, so you will 
hear the Voice Sense QWERTY speak. You can turn off the voice with 
the ‘“Space”. You can toggle it on and off by pressing “F5” while you are 
using another program in the Voice Sense QWERTY without having to 
call up the “Global options”. If you have changed the setting, press the 
“Enter” to save the setting. You can also “tab” or “shift-tab” to the 
“Confirm” button, and press “Enter.” If you do not want to save the 
setting, “tab” or “shift-tab” to the “Cancel” button, and then press “Enter.” 
You can also cancel saving the setting by pressing “Alt-F4” or “ESC.” 
 
You can also press “F5” while turning on the Voice Sense QWERTY, 
which will turn the Voice Sense QWERTY on without speech. When 
resetting the Voice Sense QWERTY, you can also press “F5” when you 
press the reset button to reset the Voice Sense QWERTY, and turn on 
the Voice Sense QWERTY without speech. 
 
3.6 Punctuation Level 
 
You can choose how you want the Voice Sense QWERTY to read 
punctuation marks. The shortcut key is “p”. The setting options are “All,” 
“Off,” “Punctuation,” and “Symbol.” The default setting is set to “All” in 
which the Voice Sense QWERTY will say all punctuation marks and 
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symbols. The “Space” allow you to cycle through all four of the setting 
values. If you select “Off,” the Voice Sense QWERTY will not say any 
punctuation marks. The option, “Punctuation” will make the Voice Sense 
QWERTY say only punctuation marks, but the “Symbol” option will say 
all symbols without saying punctuation marks.  If you have changed the 
setting, press the “Enter” to save the setting.  You can also “tab” or 
“shift-tab” to the “Confirm” button, and press “Enter.” If you do not want 
to save the setting, “tab” or “shift-tab” to the “Cancel” button, and then 
press “Enter.” You can also cancel saving the setting by pressing “Alt-
F4” or “ESC.” 
 
3.7 Keyboard Echo 
 
With this option, you can decide how the Voice Sense QWERTY will 
speak when you are typing. The shortcut key is “k”. The setting values 
are “On with characters and words,” “On with characters,” “On with 
words,” and “Off.” If you select the default “On with characters and 
words,” you can hear each keystroke and a word right after it is 
completed. If you select “On with characters,” you can hear each 
keystroke letter by letter. If you select the “On with words” option, you 
can hear each word right after it is completed, but not each letter. You 
can cycle through each of the options by pressing the “Space”. If you 
have changed the setting, press the “Enter” to save the setting.  You 
can also “tab” or “shift-tab” to the “Confirm” button, and press “Enter.” If 
you do not want to save the setting, “tab” or “shift-tab” to the “Cancel” 
button, and then press “Enter.” You can also cancel saving the setting by 
pressing “Alt-F4” or “ESC.” 
 
3.8 Capitalization alert 
 
You can decide how the Voice Sense QWERTY will speak the “capital 
character” when you type the character or read the document by using 
“Left arrow key” or “Right arrow key” in computer edit box or ASCII 
mode . The shortcut key is “u”. The setting values are “Off,” “Say cap,” 
and “Pitch.” The default value is “Pitch.” If you select the default, you will 
hear higher pitch when meet the capital letter. And if you select the “Off”, 
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read the same regardless of capital letter and lower case letter. And if 
you select the “Say cap,” you will hear “cap” sound before the capital 
letter. For example, when you meet the capital letter “V,” Voice Sense 
QWERTY will talk “cap v.” 
You can cycle through each of the options by pressing the “Space”.  If 
you have changed the setting, press the “Enter” to save the setting.  
You can also “tab” or “shift-tab” to the “Confirm” button, and press 
“Enter.” If you do not want to save the setting, “tab” or “shift-tab” to the 
“Cancel” button, and then press “Enter.” You can also cancel saving the 
setting by pressing “Alt-F4” or “ESC.” 
 
3.9 Numbers 
 
You can choose how you want the Voice Sense QWERTY to read 
number. The shortcut key is “n” with the default set to “On.” For example, 
if you set “On,” the “2007” will read “two thousand seven.” And you set 
“Off,” “the “2007” will read “two zero zero seven.” You can change the 
value by using “Space.” 
 
If you have changed the setting, press the “Enter” to save the setting.  
You can also “tab” or “shift-tab” to the “Confirm” button, and press 
“Enter.” If you do not want to save the setting, “tab” or “shift-tab” to the 
“Cancel” button, and then press “Enter.” You can also cancel saving the 
setting by pressing “Alt-F4” or “ESC.” 
 
3.10 Voice Volume 
 
You can set the volume level of the voice on the Voice Sense QWERTY. 
The shortcut key is “l”. The setting value is 1 through 10 with the default 
set on 6. When you have set this option to 1, the volume will be set at 
the lowest level. If you set this option to 10, the volume is the loudest. If 
you set the volume level to 1, you will almost not be able to hear. The 
“Space” increases the volume and the “Backspace” decreases the 
volume by one number at a time. Please note that if you are at volume 
level 10, and increase the volume by one, the volume loops back to level 
1. The same is true if you are at level 1, and decrease the volume by 
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one unit. You will then be at level 10. Without opening the “Global 
options”, you can increase the volume by pressing, “F6,” or you can 
decrease it by pressing “Shift” and “F6”. 
 
If you have changed the setting, press the “Enter” to save the setting.  
You can also “tab” or “shift-tab” to the “Confirm” button, and press 
“Enter.” If you do not want to save the setting, “tab” or “shift-tab” to the 
“Cancel” button, and then press “Enter.” You can also cancel saving the 
setting by pressing “Alt-F4” or “ESC.” 
 
3.11 Voice Rate 
 
You can control the rate of the Voice Sense QWERTY speech.  The 
shortcut key is “r”. The setting options are 1 through 12 with the default 
set to 8. The “Space” increases the rate level and the “Backspace” 
decreases the rate level by one unit at a time. Without opening the 
“Global options”, you can increase the voice rate by pressing “F7,” or 
you can decrease it by pressing “Shift” and “F7”. If you are at level 12, 
and increase the rate by one unit, you will go to level 1. Also, if you are 
at level 1, and decrease the rate by one unit, you will go to level 12. 
 
If you have changed the setting, press the “Enter” to save the setting.  
You can also “tab” or “shift-tab” to the “Confirm” button, and press 
“Enter.” If you do not want to save the setting, “tab” or “shift-tab” to the 
“Cancel” button, and then press “Enter.” You can also cancel saving the 
setting by pressing “Alt-F4” or “ESC.” 
  
3.12 Voice Pitch 
 
You can control the voice pitch of the Voice Sense QWERTY.  The 
shortcut key is “t”. The available options are 1 through 10 with the 
default set to 6. At level 10, the voice pitch will be the highest; and, at 
level 1, the voice pitch will be the lowest. The “Space” will increase the 
voice pitch and the “Backspace” will decrease the voice pitch by one 
level. Just as with the voice volume and voice rate, if you are at level 10, 
and you increase the voice pitch by one level, you will go to level 1. And, 
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if you are at level 1 and decrease the voice pitch by one level, you will 
go to level 10. When you are not in the “option,” menu, you can increase 
the pitch by pressing, “F8,” or you can decrease it by pressing “Shift” 
and “F8”. 
 
If you have changed the setting, press the “Enter” to save the setting.  
You can also “tab” or “shift-tab” to the “Confirm” button, and press 
“Enter.” If you do not want to save the setting, “tab” or “shift-tab” to the 
“Cancel” button, and then press “Enter.” You can also cancel saving the 
setting by pressing “Alt-F4” or “ESC.” 
 
3.13 Scroll Voice 
 
Note: This function will appear when the Voice Sense QWERTY is 
connected to SyncBraille. 
 
You can decide if you want the Voice Sense QWERTY to speak while 
using the scroll buttons in the document. The shortcut key is “s” with the 
default set to “Off.” The default setting (Off) does not allow the Voice 
Sense QWERTY to speak while scrolling. The “Space” toggles off/on. If 
you set the option to “On,” you can hear the Voice Sense QWERTY 
while scrolling. 
 
If you have changed the setting, press the “Enter” to save the setting.  
You can also “tab” or “shift-tab” to the “Confirm” button, and press 
“Enter.” If you do not want to save the setting, “tab”or “shift-tab”to the 
“Cancel” button, and then press “Enter.” You can also cancel saving the 
setting by pressing “Alt-F4” or “ESC.” 
 
3.14 LCD 
 
You can decide whether the Voice Sense QWERTY will show text on the 
LCD screen. If you decide to turn the LCD screen on, sighted people will 
be able to see what you are working on when they look at the LCD 
screen. The shortcut key is “l” with the default set to “Off.” The setting 
values are “Off,” “On,” and “On with backlight.” The “On with backlight” 
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setting will light the background of the LCD screen. You can toggle 
between all three of these options by pressing the “Space”. 
 
Without calling the “Global options”, you can change setting value 
directly, by pressing “Fn-F2”. 
 
If you have changed the setting, press the “Enter” to save the setting.  
You can also “Tab” or “Thift-tab” to the “Confirm” button, and press 
“Enter.” If you do not want to save the setting, “Tab” or “Shift-Tab” to the 
“Cancel” button, and then press “Enter.” You can also cancel saving the 
setting by pressing “Alt-F4” or “ESC.” 
 
3.15 Flip LCD Display 
 
You can decide if the text on the LCD screen is shown in the right or 
reverse direction. By default, it is set to “Off,” You can switch the value to 
“On” or “Off.” If you set this option to “Off,” the text on the LCD screen is 
shown in the right direction and if you set this option to “On,” the text on 
the LCD screen is shown in the reverse direction and it means the 
sighted person facing you can see the text on the LCD screen in the 
right direction. It is a good tool for teachers or Deaf-blinds. 
 
If you have changed the setting, press the “Enter” to save the setting.  
You can also “Tab” or “Shift-Tab” to the “Confirm” button, and press 
“Enter.”  If you do not want to save the setting, “Tab” or “Shift-Tab” to 
the “Cancel” button, and then press “Enter.”  You can also cancel 
saving the setting by pressing “Alt-F4” or “ESC.” 
 
3.16 LCD Font Size 
 
You can change the font size on LCD panel. The shortcut key is “”. The 
default is set to 19, but you can set the font size anywhere from 12 to 20. 
You can increase the font by one size with the “Space”, and you can 
decrease the font size with the “Backspace”. If you have the font size set 
to 20, and you increase the font by one size, the font will go to 12. If your 
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font size is 12, and you decrease the font by one size, the font will go to 
20. 
 
If you have changed the setting, press the “Enter” to save the setting.  
You can also “Tab” or “Shift-Tab” to the “Confirm” button, and press 
“Enter.” If you do not want to save the setting, “Tab” or “Shift-Tab” to the 
“Cancel” button, and then press “Enter.” You can also cancel saving the 
setting by pressing “Alt-F4” or “ESC.” 
 
3.17 Printer Port 
 
You can choose which port will be used for your printer port when 
sending your documents to a printer. The shortcut key is “p”. The default 
is set to “USB.” If you want to use a USB port printer, you keep the 
default setting. If you want to use a parallel port printer or Bluetooth 
printer, you can change the setting. You can toggle the options by hitting 
the “Space”. 
 
If you have changed the setting, press the “Enter” to save the setting.  
You can also “tab”or “shift-tab”to the “Confirm” button, and press “Enter.”  
If you do not want to save the setting, “tab”or “shift-tab” to the “Cancel” 
button, and then press “Enter.” You can also cancel saving the setting by 
pressing “Alt-F4” or “ESC.” 
For your reference, if you want to use parallel port printer, you must 
connect the USB port to cable that convert USB into parallel. 
 
3.18 Print Paper Size 
 
This option allows you to select the size of the paper that an ink printer 
will use, if you will be printing to an ink printer. The shortcut key for this 
function is “s”. You can change the size for this option by pressing 
“Space.” You can choose between the settings of, “Letter” (8.5 inches by 
11 inches) or, “Legal” (8.5 inches by 14 inches.) 
 
If you have changed the setting, press the “Enter” to save the setting.  
You can also “tab”or “shift-tab” to the “Confirm” button, and press 
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“Enter.” If you do not want to save the setting, “tab”or “shift-tab”to the 
“Cancel” button, and then press “Enter.” You can also cancel saving the 
setting by pressing “Alt-F4” or “ESC.” 
 
3.19 Audio alerts 
 
You can choose whether you will hear a warning sound or not. The 
shortcut key is “w”. This option is useful if the speech setting on the 
Voice Sense QWERTY is turned off. The default for this option is set to 
“On.” If you turn off the speech, you will hear a beeping sound when you 
type in keys that the Voice Sense QWERTY does not accept. If you don't 
want to hear the warning sound, you can press the “Space” once to turn 
“Off” the audio alerts. 
 
If you have changed the setting, press the “Enter” to save the setting.  
You can also “tab”or “shift-tab” to the “Confirm” button, and press 
“Enter.” If you do not want to save the setting, “tab”or “shift-tab”to the 
“Cancel” button, and then press “Enter.” You can also cancel saving the 
setting by pressing “Alt-F4” or “ESC.” 
 
3.20 Play Power On/Off Sound 
 
You can choose whether you will hear a power on/off sound or not when 
you turn on the Voice Sense QWERTY. The shortcut key is “s”. The 
default for this option is set to “On.” If you keep default setting, you will 
hear a starting sound signal when you turn on or off the Voice Sense 
QWERTY. 
If you don’t want to hear the on/off sound signal, you can press the 
“Space” once to turn “Off” the sound signal. 
If you have changed the setting, press the “Enter” to save the setting.  
You can also “tab”or “shift-tab” to the “Confirm” button, and press 
“Enter.” If you do not want to save the setting, “tab” or “shift-tab” to the 
Cancel” button, and then press “Enter.” You can also cancel saving the 
setting by pressing “Alt-F4” or “ESC.” 
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3.21 Skip Empty Lines 
 
You can choose to have the Voice Sense QWERTY read a blank line, or 
to skip empty lines. The shortcut key is “e”, and the default is set to “Off.” 
If you keep the default setting, you will hear the words “empty line” if 
there is a blank line. The “Space” toggles off/on. If you choose to turn 
this option on, the Voice Sense QWERTY will skip all blank lines, and 
you will not hear the words “empty line” when there is a blank line. If you 
have changed the setting, press the “Enter” to save the setting. You can 
also “tab”or “shift-tab”to the “Confirm” button, and press “Enter.” If you 
do not want to save the setting, “tab”or “shift-tab”to the “Cancel” button, 
and then press “Enter.” You can also cancel saving the setting by 
pressing “Alt-F4” or “ESC.” 
 
3.22 Control Information 
 
You can choose the display location of information regarding the files 
and menus in the Voice Sense QWERTY. The short cut key is “i”, and 
the default is set to “After.” To toggle “Control information” between 
before, after and off, press “space. 
 
If you select “Before,” you will hear control information before a menu or 
list item. If you select “After,” you will hear control information such as 
“list item” or “menu item” after a menu or list item. If you have control 
information shut off, you will not hear “list item” or “menu item.” 
 
Note that if the Web browser is activated, the control symbols will appear 
even if you turn off the “Control information” option.  
If you have changed the setting, press the “Enter” to save the setting.  
You can also “tab” or “shift-tab” to the “Confirm” button, and press 
“Enter.” If you do not want to save the setting, “tab”or “shift-tab”to the 
“Cancel” button, and then press “Enter.” You can also cancel saving the 
setting by pressing “Alt-F4” or “ESC.” 
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3.23 Show passwords 
 
When you enter the password in computer edit box, you can select 
display mode either “*” or the letter exactly that you write on the LCD.   
  
The short cut key is “p,” and the default is set to “off”. 
When you enter the password, it will be shown “*” on the LCD. 
 
By pressing “Space”, you can change set to “on”. When you type the 
password, it will be shown the letter exactly that you write on the LCD. 
 
You have changed the setting, press the “Enter” to save the setting.  
You can also “Tab)” or “Shift-Tab” to the “Confirm” button, and press 
“Enter.” If you do not want to save the setting, “tab” or “shift-tab” to the 
“Cancel” button, and then press “Enter.” You can also cancel saving the 
setting by pressing “Alt-F4” or “ESC.” 
 
3.24 Hot Key Information 
 
As described before, hot keys are keystrokes that can take you directly 
to an item, such as a menu, or a particular item in a list. You can choose 
the speech output method of hot key. The short cut key is “h”, and the 
default is set to “On”. The setting values are “On,” and “Off.” You can 
cycle through each of the options by pressing the “Space”. For example, 
when you select “On,” the “Open (o) Ctrl-o” will output with “Open (o) 
Ctrl-o”. And if you select “Off,” you can’t hear the hot key information. 
 
If you have changed the setting, press the “Enter” to save the setting.  
You can also “tab” or “shift-tab” to the “Confirm” button, and press 
“Enter.” If you do not want to save the setting, “tab”or “shift-tab”to the 
“Cancel” button, and then press “Enter.” You can also cancel saving the 
setting by pressing “Alt-F4” or “ESC.” 
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3.25 Announce shortcut keys 
 
The “Announce shortcut keys” option allows you to decide if the Voice 
Sense QWERTY will say the shortcut key for a function. The shortcut 
key is “s” and the default is set to “On.” For example, if you hear, “File (f) 
pull down,” the shortcut key is the letter “f.” If you prefer the Voice Sense 
QWERTY only says, “File pull down,” you will want to turn the 
“Announce shortcut keys” setting off. To toggle “Announce shortcut 
keys” between on and off, press “Space.” 
  
If you have changed the setting, press the “Enter” to save the setting.  
You can also “tab”or “shift-tab”to the “Confirm” button, and press “Enter.”  
If you do not want to save the setting, “tab”or “shift-tab”to the “Cancel” 
button, and then press “Enter.” You can also cancel saving the setting by 
pressing “Alt-F4” or “ESC.” 
 
3.26 Power Saving Mode 
 
You can choose to have the Voice Sense QWERTY use the power 
saving mode. The shortcut key is “p”. The default setting is set to “On,” 
which will use the power saving mode. The setting valuesswitch 
between “On”,“Off”, and “Message”, using “Space”. If you don't want to 
use the power saving mode, you can set the option to “Off.” If you set 
the option to “Message,” you will hear a warning message that says 
“power on” in 10, 20, or 30 minute increments (depending on the setting 
that you will choose for power saving kick in) if you have not pressed 
any keys on the Voice Sense QWERTY. The next section explains how 
to change the power saving kick in to 10, 20, or 30 minutes. If you have 
changed the setting, press the “Enter” to save the setting. You can also 
“tab”or “shift-tab” to the “Confirm” button, and press “Enter.” If you do not 
want to save the setting, “tab”or “shift-tab”to the “Cancel” button, and 
then press “Enter.” You can also cancel saving the setting by pressing 
“Alt-F4” or “ESC.”  
For your reference, this option is available only when the AC adaptor is 
connected to the unit. In other word, although you set the option to “On” 
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if AC adaptor is connected to the unit, the unit will not go to the sleep 
mode automatically when you meet the “Power saving kick in” time. 
 
3.27 Power Saving Kick In 
 
When you want to use the power saving mode, you can set the time 
when the power saving mode will begin. The shortcut key is “k” with the 
default set at “After 10 minutes.” If you set this option to the default, the 
Voice Sense QWERTY will enter into power saving mode when you 
have not used the Voice Sense QWERTY for 10 minutes.  The “Space” 
changes the option setting to 10 minutes, 20 minutes, or 30 minutes. 
 
If you have changed the setting, press the “Enter” to save the setting.  
You can also “tab”or “shift-tab”to the “Confirm” button, and press “Enter.”  
If you do not want to save the setting, “tab”or “shift-tab”to the “Cancel” 
button, and then press “Enter.” You can also cancel saving the setting by 
pressing “Alt-F4” or “ESC.” 
 
3.28 Check Today’s Schedule 
 
In the “Schedule manager” (which you will learn about later), you are 
able to keep track of your appointments, using the Voice Sense 
QWERTY. The Voice Sense QWERTY is able to check today’s schedule 
when you turn it on.You can decide if you want the Voice Sense 
QWERTY to show today’s schedule when it powers on.  The short cut 
key for this option is “s”. To toggle this option between off and on, press 
“Space.” 
 
If you have changed the setting, press the “Enter” to save the setting.  
You can also “tab”or “shift-tab”to the “Confirm” button, and press “Enter.”  
If you do not want to save the setting, “tab”or “shift-tab”to the “Cancel” 
button, and then press “Enter”. You can also cancel saving the setting by 
pressing “Alt-F4” or “ESC”. 
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3.29 One-Handed Mode 
 
You can choose one-handed mode on or off when you use the Voice 
Sense QWERTY. The shortcut key is “h”. The default for this option is 
set to “Off.” The setting options are “On” and “Off.” The detail information 
about one-handed mode refers to “2.16 One-Handed Mode.” 
 
If you have changed the setting, press the “Enter” to save the setting.  
You can also “tab”or “shift-tab”to the “Confirm” button, and press “Enter.”  
If you do not want to save the setting, “tab”or “shift-tab”to the “Cancel” 
button, and then press “Enter.” You can also cancel saving the setting by 
pressing “Alt-F4” or “ESC.”  
For your reference, this option is set to “Off” even if you are set to “On” 
when connected the Voice Sense QWERTY to USB keyboard. And if 
you remove the USB keyboard, this option will be returned to value that 
before you connected to the USB keyboard. 
 
3.30 Spell check Automatically 
 
You can choose whether the Voice Sense QWERTY will check spelling 
or not. This option is available in “multi edit boxes” in programs such as 
the schedule manager, address manager, e-mail messages, the word 
processor, etc. The short cut key for this option is “c”. 
 
By default this setting is set to “No” which will not check your spelling.  
If you want to check spelling, press “Space” to toggle the option to “Yes” 
and press “Enter.” Or, press “tab” to move to the “Confirm” button, and 
press “Enter.” 
 
If you set the option to “Yes” and enter a misspelled word, you will hear 
a beep sound. You will hear a beep sound, even though you shut “No” 
the audio alert discussed in section “3.18”. 
If you do not want to save the changed setting, press “tab” to move to 
the “Cancel” button, and press “Enter.” You can also cancel saving the 
setting by pressing “Alt-F4” or “ESC”. 
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3.31 Default Document 
 
This function is used to set the default document type applied when you 
create a new document using the word processor on the Voice Sense 
QWERTY. The shortcut key for this option is “q”. When you create a new 
document in the “word processor”, “Text document” is selected as the 
file type by default. You can change the default setting using this option. 
 
You can choose between “Sense document”, “Braille document,” and 
“Text document.” By default, it is set to “Text document”. Press “Space” 
to toggle through the three settings, and press “Enter,” or press “tab” to 
move to the “Confirm” button, and press “Enter,” to save the changed 
setting. 
 
If you do not want to save the changed setting, press “tab” to move to 
the “Cancel” button, and press “Enter.” You can also cancel saving the 
setting by pressing “Alt-F4” or “ESC.” 
For your reference, this option is set to “Text document” even if you are 
set to “Sense document” or “Braille document” when connected the 
Voice Sense QWERTY to USB keyboard. And if you remove the USB 
keyboard, this option will be returned to value that before you connected 
to the USB keyboard. 
 
3.32 Automatically synchronize with time server 
 
“Automatically synchronize with time server”, the date and time 
syncronize automatically, when the Voice Sense QWERTY is being  
connected to internet. Using this feature, you can correct the time of 
Voice Sense QWERTY through accurate internet time server. Once the 
Voice Sense QWERTY is being connected to internet, you will hear the 
sound. From this point, the date and time of Voice Sense QWERTY 
syncronize the internet server automatically. The default is "ON", you 
can check or change this option following steps. 
 

1) Press “F10” to call up the menu. 
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2) Press “T” or press “Down arrow key”, move to “Automatically 
synchronize with time server” and press “Enter”. 

3) By pressing “Space”, you can change setting value. 
4) Press “Enter”. 

 
3.33 Progress indicator 
 
Progress indicator shows the progress of opening a document, copying 
files or opening any webpage. This option is used to set the progress 
sign. The shortcut key is “p”, and you can choose one among “Silent,” 
“Beep,” and “Message.” By default, it is set to “Message.” Press “Space” 
to toggle through three settings, and press “Enter” to save to the 
changed option. 
 
If it is set to “Message,” the Voice Sense QWERTY will say progress in 
percentage, like 10% or 20%. If it is set to “Beep,” the Voice Sense 
QWERTY outputs beep sound during copying or opening any 
documents or webpage. If it is set to “Silent”, the Voice Sense QWERTY 
will not hear the any sound in progress of copying or opening. 
 
If you have changed the setting, press the “Enter” to save the setting.  
You can also “tab” or “shift-tab” to the “Confirm” button, and press 
“Enter.” If you do not want to save the setting, “tab”or “shift-tab”to the 
“Cancel” button, and then press “Enter.” You can also cancel saving the 
setting by pressing “Alt-F4” or “ESC”. 
 
3.34 Bluetooth 
 
You can decide whether the Voice Sense QWERTY will turn Bluetooth 
on. The shortcut key for this option is “b”. You can choose between “On” 
and “Off” by pressing “Space.” By default, it is set to “Off.” You can 
toggle it on and off by pressing “F9” while you are using another 
program in the Voice Sense QWERTY without having to call up the 
“Global options”. 
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If you have changed the setting, press the “Enter” to save the setting.  
You can also “tab”or “shift-tab”to the “Confirm” button, and press “Enter.”  
If you do not want to save the setting, “tab”or “shift-tab”to the “Cancel” 
button, and then press “Enter.” You can also cancel saving the setting by 
pressing “Alt-F4” or “ESC.” 
 
For your reference, in order to use Bluetooth function of the Voice Sense 
QWERTY, please turn it on. And please turn it off while you are not 
using the Bluetooth function to save battery power. 
 
3.35 Wireless LAN 
 
You can decide whether Voice Sense QWERTY will turn Wireless LAN 
on. The shortcut key for this option is “w”. You can choose between “On” 
and “Off” by pressing “Space.” By default, it is set to “Off.” You can 
toggle it on and off by pressing “F11” while you are using another 
program in the Voice Sense QWERTY without having to call up the 
“Global options”. 
 
If you have changed the setting, press the “Enter” to save the setting.  
You can also “tab” or “shift-tab” to the “Confirm” button, and press 
“Enter.” If you do not want to save the setting, “tab” or “shift-tab” to the 
“Cancel” button, and then press “Enter.” You can also cancel saving the 
setting by pressing “Alt-F4” or “ESC”.  
For your reference, in order to use wireless LAN function of the Voice 
Sense QWERTY, please turn it on. And please turn it off when you are 
not using the wireless LAN to save battery power. 
 
3.36 Ethernet port 
 
You can decide whether the Voice Sense QWERTY will turn Ethernet 
card (Ethernet port) on or off. The shortcut key for this option is “l”. You 
can switch to “On” or “Off” by pressing “Space.” By default, it is set to 
“Off.” You can toggle it on and off by pressing “Fn-F11” while you are 
using another program in the Voice Sense QWERTY without having to 
call up the “Global options”. 
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If you have changed the setting, press the “Enter” to save the setting.  
You can also “tab” or “shift-tab” to the “Confirm” button, and press 
“Enter.” If you do not want to save the setting, “tab”or “shift-tab”to the 
“Cancel” button, and then press “Enter.” You can also cancel saving the 
setting by pressing “Alt-F4” or “ESC.” 
For your reference, if you want to save battery power, turn this option off 
when you are not using the Ethernet (Wire LAN). 
 
3.37 Mass-storage device mode 
 
You can choose whether the Voice Sense QWERTY will be used as a 
mass-storage device mode or not when the Voice Sense QWERTY is 
connected to the personal computer (PC) via USB. The shortcut key for 
this option is “d” with the default set to “On.” The “Space” toggles off/on. 
If you keep default setting, PC recognizes Voice Sense QWERTY as the 
mass-storage device mode automatically when connecting the Voice 
Sense QWERTY to PC. 
 
If you select “Off,” PC doesn’t recognizes Voice Sense QWERTY. In this 
case, if you want to connect the PC to the Voice Sense QWERTY, you 
need to install and execute the Active Sync program in the PC. You can 
download the Active Sync program from the Microsoft website for free. 
 
If you have changed the setting, press the “Enter” to save the setting.  
You can also “tab”or “shift-tab”to the “Confirm” button, and press “Enter.”  
If you do not want to save the setting, “tab”or “shift-tab”to the “Cancel” 
button, and then press “Enter.” You can also cancel saving the setting by 
pressing “Alt-F4” or “ESC.” 
 
3.38 Common Combination Keys 
 
1. Increase the voice volume: F6 
2. Decrease the voice volume: Shift-F6 
3. Increase the voice rate: F7 
4. Decrease the voice rate: Shift-F7 



47 
 

5. Increase the voice pitch: F8 
6. Decrease the voice pitch: Shift-F8 
7. One-handed mode on/off: Fn-h 
8. Bluetooth on/off: F9 
9. Wireless LAN on/off: F11 
10. Ethernet port on/off: Fn-F11 
11. Selection control information: Fn-F1 
12. Eight dot mode on/off: Fn-F4 (This function executes when the 

Voice Sense QWERTY is connected to SyncBraille.) 
13. Voice on/off: F5 (This function executes when the Voice Sense 

QWERTY is connected to SyncBraille.) 
14. Selecting Braille cursor: Fn-F3 (This function executes when the 

Voice Sense QWERTY is connected to SyncBraille.)  
15. Scroll voice on/off: Fn-F5 (This function executes when the Voice 

Sense QWERTY is connected to SyncBraille.) 
16. LCD on/off: Fn-F2 
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4. File Manager 
 
4.1 Overview 
 
The functions and structures of the “File manager” on the Voice Sense 
QWERTY are very similar to the “file manager” on a personal computer. 
In order to run the “file manager,” press “f” or press “Enter” when you are 
on “file manager” in the “program” menu. 
 
The “File manager” includes an “address window” and a “file list.”  
When you open the “file manager,” the disk name will appear. The 
default disk name is “flashdisk.” You can use the up and down arrows to 
explore additional disks. Press “Enter” on the disk you want to open. The 
Voice Sense QWERTY will show you the list of the files or folders on the 
disk you have opened. 
 
When you press “tab” or “shift-tab” on the “file list,” you will enter into an 
“address window.” The “file list” and “address window” will be explained 
in more detail in section 4.2 and section 4.3 in this user manual. 
 
For your convenience, the “File manager” provides you with menus and 
“hot keys.” The menus will appear when you press “Alt” Section 4.4 will 
provide a more detailed explanation of the hot keys that you can use. 
 
It is possible to format the flashdisk, which will erase everything on the 
flashdisk. Be extremely cautious when executing this command. If you 
execute this command, you will loose all of your data. You will NOT be 
able to get this data back once the command has been executed. 
 
4.1.1 Navigating the File List 
 
There are two kinds of lists that you will see when using the Voice Sense 
QWERTY. The lists are: “file list” and the “menu list.”   When you reach 
the end of the “menu list,” the Voice Sense QWERTY will automatically 
bring you back to the top of the list when you press “Down arrow key.” 
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However, when you reach the end of a “file list,” the Voice Sense 
QWERTY will remain at the end of the “file list,” even if you press “Down 
arrow key.” The following is a list of the navigation keys; 
 

1. Move to previous item: Up arrow key 
2. Move to next item: Down arrow key 
3. Move to the beginning of a list: Ctrl-fn-Left arrow key 
4. Move to the end of a list: Ctrl-fn-Right arrow key 
 
The following keystrokes are valid only when you are on a “file list.” 
 

1. Fast move to folder list or move to file list: Ctrl-Down arrow key 
2. Move between file list and address window: Tab / shift-tab  
3. Enter into a selected folder or open the selected file: Enter 
4. Move to the upper level folder: Backspace 
5. Fast move to the top level disk: Shift-Backspace 
6. Move to the previous 32-item group: Fn-Up arrow key 
7. Move to the next 32-item group: Fn-Down arrow key 
8. Find and move to the file or folder in the file list by pressing the first 

character of the folder or file names.  
 
4.1.2 Item (Folder or File) Selection Key  
 

1. Select item by item (“Space”): Select one or more item(s) while 
moving in a list. If item is select, the Voice Sense will say, “select.”  If 
you pressing “Space” again on the selected file, it will cancel the 
selection.   
Note: When Voice Sense QWERTY connected to SyncBraille, “*” is 
displayed in front of the selected item in Braille. (SyncBraille is sold 
separately.) 

2. Continuous selection (“Ctrl-b”): This will select all of the items from 
the point where this command is executed to the item where 
navigation key is moved to. 

3. Select all (“Ctrl-a”): This selects all the items including files and 
folders in the current path. You can use navigation keys to move 
around the selected items to make sure they are selected.   You can 
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cancel selections or reselect canceled items by pressing the “Space” 
on the item. When the “select all” command is given, the Voice Sense 
QWERTY will say the number of selected files.Voice Sense QWERTY 

 
4.1.3 Cancel / Exit Key 
 
1. Cancel (“ESC”): This command will cancel a function. 
2. Exit (“Alt-F4”): This will cancel or stop a selected function or program.   
 
4.2 Using File Manager Features in the File List 
 
When you open the “File manager,” you will see the list of disks that you 
can access. You can choose a disk from the list, and then press “Enter” 
to get into the selected disk. The Voice Sense QWERTY will show you 
the list of folders and files on that disk.  
 
Note: If the SyncBraille that is a Braille display device is connected to 
the Voice Sense QWERTY, the folder name will be displayed in the 
double quotation mark in Braille, and the file name will be displayed with 
the file extension in Braille.  
 
The items on the list will be followed by numbers, such as 1/5 or 2/5. 
The numbers after the names of the items indicate where an item is on 
the list, and how many items are on the list. For example, “database 
1/5,” means that this is the first folder on a list that has five items. 
 
4.2.1 Selecting Disks 
 
When you open the “File manager,” the first item on the list is “flashdisk.”  
If you inserted the USB memory or SD card in USB port or SD card slot, 
USB memory and SD card will be listed on this list. Any of the disks can 
be selected by using the up and down arrows. After selecting the disk 
you want, press “Enter” to open the disk you have selected.  For more 
information on the name of the disks, refer to section 2.11. 
 
 



51 
 

4.2.2 Getting in and Out of a Folder (Opening/Closing a 
Folder) 
 

1. There are several ways to open a folder. You can utilize a menu to 
get into a specific folder. 
1) You can call up a menu by pressing “Alt”. You will have to choose 

the menu item called “Open” from the list and press “Enter” to get 
into a selected folder. 

2) You can also press “Ctrl-o” to call up the menu to open a desired 
folder. 

3) Another way to open a selected folder is by just pressing “Enter” 
on the folder that is selected. 

2. To close the current folder, you can use the “Backspace”. Then, you 
will be at the next upper level folder list. 

 
4.2.3 Opening a File 
 
You can open a file by pressing “Enter” on the item that is displayed.  
You can also use “Ctrl-o” to open a file or folder. The Voice Sense 
QWERTY will load the appropriate application or program to open the 
file you have chosen. 
 
Another way of opening a file is using the menu. You can press “Alt” to 
call up the menu. Then, press the letter “o,” or you can press “Enter” on 
the item named “Open”. 
 
The file formats that are supported by the Voice Sense QWERTY are as 
follows: 
 
1. Hbl, brl, txt, pwd, brf, rtf, and doc files are supported by the word 

processor on the Voice Sense QWERTY. 
2. Url, and html files are supported by the Web browser on the Voice 

Sense QWERTY. 
3. ac3, asf, asx, m3u, mp2, mp3, ogg, pls, wav, wax, wma, and wmv 

files are supported by the media player on the Voice Sense QWERTY. 
4. Daisy files are supported by the Daisy player on Voice Sense 
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QWERTY. 
 
If you press “Enter” on a file type other than those mentioned above, the 
“Open With” dialog box appears, because the file type is not associated 
with a program. Also, you can bring up the “Open With” dialog box 
through the menu. By using the “Open With” menu item, you can open 
the currently selected file with a program other than the program 
originally associated with it. First, press “Alt” to bring up the menu, press 
“Down arrow key” repeatedly until you reach “Open With,” and then 
press “Enter.” You can also open the dialog box by pressing “Ctrl-h” in 
the file list, or by pressing “e” in the menu. 
 
This dialog box consists of the “Open With” list, the “adopt” list, a 
“Confirm” button, and a “Cancel” button. You can move between these 
elements by pressing “tab” or “shift-tab”. Within the list, you can select 
the next item by pressing “Down arrow key,” and the previous item by 
pressing “Up arrow key”. 
 
As soon as the dialog box opens, “Open with: Word processor” will be 
displayed. In this list, you can select a program, which would be the 
word processor, media player, or web browser. Pressing “Down arrow 
key” will select the next program, and “Up arrow key”will select the 
previous program. Once you have selected the program to open the file 
type with, press “tab” to move to the “adopt” list. If you have selected the 
word processor, pressing “tab” will take you to an additional list called 
“Open mode.” Using this list, you can specify whether the file will be 
opened as a Braille file or a text file. Press “Down arrow key” or “Up 
arrow key” to select one of the two file types, and then press “tab” to 
move to the “Apply to” radio button. In this radio button, you can specify 
whether only the currently selected file or all of the files with the same 
file extension as the currently selected file will be opened with the 
specified program. If you have set one of the two, press “Enter” or “tab” 
to move to the “Confirm” button, and then press “Enter” to apply what 
you have just set. If you have specified a program that does not support 
the file type, nothing will be displayed or played after the program has 
started. 
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In the “File manager,” if you activate the “Open With” menu after 
focusing on folders that have Daisy or media files, you will see the 
associated program, Daisy or media player. If you activate the “Open 
With” menu, and encounter a folder that does not have the Daisy info file 
(discinfo.html or ncc.html), you will not be able to see the Daisy player 
as an associated program. You can play all of the files after selecting 
either the Daisy or media player. 
 
4.2.4 Zip 
 
With this item you can compress files and folders into a zip file.  
Compressing a file makes the total file size smaller, which can make it 
easier to email, or allow you to save space on a storage device or disk.  
To activate the “Zip” function, use the following steps: 
 

1) Select the files or folders you want to compress in the “file list” by 
using “Space” or “Ctrl-b”. 

2) Open the menu by pressing “Alt”, and press “Enter” on “Zip.” Or, 
while you are in the menu, press “z”. You can also activate this 
function without calling up the menu by pressing “Ctrl-z”. 

3) Then, “Zip filename: (default filename.zip)” will appear. “Default 
filename” is the file name that will be used for the compressed file 
if you try to compress only one file or folder. If you try to compress 
several files or folders, the default name is the folder name that 
contains the files and folders. If you want to change the name of 
the zip file, you can modify by typing in a new name in “Zip 
filename” CE. 

4) If you press “Enter” (or press “Enter” on “Confirm” by pressing 
“tab”), the zip file will be created in the current path. If you want to 
cancel, press “ESC” or “Alt-F4.” Or, move to “Cancel” by pressing 
“tab”, and then press “Enter” on “Cancel.” 
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4.2.5 Unzip 
 
The “Unzip” function will allow you to unzip (or decompress) a zip file, 
regardless of whether it was made in Voice Sense QWERTY or a PC. To 
activate the “Unzip” function, use the following steps: 
 

1) After selecting a zip file, open the menu with “Alt” and press 
“Enter” on “Unzip.” Or, press “u” in the menu. You can also 
activate this function without opening up the menu by pressing 
“Ctrl-u” after selecting a zip file. 

2) Then, “Unzip to folder name: (default folder name)” will appear. 
The default folder name is the compressed file name. For 
example, if you unzip a file called “test.zip,” you will see “unzip to 
folder name: test.” If you want to change the default folder name, 
you can modify the default folder name by typing in a new name. 

3) Then, press “Enter,” or move to “Confirm” by pressing “tab,” and 
then press “Enter” on “Confirm”. Then, the Voice Sense QWERTY 
will unzip the files to the default folder. If you want to cancel, press 
“ESC” or “Alt-F4.” You can also move to the “Cancel” button by 
pressing “tab”. Then, press “Enter” on “Cancel.” 

 
4.2.6 Send To 
 
You can use this option to copy files and folders to different disks such 
as a flash disk, USB flash drive (also known as USB stick memory) or 
SD card.  
 

1) You can select files or folders by pressing one of the “Space”, 
“Ctrl-a”-a and “Ctrl-b”. 

2) After selecting files and folders, you can call up the menu with “Alt” 
to choose the “Send To” option.  

3) Then, when you press “Enter” on “Send To,” the Voice Sense 
QWERTY will display the list of disks that you can use to send 
your files or folders to.  

4) You can choose a destination disk by using the “Up arrow key” 
and “Down arrow key”.  
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5) Pressing “Enter” on the desired disk will start copying the selected 
files and folders into the selected disk. Also, you can send files 
and folders by pressing “Ctrl-s” without calling up a menu. 

 
4.2.7 Copy / Move 
 
There are some differences between “Copy” and “Move.” “Copy” leaves 
the original files and folders in their original places, while “Move” 
removes original files and folders from their original places. 
 
In the “File manager,” you can use the copy function as follows: 

1) You have to select the files and folders you would like to copy. 
You can select files or folders by pressing one of the “Space”, 
“Ctrl-a” and “Ctrl-b”. 

2) You need to call up the menu, and choose “Copy” from the list to 
copy selected files and folders. If you want to move files and 
folders, you can choose “Cut” from the menu.  

3) When the “Copy” or “Cut” command is executed, the Voice Sense 
QWERTY will return to the file list. 

4) You need to go into the destination folder and call up the menu, 
and choose “Paste.” Press “Enter” on “Paste,” and your selected 
files and folders will be copied or moved. 

 
If the destination folder is the same folder where the selected files are, 
the Voice Sense QWERTY will attach “Copy1-” to your original file 
names for copied files. If the same files are copied into the same folder 
once again, the Voice Sense QWERTY will attach “Copy2-” to the 
original file names for the second copied files. 
  
If your destination folder has the same name as the file you are copying, 
the Voice Sense QWERTY will say “File xxx already exists.  Overwrite? 
Yes.” Press “Enter” if you want to replace the file. However, if you do not 
want to overwrite the file, select “No,” and press “Enter.”  When “No” is 
selected, the “Paste” function will be canceled. 
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Example: Copying “sample.txt” from the root folder to the download 
folder. 
 

5) Select “sample.txt” from the root folder by using the navigation 
keys “up arrow” or “down arrow”. 

6) Call up the menu by pressing “Alt,” and choose “Copy.” Then, 
press “Enter.” The Voice Sense QWERTY will return to the file list 
in the root folder. 

7) Move to the download folder, and press “Enter.” Call up the menu 
again to choose “Paste.” Press “Enter” on “Paste,” or press “v” 
after calling up the menu to complete the file copy function. You 
can also use “Ctrl-v” to do the same thing. 

 
4.2.8 Delete Files or Folders 
 
To delete files or folders, go to the folders or files you want to delete, 
and then select them, as explained in section 4.1.2. Call up the menu by 
pressing “Alt” to choose the “Delete” function. Press “Enter” on “Delete” 
to complete the deletion of the selected files and folders. You can also 
press the letter “d” after calling up the menu to have the same result as 
above. You can delete selected files or folders even without calling the 
menu by using hot keys. “Del” is the hotkey assigned to perform the 
delete function. When you delete only one file or one folder, it is not 
necessary to use the select function. Instead, just use the navigation 
keys to go to the file or folder you want to delete, and then you can use 
the delete function from the “File manager.” 
 
4.2.9 Rename 
 
You can change the name of a file or folder. To change the name of a 
file or folder, move to the file or folder you desire to rename. Section 
4.1.1 describes the navigation method for using the file list. Call up the 
menu by using “Alt” to choose “Rename” from the menu list. Press “r” 
after calling up the menu to activate the rename function quickly. 
Otherwise, you can use the down arrow until you reach “Rename” on the 
list. Press “Enter” on this menu. Then, the Voice Sense QWERTY will 
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ask for a new name. You must type in a new file name and folder name 
in ASCII characters. And if you type the file extension, you can change 
the file extension. Pressing “Enter” after entering a new file name will 
complete the process of changing a file or folder name. You cannot use 
the following characters in a file name or folder:  “|, \, <, >, ?, :, *” 
 
4.2.10 New Document 
 
You can create a new document with this option. There are several ways 
to access this function. You can utilize the menu by pressing “Alt”, and 
you can use the down arrow until you reach “New Document.” Another 
way to use this function is by pressing “n” after calling up the menu.  
The hot key for this option in the “File manager” is “Ctrl-n”. When the 
new document function is activated, the Voice Sense QWERTY will 
display “File type: text (txt).” You can create two types of documents, 
which are “text file” and “Braille file.” When the Voice Sense QWERTY 
displays “File type: text (txt),” you can use the down arrow to select the 
“Braille (brl)” file format. When you press “Enter” on either “text (txt)” or 
“Braille (brl),” the Voice Sense QWERTY will display “New document 
name: New Document0.txt” or “New Document0.brl.” “New 
Document0.xxx” is the default file name based upon the file type you 
have chosen. The number after the new document will increase by one 
whenever you create a new document. You can also type in the 
document name you prefer. Then, the new document you named will be 
created. “|, \, <, >, ?, :, *” characters cannot be used when creating a file 
name. 
 
4.2.11 New Folder 
 
You can create a new sub-folder under the current folder by using this 
option. You need to call up the menu in the “File manager” by pressing 
“Alt”, and select “New Folder” from the menu list by using the down 
arrow. Press “Enter” on “New Folder” to activate this function. The Voice 
Sense QWERTY will ask, “New folder name:,” and wait for your 
response. Enter your preferable new folder name, and press “Enter.” 
Finally, your new folder has been created. You can still use the letter “f” 
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after calling up the menu to invoke the new folder option. “Alt-f” is the 
hotkey that you use to access this feature quickly without going through 
the menu. When creating a new folder name, you cannot use the 
following characters:  “|, \, <, >, ?, :, *” 
 
4.2.12 File Conversion 
 
The “File conversion” on the Voice Sense QWERTY is similar to the 
“Save As” item in the word processor. This feature converts files to 
different file formats. The Voice Sense QWERTY file conversion feature 
will support the following file formats: “Sense Word (hbl),” “Text (txt),” 
and “Braille (brl).” 
 
The Voice Sense QWERTY can convert one or more files at the same 
time to the file format you prefer. Select files using the file selection 
method (method described in section 4.1.2). After selecting the files you 
want to convert, call up the menu by pressing “Alt”. Move down to the 
“File Conversion,” and press “Enter.” The Voice Sense QWERTY will 
prompt you to choose the preferred file format. Use the up and down 
arrows to select the desired file format. When you press “Enter” on the 
file format you want, the Voice Sense QWERTY will start converting files 
to the file format you have chosen. The Voice Sense QWERTY will keep 
the original file names for the files you have converted, except for the file 
name extension. The Voice Sense QWERTY will change your file 
extension to the extension that you have selected. If there is a file with 
the same file name and format already, “date” and “time” will be added 
to the file name. You can always use the letter “t” after calling up the 
menu to invoke the file conversion feature. Also, “Ctrl-t” is the hot key 
that activates this feature without calling up the menu. 
 
4.2.13 Select All 
 
This feature selects all the files and folders in the current path. You can 
use this feature through the menu, or by using a shortcut key. Press “Alt” 
to call up the menu. Press the down arrow to go to “Select All.” Press 
“Enter” to execute the “Select All” function. You can use the letter “a” 
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after calling up the menu to use this feature. “Ctrl-a” is the hot key to 
select all of the files and folders in the current path. When “Select All” is 
activated, the Voice Sense QWERTY will say, “x objects selected.”  The 
Voice Sense QWERTY will return to the file list in the current path after 
this brief announcement. You will see “*” in front of each file name you 
have selected When Voice Sense QWERTY connected to SyncBraille. 
You can always cancel your selections by pressing “Space” after moving 
to the file you want to cancel. This feature is a convenient way of 
copying, cutting, and deleting multiple files. 
 
4.2.14 Search for File 
 
“Search For File” is to find out files of the current or other disk. You can 
press “Alt” to call up the menu and move to “Search For File,” and press 
“Enter” or “b.” Or, you can press “Ctrl-f” without calling the menu. Then, 
you can see dialog box for file search. 
 
The dialog box for file search consists of “edit window for file name to 
search”, “combo box to select a disk”, “check box to searching sub-
folder”, “search button”, “cancel button” and “list to be searched file” and 
you can use “tab” or “shift-tab” to move to each control. 
When you perform file search, you will hear “File for find:” This edit 
window is “edit window for file name to search.” You need to input whole 
or part of the file name and press “Enter.” Then, it will search all files 
which contains the word which you inputted in the current disk. After the 
file search, it is located in “list to be searched file” automatically. 
 
You can press up and down arrow to move to each file in “list to be 
searched file.” If you press “Enter” on a file, it moves to the path where a 
file is stored and dialog box for file search will be closed. You can open 
the file by pressing “Enter” on the file name once again. 
 
If you want to search a file in another disk, not in current disk, you need 
to input file name and press “tab” to move to “combo box to select disk.” 
Then, you can press up and Down arrow keys to move to a disk. If you 
press “Enter” on a disk or “Search button,” it will start to search a file in a 
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disk. In “combo box to select disk,” you can see the disk list which is 
linked with Voice Sense QWERTY now. If there are many files in a disk, 
it can take some time to search a file and you can see a message of 
“searching.” 
 
If you want to search in a root of a disk excluding sub-folders, then press 
“tab” to move to the “check box to searching sub-folder,” press “Space” 
to cancel the selection in the check box and press “Enter.” The default 
set-up is to include sub-folders when you search in a disk. 
 
4.2.15 Sort Files By 
 
This option is used to specify the order of how files and folders will be 
displayed within the file list. Press “Alt” to bring up the menu. Then, 
press “Down arrow key” repeatedly until you reach “Sort Files By,” and 
then press “Enter.” Also, you can access this feature by pressing “Ctrl-g” 
in the file list, or by pressing “g” in the menu. Then, you can specify in 
what order the files and folders in the file list will be sorted. Files and 
folders can be sorted according to the following: “Name,” “Size,” 
“Extension,” and “Date and Time.” You can move between these items 
by pressing “Down arrow key” or “Up arrow key”. If you press “Enter” 
after selecting the sorting criterion, files and folders will be displayed in 
the specified order. If you select “Name” or “Extension,” the list will be 
sorted in ascending order, and if you select “Size” or “Date and Time,” 
the list will be sorted in descending order. By default, files and folders in 
the file list will be sorted by “Name.” Once you have chosen how you 
want your file and folder lists sorted, the option will be kept even after 
the “File manager” is closed, so that files and folders can be sorted in 
the same order when the “File manager” is opened again later. 
 
4.2.16 Set File Info 
 
This item is used to set what kind of information will be displayed in the 
file list. Press “Alt”. Then, press “Down arrow key” repeatedly until you 
reach “Set File Info,” and then press “Enter.” You can also access this 
feature by pressing “Ctrl-i” in the file list or press “l” when you are in the 
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menu. Then, you can select the information to be displayed in a list 
containing “Name,” “Name, Size,” and “Name, Size, Date and Time.”  
You can move between these items by pressing “Down arrow key” or 
“Up arrow key”. If you press “Enter” after selecting the information to be 
displayed, the file list will be updated, and show all the information you 
specified. By default, only names are displayed in the “file list.” If you 
have selected “Name, Size,” the name and size of files will be displayed.  
But, for folders, size will not be displayed. If you have set the “Set File 
Info” option, it will be kept even after closing the “File manager,” and the 
same information will be displayed when the “File manager” is started 
again. 
 
4.2.17 Display Only Files of Type 
 
This is used to specify what type of files will be displayed in the file list.  
Press “Alt” to bring up the menu. Then, press “Down arrow key” 
repeatedly until you reach “Display Only Files Of Type,” and press 
“Enter.” You can also access this feature by pressing “Ctrl-w” in the file 
list, or press “w” in the menu. Then, you can select one of the following 
items:  “All Files,” “Sense Word Files,” “MS Word Files,” “Text Files,” 
“Braille files,” “HTML Files,” “URL Files,” “Media Files,” and “Wave Files.”  
You can move between these items by pressing “Down arrow key” or 
“Up arrow key”. If you press “Enter” after selecting the file type you want, 
only the files of the specified type will be displayed in the file list. Folders 
will be displayed for whatever type you have specified. By default, all 
files are displayed in the file list. This option setting is not kept after 
closing the “File manager,” so all the files will be displayed after starting 
the “File manager” again. 
 
4.2.18 Information 
 
The Voice Sense QWERTY can provide information about files and 
folders. The information feature in the “File manager” provides you with 
information about the file type, file size, the date and time of the file or 
folder’s creation, and file attribute. Press “Alt” to call up the menu.  
Press the down arrow until you reach “Information.” Press “Enter” to 
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activate the “Information” feature. Use the letter “I” to call up the 
“Information” feature after opening up the “menu.” “Alt-Enter” is the hot 
key for this option. You can use this hot key without going through the 
menu.  The Voice Sense QWERTY will display the information about a 
file or folder in the following order: file type, file size, creation date and 
time, and attribute. You can review this information by pressing the “tab.”  
You can also press “Fn-i”, while you are in the disk list or “program” 
menu in the Voice Sense QWERTY, to hear how much space is 
available on the flashdisk. 
 
1. File type: This will give you the file type information, such as “brl file,” 

“doc file,” and “txt file.” When a folder is selected, it will give you the 
information indicating that this is a folder containing x number of files 
and folders. 

2. File size: This will show you the size of the selected file or folder.  
When multiple files or folders are selected, this will give you the total 
size of the selected files and folders. 

3. Date and time: This will show you the time and date when the folder 
and file was created or modified. 

4. Attribute: This will show you whether the file is write protected or not.  
You can change this attribute by using the up and down arrows or 
“space. When multiple files or folder are selected, you won't be able 
to see this attribute. 

5. Confirm: In order to change the attribute, press “Enter” when 
“Confirm” is displayed. 

6. Cancel: In order to cancel the change, press “Enter” while “Cancel” is 
displayed. 

 
4.3 Using the Address Window 
 
This window provides you with the ability to type in the file name you 
want to open. Also, this window provides you with the opportunity for you 
to type in the path name you want to go to. This window contains the 
history list you can use for opening a file or for moving to a directory.  
The history list contains file names and directory paths you have used 
recently. 
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4.3.1 Editing 
 
When you are in a file or folder list, you can press “tab” to get into the 
address window. The Voice Sense QWERTY will show you the current 
path including the current disk name, such as “flashdisk/download/.”  
 
The address window is only valid when you are in a file or folder list.  
When you are in the disk list, the address window is not available. 
 
4.3.2 Type in Path / File Name 
 
. If you know the exact path and file name, you can type in the path and 
file name to open the file with the appropriate application. For example, if 
you type in “flashdisk/download” in the address window and press 
“Enter,” the Voice Sense QWERTY will show you the list of the files in 
the download folder. If you type “flashdisk/My Documents/sample.txt” in 
the address window, and press “Enter,” the Voice Sense QWERTY will 
first load the word processor, and then open the file “sample.txt.” After 
the file opens, you can read or edit the file, “sample.txt.” 
 
4.3.3 Opening the History List 
 
The history list contains paths, folders, and files that you have opened 
previously. You can access this history list within the address window by 
pressing the down arrow. Use the up and down arrows to review the 
history list. You can also use the arrow keys to move around on this list. 
Simply open or visit the file and path by pressing “Enter” on the item.. 
The files that are supported by the Voice Sense QWERTY will open with 
the appropriate applications (see section 4.2.3). During the navigation of 
the history list, you can still type in new path names or file names that 
you want to access. 
 
4.4 Hot Keys in the “File Manager” 
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1. Open: Ctrl-o  
2. Open with: Ctrl-h 
3. Zip: Ctrl-z  
4. Unzip: Ctrl-u 
5. Send: Ctrl-s 
6. Copy: Ctrl-c 
7. Cut: Ctrl-x 
8. Paste: Ctrl-v 
9. Delete: DEL 
10. Rename: F2 
11. New document: Ctrl-n 
12. New folder: Alt-f  
13. File conversion: Ctrl-t 
14. Select all: Ctrl-a  
15. Sort files by: Ctrl-g 
16. Set file info: Ctrl-i 
17. Display only files of type: Ctrl-w  
18. Search for file: Ctrl-f  
19. Information: Alt-Enter 
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5. Word Processor 
 
When you launch the word processor on the Voice Sense QWERTY, the 
Voice Sense QWERTY will place you in a new document that is ready 
for you to write in. The menu can be opened by pressing “Alt.” Don’t 
worry if you can’t remember the exact shortcut keys for each of the 
menu items, since you can activate various functions of the word 
processor by activating the word processor menu. The menu in the word 
processor consists of file, edit, go to, read, and layout. In order to use 
these menus, press “Alt” in the word processor, select a menu item, and 
press “Enter” or press “Backspace” and the corresponding character that 
represents the menu item name. For example, in order to open the edit 
menu, press “Alt” to open the menu, and move to the next menu by 
pressing up and down arrows to find the “Edit” menu, and then press 
“Enter.” Or, press “Alt” and press “e,” which represents the “Edit” menu. 
The “Edit” menu contains a lower level menu.  
Before going in to more detail about the word processor, it is also 
important to note that while you are anywhere in a document, you can 
find out your location by pressing “Fn-s.” Also, if you are editing a 
document, and turn the Voice Sense QWERTY off while you are editing 
a document, the Voice Sense QWERTY will say the status when you 
turn the Voice Sense QWERTY back on. In the next few sections the 
features of the word processor will be explained in more detail. We will 
also explain the functions of each of the menu items available in the 
word processor. 
 
5.1 File Menu 
 
The “File” menu contains the menus that will allow you to create new 
documents, open documents that were saved to a disk, save any 
documents that were edited, and print in Braille. It also contains various 
environment setting menus. In order to select the file menu, press the 
“Alt”, and press “f”. Or, press “Enter” on “File.” 
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5.1.1 New 
 
The new command creates a new document that can be edited. By 
default, the name of the new document is “noname.txt.” It is the same 
file name that is named automatically when the word processor opens. 
In order to create a new document, select “New” on the “File” menu. Or, 
press “Ctrl-n.” If “New” is executed while editing another document, 
“Sense Document (s)” is displayed first. If you press “Down arrow key” 
repeatedly, “Braille Document (b)” and “Text Document (t)” will appear. 
Select the document type that you want, and then press “Enter”. 
 
“New” means that users can create a new document after closing the 
document that is currently being edited. Closing the document that is 
currently being edited means that the document is erased from the 
temporary memory. If a new document is executed without saving the 
document that is currently being edited, the Voice Sense QWERTY asks 
whether it should save the current document, so that changes to the 
document will not be lost. When “Save: Yes” is displayed, users can 
select “Yes” in order to save the current document or select “No” in order 
not to save the changes. If you select “Cancel” by pressing “Space” once 
more, the word processor will cancel the new document, and return to 
the current document. 
 
Note that you can change the “Default document type”, in the “Global 
options”. By changing the “Default document type”, you can choose to 
have your default document type as text, sense, or Braille. 
  
5.1.2 Open 
 
The open command opens a document that has already been saved on 
to a disk. Select “Open” on the “File” menu, or press “Ctrl-o.” You can 
access the “File” menu by pressing “Alt”. Then, a dialog box pops up, so 
that you can open a file. The “Open dialog box” is a tool that helps you 
find documents that you want to edit and read. It consists of the “file list” 
(which shows the list of files or folders), “File name” (to type in a file 
name directly), “Type” (which changes the file format when opening a 
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document), a “Confirm” button (for confirming the selection), and a 
“Cancel” button (for canceling the selection). In order to move between 
these controls, press “tab”or “shift-tab.” If the “Open dialog box” is 
executed, “File name:” is displayed first. If “File name:” is displayed, then 
type in a file name that you want to open, and press “Enter.” The Voice 
Sense QWERTY will look for that file in the “/flashdisk/My Documents” 
folder. If there are files that you used recently, you can move through 
them by pressing “Down arrow key.” The file names that were opened 
recently are displayed one by one by pressing “Down arrow key.” If the 
file open that you want to open is selected press “Enter” to open it. In 
order to move to the previous file name in the list, press “Up arrow key.” 
In order to open a file with a different file format, press “tab” to move to 
the file format selection, and then press the up arrow or down arrow to 
select a desired file format. You can find and open a desired file from the 
file list without typing in the file name directly in the “File name:” box. 
Press “tab”several times to move to the “file list,” and then select a 
desired file. You can also move to the “file list” by pressing “shift-tab” 
when you are at the “File name:” dialog box. The files in the “file list” 
have the file format that was selected in “file type.” 
 
You can select a file that you want by using the up and down arrow keys, 
and you can open the file by pressing “Enter.” If you select a folder and 
press “Enter,” you will see the list of files in that folder.  
 
If you want to access a file that is on a SD card, or USB memory stick, 
you can access the file in the “Open” dialog box by first moving to the 
“file list” by pressing “shift-tab. Then, press “Backspace” until you hear 
the USB stick memory or the SD card. Then, press “Enter” to open the 
memory.  
The Voice Sense QWERTY will choose the Braille mode depending 
upon the file type. For example, if you press “Enter” to select a file that 
has the extensions hbl or brl, or if you type in a file name with those 
extensions and press “Enter,” the Voice Sense QWERTY will open the 
selected file in Contracted Braille. You will not be able to change the 
Braille mode in these documents. If you press “Enter” to select a file that 
has the extensions of txt or doc, it will open the file in what is currently 
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set in “View grade” of “Global options”. After the file opens, you can 
switch the Braille mode, as was explained in section 3.3.  
 
In the word processor of the Voice Sense QWERTY, it is possible to 
open and work simultaneously with up to 10 files at one time. If you 
already have one document open, and you try to open another 
document, the Voice Sense QWERTY will ask you if you want to save 
changes to the document that is already open. Then, you can save the 
file (see section 5.1.3 for a detailed explanation). Once you have 
completed saving the document, an open dialog box will appear.  
However, you will still have the two files open. It only seems that you 
closed one without saving it. With the new document open, if you want to 
go to the previous document, you can press “shift-tab.” If you want to go 
back to the other document again, press “tab.” 
 
5.1.3 Save 
 
The save command will save a document to a disk drive. If you want to 
use this option, you can press “Alt” to open the “File” menu and execute 
the “Save” command by pressing “Enter” on it, or you can press “s.”  
Otherwise, you can press “Ctrl-s” while editing a document. 
 
If you created a new document by activating the word processor or by 
pressing enter on “New” in the menu; if you execute “Save,” the “Save 
as dialog box” will open. You can refer to section 5.1.4 that explains how 
to use the “Save as dialog box.” 
 
If you execute “Save” after you edit a document that was opened using 
the “Open” function, the Voice Sense QWERTY will save the document 
with the same file name without using a dialog box. After saving a 
document, it will return to document edit status. 
When you have several documents open, you can save the current open 
document, by pressing “Ctrl-F4.” This will close the document, save it, 
and return to the previous document. 
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5.1.4 Save As 
 
The “Save As” option is used to save a document as a different file 
name, on another disk, or as a different file type. If you want to execute 
this command, press “Alt”, and then press “Enter” when the “File” menu 
is displayed. Move to “Save As” by pressing “Down arrow key.” Then, 
press “Enter.” Another way is to press “Alt-s,” which executes the “Save 
As” command in the word processor. 
 
If you execute “Save As,” the “Save as dialog box” is displayed. This 
dialog box is almost the same as the “Open” dialog box. It consists of 
“file list,” “File name,” “Type” (representing the file format), a “Confirm” 
button, and a “Cancel” button. If the dialog box is opened, “File name:” is 
displayed. You can move from one tab to the other tab by pressing 
“tab”or “shift-tab”. 
 
If you execute “Save As” when you are editing a document that you 
opened, the displayed file name, file format, and the folder are the same 
as those of the file that you opened. 
 
However, if you created a new document by executing the word 
processor or by executing “New,” and you execute “Save” or “Save As,” 
the displayed default file name is “noname.brl” and the file path is 
“flashdisk/My Documents/.” 
 
If you want to edit the file name, type in the new file name. You cannot 
use the following characters in a file or folder name. “|, \, <, >, ?, :, *” 
 
If you want to change the file format, move to “Type.” In “Type,” move to 
the file format that you want by pressing “Up arrow key”or “Down arrow 
key.” 
 
If you want to save a file with a file name that is in the file list, move to 
the “file list” by pressing “shift-tab.” When “file name” is displayed, select 
your desired file by navigating the file list with the same method that you 
used to navigate the “File manager” that was explained in chapter 4. 
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5.1.5 Close Current Document 
 
The “Close Current Document” command allows you to close the current 
document that you are working on without closing the word processor.  
You can access the “Close Current Document” command by pressing 
“Alt.” Then, press “Enter” on the “File” menu. Use the up and down 
arrows until you find “Close Current Document,” and then press “Enter.”  
Or, you can press “q” in the “File” menu. You can also access this 
function by pressing “Ctrl-F4” while you are editing a document. Please 
note that this function will not work if you only have one document open.  
You must have at least two or more documents open in order to execute 
the “Close Current Document” command. 
 
5.1.6 Print 
 
The “Print” command is used to print the current document in ink or 
emboss it in Braille. If you want to execute this command, press “Alt,” 
and press “Enter” on the “File” menu. Then, move to “Print” by pressing 
“Down arrow key,” and then press “Enter,” or just press “p.” While editing 
a document, the hot key for printing is “Ctrl-p.” There are two lower level 
menus for the “Print” menu. One is for printing with an ink printer, and 
the other is for embossing in Braille. Remember that you can move 
between the menu items by using “Up arrow key”or “Down arrow key.” 
 
1. Embossing in Braille 
Open the document that you want to be embossed. Press “Alt” to 
activate the menu. Locate “print” in the “File” menu and select 
“Embosser,” or press “b.” If you select “Embosser (b)” above, the 
“Embosser dialog box” is opened. Here you can type in the page number 
where you want the embossing to start, and type in the end page 
number, where you want the embossing to stop. The following items are 
in the dialog box. 
 
1. Print method 

This is the beginning page number to be embossed. The default page 
number is set to 1. You can change the value of the page number, by 
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typing in the value that is desired. You can move to the next selection 
item, which is the “End page number” by pressing “Down arrow key.” 

 
2.  End page number 

This is the ending page number that is to be embossed. The default 
value is set to 100000. It means that the document will be embossed 
to the end of the document, unless the document exceeds 100000 
pages. In order to change the value, input the number of the ending 
page. You can move to the next selection item (which is the “Number 
of copies”) by pressing “Down arrow key.” 

 
3.  Number of copies 

This option designates the number of copies to be embossed.  The 
default value is set to 1. You can change this number by typing in the 
number that is desired. If you press “Down arrow key” or “Up arrow 
key,” you will be moved to “Print method” or “End page number,” 
respectively. If you want to move to “Confirm,” “tab” is pressed. 

 
4.  Set Braille format 

In this option, you can set whether or not the Braille document layout 
settings specified in Voice Sense QWERTY will be used when 
embossing. If you set this to “Yes,” the document will be embossed 
using the Braille document layout setting in Voice Sense QWERTY. If 
you set it to “No,” the document will be embossed in the format 
specified in the original document. 

 
5.  Confirm / Cancel 

In order to emboss as designated above, move to “Confirm” by 
pressing “tab,” and then press “Enter.” Or, if you are canceling 
embossing, move to “Cancel” by pressing “tab”, and then press 
“Enter.” 

 
If “Enter” is pressed on “Confirm,” “Print: Yes” is displayed on LCD and it 
is also spoken. If “Enter” is pressed on “Yes,” embossing will start. If you 
do not want to emboss, press “Space” to select “No,” and then press 
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“Enter.” If “Save as file” is selected by pressing “Space,” then the current 
document is saved as a “brl” file. 
 
If there are any problems with the Braille printer, the Voice Sense 
QWERTY shows an error message and returns to the open document. 
 
2. Print Text 
This option is used when you want to print a document on an ink printer.  
To do so, open the document to be printed and press “Alt,” and then 
press “Enter” on the “File” menu. Move to “Printer” by pressing “Down 
arrow key” repeatedly. Then, press “Enter” when you are on “Printer,” or 
just press “p.” The dialog box for “Printer” is almost the same as 
“Embosser.” After you input the value as in embosser dialog box, 
press ”Enter,” and then “Print: Yes” is displayed. If “Enter” is pressed, 
printing will start. But, if you press “Space” to move to “No,” and press 
“Enter,” printing will be canceled, and the Voice Sense QWERTY will 
return you to the open document. 
 
Note: The Voice Sense QWERTY will work with all HP printers (level 3 
PCL or higher), and with HP-compatible printers. 
 
5.1.7 Settings 
 
If you want to change the environment, press “Alt,” and press “Enter” on 
the “File” menu in order to enter into the “File” menu. Move to “Settings 
(e)” by pressing “Down arrow key” repeatedly, and then press “Enter” on 
“Settings,” or just press “e.” While editing a document, pressing “Ctrl-e” 
will open the “Settings” menu. 
 
When this menu is opened, a dialog box is displayed, which contains the 
followings: the “settings” list, “Default folder” button, “Confirm” button and 
a “Cancel” button. You can move between controls by pressing “tab”or 
“shift-tab”. And you can move between setting items in list by pressing 
“Up arrow key”or “Down arrow key.” 
 
The following are the setting items that can be changed: 
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5.1.7.1 View format character  

 
Note: This function will appear when the Voice Sense is connected to 
SyncBraille. 
 
If this option is set to “Yes,” all of the format characters are displayed. If 
you want to change this option, use “Space” to toggle. Formatted 
characters will be marked with the “carriage return ($p)”, “auto return 
($l)” and the “mark sign ($pl).” 
Whenever you press “Ctrl-5”, settings will change. 

 
5.1.7.2 Reading unit  

 
It sets the moving unit when “Up arrow key”or “Down arrow key” is 
pressed while you are reading a document. If this option is set to “Line,” 
“Up arrow key”moves line by line. If this option is set to “Paragraph,” “Up 
arrow key” moves paragraph by paragraph. In order to toggle between 
“Line” and “Paragraph,” press “Space.” Whenever you press “Ctrl-3”, 
settings will change. 

 
5.1.7.3 Read only  

 
If this option is set to “Yes,” the document cannot be modified. This 
setting is used in order to protect the document from any unintentional 
modifications. If you want to change it to “No,” press “Space.” 
When you choose to select “Compressed” on the option, you set “Read 
only” to “Yes.” Whenever you press “Ctrl-2”, settings will change. 

 
5.1.7.4 Reading mode 

 
Note: This function will appear when the Voice Sense is connected to 
SyncBraille. 
 
This option sets the reading mode. Reading mode “Original”, will show 
the document in its original format. 
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If the Reading mode is set to “Compressed”, The Voice Sense QWERTY 
will continue displaying contents even if there exists a carriage return 
($p). In order to toggle between “Original” and “Compressed,” press 
“Space.” Whenever you press “Ctrl-4”, settings will change. 

 
5.1.7.5 Auto scroll speed 

 
Note: This function will appear when the Voice Sense is connected to 
SyncBraille.  
 
This option sets the duration of displaying one line while you are 
scrolling in a document. Twenty is the fastest scrolling speed. Pressing 
“Space” makes the number increase, and “Backspace” makes the 
number decrease. Refer to section 5.4.5 for more information about the 
auto scroll option. 

 
5.1.7.6 Automatic save interval  

 
This option sets the automatic save time interval of the file that is 
currently being edited. The setting options that you can choose from are 
“Don’t save automatically”, and 1 to 20 minutes. The setting time can be 
increased or decreased by 10 minutes if you press “Space” or 
“Backspace,” respectively. 

 
5.1.7.7 Apply settings to all documents 

 
This option selects the settings only if they are valid for all documents. If 
“Yes” is selected, the settings will be kept for all future documents, and if 
“No” is selected, the settings will only affect the document that is 
currently being edited. In order to toggle between “Yes” and “No,” press 
“Space.” 
 
If you want to change the default saving folder, you move to “Default 
folder” button by press “tab” and press “Enter.” And then you will see the 
“file list.” In file list, you move to folder or disk that you want by using the 
moving keys and press “Enter” after press “Space.” 
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If you completed the settings, you move to “Confirm” button by press 
“tab” and press “Enter.” If so, you can change the settings and return to 
the current editing document. If you do not want to save the setting, you 
press “Enter” on “Cancel” button. If so, it will cancel the setting and 
return to the current editing document. 
 
5.1.8 Exit 
 
This command will close the word processor. In order to execute this 
command, select “Exit” in the file menu, or press “Alt-F4.” If the 
document has been changed (or edited) and “Exit” is selected without 
saving the document, a dialog box will ask you if you want to save the 
current document. You can select “(Yes)” with the “space” and press 
“Enter” to exit the word processor. 
 
5.2 Edit Menu 
 
In the Voice Sense QWERTY, you can edit all files regardless of what 
the view mode is set to. In the “Edit” menu, you will find the following 
items: “Start Selection,” “Copy,” “Cut,” “Paste,” “Delete,” “Delete Blank 
Lines,” “Add To clipboard,” “Clear Clipboard,” “Select All,” “Insert From 
File,” “Insert Date,” “Toggle Insert/Overwrite Mode,” and “Check 
Spelling.” If you want to open the menu, press “Alt,” and then press 
“Enter” on “Edit.” Or, you can press “e” in the menu. Now, let’s explore 
the edit menu. 
 
5.2.1 Start Selection 
 
The “Start Selection” command allows you to select a certain portion of 
text that you would like to edit. The “Start Selection” command allows 
you to make changes to only the text that is selected, and the changes 
will not affect text that has not been selected. The “Start Selection” 
command is especially useful for copying, cutting, and pasting. You can 
select text in a document by placing your cursor on the location where 
you want to start selecting text.  If you want to use this function, press 
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“Alt” to open the “Edit” menu, and then press “Enter” on “Start Selection,” 
or you can press “b” in the “Edit” menu to get to this option. While editing 
a document, pressing “Ctrl-b” will activate this command. The end point 
of the selected text is where you want to place the cursor after setting 
the starting point. For example, if you have typed the word, “mother” in a 
document, and you want to select the word “mother,” you should place 
the cursor on the letter “m,” and then place the cursor directly after the 
letter “r.” Then, you will have selected the entire word. 
 
5.2.2 Copy 
 
After selecting text in a document, press “Alt” to open the menu, and 
move to “Edit” by pressing “Down arrow key.” Press “Enter” to open the 
“Edit” menu. Press “Down arrow key” to move to “Copy” and then press 
“Enter,” or press “c” in the “Edit” menu. While editing a document, 
pressing “Ctrl-c” will activate this command. 
 
When you copy the selected text, it will be copied to the clipboard. The 
clipboard is the virtual space that is used for storing copied data 
temporarily. However, if you decide to copy new text that you have 
selected, the data in the clipboard that you copied before will be erased, 
and the selected text that you have just copied will replace the 
previously selected text that was on the clipboard. 
 
5.2.3 Cut 
 
To cut a selection of text, press “Alt,” and press “Enter” on “Edit” to enter 
into the “Edit” menu. Move to “Cut” by pressing “Down arrow key” 
repeatedly, and then press “Enter” on “Cut,” or press “x” in the “Edit” 
menu (which is the short cut) to cut your selected text. While editing a 
document, pressing “Ctrl-x” will activate the “Cut” command. 
 
The difference between “Cut” and “Copy” is that if you execute the “Cut” 
command, the text that has been selected will be moved to the clipboard 
and the selection in the document will be cut. However, the “Copy” 
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command will copy the selection to the clipboard, and the text that has 
been selected will not be erased from the document. 
 
5.2.4 Paste 
 
To paste selected text to the clipboard, press “Alt,” and then press 
“Enter” on “Edit” to enter into the “Edit” menu. Move to “Paste” by 
pressing “Down arrow key” repeatedly and then press “Enter” on 
“Paste,” or press “v” in the “Edit” menu (which is the short cut) to paste 
the selected text from the clipboard. While editing a document, press 
“Crtl-v” to paste the text from the clipboard. 
 
5.2.5 Delete 
 
To delete text that has been selected, press “Alt,” and then press “Enter” 
on “Edit” to enter into the “Edit” menu. Move to “Delete” by pressing 
“Down arrow key” repeatedly, and then press “Enter” on “Delete,” or 
press “d” (as a short cut) in the “Edit” menu to delete the selected text.  
When you are editing a document, you can press “DEL” to delete text 
that you have selected. 
 
5.2.6 Delete Blank Lines 
 
In order to delete blank lines, you must select the area of the document 
where you want the blank lines to be deleted from. Once this has been 
done, press “Alt,” and press “Enter” on “Edit” to enter into the “Edit” 
menu. Then, use the up and down arrows, and press “Enter” on “Delete 
Blank Lines,” or press “l” as a short cut, while in the “Edit” menu. If you 
want to delete an empty line while you are editing a document, press 
“Alt-e,” which is the hot key for “Delete Blank Lines.” 
 
5.2.7 Add to Clipboard 
 
When you have selected the text you want to select in your document, 
you should press “Alt,” and then press “Enter” on “Edit” to enter into the 
“Edit” menu. Move to “Add to Clipboard” by pressing “Down arrow key,” 
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and then press “Enter,” or press “p.” While editing a document, pressing 
“Ctrl-Insert” will activate this command. 
 
“Add to Clipboard” is almost the same as the “Copy” command. However, 
with the “Copy” command, the newly selected text will replace the text 
that was copied before. The “Add to Clipboard” command however, will 
not erase the previously data from the clipboard when you use this 
command to copy the selected text. It will keep the previously selected 
text, and the new text that you have selected will also be added to the 
clipboard. 
 
5.2.8 Clear Clipboard 
 
To clear the clipboard, press “Alt,” and press “Enter” on “Edit” to select 
the “Edit” menu. Move to “Clear Clipboard” by pressing “Down arrow 
key” repeatedly, and then press “Enter.” Or, you can press “e” in the 
“Edit” menu as a short cut. Once you have executed the “Clear 
Clipboard” command, everything on the clipboard will be erased. When 
you are editing a document, you can press “Ctrl-Del” to activate this 
command. 
 
5.2.9 Select All 
 
The “Select All” command will select all text within a document. To 
activate this command, press “Alt,” and then press “Enter” on “Edit” to 
enter into the “Edit” menu. You can move to “Select All” by pressing 
“Down arrow key” repeatedly, and then press “Enter” on “Select All,” or 
press “a” in the “Edit” menu (which is the short cut). While editing a 
document, press “Ctrl-a” to activate this function. 
 
5.2.10 Insert from File 
 
This command will insert another file in the current document that is 
being edited. If you want to run this command, press “Alt,” and press 
“Enter” on the “Edit” menu. Move to “Insert from File” by pressing “Down 
arrow key” repeatedly. Then, press “Enter” on “Insert from File,” or just 
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press “I” in the “Edit” menu. While editing a document, pressing “Ctrl-i” 
will activate this function. 
 
When you use this option, an insert dialog box will appear just like the 
open dialogue box. Select a file that you want to insert in to the current 
document, and press “Enter” on the file. Then, the selected file will be 
inserted at the beginning of the paragraph with your cursor. 
 
When you execute “Insert from File,”the text inserted from the file will be 
converted to the file format of the current document. Although the saved 
file that you pasted was in a different formatted document, the same file 
format will be kept as the current document. For example, if you insert 
“sample.txt” in “sample.hbl” and save it, the saved file will be 
“sample.hbl.” 
  
Note that if you are going to insert a Braille file in a text file, the Braille 
document will be translated back into a text document. You can read it in 
Braille, but on rare occasions you might see differences in the translated 
text. 
 
5.2.11 Insert Date 
 
To insert the date into your document, press “Alt,” and then press “Enter” 
on “Edit” to enter into the “Edit” menu. Move to “Insert Date” by pressing 
“Down arrow key” repeatedly. Then, press “Enter” on “Insert Date,” or 
press “w” (which is the short cut) in the “Edit” menu. Then, you can insert 
the current date and time where the cursor is located in your document.  
If you want to insert part of the current date and time, you can modify 
what you want to change after completing the “Insert Date” command.  
When you are editing a document, you should press “Ctrl-w” to activate 
this command. 
 
5.2.12 Toggle Insert/Overwrite Mode 
 
There are two ways of editing documents in the Voice Sense QWERTY.  
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If you start the word processor (or open a document), the “Insert mode” 
is the default. This will write text, while pushing back other words that 
are already in the document. However, you can overwrite text while 
erasing the old text by switching to “Overwrite mode.” You can switch to 
the “Overwrite mode” by pressing “Insert”. In the “Overwrite mode,” you 
can change the old text into new text at the cursor location. If you want 
to go back to “Insert mode,” you should press “Insert” again. You can 
also access this function via the menu. Press “Alt,” and go to “Edit” using 
the up and down arrows. Next, press “Enter” on “Edit” to enter in to the 
“Edit” menu. Then, use the arrow keys to move “Toggle Insert/Overwrite 
Mode,” or you can just press “m” while you are in the “Edit” menu. 
 
5.2.13 Check Spelling 
 
This option is used to check spelling while you are editing a document. 
In order to bring up check spelling option, do the following; 
 
1. Call up the menu by pressing “Alt.” 
2. Move to the “Edit” menu by pressing “Down arrow key.” 
3. Press “Enter” on the “Edit” menu. 
4. Press “Down arrow key” until “Check Spelling” is displayed. Or, press 

“k” in order to move to “Check Spelling” directly. 
5. Press “Enter” on the “Check Spelling.” Or, you can call up the “Check 

Spelling” menu by pressing “Ctrl-k” while you are editing a document. 
 
If “Check Spelling” is executed, a dialog box with the following items will 
be displayed: 
 
“Range” combo box 
“Custom dictionary” dialog (c) 
“Options” dialog (o) 
“Begin” button (b) 
“Cancel” button 
 
You can move from one item to the next by pressing “tab” or “shift-tab”. 
The following is a detailed explanation for each item: 
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The “Range” combo box is used to designate the range that is to be 
spell checked. 
 
1. Whole document: check throughout the entire current document. 
2. Chapter: check the current chapter where the cursor is located. 
3. Sentence: check the current sentence where the cursor is located. 
4. From cursor to bottom: check from the cursor position to the end of 

the document. 
5. Current word: check just the word where the cursor is located. You 

can move from one item to the next by pressing “Up arrow key”or 
“Down arrow key.” 

 
When you press “Enter” on the “Custom dictionary” dialog, the following 
items will be displayed: 
 
1. List: it shows the words that are registered in the custom dictionary.  

(Example: Braille 1/20). If there are no words registered, “no items” 
will be displayed. 

2. Add word (Alt-a): if “Enter” is pressed on this button, “Add word:” will 
be displayed. If you want to add a word, press “Enter” after you enter 
the new word. Then, the new word is added and the Voice Sense 
QWERTY exits to the “Add word” button. 

3. Modify word (Alt-m): select the word to be modified on the “list” and 
then press “Enter.” The “Modify word:” message is displayed. Input 
the correct word that will replace the selected word and then press 
“Enter” in order to modify the selected word. The “Modify word” button 
will be displayed again after the Voice Sense QWERTY modifies the 
selected word. 

4. Delete word (Delete): select the word to be deleted on your “list” and 
press “Enter” in order to delete the selected word. 

5. Close: this command closes the dialog box. You can move from one 
item to the next item by pressing “tab” or “shift-tab”. 

 
When you press “Enter” on the “Options” dialog, the following items will 
be displayed: 
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1. Always suggest recommended word: if this option is set to “On,” the 

Voice Sense QWERTY will suggest a word if the word that is 
encountered is not in the dictionary. The default is set to “On.” If the 
option is set to “Off,” the Voice Sense QWERTY will not recommend 
a word. In order to toggle between “On” and “Off,” press “Space.” 

2. Use main dictionary only: if this option is set “On,” the spell checker 
will not look up any words in the “custom dictionary.” It will only use 
the main dictionary. The default value is set to “Off,” and you can 
toggle between “On” and “Off” by pressing “Space.” 

3. Skip an upper-case word: if this option is set to “On,” words with only 
upper-case letters will not be checked. The default is set to “On,” and 
you can change it by pressing “Space.” 

4. Skip a word which includes an address: if this option is set to “On,” 
the words that contain an address will not be checked. The default is 
set to “On,” and you can change it by pressing “Space.” 

5. Skip a word which includes numbers: if this option is set to “On,” the 
words that include the numbers will not be checked. The default value 
is set to “Off,” and you can change it by pressing “Space.” 

6. Confirm: if you press “Enter” on “Confirm,” the changes that you 
made above will be saved, and the Voice Sense QWERTY will exit 
from the “Options” dialog. 

7. Cancel: if you press “Enter” on “Cancel,” the changes that you have 
made above will be canceled and the Voice Sense QWERTY exit 
from “Options” dialog. 

 
In order to move between the items 1) through 5), press “Up arrow 
key”or “Down arrow key.” But, in order to move to “Confirm” or “Cancel,” 
press “tab”or “shift-tab”. 
 
If you press “Enter” on the “Begin” button after you set all of the settings, 
the Voice Sense QWERTY will start to check spelling. If you press 
“Enter” on the “Cancel” button, the “Spell Check” will be canceled. 
Once “Spell Check” is executed, the following dialog box will be 
displayed: 
 



83 
 

1. Window to show the text: it shows the sentence with the word to be 
checked currently. The cursor will be located at the word that is to be 
checked currently. 

2. Change word edit box: it shows the word to be checked currently. 
You can input the correct word in edit box directly. 

3. Recommendation word list: if the word to be checked is not in the 
dictionary, the Voice Sense QWERTY will recommend words. You 
can move from one recommended word to the next by pressing “Up 
arrow key”or “Down arrow key.” 

4. Skip once (s): if you press “Enter” on this button when a word is 
encountered that is not in the dictionary, the word will not be modified.  
Note: When Voice Sense QWERTY connected to SyncBraille, you 
can also press the “down scroll button” in order to skip the word. 

5. Skip all (i): if you press “Enter” on this button, the word that is the 
same word as the currently focused word will not be modified and 
skipped throughout the spell check range. 

6. Add to custom dictionary (a): if you press “Enter” on this button, the 
word that is currently focused is added to your “Custom dictionary.” 

7. Modify once (c): focus on the modified word and select the desired 
word on the “recommendation word list,” and then press “Enter.”  
Then, the currently focused word that is on your document will be 
replaced by the recommended word. 

8. Modify all (m): focus on the modified word and select the desired 
word on the “recommendation word list,” and then press “Enter.”  
The same words with the same spelling will be replaced by the new 
word throughout the document. 

9. Cancel: if you press “Enter” on the “Cancel” button, the “Spell Check” 
will be ended. 

 
You can move from one item to the next by pressing “tab” or “shift-tab”. 
When the spell check has completed, the Voice Sense QWERTY will 
say “search: 00 mismatch: 00 replace: 00.” 
 
Also simply, you can check spelling of the current word by press “Alt-k” 
when you enter or meet the misspelled word. If you press “Alt-k”, you will 
hear list of recommended word. You move to word that you want by 
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using the “Up arrow key”or “Down arrow key.” And press “Enter.” 
misspelled word will change to the correct word. 
 
5.3 Go to Menu 
 
If you want to open the “Go To” menu in the word processor, press “Alt,” 
and move to “Go To” by pressing “Down arrow key.” Then, press “Enter” 
on “Go To.” Or, you can press “g” in the menu. In the “Go To” menu, you 
will find the following submenus:  “Find,” “Find Again,” “Replace,” “Go 
To Location,” “Go to Previous Page,” “Go To Next Page,” “Set Mark,” 
“Go to Mark,” “Go To Previous Document,” and “Go To Next Document.” 
 
5.3.1 Find 
 
The find function allows you to search for text in a document. Once the 
text is found you will be taken to that position in your document. To 
execute this command, press “Alt,” and move to “Go To” by pressing 
“Down arrow key” and press “Enter” on “Go To.” Then, select “Find.”  
You will be able to navigate the “Go To” menu with “Up arrow key”or 
“Down arrow key.” Otherwise, you can press “f” in the “Go To” menu, 
which is the shortcut. While editing a document, pressing “Ctrl-f” will 
activate the “Find” command. If “Find” is executed, the dialog box is 
displayed. This dialog box consists of “Text to find,” “Search direction,” 
“Match case,” a “Confirm” button, and a “Cancel” button. You can move 
from one field to the next field by pressing “tab”or “shift-tab. 
 
1. Text to find 

The first field in “Find” is “Text to find.” In this window, you can type in 
the text that you want to find. If you want to find the text immediately, 
press “Enter.” However, if you want to set other fields in the dialog 
box, press “tab”to move to the next field. 

2. Search direction 
The next field is “Search direction.” The default direction is “Forward.”  
If you would like to change the search direction, you should press 
“Space.” Pressing “Space” will toggle between “Forward” and 
“Backward”. After you type in the text to be found, and set the 
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searching direction, press “Enter” if you want to find the text 
immediately. 

3. Match case 
The next field is “Match case.” This field display only when you 
execute the “Find” command in text file. This field does not display in 
Braille file. The default value is “No.” If you want to change the value, 
press “Space.” Pressing “Space” will toggle between “No” and “Yes.” 

4. Confirm 
After you set all of the fields and want to execute “Find,” press “Enter” 
on “Confirm.”You can also start finding text by pressing “Enter” on 
“Text to find” or “Search direction.” 

5. Cancel 
In order to cancel the “Find” function, press “Enter” on “Cancel.”Or, 
you can cancel the “Find” command by pressing “Alt-F4.” 

 
If you have executed the “Find” command as explained above and it 
finds the text that you typed in, and “completed” is announced by the 
voice. If there was no text that matched what you typed in, the cursor 
does not move and the Voice Sense QWERTY announce the “not 
found.” by the voice. This function saves the text that was typed in last, 
as well as the direction, so you can use it again to search for the next 
occurrence of text. 
 
When using the find command, the current cursor position is very 
important. If the cursor is located at the beginning of the document, it is 
better for you to select “Forward” direction. If the cursor is located at the 
end of the document, it is better to select “Backward” as the direction 
used for searching. 
 
5.3.2 Find Again 
 
When you want to run the “Find Again” command; you can press “Alt.”  
Then move to “Go To” by pressing “Down arrow key.” Then, press 
“Enter” on “Go To.” Move to “Find Again” by pressing “Down arrow key” 
to move to “Find Again” and press “Enter,” or press “h” in the “Go To” 
menu. When you are editing a document, you should press “F3” to 
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activate this command. When “Find Again” is executed, “Find Again” will 
look for the text that was used in the previous “Find.” “Find again” will 
search in the same direction that was used with the last “Find.” If you 
have not yet used the “Find” command in the current document, and you 
execute “Find Again,” it will not work. “Find again” is used to find the text 
that you have previously found in the current document. 
 
5.3.3 Replace 
 
To execute this command, press “Alt,” and move to “Go To” by pressing 
“Down arrow key.” Then, press “Enter” on “Go To.” Move to “Replace” by 
pressing “Down arrow key” to move to “Replace (r),” and press “Enter,” 
or press “r” in the “Go To” menu (which is the short cut). While editing a 
document, pressing “Ctrl-r” will activate this function. 
 
“Replace” also has a dialog box that consists of the following fields:  
“Text to find,” “Replace with,” “Search direction,” “Match case,” 
“Replace,” “Confirm” and “Cancel.” You can move between the fields by 
pressing “tab”or “shift-tab”. 
 
The following is a description of each function. 
 
1. Text to find 

You can type in the text that you want to be replaced in this field. 
2. Replace with 

You can type in new text that will replace the text that is found. After 
you type in “Text to find” and “Replace with,” the Voice Sense 
QWERTY will find the text and replace it in the direction that you have 
specified. If you want to change the direction, press “tab”to move to 
the next field. 

3. Search direction 
The “Search direction” has the same function as the “Search 
direction” explained in section 5.3.1. After you set the searching 
direction, press “Enter” to start the replacement of text, or press 
“tab”to set the “Match case” or “Replace.” 

4. Match case 
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This field display only when you execute the “Replace” command in 
text file. This field does not display in Braille file. The default value is 
“No.” If you want to change the value, press “Space.” Pressing 
“Space” will toggle between “No” and “Yes.” 

5. Replace 
You may want to replace only one piece of text. Or, you may want to 
replace all the texts that coincides with the text that you typed in the 
“Text to find” field. You can set it in the “Replace” field. There are two 
choices: “Once” and “All.”You can toggle between the two choices by 
pressing “Space.” 

6. Confirm and Cancel 
Pressing “Enter” on “Confirm” will start finding and replacing text. If 
there is no text that coincides with the text that was typed in, “Not 
found.” is displayed, and the function is canceled. Pressing “Enter” on 
“Cancel” will cancel the “Replace” function. 

 
5.3.4 Go to Location 
 
The “Go to Location” command moves rapidly to a specific location.  
You can move to a specific page, paragraph, or line. To execute this 
command, press “Alt,” and move to “Go To” by pressing “Down arrow 
key.” Then, press “Enter” on “Go To.” Move to “Go to Location” by 
pressing “Down arrow key,” and then press “Enter.” While editing a 
document, press “Ctrl-g” to activate this function. If “Go to Location” is 
executed, the word processor says, “Move to page number:” If you type 
in a number here, Voice Sense QWERTY will take you to the page 
number that corresponds with the number you have just typed in.  You 
can also type the letter “f” before the number. This will tell the Voice 
Sense QWERTY that you are looking for a page number, and not a 
paragraph, or, line number. Type in the number of the page you want to 
move to without the plus sign or minus sign, and then press “Enter.”  
The word processor will jump from start of the document to the specific 
page at once. If you want to move forward from your current location, put 
the plus sign in front of the number and letter. For example, if you want 
to move forward five pages, you would type “+f5.” If you want to move 
backward from your current location, put the minus sign in front of the 
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number and letter. If you want to move to the previous page, type “-f,” 
and if you want to move to the next page, type “+f.” If the page number 
you type in is not valid, the Voice Sense QWERTY will say, “Move range 
error.” 
 
You can also use this function to move to a specific paragraph. First, 
select “Go to Location” in the “Go To” menu, or just press “Ctrl-g”. Then, 
the Voice Sense QWERTY will say, “Move to page number:” Before you 
type in the number of the paragraph that you want to go to, type “p,” and 
then type the number of the paragraph that you want to go to. By typing 
in the letter “p,” the Voice Sense QWERTY will know that you are 
looking for a paragraph, and not a page or line. If you want to move 
forward from your current location, put the plus sign in front of the 
number and letter. If you want to move backward from your current 
location, put the minus sign in front of the number and letter. For 
example, if you want to move backward two paragraphs, you would type, 
“-p2.” If you want to move to the previous paragraph, type “-p,” and if you 
want to move to the next paragraph, type “+p.” If the paragraph number 
you type in is not valid, the Voice Sense QWERTY will say, “Move range 
error.” 
 
You can also use this function to move to a specific line. First, select “Go 
to Location” in the “Go To” menu, or just press “Ctrl-g.” Then, the Voice 
Sense QWERTY will say, “Move to page number:” Before you type in 
the number of the line that you want to go to, type “l,” and then type the 
number of the line that you want to go to. By typing in the letter “l,” the 
Voice Sense QWERTY will know that you are looking for a line, and not 
a page or paragraph. If you want to move forward from your current 
location, put the plus sign in front of the number and letter. If you want to 
move backward from your current location, put the minus sign in front of 
the number and letter. For example, if you want to move backward two 
lines, you would type, “-l2.” If you want to move to the previous line, type 
“-l,” and if you want to move to the next line, type “+l.”  If the line 
number you type in is not valid, the Voice Sense QWERTY will say, 
“Move range error.” 
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You can also go to a specific line number on a specific page. The Voice 
Sense QWERTY enables you to type in this information at the same 
time. To do this, press “Ctrl-g,” or you can select “Go to Location” in the 
“Go To” menu. Then, when the Voice Sense QWERTY says, “Move to 
page number:” you can type in the page number followed by the line 
number. For example, to move to the 3rd line on the 20th page, you would 
type “20 3,” or you could type “f20 3.” When you use the command of the 
“Go to Location” function, you cannot use the “+” or “-” sign. You can 
only go directly to the page and line number. 
 
5.3.5 Go to Previous Page 
 
The “Go To Previous Page” command allows you to move to the page 
that is located before the page you are currently on. To execute this 
command, press “Alt,” and move to “Go To” by pressing “Down arrow 
key.” Then, press “Enter” on “Go To.” Move to “Go to Previous Page” by 
pressing “Down arrow key,” and then press “Enter,” or press “Page up” 
while you are in the document. Once you have activated the “Go to 
Previous Page” function, the Voice Sense QWERTY will go directly to 
the previous page. 
 
5.3.6 Go to Next Page 
 
The “Go To Next Page” command allows you to move to the page that is 
located after the page you are currently on. To execute this command, 
press “Alt,” and move to “Go To” by pressing “Down arrow key.” Then, 
press “Enter” on “Go To.” Move to “Go to Next Page” by pressing “Down 
arrow key,” and then press “Enter.” Or, you can press “Page down” while 
you are in the document. Once you have activated the “Go to Next 
Page” function, the Voice Sense QWERTY will go directly to the next 
page. 
 
5.3.7 Set Mark 
 
The “Set mark” command marks a position in the document that you 
want to use later. To execute this command, press “Alt,” and move to 
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“Go To” by pressing “Down arrow key.” Then, press “Enter” on “Go To.”  
Move to “Set mark” by pressing “Down arrow key,” and then press 
“Enter,” or press “m” in the “Go To” menu, which is the short cut. While 
editing a document, press “Ctrl-m” to activate this command. 
 
Move the cursor to the location that you want to mark, and press “Ctrl-m”.  
Then, the Voice Sense QWERTY will say “Mark name:”. To name the 
mark, use the letters a through z. For example, if you put down the letter 
“a,” the Voice Sense QWERTY will move you to that point in the 
document immediately. If you are in the document, the Voice Sense 
QWERTY will not show the mark sign.  
 
Note: If you selected “View format character” in “Settings,”, you will see 
the bookmark sign in the document when Voice Sense QWERTY 
connected to SyncBraille. You can go to marked text by using “Left 
arrow key” or “Right arrow key,” and the bookmark sign will appear, 
which is “$pl (mark name).” If you move the cursor to the mark location 
in a document, you can see dots 7-8 all through the mark sign. This 
means that the Voice Sense QWERTY will deal with the marked text as 
a chunk, but not with every character one by one. 
 
5.3.8 Go to Mark 
 
The “Go to Mark” command finds a mark that has already been marked.  
When you want to execute this command, you can press “Alt”, and move 
to “Go To” by pressing “Down arrow key.” Then, press “Enter” on “Go 
To.” Move to “Go to Mark” by pressing “Down arrow key,” and then press 
“Enter,” or press “j” in the “Go To” menu, which is the short cut. You can 
jump to anywhere in a document to marked text with by pressing “Ctrl-j.” 
 
If you press “Ctrl-j”, the Voice Sense QWERTY will say “Move to mark:.”  
 
Note: If you type in the character of the mark name that you want to 
locate, the Voice Sense QWERTY will move the cursor to the marked 
text with dots 7-8 embossed in the first cell when it connects to 
SyncBraille. 
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5.3.9 Go to Previous Document 
 
If you have multiple documents open, you can go directly to the 
document that you had opened before the document that you are 
currently editing. To execute this command, press “Alt,” and move to “Go 
To” by pressing “Down arrow key.” Then, press “Enter” on “Go To.”  
Move to “Go To Previous Document” by pressing “Down arrow key,” and 
then press “Enter.” Or, you can press “shift-tab” while you are editing a 
document to go to the previous document. 
 
5.3.10 Go to Next Document 
 
If you have multiple documents open, you can go directly to the next 
document that is open. To execute this command, press “Alt,” and move 
to “Go To” by pressing “Down arrow key.” Then, press “Enter” on “Go 
To.” Move to “Go to Next Document” by pressing “Down arrow key,” and 
then press “Enter.” Or, you can press “tab” while you are editing a 
document to go to the next document. 
 
5.4 Read Menu 
 
The “Read” menu reads the document in voice In order to call up the 
“read menu,” press “Alt,” and then press “r.” The submenus of the 
“Read” menu are “Read Selected Text,” “Read Beginning Of Selected 
Text,” “Read From Beginning To Cursor,” “Read From Cursor To End,” 
“Auto Scroll,” “Read Current Line,” “Read Current Word,” “Read Current 
Character,” and “Read Status.” 
 
Note: “Auto Scroll” will appear when Voice Sense QWERTY connected 
to SyncBraille. 
 
5.4.1 Read Selected Text 
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The “Read Selected Text” command allows you to have the Voice Sense 
QWERTY read text that you have in a selection. To execute this 
command, press “Alt,” and move to the “Read” menu by pressing “Down 
arrow key,” and then press “Enter,” or press “r” to call up the “Read” 
menu. Press “Enter” on “Read Selected Text” in the “Read” menu. While 
editing a document, you can press “Alt-b” to activate the “Read Selected 
Text” function. Although you activate this function, the cursor location will 
not move to the selected text. The cursor will stay where you have 
activated “Read Selected Text.” 
 
5.4.2 Read Beginning of Selected Text 
 
The “Read Beginning of Selected Text” command will allow you to hear 
the first line of the selected text, without moving the cursor location. To 
execute this command, press “Alt,” and move to the “Read” menu by 
pressing “Down arrow key.” Then, press “Enter.” Move to “Read 
Beginning of Selected Text” by pressing “Down arrow key,” and then 
press “Enter,” or you can press “u” on the read menu, which is the short 
cut. While editing a document, you can press “Ctrl-u” to activate this 
function. When you execute “Read Beginning Of Selected Text,” the 
cursor will stay in the same position it was at when you executed “Read 
Beginning Of Selected Text.” 
 
5.4.3 Read from beginning to cursor 
 
Using this function, the Voice Sense QWERTY will audibly speak a 
document from the beginning to the position where the cursor is located.  
To execute this command, press “Alt,” and move to the “Read” menu by 
pressing “Down arrow key.” Then, press “Enter.” Move to “Read from 
Beginning to Cursor” by pressing “Down arrow key,” and then press 
“Enter” or you can press “t” on the read menu, which is the short cut.  
While editing a document, you can press “Alt-g” to activate this function. 
 
If you want to quit this function before you reach the cursor location, you 
can press “Ctrl”. Your cursor will stay where it was when you started this 
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function. That is, the cursor will not move to the position to where you 
stopped the function. 
 
5.4.4 Read from Cursor to End 
 
This command will read a document from where the cursor is located to 
the end of the document. While the Voice Sense QWERTY is reading 
the text, the cursor will stay in the same location that you were, before 
you started this command. The cursor will not be moved until the reading 
has been completed. Once the text has been read, the cursor will move 
to the end of the document. To execute this command, press “Alt”, and 
move to the “Read” menu by pressing “Down arrow key.”  Then, press 
“Enter.” You can move to “Read from Cursor to End” by pressing “Down 
arrow key” and press “Enter,” or you can press “g” on the “Read” menu, 
which is the short cut. While editing a document, you can press “Fn-
Enter” to activate this function. 
 
If you stop this command before the end of a document, you can press 
“Ctrl,” which will move the cursor to where you stopped the command. 
 
5.4.5 Auto Scroll 
 
Note: This function will appear when the Voice Sense is connected to 
SyncBraille. 
 
The “Auto Scroll” command scrolls automatically. The speed of the “Auto 
Scroll” is set in the “Settings” menu, which is located in the “File” menu, 
which was explained in section 5.1.7. The auto scroll mode does not 
read the document using the voice. It is only displayed on the Braille 
display. It reads the document line by line automatically. To execute this 
command, press “Alt,” and move to the “Read” menu by pressing “Down 
arrow key.” Then, press “Enter.” Move to “Auto Scroll” by pressing 
“Down arrow key,” and then press “Enter,” or you can press “a” on the 
read menu, which is the short cut. You can turn the auto scroll feature on 
and off by pressing the up and down scroll buttons simultaneously. For 
faster scrolling, press the “Right arrow key”. For slower scrolling, press 
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“Left arrow key”. If you want to read a line again that you have already 
scrolled past, you can read it again by pressing the up scroll button or 
“Up arrow key” until you can get to what you want to read. Similarly, if 
you want to skip some lines that you do not wish to read, you can skip 
them by pressing the down scroll button or “Down arrow key.” You can 
also access this function without opening the menu by pressing both 
scroll buttons at the same time when in your document. 
 
5.4.6 Read Current Line 
 
This function will tell you information about your current line. To execute 
this command, press “Alt,” and move to the “Read” menu by pressing 
“Down arrow key.” Then, press “Enter.” Move to “Read Current Line” by 
pressing “Down arrow key,” and then press “Enter,” or you can press “l” 
in the read menu, which is the short cut. While editing a document, you 
can press “Fn-c” to activate this function. In order to return to the 
document that you are editing, press any key.  
 
5.4.7 Read Current Word 
 
This function will tell you information about your current word. To 
execute this command, press “Alt,” and move to the “Read” menu by 
pressing “Down arrow key.” Then, press “Enter.” Move to “Read Current 
Word” by pressing “Down arrow key,” and then press “Enter,” or you can 
press “w” in the read menu, which is the short cut. While editing a 
document, you can press “Fn-x” to activate this function. In order to 
return to the document that you are editing, press any key.  
 
5.4.8 Read Current Character 
 
This function will tell you information about your current character. To 
execute this command, press “Alt,” and move to the “Read” menu by 
pressing “Down arrow key”. Then, press “Enter.” Move to “Read Current 
Character” by pressing “Down arrow key,” and then press “Enter,” or you 
can press “c” in the read menu, which is the short cut. While editing a 
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document, you can press “Fn-z” to activate this function. In order to 
return to the document that you are editing, press any key.  
 
5.4.9 Read Status 
 
This function will tell you information about your current file. If you 
activate this function, Voice Sense QWERTY will tell you the “file name,” 
“edit mode (insert or overwrite),” and “file protection (write or read only).” 
To execute this command, press “Alt,” and move to the “Read” menu by 
pressing “Down arrow key.” Then, press “Enter.” Move to “Read Status” 
by pressing “Down arrow key,” and then press “Enter,” or you can press 
“s” in the read menu, which is the short cut. While editing a document, 
you can press “Fn-/” to activate this function. In order to return to the 
document that you are editing, press any key. 
 
5.5 Layout 
 
The “Layout” command sets the layout for printing on an ink printer or 
embossing on a Braille printer. The “Layout” menu has the following 
submenus: “Braille Document Layout,” “Print Document Layout,” “Braille 
Paragraph Layout,” and “Print Paragraph Layout.” In order to check the 
layout, call up the menu by pressing “Alt,” and check the layout values 
one by one. The changed values will be displayed within the menu. 
 
5.5.1 Braille Document Layout  
 
While you are editing a document, press “Alt” to call up the menu, and 
select “Layout” or press “l,” (which is the short cut), and then select 
“Braille Document Layout.” Or, you can press “Alt-F5.” “Braille Document 
Layout” is used to set the width and height of the paper for embossing 
as well as the following options. Whenever you change a layout setting 
while you are editing a document, the setting will be valid on the rest of 
the document. 
 
You can navigate the menu items with “Up arrow key”or “Down arrow 
key,” and you can move to “Confirm” or “Cancel” by pressing “tab”. You 
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can skip an item by pressing “Down arrow key” if you don’t want to 
change the default setting. 
 
The following are the items that can be changed: 
 
1. Set characters per line 

This sets the number of characters (Braille) per line to emboss in 
Braille. The default value is set to 32. Type in the number of 
characters per line, if you decide you want to change the value.  
Then, you can move to the next setting by pressing “Down arrow key.” 

2. Set lines per page 
This sets the number of lines per page to be embossed. It includes 
the line that the page number is printed in. For example, if it is set to 
26, the content of the document will be embossed with 25 lines and 
the page number is printed as the 26th line. If you want to change the 
value, type in the number of lines that you want to emboss. Then, you 
can move to the next setting by pressing “Down arrow key.” 

3. Print type 
This sets whether the document will be embossed on a single sided 
or a double sided (both sides). The default value is set to double side 
embossing. If you want to emboss using single sided embossing, 
press “Space” until “Print type: Single sided” isheard. Then, the 
setting will be changed to single side embossing. If you want to go 
back to double side printing again, pressed “Space” again, and “Print 
type: Double sided” will be displayed.  After setting your preference, 
move to the next setting by pressing “Down arrow key.” 

4. Page numbering type 
This sets the numbering type for embossing a document.  The 
default type is set to “Double sided.” It means that the page number 
will be embossed on every page. The setting values are “Double 
sided,” “Odd,” “Even,” and “None.” These settings are changed when 
you press “Space.” Pressing “Backspace” will allow you to move in 
reverse order. When you have selected your preference, you need to 
press “Down arrow key” in order to move to the next setting. 

5. Set page numbering 
This sets the position of the page number when embossing. The 
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selections are “Upper right” and “Lower right.” The default setting is 
set to “Lower right.” Press “Space” in order to change the setting.  
Pressing “Backspace” will allow you to move in reverse order. After 
selecting your preference, you should press “Down arrow key” in 
order to move to the next setting. 

6. Header 
This is used to edit the header that will be embossed on the head of 
every page. Move to “Header” and type in the text to be embossed as 
the header. In order to move to the next setting, press “Down arrow 
key.” 

7. Footer 
This is used to edit the footer that will be embossed on the bottom of 
every page. Move to “Footer” and type in the text to be embossed as 
the footer. After you set every field, move to “Confirm” or “Cancel,” 
and press “tab.” If you want to change a setting or check your settings 
again, press “Up arrow key” to move to the previous fields. 

8. Confirm / Cancel 
In order to apply a setting, press “Enter” while “Confirm” is displayed.  
If you do not want to change the setting, you will need to press “Enter” 
when “Cancel” is displayed. 

 
5.5.2 Print Document Layout 
 
This option will allow you to set the layout of the document for printing on 
an ink printer. Press “Alt” to call up the menu while you are editing a 
document, and select “Layout” or press “l” (which is the shortcut), and 
then select “Print Document Layout.” Or, press “Alt-F6,” which is the hot 
key for “print document layout.” The settings in this menu are applied to 
all the paragraphs in the selected document. You can navigate the menu 
items with “Up arrow key”or “Down arrow key,” and you can move to 
“Confirm” or “Cancel” by pressing “tab”. You can skip an item by 
pressing “Down arrow key” if you do not want to change the default 
setting. 
 
The following is a detailed explanation of each setting: 
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1. Set top margin 
This sets the top margin for ink printing. The top margin is the 
distance from the top of the paper to the first line of the printed 
paragraph. The default value is set to 20mm (about 0.78 inches). If 
you are going to change the default setting, you can type in a number, 
which will make the margin as big as you would like to have it. 

2. Set bottom margin 
This sets the bottom margin for ink printing. The bottom margin is the 
distance from the bottom of the paper to the last line of a printed 
paragraph. The default value is set to 20mm (about 0.78 inches). If 
you are going to change the default setting, you can type in a number, 
which will make the margin as big as you would like to have it. 

3. Set left margin 
This sets the left margin for ink printing. The left margin is the distance 
from the left edge of the paper to the first text that is printed. The 
default value is set to 20 mm (about 0.78 inches). If you are going to 
change the default setting, you can type in a number, which will make 
the margin as big as you would like to have it. 

4. Set right margin 
This sets the right margin for ink printing. The right margin is the 
distance from the right end of the printed text to the right edge of the 
paper. The default value is set to 20mm (about 0.78 inches). If you 
are going to change the default setting, you can type in a number, 
which will make the margin as big as you would like to have it. 

5. Set page numbering 
This sets the position where the page numbers will be printed. The 
page number positions are “Upper left,” “Upper middle,” “Upper right,” 
“Lower left,” “Lower middle,” and “Lower right.” To change the setting, 
press “Space.” Pressing “Backspace” will allow you to move in 
reverse order. After selecting your preference, you should press 
“Down arrow key” in order to move to the next setting. 

6. Header 
This is used to edit the header that will be printed at the top of each 
page. Move to “Header,” and type in the text that you want to be 
printed. 

7. Footer 
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This is used to edit the footer that will be printed at the bottom of each 
page. Move to “Footer,” and type in the text that you want to be 
printed. 

8. Distance between lines 
This sets the distance between the lines that will be printed. The 
default value is set to 150%. The distance can be anywhere from 
100% to 300%. If you type in a value that exceeds this range, the 
Voice Sense QWERTY will say “Out of range. Value too large,” and 
wait for you to type in another value. 

9. Confirm / cancel 
In order to apply a setting, press “Enter” while “Confirm” is displayed.  
If you do not want to apply a setting, you will need to press “Enter” 
when “Cancel” is displayed. If you press “Enter” on cancel, you will be 
taken out of the menu. You must press “tab”or “shift-tab”to get to the 
Confirm and Cancel buttons. 

 
5.5.3 Braille Paragraph Layout  
 
In order to call up the “Braille Paragraph Layout,” press “Alt” while you 
are editing a document. Then, press “Enter” on “Layout,” or press “l” 
while in the “Layout” menu (which is the short cut), and then select 
“Braille Paragraph Layout.” Or, you can press “Alt-F7.” The changed 
layout will be applied only to the selected paragraph. These settings are 
not applied to other paragraphs. 
 
You can navigate between the menu items by pressing “Up arrow key”or 
“Down arrow key.” By pressing “tab”, move to “Confirm”or “Cancel”. You 
can skip an item by pressing “Down arrow key” if you do not want to 
change the default setting. 
In this setting, you can set the following items:   
 
1. Indent first line 

This indents the first line of the paragraph as designated by the 
number of characters. The default value is set to 0. In order to change 
this setting, type in the number of characters to be indented on the 
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“Indent first line” setting item. Press the “Down arrow key” in order to 
move to the next setting item. 

2. Indent all lines except the first line 
This indents all the lines of the paragraph, except the first line of the 
paragraph as designated by the number of columns. If you want to 
indent all of the text, except for the first line, by typing in a number.  
You can make the indent as big as you want it by changing the 
number of columns, which will indent all lines, except for the first line.  
Press “tab”in order to “Confirm” and “Cancel.” If you want to change 
the setting of a previous item, move to it by pressing “Up arrow key,” 
and change it. The default is set to “0. 

3. Confirm / cancel 
In order to apply changes, you need to press “Enter” when “Confirm” 
is displayed. If you want to exit from a setting without changing it, you 
should press “Enter” when “Cancel” is displayed. You must press 
“tab”or “shift-tab”to get to the Confirm and Cancel buttons. 

 
5.5.4 Print Paragraph Layout  
 
You can set the layout of the current paragraph for printing on an ink 
printer. In order to set “print paragraph layout,” press “Alt” while you are 
editing a document, and select “Layout,” or press “l” (which is the short 
cut), and select “Print Paragraph Layout.” Or, press “Alt-F8,” which is the 
hot key for “Print Paragraph Layout.” This setting applies only to the 
paragraph that you are on when the setting is changed. This setting 
change does not apply to other paragraphs. You can navigate the menu 
items by pressing “Up arrow key”or “Down arrow key,” and you can 
move to “Confirm” or “Cancel” by pressing “tab.” You can skip an item by 
pressing “Down arrow key” if you do not want to change the default 
setting. 

 
The following is a detailed explanation of the settings for “Print 
Paragraph Layout:” 
 
1. Set left margin 
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This sets the left margin for ink printing. The default value is set to 
0mm. In order to change the setting, you will need to type in the value. 
Move to the next setting by pressing the press “Down arrow key.” 

2. Set right margin 
This sets the right margin for ink printing. The default value is set to 
0mm. In order to change the setting, you will need to type in the value. 
Move to the next setting by pressing the press “Down arrow key.” 

3. Indent first line 
This sets the indentation of the first line. The first line will be indented 
by the value that you select, and the other lines will not be indented.  
This setting is valid for the paragraphs that follow, unless the setting 
is changed. The default value is set to 0. In order to change the 
setting, you should type in the number of characters. Press the press 
“Down arrow key” in order to move to the next setting. 

4. Indent all lines except the first line 
All the lines in the paragraph, except the first line, are indented if this 
is set. This setting will be valid for the following paragraphs, unless 
the setting is changed. The default value is set to 0. In order to 
change the setting, you should type in the number of characters. 

5. Alignment 
This sets the alignment type. The default type is set to “Left justified.”  
The other options are “Centered” and “Right justified.” Press “Space” 
in order to change the setting. 

6. Set style 
When printing a document through an ink printer, the style of each 
paragraph can be set to a desired style. Style includes “font type,” 
“font size,” and “text shape for text.” You can select “Text,” “Title,” 
“Sub title,” “Abstract 1,” and “Abstract 2” by pressing “Space” or 
“Backspace.” The default fonts for each style are listed below. 

Text: Times New Roman, Font size 11 
Abstract1: Times New Roman, Font size 11, Boldface  
Abstract2: Times New Roman, Font size 14, Boldface  
Sub title: Courier New, Font size 16, Italic, Boldface, CEnter-
aligned  
Title: Times New Roman, Font size 20, Boldface, CEnter-aligned  

7. Confirm / cancel 
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In order to apply a setting, press “Enter” on “Confirm.” In order to 
cancel a setting, and move to “edit mode,” press “Enter” on “Cancel.”  
You must press “tab”or “shift-tab”to get to the “Confirm” and “Cancel” 
buttons. 

 
5.6 Keys for Text moving and deleting 
 
While reading a document, you can use the following commands to read 
Braille or hear speech. You can move character by character, word by 
word, or paragraph by paragraph. 
 
The previous character: Left arrow key 
The next character: Right arrow key 
The previous word: Ctrl-Left arrow key 
The next word: Ctrl-Right arrow key 
The beginning of line: Fn-Left arrow key 
The end of line: Fn-Right arrow key 
The previous sentence: Ctrl-Alt-Right arrow key 
The next sentence: Ctrl-Alt-Left arrow key 
The previous line: Up arrow key 
The next line: Down arrow key 
The next paragraph: Ctrl-Down arrow key 
The previous paragraph: Ctrl-Up arrow key 
The top of document: Ctrl-fn-Left arrow key 
The bottom of document: Ctrl-fn-Right arrow key 
 
In addition, if you use the following commands, you can read the part of 
a document where the cursor is. For example, if you activate the read 
the current paragraph function, you will hear the entire paragraph where 
the cursor is located. 
 
Read the current paragraph: Fn-v 
Read the current line: Fn-c 
Read the current sentence: Fn-n 
Read the current word: Fn-x 
Read the current character: Fn-z 
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If you want to delete a part where the cursor is, you can use the 
following keys. For example, if you activate the delete the current 
paragraph function, you can delete the entire paragraph where the 
cursor is located. 
 
Delete the current paragraph: Alt-Del 
Delete the current line: Ctrl-Backspace 
Delete the current word: Alt-Backspace 
Delete the current character: Del 
 
5.7 Cursor Location 
 
While reading a document, you can check the cursor location. To do this, 
press “Fn-s.” You will then hear, “Page: xx, Line: xx, column: xx, xx%, 
Paragraph: xx/yy, Line: xx/yy.” 
 
5.8 Hot keys in the word processor 
 
1. File menu 

New document: Ctrl-n 
Open: Ctrl-o 
Save: Ctrl-s  
Save as: Alt-s 
Close current document: Ctrl-F4 
Print: Ctrl-p  
Settings: Ctrl-e  
Exit: Alt-F4 

 
2. Edit menu 

Start selection: Ctrl-b 
Copy: Ctrl-c 
Cut: Ctrl-x  
Paste: Ctrl-v 
Delete: Del 
Delete blank lines: Alt-e 



104 
 

Add to clipboard: Ctrl-Insert 
Clear clipboard: Ctrl-Del 
Select All: Ctrl-a  
Insert from file: Ctrl-i 
Insert date: Ctrl-w 
Toggle insert/overwrite mode: Insert 
Check spelling: Ctrl-k 
Check spelling of the current word: Alt-k 

 
3. Go to menu 

Find: Ctrl-f 
Find again: F3 
Replace: Ctrl-r  
Go to location: Ctrl-g 
Go to previous page: Page up (Fn-Up arrow key) 
Go to next page: Page down (Fn-Down arrow key)  
Set mark: Ctrl-m  
Go to mark: Ctrl-j 
Go to previous document: Shift-tab 
Go to next document: Tab 

 
4. Read menu 

Read selected text: Alt-b 
Read beginning of selected text: Ctrl-u  
Read from beginning to cursor: Alt-g 
Read from cursor to end: Fn-Enter 
Read status: Fn-/ 

 
5. Layout menu 

Braille document layout: Alt-F5 
Print document layout: Alt-F6 
Braille paragraph layout: Alt-F7 
Print paragraph layout: Alt-F8 

 
6. Miscellaneous hot keys 

Move to previous character: Left arrow key 
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Move to next character: Right arrow key 
Move to previous word: Ctrl-Left arrow key 
Move to next word: Ctrl-Right arrow key 
Move to the beginning of the line: Fn-Left arrow key 
Move to the end of the line: Fn-Right arrow key 
Move to previous sentence: Alt-Ctrl-Left arrow key 
Move to next sentence: Alt-Ctrl-Right arrow key 
Move to previous line: Up arrow key 
Move to next line: Down arrow key 
Move to previous paragraph: Ctrl-Up arrow key  
Move to next paragraph: Ctrl-Down arrow key 
Move to the beginning of the document: Ctrl-fn-Left arrow key 
Move to the end of the document: Ctrl-fn-Right arrow key 
Read current paragraph: Fn-v 
Read current line: Fn-c 
Read current sentence: Fn-n 
Read current word: Fn-x 
Read current character: Fn-z 
Delete current paragraph: Alt-Del 
Delete current line: Ctrl-Backspace 
Delete current word: Alt-Backspace 
Delete current character: Del 
Confirm current cursor position: Fn-s 
Set reading unit: Ctrl-3 
Set read only: Ctrl-2 

 
Auto scroll: up-down scroll buttons (This function executes when the 
Voice Sense is connected to SyncBraille.) 
Set view format character: Ctrl-5 (This function executes when the 
Voice Sense is connected to SyncBraille.) 
Set reading mode: Ctrl-4 (This function executes when the Voice 
Sense is connected to SyncBraille.) 
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6. Address Manager 
 
6.1 What is the “Address Manager”? 
 
The “Address manager” is a program that you can use to keep track of 
your contact information and schedule information, such as names, 
company addresses, home addresses, as well as other information. 
 
“Address manager” has two main dialog boxes: “Add Address” and 
“Search Address.” In the “Add Address,” dialog you can enter contact 
information, such as names, company addresses, home addresses and 
so on. The information that you have entered can be saved for later use.  
In the “Search Address,” dialog you can look for information that is 
stored in the “Address manager.” You can edit or delete information that 
you find. You can also select addresses to be printed using an ink or 
Braille printer. 
 
You can also connect to a web site by pressing “Enter” on a homepage 
address field if the field contains an address for a web site. In the 
“program” menu, you can start “Address manager” by typing “a,” or by 
selecting “Address manager.” Press “Down arrow key” or “Up arrow 
key”repeatedly in the “program” menu until you arrive at the “Address 
manager,” and then press “Enter” to open it. Before going into the details 
of how to use the “Address manager,” let's discuss the structure of 
address data. 
 
The address data that is stored in “Address manager” consists of a set 
of records. A “record” is a collection of contact information about one 
person or company. Each record contains 23 fields. These 23 fields are:  
“Last name,” “First name,” “Company name,” “Title,” “Mobile phone,” 
“Home phone,” “Home fax,” “Company phone,” “Company fax,” “Home 
street address,” “Home city,” “Home state,” “Home zip code,” “Home 
country,” “Company street address,” “Company city,” “Company state,” 
“Company zip code,” “Company country.” “Home e-mail,” “Company e-
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mail,” “Home page,” and “Memo.” Thus, one record contains all the 
information you can keep about a person or company. 
 
6.2 Starting the Address Manager 
 
When you press “Enter” on “Address manager” in the “program” menu, 
Voice Sense QWERTY will say “Search Address,” and display the 
prompt, “Last name:.” In other words, when you start the “Address 
manager,” the “Search Address” dialog box will be opened. 
 
In “Address manager,” you can use the menus to conveniently browse 
and execute all of the available commands. When you cannot remember 
the exact hot key for the command that you want to execute, you can 
press “Alt” to open the menu. 
 
6.3 Using “Add Address” 
 
This dialog box allows you to enter new addresses in the Address 
manager. In order to use the “Add Address” function, press “Alt” to bring 
up the “Address manager” menu, and then press the “Up arrow key,” 
“Down arrow key” to move to “Add Address.” Then, press “Enter.” Or, 
press “Ctrl-n” (which is the hot key) in “Address manager.” While you are 
entering an address, you can use the “Search Address” function (refer to 
section 6.4), “Set Address Fields” (refer to section 6.3.2), “Set Backup 
Option (refer to section 6.5.3),” “Backup Address List (refer to section 
6.5.1)” “Restore Address List (refer to section 6.5.2)” and “exit” 
commands, using the menu or with other shortcut keys. 
 
6.3.1 Adding an Address 
 
“Add address” is a dialog box that contains a list of 22 input fields, the 
“Memo” field, a “Confirm” button, and a “Cancel” button. In the input 
fields, you can enter the information corresponding to the 22 fields of a 
record. “Confirm” is used to save the information entered, and “Cancel” 
is used to discard the entry. You can move among the input fields, 
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“Memo,” “Confirm,” and “Cancel” by pressing “tab”or “shift-tab”. Among 
the 22 input fields, you can move from one field to the next by pressing 
the “Up arrow key,” “Down arrow key”. Here you should type in the 
appropriate information for each field, and press the “Down arrow key” to 
move to the next field. You do not have to fill in all of the fields. If you 
want to skip a field, press the down arrow, and the field will be left blank. 
You will then be prompted for the next field. 
 
When you have entered information in the desired fields, you can save 
the information by pressing “tab”or “shift-tab”repeatedly to move to the 
“Confirm” button. Then, press “Enter.” Or, you can press “Enter” in any 
field. 
 
If you don’t want to save the information that you have entered, press 
“tab”or “shift-tab”repeatedly to move to the “Cancel” button, and then 
press “Enter.” 
 
After you cancel the entry, you will be prompted for another record, 
beginning with the “Last name” field. 
 
You can the use the cursor routing keys to move from one field to the 
next. 
 
If you have pressed the any key to the right of the 23th key is pressed, 
you will hear a warning sound because there are only 23 fields in a 
record. 
 
You can enter telephone numbers. To type in a dash (-) while typing in a 
telephone number (e.g. 000-000-0000), you should press “-”. 
If you want to put an extension number after any phone number, enter 
the phone number as described above, and then type a comma (,), 
followed by the extension number, as in “000-000-0000,100.”  
 
When you enter a home page address or an e-mail address, you should 
enter the information using keys. For the @ (at sign), you should press 
“@.” A period in a home page address (or an e-mail address) should be 
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entered as “.”  A colon (:) can be typed in using “:” and a slash (/) can 
be typed in using “/”. 
 
By pressing “tab,” you can get to the “Memo” field. You can type in 
multiple lines of text in the “Memo” field. When you want to start a new 
line of text, you should press “Enter.” 
 
When you are done entering information for a record, you can press 
“tab” until you reach the “Confirm” button. Then, press “Enter” on 
“Confirm.” 
 
6.3.2 Setting Add Address Fields 
 
“Set Address Fields” enables you to select one of the 22 fields to be 
shown when you enter contact information. There are 22 fields in a 
record, but you may not want to enter information in every one of the 22 
fields. You can use “Set Address Fields” to select only the fields that you 
need. 
 
To use this function, press “Alt” to bring up the menu, and then select 
“Set Address Field,” or press “o” (which is the short cut), and then press 
“Enter.” Or, you can press “Ctrl-o” in the “Add Address” dialog box. 
 
On the right side of each field name, “used” or “unused” is displayed.  
The default value is set to “used.” In order to toggle the value, press 
“Space.” 
 
After setting all the fields you want to change, move to the “Confirm” 
button or the “Cancel” button by pressing “tab”or “shift-tab”, and then 
press “Enter” to save or cancel the changes. Another way you can 
cancel the changes is by pressing “ESC” or “Alt-F4.” 
 
6.3.3 Using “Search Address” in “Add address” 
 
In “Add Address,” use the “Search Address” function to jump to another 
record. To use the “Search Address” function, press “Alt” to call up the 
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menu. Move to the “Search Address”, and press “Enter” or press “s”.  
You can also press “Ctrl-f” in the “Add Address” dialog box. 
 
If you have entered any information and execute “Search Address,” you 
will be asked “Save changes? Yes/No.” Once you answer this, the 
“Search Address” dialog box will be displayed. 
 
6.4 Searching For an Address 
  
6.4.1 Using “search address” 
 
The “Search Address” dialog box enables you to search for any 
information stored in “Address manager.” If you execute “Address 
manager” in the “program” menu, “Search Address” is executed 
automatically. If you want to use “Search Address” in “Add Address,” you 
can either select it from the menu, and press “Enter,” or press “Ctrl-f” 
(which is the hot key), as explained in section 6.3.3. If you press “Enter” 
in the “Search Address” dialog box, without typing any text, when “Last 
name:” is displayed, you can browse through all of the records that are 
stored in “Address manager.” A “record” is a collection of information 
about one person. If more than one record is found, you can move to the 
next record by pressing “Down arrow key.” If you want to move to the 
previous record, you need to press “Up arrow key.” 
 
For moving each field and record in the search result list, you can use 
the following keys. 
Following are the move keys in the search result list 
 
Move to a previous field in a record: Ctrl-Left arrow key 
Move to the next field in a record: Ctrl-Right arrow key 
Move to the first field in a record: Fn-Left arrow key 
Move to the last field in a record: Fn-Right arrow key 
Move to the previous record: Up arrow key 
Move to the next record: Down arrow key 
Move to the first record: Ctrl-fn-Left arrow key 
Move to the last record: Ctrl-fn-Right arrow key 
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Move to previous same field different record: Left arrow key 
Move to next same field different record: Right arrow key 
 
You can also search records using not only name field but also the other 
fields. If you want to find records with a company name, press “Down 
arrow key” repeatedly until “company name:” is heard. Then, type the 
company name, and press “Enter.” The first record that has the 
company name will be displayed. 
 
When you enter text to be searched for, you do not have to type the 
entire content of a field. For example, if you want to find a record about 
“Edward,” type in “ed” in the “search name” field. Then, all the records 
whose name field contains “ed” will be found. 
 
6.4.2 Setting Searching Address Fields 
 
This option enables you to select the fields that you want to search.  
Press “Alt” to bring up the menu, and select “Set Address Search 
Fields.” Then, press “Enter.” Or, you can press “Ctrl-o” (which is the hot 
key) in the “Set Address Search Fields” dialog box. 
 
If you want to search only the name, mobile phone number, and 
company telephone number fields, move to those fields that you do not 
want to search by pressing “Down arrow key” or “Up arrow key,” and 
then press “Space” to change the value of that field to “unused.” By 
pressing “Space,” you can toggle the value of a field between “used” and 
“unused.” This works just like the “set address fields” function that was 
explained in section 6.3.2. 
 
6.4.3 Using “Add Address” In “Search Address” 
 
You can use the “Add Address” command in the “Search Address” dialog 
box. To do this, press “Alt” to bring up the menu, and then select “Add 
Address.” Then, press “Enter.” You can also press “Ctrl-n,” which is the 
hot key for this option. 
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6.5 Backing up and restoring the address list 
 
6.5.1 Backup Address List 
 
If a cold reset occurs, or if your battery goes dead, all of the data in the 
address manager will be lost. So, it is very important that you make a 
backup file every time you make a change to the address list. To go to 
“Backup Address List,” open the menu by pressing “Alt.” Then, use the 
up and down arrows, and find “Backup Address List.” Then, press 
“Enter.” You can also press “u” while you are in the menu to get to 
“Backup Address List.” Or, you can press “Ctrl-u” to activate this function 
without calling up the menu. 
 
If you already have a backup file, you will see the message “Backup file 
already exists. Continue to backup? Yes.” If you have made any changes 
to your address list, press “Enter” to create a new backup file. If you 
want to keep the previous backup file, press “Down arrow key,” locate 
“No,” and press “Enter” on it. When you make a backup file in your 
address list, you will always have a new backup file with the extension 
DAT, and you will have another file with the extension BAK (which 
originated from the previous “address.dat” file). 
 
6.5.2 Restore Address List 
 
If you want to restore the address list after a cold reset, press “Alt” to call 
up the menu, and use the up and down arrow keys to find “Restore 
Address List.” Then, press “Enter” on “Restore Address List.” Or, you can 
press “r” while you are in the menu to find “Restore Address List.” You 
can also press “Ctrl-r” to activate this function, without calling up the 
menu. 
 
If you activate the “Restore Address List” function, and you already have 
an address list, you will see the message, “Address file already exists.  
Which do you prefer? Append.” If you press “Enter,” the backup address 



113 
 

list will be appended to the current address list. If you press “Down arrow 
key” once and press “Enter” on “Overwrite,” you will install the new 
backup file, erasing the old backup file. For example, let us assume that 
you have three records in your address list and you have ten addresses 
in your backup file. If you select “Append,” you will have 13 records in 
your address list. In this case, three addresses could possibly be 
redundant. If you select “Overwrite,” you will have 10 addresses backed 
up, and the three original addresses will be deleted. If you don’t want 
either “Append” or “Overwrite,” press “Down arrow key,” locate “Cancel,” 
and press “Enter” on it. 
 
6.5.3 Setting Backup Option 
 
To backup your address list, you can do it manually using the “Backup 
Address List” function. You can also backup your address list 
automatically by using the “Set Backup Options.” To activate the “Set 
Backup Options” function, press “Alt” to open up the menu. Then press 
“Down arrow key” or “Up arrow key”repeatedly to locate “Set Backup 
Options.” Then press “Enter” on it. Or, you can press “e” in the menu to 
go to “Set Backup Options.”You can also activate the function without 
opening up the menu by pressing “Ctrl-e.” 
 
If you activate the function, you will see a dialog box. The dialog box has 
three controls: “Backup mode” radio button, a “Confirm” button, and a 
“Cancel” button. You can switch between controls by pressing “tab” or 
“shift-tab.”To switch between radio buttons, you can press “Up arrow 
key,” “Backspace,” “Down arrow key,” or “Space.” 
 
The “Backup mode” has three radio buttons: “Always backup changes 
when exiting,” “Manual backup” and “Prompt backup changes when 
exiting.” 
 
1. If you select the “Always backup changes when exiting,” a new 

backup file will be automatically created if you modify the address list 
or add other information when you exit the address manager. 

2. If you select the “Manual backup,” it will not create a new backup file 
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even though there may be changes in the address list. In this case, 
you can only make a new backup file by using the “backup address 
list” menu. 

3. If you select the “Prompt backup changes when exiting,” you will see 
the message “Backup changes? Yes” when you exit the address 
manager, if you have modified the address list or added other 
information. If you press “Enter” on “Yes,” it will automatically create a 
new backup file and exit the address manager. If you press Down 
arrow key once and press “Enter” on “No,” it will exit without making a 
new backup file. 

 
You can change the backup mode if you press “Enter” after focusing on 
one of the three radio buttons. Or, you can press “Enter” on “Confirm” by 
moving to it by pressing “tab.” The default backup mode is set to 
“Prompt backup changes when exiting. 
 
6.6 Commands in the Found Records 
 
6.6.1 Find again 
 
If you want to search for another name, press “tab”or “shift-tab.” The 
prompt, “Last name:” will be displayed. Now, you can type in the new 
text that you want to look for. 
 
Just as in a new search, you can start the search by pressing “Enter.”  
Even if you have canceled a search, you can go back to the “Search 
Address” dialog box by pressing “tab.” 

 
6.6.2 Opening a home page 
 
If a record has a homepage address or an email address, you can open 
the homepage or send an email. Move to “Home page,” “Home e-mail” 
or “Company e-mail” by pressing “Up arrow key”or “Down arrow key.”  
Then, press “Enter” on “Home page,” “Home e-mail” or “Company e-
mail.” 
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If you press “Enter” on a “Home page,” the Voice Sense QWERTY will 
automatically connect to the Web browser program. If you press “Enter” 
on an “Home e-mail” or “Company e-mail,” the Voice Sense QWERTY 
will bring up the “E-mail” program, so that you can send an email to the 
email address that you have selected. 
 
Before you use this command, please make sure that you are connected 
to the internet. 
 
6.6.3 Editing Addresses 
 
In order to edit a field that is in a record, find the desired address by 
using the “Search Address” function, and then move to the field you want 
to change by using the “Ctrl-Left arrow key” or the “Ctrl-Right arrow key” 
repeatedly until you arrive at the field that you want to change. Then, 
press “Alt” to call up the “menu,” and select “Modify Address.” Then, 
press “Enter,” or you can press “Ctrl-m,” which is the hot key. You can 
now enter new information for that field. After entering the information, 
press “Enter.” The Voice Sense QWERTY will save the changes that 
have been made, and you will be returned to the first field of the record. 
 
To save the changes that have been made, and exit from modify mode, 
move to “Confirm” by pressing “tab”or “shift-tab”, and then press “Enter.” 
In order to exit from modify mode without saving the changes that have 
been made, move to “Cancel” by pressing “tab”or “shift-tab”and press 
“Enter.” You can also exit from the “Modify Address” by pressing “ESC” 
or “Alt-F4,” which are the hot keys. 
 
6.6.4 Deleting Addresses 
 
To delete the record you are currently reading, call up the “menu” by 
pressing “Alt” and select “Delete Address.” Then, press “Enter” or press 
“d” (which is the short cut) in the “menu.” Or, you can press “Del” (which 
is the hot key) while the record is displayed. You can also delete more 
than one record at a time as follows: 
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1. Select the records to be deleted and use the “Delete” command. 
To select the record that you want to delete, press “Space” when the 
record is displayed. Selected records can be deleted by pressing the 
“delete”. If you press “Space” again on a selected record before you 
delete it, the selection will be canceled. The records you have 
selected will say “selected.” Yu cancel a selection by pressing 
“Space” on a selected record. Voice Sense QWERTY will say 
“Canceled selection.” 

2. Select all and delete 
If you want to delete all the records in “Address manager,” press “Alt” 
to call up the “menu” and select “Select All.” Then, press “Enter.”  
Next, press “Alt” to call up the “menu” again, and then select “Delete 
Address.” Then, press “Enter.” Or, you can press “Ctrl-a” (which is the 
hot key) and press “Del” while you are using the “Search Address” 
function.  

 
6.6.5 Printing addresses 
 
This option allows you to print the selected records to a Braille printer or 
an ink printer. First, search the records to be printed with the “Search 
Address” command, and then select the records that you want to print.  
To select a record, press “Space” on the record to be printed. If you want 
to select all records in “Address manager,” press “Ctrl-a,” or select 
“Select All” from the “menu,” and press “Enter.”  
 
After selecting the records that you want to print, press “Alt” to bring up 
the “menu,” and then select “Print Address.” Then, press “Enter,” or 
press “Ctrl-p,” which is the hot key. The Voice Sense QWERTY will now 
prompt you to select a printer. The default selection is “Printer.” If you 
press “Space” once, the selection will be changed to “Embosser.”  And, 
if you press “Space” again, “Cancel” will be selected. Each time when 
you press “Space,” the Voice Sense QWERTY will cycle through 
“Printer,” “Embosser,” and “Cancel.” You can select one of them by 
pressing “Enter” when the option you want to choose is displayed. 
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6.6.6 Saving Addresses to a File 
 
You can save selected records to a file. Regarding how to select records, 
you can find a detailed explanation in section 6.6.4 and 6.6.5. 
 
To save selected records in a document file format, press “Alt” to call up 
the “menu,” select “Save addresses As File,” and then press “Enter.” Or, 
you can press “Alt-s” (which is the hot key) after selecting the desired 
records. If you execute the “Save addresses As File” command, the “file 
save” dialog box will be displayed and you will be asked to enter the file 
name and select a file format. After you type in the file name, and select 
one of the available file formats, you should press “Enter” on “Confirm,” 
which will save the selected record(s) to a file. This dialog box is the 
same as the “Save As” dialog box in the Word processor, except that, 
here, when you are saving addresses to a file, the default file name is 
not displayed unlike the dialog box in the Word processor. You should 
refer to section 5.1.4 to learn about the dialog box “Save As” in the Word 
processor. 
 
6.7 Importing and Exporting CSV 
 
“CSV” is the acronym for Comma Separated Value. The CSV file is used 
for the digital storage of data structured in a table of lists form, where 
each associated item (member) in a group is in association with others 
also separated by the commas of its set. It will import CSV file from 
contacts of MS outlook or contacts of some cell phones. 
 
In “Address Manager” of Voice Sense QWERTY, 
1. “Import from CSV” allows you to import the data of CSV file in 
“Address Manager”. 
2. “Export to CSV” allows you to export the data of "address manager" 
as CSV file. 
 
6.7.1 Import from CSV 
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You can import the data of CSV file in “Address Manger”, using this 
function. You can execute this function, regardless of “Add address” or 
“Search address”. 
 
6.7.1.1 Executing the menu of the “Import from CSV” 

 
In order to execute “Import from CSV”, follow these steps: 

1) Press “Enter” on the “Address Manager”. Or Press “a” in program 
list. 

2) Press “Alt” to call up the menu. 
3) Press “Down arrow key” move to “Import from CSV” and press 

“Enter”. Or press “r. 
 
Without calling up menu, you can move to this menu by pressing “Alt-i.” 
 
6.7.1.2 The Structures of the “Import from CSV” menu 

 
1. “File name” ECB 
2. “Confirm” Button 
3. “Cancel” Button 
4. “File search” list 
 
You can move between the controls by pressing “Tab” or “Shift-Tab”. 
 
6.7.1.3 Importing the CSV file 
 
In order to import the CSV file, follow these steps: 
 

1) Press “Enter” on “Address Manager”. Or press “a” in program list. 
2) Press “Alt” to call up the menu. 
3) Press “Up arrow key” or “Down arrow key” to move to “Import from 

CSV” and press “Enter”. Or press “R. Without calling the menu, 
you can move to it by pressing “Alt-i”. 

4) It shows “File name”. 
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5) Typing file name that you want to import. For example, if you want 
to search the “address.CSV”, type “address” or “address.CSV” in 
the “File name”. 

6) After file name is typed, press “Enter”. Or press “Tab”, move to 
“Confirm” and press “Enter”. 

7) Importing the CSV file is complete. 
8) Press “Enter” on the CSV file that you import. 
9) Importing CSV file is completed. 

 
If you don’t know file name of CSV file,  

1) Press “Tab” on the “File name”. 
2) Move to “File search” list. 
3) It shows lists of “Flashdisk”. 

· If CSV file is inside of a Flashdisk: Press “Up arrow key” or 
“Down arrow key”, move to CSV file and press “Enter” on the CSV 
file. 
· If CSV file is inside of an external memory: Press “Backspace”, 
move to disk list. Press “Up arrow key” or “Down arrow key”, move 
to CSV file and press “Enter on the CSV file. 

 
If you want to cancel this function, press “Tab” on “Confirm”. Move to 
“Cancel” and press “Enter”. Or press “Alt-F4”. 
 
6.7.1.4 Adding the CSV file in data of “Address Manager” 
 
Once you import the CSV file, “Last name: unused 1/xx” will be 
displayed.  
Structure is like below. 
 
1. 23 filed list of Search address/ Add address 

1) unused 
2) Field name list of CSV file 

2. “Allow fields in first record” 
3. “Confirm” 
4. “Cancel” 
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By pressing “Tab” or “Shift-Tab”, you can move to “23 list of Search 
address/Add address”, “Allow fields in first record” SCHB, “Confirm” 
button, “Cancel” Button. 
 
By pressing “Up arrow key” or “Down arrow key”, you can move to 
“Unused” and “Field name list of CSV file”. 
 
In order to add the CSV file in data of “Address Manager”, follow these 
steps: 

1) In list of “Last name: unused 1/xx”, press “Up arrow key” or “Down 
arrow key”. Move to field of CSV file that you want to import in the 
“Last name” field.  
For example, there are 5 fields like “Name”, “Company name”, 
“title”, “Company address” and “Company zip code” in CSV file. It 
shows “Last name: unused 1/6”. If you want to import the value of 
“Name” field in CSV file, press “Down arrow key” and move to 
“Name”. Then it shows “Last name: Name 2/6” on the LCD and 
Braille display. If there is no field value from the CSV file that you 
need to import, you just leave “unused”. 
If you set “unused” in “First name” and “Company name”, you will 
hear “Must select one or more of first name and company name”. 
You will select value from the CSV file of “First name” or 
“Company name”. 

2) Follow steps the above by pressing “Tab” to move to different field 
such as “Group”, “Company”, and “Title” etc. 

3) Press “Tab”, move to “Allow fields in first record”. You can change 
setting, by pressing “Space”. When you import the fields of first 
record in CSV file, you select it. 
· When you select in “Allow fields in first record”: If there is field 
value of the first record in CSV file, select it. 
· When you unselect in “Allow fields in first record”: If the field 
value of the first record is unnecessary, such as field name, 
unselect it. 

4) Press “Tab”, move to “Confirm”.  
5) Press “Enter” on the “Confirm”. 
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6) It shows “Address file already exists. Which do you prefer?” The 
default value is “Overwrite”. The setting values are “Overwrite” and 
“Add”. To change the setting value, press “Space. 
· Overwrite: If you want to overwrite when exist record has same 
data, select it. 
· Add: If you want to add the data, select it. 

7) It will return “Search Address”. 
8) Press “Enter”. It shows data imported of CSV file with existing data 

of “Address manager”. 
 

If you want to cancel this function, press “Tab” on “Confirm”. Move to 
“Confirm” and press “Enter”. Or press “Alt-F4”. 
 
6.7.2 Export to CSV 
 
You can export data of “Address Manger” as CSV file, using this function. 
You can execute this function, regardless of “Add address” or “Search 
address”. 
 
6.7.2.1 Executing the menu of the “Export to CSV” 

 
In order to execute the menu of the “Export to CSV”, follow these steps: 

1) Press “Enter” on the “Address manager”. Or press “a”. 
2) Press “Alt” to call up the menu. 
3) Press “Up arrow key” or “Down arrow key” and move to “Export to 

CSV”. 
4) Press “Enter”. Or press “x”. 

 
Without calling menu, you can directly execute this function by pressing 
“Alt-x”. 
 
6.7.2.2 Structure and Move of “Export to CSV” menu 

 
1. “File name” ECB 
2. “Confirm” Button 
3. “Cancel” Button 
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4. “File storage” list 
 
You can move between the controls by pressing “Tab” or “Shift-Tab”. 
 
6.7.2.3 How to save as CSV file 
 
In order to save as CSV file, follow these steps: 
 

1) Execute “Address manager”. 
2) Press “Alt” to call up the menu. 
3) Press “Up arrow key” or “Down arrow key”, move to “Export to 

CSV”. 
4) Press “Enter”. Or press “x”. 
5) It shows “File name”.  
6) Type the file name. 
7) Press “Tab”, move to “Confirm”.  
8) Press “Enter”. 

 
It will save in the “Flashdisk”.  
If you want to cancel this function, press “Tab” on “Confirm”. 
Move to “Cancel” and press “Enter”. Or press “Alt-F4”. 
 
6.7.2.4 How to change storage path 

 
In order to change storage path, follow these steps: 

1) Execute “Address manager”. 
2) Press “Alt” to call up the menu. 
3) Press “Up arrow key” or “Down arrow key”, move to “Export to 

CSV”. 
4) Press “Enter”. Or press “x”. 
5) It shows “File name”. 
6) Press “Tab”, move to “File storage” list. It shows “Flashdisk” list. 

· When you want to save folder in “Flashdisk”: Press “Enter” on 
folder that you want to save in “Flashdisk”. 
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· When you want to save folder in external memory: Press 
“Backspace”, move to disk list. Press “Enter” on the folder that you 
want to save in external memory. 

7) Press “Tab”, move to “Confirm”. 
8) Press “Enter” on the “Confirm”. It will be saved in the changed 

path. 
 
If you want to cancel this function, press “Tab” on “Confirm”. 
Move to “Cancel” and press “Enter”. Or press “Alt-F4”. 
 
6.8 Synchronizing With Microsoft Outlook 
 
In XP and earlier version, the “Address manager” can be synchronized 
with Microsoft Outlook on your personal computer to help you keep track 
of your information. For a more detailed explanation of how to connect 
the Voice Sense QWERTY to your computer, and for more information 
on how to use ActiveSync, please refer to chapter 18. Please take the 
following steps in order to synchronize the Voice Sense QWERTY with 
Microsoft Outlook: 
 

1) Download and install “ActiveSync” on to your personal computer. 
2) Connect the Voice Sense QWERTY to your personal computer, 

using a USB cable. 
3) If the “Partnership” dialog box opens on your PC after you connect 

the Voice Sense QWERTY to your PC, select “Yes,” and press the 
“Next” button on your PC. 

4) Then, you will be asked for a device name. Type in 
“VoiceSenseQWERTY” (or whatever you would like to call the 
Voice Sense QWERTY) 

5) Press the “Next” button. Then, the program list dialog box will be 
displayed on your PC. Click on the “check box” that is located next 
to “Contacts.” Note that the other check boxes should not be 
checked.  Press the “Next” button. 

6) Then, the synchronization between Microsoft Outlook and the 
Voice Sense QWERTY are complete. You can then check the 
contacts in Microsoft Outlook and the Voice Sense QWERTY. 
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In Vista, the “Address manager” can be synchronized with Microsoft 
Outlook on your personal computer to help you keep track of your 
information. For a more detailed explanation of how to connect the Voice 
Sense QWERTY to your computer, and for more information on how to 
use Windows Mobile Device Center, please refer to chapter 18. Please 
take the following steps in order to synchronize Voice Sense QWERTY 
with Microsoft Outlook: 
 

1) Get the latest version of “Windows Mobile Device Center” 
downloaded and install it on to your personal computer. 

2) Connect the Voice Sense QWERTY to your personal computer, 
using a USB cable. 

3) If the “Windows Mobile Device Center” dialog box opens on your 
PC after you connect the Voice Sense QWERTY to your PC, 
select “Set up your device,” and press the “Enter” on your PC. 

4) Then, the “Set Up Windows Mobile Partnership” dialog box will be 
displayed on your PC. Click on the “check box” that is located next 
to “Contacts.” Note that the other check boxes should not be 
checked.  Press the “Next” button. 

5) Then, you will be asked for a device name. Type in “VoiceSense 
QWERTY” (or whatever you would like to call the Voice Sense 
QWERTY). Press “OK” button. 

6) Then, the synchronization between Microsoft Outlook and the 
Voice Sense QWERTY are complete. You can then check the 
contacts in Microsoft Outlook and the Voice Sense QWERTY. 

 
6.9 Hot Keys in the Address Manager 
 
1. Move keys for moving from field to field in add address or in the 

“menu” 
Move to the previous field or menu item: Up arrow key  
Move to the next field or menu item: Down arrow key  
Move to the first field or menu item: Fn-Left arrow key 
Move to the last field or menu item: Fn-Right arrow key 

2. Move Keys For Moving From Record To Record in the search result 
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list 
Move to a previous field in a record: Ctrl-Left arrow key 
Move to the next field in a record: Ctrl-Right arrow key 
Move to the first field in a record: Ctrl-Fn-Left arrow key 
Move to the last field in a record: Ctrl-Fn-Right arrow key 
Move to the previous record: Up arrow key 
Move to the next record: Down arrow key 
Move to the first record: Ctrl-fn-Left arrow key 
Move to the last record: Ctrl-fn-Right arrow key 
Move to previous same field different record: Left arrow key 
Move to next same field different record: Right arrow key 

3. Shortcut keys in the “menu” 
Add address: i 
Find address: s  
Modify address: m 
Delete address: d 
Select all: a  
Save as a file: t 
Print address: p 
Backup address list: u 
Restore address list: r  
Setting backup option: e 

4. Hot Keys For The Commands 
Add address: Ctrl-n 
Find address: Ctrl-f 
Modify address: Ctrl-m 
Delete address: Del 
Select all: Ctrl-a 
Save as a file: Alt-s  
Print address: Ctrl-p 
Backup address list: Ctrl-u 
Restore address list: Ctrl-r 
Setting backup option: Ctrl-e 
Setting add/searching address fields: Ctrl-o 
Import from CSV: Alt-i 
Export to CSV: Alt-x 
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5. Miscellaneous hot keys 
Cancel: ESC  
Exit: Alt-F4 
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7. Schedule Manager 
 
7.1 Overview 
 
The “Schedule manager” is a program that is used to manage important 
information about appointments, anniversaries, and events. The 
Schedule manager can also inform you of appointments at a specified 
time. You can start the “Schedule manager” from the “program” menu, 
by pressing the up or down arrows to move to “Schedule manager.”  
Then, press “Enter.” Or, you can press “s” in the “program” menu, which 
is the short cut. The “Schedule manager” has two main dialog boxes:  
“Add Schedule” and “Search Schedule.” In “Add Schedule,” you can 
enter information about a new appointment. Using “Search Schedule,” 
you can look for information about a specific appointment stored in the 
“Schedule manager,” and you can edit or delete the schedule 
information that is stored. 
 
7.2 Starting “Schedule Manager” 
 
If you press “Enter” on “Schedule manager,” or press “s” (which is the 
short cut) in the “program” menu, the “Search Schedule”  dialog box will 
appear, so that you can search stored information. The first thing you will 
hear is “Find date:” followed by the current date. If you want to add new 
schedule information, press “Alt” to bring up the menu. Then, select “Add 
Schedule,” and then press “Enter.” Or, you can quickly open it by 
pressing “Ctrl-n” in the “Search Schedule” dialog box. As in other 
programs on the Voice Sense QWERTY, you can use menus and 
shortcut keys in the “Schedule manager.” Section 7.13 lists all the hot 
keys and shortcut keys available in the “Schedule manager.” 
 
7.3 Setting Date and Time 
 
When you use “Add Schedule,” “Search Schedule,” or “Wake up alarm” 
(which are located in the “Utilities” menu), you are asked to set the date 
and time. The Voice Sense QWERTY provides you with a consistent 
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interface to enter time and date information in these dialog boxes. So 
before we start talking about using the “Schedule manager” in this 
section, we should explain how to enter the date and time. When you 
are asked to enter a date and time, you can either type in the date and 
time, or select it using shortcut keys, which are outlined at the end of this 
section. When entering time, use “hh mm” format, two digits for the hour, 
and two digits for the minute. For example, use “10 05” to enter 5 
minutes past 10. You can use a colon (:) to separate the hour field and 
minute field, but not a dash(-) and slash(/). You can enter a date in “mm 
dd yyyy” format, which uses two digits for the month, two digits for the 
day, and four digits for the year, as in “09 01 2004” to enter September 
01, 2004. Again, you can use a space, slash (/) to separate the month, 
day, and year. To set the date and time with shortcut keys, you can use 
the following commands. 
 
1. Date setting keys 

Move to the next day: Right arrow key 
Move to the previous day: Left arrow key 
Move to the next week: Ctrl-Right arrow key 
Move to the previous week: Ctrl-Left arrow key 
Move to the next month: Down arrow key 
Move to the previous month: Up arrow key 
Move to the next year: Ctrl-Down arrow key 
Move to the previous year: Ctrl-Up arrow key 

2. Time setting keys 
Move to 1 hour after: Down arrow key 
Move to 1 hour before: Up arrow key 
Move to 10 minutes after: Ctrl-Right arrow key 
Move to 10 minutes before: Ctrl-Left arrow key 
Move to 1 minute after: Right arrow key 
Move to 1 minute before: Left arrow key 

 
7.4 Adding a Schedule 
 
To add a new appointment, press “Alt” to bring up the menu.  Select 
“Add Schedule,” and press “Enter,” or press “Ctrl-n” in the “Search 
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Schedule” dialog box. The “Add Schedule” dialog box has a set of input 
fields, a “Confirm” button, and a “Cancel” button. The input fields are 
“Start date,” “Start time,” “End date,” “End time,” “Subject,” “Location,” 
“Memo,” “Alarm time,” and “Set recurrence schedule.” Among the input 
fields, you can move from one field to the next by pressing “tab”or “shift-
tab.” For the “Subject” and “Memo” fields, you can type in text, and for 
the “Start date”, “End date”, “Start time”, “End time” fields, you can either 
type in a date/time, or select it using shortcut keys, as explained in 
section 7.3.  If you press “Enter” on the “Confirm” button, the schedule 
information will be saved. If you press “Enter” on “Cancel” button, the 
entry will not be saved. 
 
7.4.1 Start date 
 
When you start “Add Schedule”, the “Start date” edit box is displayed 
first. If you want to use this date, just press “tab” to move to the next field. 
If you want to enter a new date, you want to type month/day/year in this 
order. You can see “7.3 Setting Date and Time” for more details about 
how to enter a date. After you have entered the date, you should then 
press “tab” to move to the next field. If you press “Enter” by accident 
right after filling in this field, you will get the message, “no subject,” and 
then the focus moves to the “Subject” field. 
 
Note: “Start date” varies following 2 cases.  

1. If you try to add schedule that has not been performed the search 
mode in schedule manager, “Start date” is set to the date based 
on current system. 

2. If you try to add schedule that has been performed the search 
mode in schedule manager, “Start date” is set to the date which 
has been searched by specific date. 

 
Note: Above 2 cases only apply if you search by “date” in schedule 
manager. If you search by “subject”, “Start date” is set to the date based 
on current system. 
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7.4.2 Start time 
 
“Start time” is the second field in the “Add Schedule” dialog box. Here 
you can set the time when your appointment starts.  By default, this 
field shows the current time, which can be changed in the “Set time and 
date” in the “Utilities” program. If you set the time format as “12 hour” in 
this option, the time will be displayed in “am/pm” format.  Otherwise, the 
time will be displayed in 24 hour format. If you want to change the time, 
you should enter the time as explained in “7.3 Setting Time and Date.” If 
you have set the time format to “12 hour,” you will want to press “Fn-x” to 
change between am and pm. After you have entered the time, press the 
“tab” to move to the next field. If you press “Enter” by accident right after 
entering this field, you will get the message, “no subject,” and then the 
focus will move to the “Subject” field. 
 
7.4.3 End date 
 
The “End date” is the third field in the “Add Schedule” dialog box, and 
here you can set the date when the appointment ends.  By default, the 
same date as the date you set in the “Start date” field is displayed. If you 
want to use this date, you can press “tab” to move to the next field. If you 
want to enter a new date, you should type month/day/year in this order. 
You can refer to “7.3 Setting Time and Date” for more details about how 
to enter a date. After you have changed the date, you can press “tab” to 
move to the next field. If you press “Enter” by accident right after 
entering the date, you will get the message, “no subject,” and the focus 
will move to the “Subject” field. 
 
7.4.4 End time 
 
“End time” is the fourth field in the “Add Schedule” dialog box. Here you 
can set the time when the appointment ends. By default, the same time 
as the time you set in the “Start time” field is displayed. If you want to 
change the time, type the time as you would in the “Start time.” You 
should refer to “7.3 Setting Date and Time” for more details about how to 
enter the time. After setting the time, press “tab” to move to the next field. 
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If you press “Enter” by accident right after entering the time, you will get 
the message, “no subject,” and then the focus moves to the “Subject” 
field. 
 
7.4.5 Subject 
 
“Subject” is the fifth field where you can type in the subject of an 
appointment. If you do not enter anything in this field, you will not be 
able to save the record. If you press “Enter” after typing in the subject, 
the record will be saved, leaving the “Location” and “Memo” field empty, 
and the “Alarm time” field set to its default value (“Time of appointment”).  
If you want to move to the next field, press “tab,” instead of “Enter.” 
 
7.4.6 Location 
 
In the “Location” field, you can type appointed location. If you press 
“Enter” after typing in the location, the record will be saved, leaving the 
“Memo” field empty, and the “Alarm time” field set to its default value 
(“Time of appointment”). If you want to move to the next field, press “tab”, 
instead of “Enter.” 
 
7.4.7 Memo 
 
In the “Memo” field, you can enter detailed information about an 
appointment. Here, you can type in more than one line. You can use 
most of the editing commands that are used in the “Word processor.”  
Press “Enter” to enter information on a new line. You can leave this field 
blank if you want to. After you finish writing the information, you can 
press “tab”to move to the next field. 
 
7.4.8 Alarm Time 
 
The “Alarm time” function allows you to set the time when you will be 
notified about an appointment. The alarm is set relative to the 
appointment time. For example, you may want the alarm to sound 30 
minutes before your appointment, so that you are not late. The default 
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value for this field is set to “Time of appointment.” This means that the 
alarm will sound at the same time as you have set for your appointment.  
You can set the time in the same way as when you set the appointment 
time. The time can be set anywhere from one minute to forty-seven hour. 
To set the time with shortcut keys, you can use the following commands. 
1. Time setting keys 

Move to 1 hour after: Down arrow key 
Move to 1 hour before: Up arrow key 
Move to 10 minutes after: Ctrl-Right arrow key 
Move to 10 minutes before: Ctrl-Left arrow key 
Move to 1 minute after: Right arrow key 
Move to 1 minute before: Left arrow key 

  
If you attempt to set the time to 0, the Voice Sense QWERTY will display 
the message, “Time of appointment.” If you do not want to set an alarm, 
press “Up arrow key” while “Alarm time” is set to “Time of 
appointment.”Then, “Alarm off” will be displayed, and the alarm for this 
appointment will be turned off. After setting the “Alarm time,” save this 
appointment by pressing “Enter,” or by pressing “tab”to move to the 
“Confirm” button, and press “Enter.” If you have set the “Alarm time,” it 
will go off at the specified time even if the Voice Sense QWERTY is 
turned off. If you want to stop the alarm, press “Ctrl.” 
 
7.4.9 Setting a recurring Schedule 
 
You can set this option when the schedule you are creating currently 
recurs periodically. If you clear this check box, the schedule will be set to 
occurring once. You can check or uncheck this option by pressing 
“Space.” That is, if you press “Space” when this box is checked, it will be 
unchecked, and if you press “Space” when this box is unchecked, it will 
be checked. If you have unchecked this, just press “Enter”, or press “tab” 
repeatedly to move to the “Confirm” button and press “Enter”, to save 
the schedule. If you want to set recurrence schedule, you should press 
“Space” and then press “tab” or “Enter” to move to the combo box where 
you can set the recurrence pattern. In this combo box, you can select 
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one of “Daily”, “Weekly”, “Monthly” and “Yearly.” We will discuss these 
options in more detail in the next section. 
 
7.4.9.1 Daily 

 
If you select “Daily,” and press “tab,” the focus will move to “Recurring 
interval of day” edit box. Here, you can enter the number of days after 
which the appointment recurs. You can type a number between 1 and 
999. If you enter 1, the appointment recurs every day, and if you enter 2, 
it recurs every other day. One thing you have to be careful when you use 
this is that the difference between the starting and end date should be 
shorter than the recurring interval value. For example, suppose that the 
appointment starts at 09:00, Feb. 1, 2006, and ends at 12:00, Feb. 2, 
2006. If you set the recurring interval to 1, you will get an error message 
“The appointment duration should be shorter than the recurring interval.”  
This is because it is logically impossible that the appointment duration is 
27 hours, and the appointment recurs 24 hours. This rule is applied in 
the same way when you set weekly, monthly, or yearly recurring 
appoints. If you press “tab” after setting the recurring interval, the “Set 
recurrence end date” check box appears. By default, it’s unchecked, 
which indicates that there is no apparent end date when the recurrence 
will stop. If you check this box by pressing “Space,” and press “tab,” the 
focus will move to the edit combo box that asks for the end date. Enter 
the date when the recurrence will stop. You can directly type the date, or 
you can set the date as described in “7.3 Setting date/time”. Once you 
set the date, press “tab” to move to the “Confirm” button. 
 
7.4.9.2 Weekly 

 
If you set the “Recurrence” to “weekly”, press “tab” to move to the 
“Recurring interval” edit box. Here you can set after how many weeks 
the appointment will recur. You can type a number between 1 and 999. If 
you set it to 1, the appointment will recur every week, and if you set it to 
2, it will recur every other week. The restriction on the recurring interval 
as in “Daily” is applied to “Weekly.” If the recurring interval is one week, 
the appointment duration should be shorter than one week. Otherwise, 
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you will get an error message, “The appointment duration should be 
shorter than the recurring interval.” If you press “tab” after entering the 
recurring interval, the focus will move to a list box where you can select 
the day of the week on which the appointment recurs. You can move 
between the items in the list box, by pressing “Up arrow key”or “Down 
arrow key.”To select or unselect the current item, press “Space”. You 
can make more than one selection. If you don’t select any day, it will be 
set to the today’s day of the week. Press “tab” after selecting the days of 
the week when the appointments recurs. Then the focus will move to 
“Set recurrence end date” check box. You can set the recurrence end 
date as described in 7.4.9.1. 
 
7.4.9.3 Monthly 

 
If you press “tab” after setting the “Recurrence to monthly,” the focus will 
move to the “Recurring type” combo box. Here, you can set the recurring 
type as “Date” or “Day of the week.”To move between the two options, 
you can use “Up arrow key”or “Down arrow key.”“Date” is used when 
you want to set an appointment recurring on the same day of a month, 
for example, on the 17th of every month, or every other month. On the 
other hand, “Day of the week” is used when you want to set an 
appointment recurring on the same week and the day of the week of a 
month, for example, on Wednesday of the second week of every month. 
After selecting the “Recurring type,” press “tab” to move to the 
“Recurring interval.” In this field, you set after how many months the 
appointment will recur. You can type a number between 1 and 999. If 
you press “tab” after setting “Recurring interval,” different fields will be 
shown depending on what you have selected in “Recurring type.” If you 
set the “Recurring type” to “Date,” an edit box will be shown, where you 
can type the day of the month when the appointment recurs. By default 
the date set in the “Start date” is shown. You can type a number 
between 1 and 31. If you press “tab” after setting this, the focus will 
move to “Set recurrence end date” and you can set the date in the same 
way as described in 7.4.9.1. If you have set the “Recurring type” to “Day 
of the week,” you will be asked the “Recurring week” first. You can set 
this to “First week,” “Second week,” “Third week,” “Fourth week” or “Last 
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week.” This is for setting the week of a month when the appointment 
recurs. Here if you press “tab,” the focus will move to a combo box 
where you can select the day of the week when the appointment recurs. 
Since you can select only one of the 7 days, the one shown currently is 
the selected day. If you press “tab” here, the focus will move to the “Set 
recurrence end date” check box, and you can set it in the same way as 
described in 7.4.9.1. 
 
7.4.9.4 Yearly 
 
If you set the “Recurrence” to “Yearly,” press “tab” to move to the 
“Recurring type” combo box. You can select either “date” or “day of the 
week,” and you can move between them by pressing “Up arrow key”or 
“Down arrow key.” If you set the “Recurring type” to “Date,” you can set 
the month and the day of the month when the appointment recurs. If you 
set it to “Day of the week,” you can set the month, the week, and the day 
of the week when the appointment recurs every year. If you press “tab” 
after setting “Recurring type,” the focus will move to the “Month for 
recurrence” combo box. You can select one of the 12 months by 
pressing “Up arrow key”or “Up arrow key.” If you press “tab” here, the 
focus will move to different fields, depending on what you have set the 
“Recurring type” to. If you have set the “Recurring type” to “Date,” the 
focus moves to “Day for recurrence” edit box. You can type a number 
between 1 and 31 here. If you press “tab” here, the focus will move to 
“Set recurrence end date” check box, using the same way as described 
in 7.4.9.1. If you have set the “Recurring type” to “Day of the week,” you 
have to set “recurring week” and “Day of week for recurrence.” You can 
set the values of these combo boxes in the same way as described in 
7.4.9.3. 
 
7.4.10 Confirm 
 
If you press “Enter” on the “Confirm” button, the appointment will be 
saved, and the “Add Schedule” dialog box will be closed. 
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7.4.11 Cancel 
 
If you press “Enter” on the “Cancel” button, the appointment information 
you entered will be discarded, and you will be asked to enter information 
about another appointment. You can also cancel the entry by pressing 
“ESC.” 
 
 
7.5 Search Schedule 
 
“Search schedule” is used for searching Appointments that you have 
entered before. When you start “Schedule manager,” the “Search 
Schedule” dialog box will be opened. You can also open this dialog box 
when you are in the “Add Schedule” dialog box, by pressing “Ctrl-s.”Or 
you can open the menu by pressing “Alt”, and press “Enter” on “Search 
Schedule.” 
 
There are two methods to search for the schedule; “searching with 
subject” and “searching with date.” With the “searching with subject,” you 
can find schedule with the keywords in the subject field. With the 
“searching with date,” you can find schedules with the specified date. In 
order to toggle the searching mode, press Alt” to call up the menu and 
move to “Toggle Search Mode” and press “Enter.”Or you can execute it 
by pressing “Ctrl-f2” without calling up the menu. Every time you press 
“Ctrl-f2”, the Voice Sense QWERTY will say “Search mode: Date” or 
“Search mode: Subject,” and the searching mode will be toggled. 
The latest searching mode will be saved when you will exit the Schedule 
manager. So if you execute the Schedule manager and search any 
schedule, the latest searching mode will be displayed. 
 
7.5.1 Searching with date 
 
It searches the schedule with the date. If it is executed, Voice Sense 
QWERTY will say “Find date: (current date).” 
If you just press “Enter” here, the appointments occurring today will be 
searched for. If you want to search for another date, you can type the 
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date in the format “mm/dd/yyyy,” or use the “move by date” hotkeys as 
described in “7.3 Setting date and time.”If you press “Enter” after 
entering the date, the appointments occurring on the day will be shown. 
If there is no appointment on that day, “There is no schedule registered.” 
will be announced. Otherwise, the first appointment on that day will be 
announced in the form of “date, time, and subject.” If the appointment 
lasts for more than one day, “continuous schedule” will be announced. If 
the appointment recurs, “recurring schedule” will be announced. If you 
registered more than one appointment for that day, you can move 
between the appointments on that day by pressing “Up arrow key”or 
“Down arrow key.” If you want to move to the first appointment on a day, 
you can press “Fn-Left arrow key,” and if you want to move to the last 
appointment on the day, press “Fn-Right arrow key.” To move to the 
appointments on another day, press “Ctrl-Left arrow key” or “Ctrl-Right 
arrow key.” Then, the previous/next appointment occurring within four 
months will be displayed. If you want to move to the first appointment 
registered in the schedule manager, press “Ctrl-Fn-Left arrow key,” and 
if you want to move to the last appointment registered in the schedule 
manager, press “Ctrl-Fn-Right arrow key.” If you want to know more 
about a registered appointment, press “Enter” on the desired 
appointment item. Then, if you press “Up arrow key”or “Down arrow 
key,” you can hear the Start date, start time, end date, end time, subject, 
and memo. 
 
7.5.2 Searching with subject 
 
If it is executed, the Voice Sense QWERTY will say “Search subject:” 
Type in the keywords which you are searching. After you type in the 
keywords and press “Enter,” then all schedules with the keywords will be 
displayed. If you press “Enter” without typing in any word in “Search 
subject:” edit box, the Voice Sense QWERTY will display all schedules 
in your Voice Sense QWERTY. 
 
In order to move to the next or previous schedule, press “Down arrow 
key” or “Up arrow key”, respectively. Pressing “Fn-Left arrow key” will 
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move to the first item of the schedule list, and pressing “Fn-Right arrow 
key” will move to the last item of the schedule list. 
 
For the recurring appointment and multi Voice Sense QWERTY will 
show the schedules of the first day only, if you search the schedule with 
subject. For example, if you registered any appointment on January 1, 
2007 and made it recur the first day of every month, the Voice Sense 
QWERTY will show this schedule on January 1, 2007 only when you 
search it with “searching with subject.” 
 
If you want to read the schedule in detail, you can press “Enter” at the 
schedule that you want to read in detail. After you read the schedule in 
detail and return to the schedule list, press “ESC.” And if you want to 
search with the other keywords, press “tab” to move to “Search subject” 
edit box. 
 
7.6 Modify Schedule 
 
You can modify an appointment that you have scheduled. First, move to 
the appointment you want to modify in the find result list. Press “Alt.”Or 
open the menu by pressing “Alt” and press “Enter” on “Modify Schedule,” 
or press the shortcut key “m” in the menu. Or you can press its hot key, 
“Ctrl-m” in the find result list. If the appointment is a recurring schedule, 
a prompt is displayed “Recurrence appointment. Open type?” will appear. 
This is asking whether you want to modify the recurring schedule or the 
schedule for a specific day. If you select “This occurrence,” you will 
make changes for the appointment of the day, but the recurring 
appointments on other days will not be changed. If you select “The 
series,” you will make changes for all the recurring appointments of the 
schedule. If you select “Cancel,” “Modify Schedule” dialog box will not be 
opened and go back to the previous status. You can select these values 
by pressing “Space” or “Backspace.” Press “Enter” to open the “Modify 
Schedule” dialog box. This dialog box contains the same controls as in 
the “Add Schedule” dialog box. The only difference is that each field has 
the value entered previously. You can make changes in these fields in 
the same way as described in 7.4. If you change a recurring schedule, 
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all the instances of the schedule will be changed according to the new 
values. Once you finish modifying the schedule, the information shown 
in the find result list will be updated accordingly. 
 
7.7 Deleting a Schedule 
 
If you want to delete a schedule, move to the schedule in the find result 
list. Then, press “Alt” to open the menu, and press “Enter” on “Delete 
Schedule.” Or you can press its hot key, “Del” in the find result list. If the 
selected schedule is a recurring schedule, “Recurring appointment. 
Delete type?” will be displayed. This is asking whether you want to 
delete the recurring schedule, or just the appointment for that day. If you 
select “This occurrence,” only the appointment on that day will be 
deleted. If you select “The series,” the recurring schedule itself will be 
deleted. You cannot select and delete multiple schedules at once. You 
can delete only the appointment currently focused.  
 
7.8 Printing a Schedule 
 
After finding an appointment using the “Search Schedule” command (as 
explained in section 7.5), you can print an appointment that you have 
found using the “Print Schedule” command. In the search results list, 
press “Ctrl-p,” or call up the menu by pressing “Alt,” and press “p,” or 
select “Print Schedule.” Then, press “Enter.” The Voice Sense QWERTY 
will ask you to specify the beginning date of the appointments to be 
printed. By default, the current date is displayed. You can specify a date 
that you want to search for. Refer to section 7.3 for information on how 
to enter dates. Now, press “tab”to set the end date of the appointments 
that you want to be printed. Again, you can enter the dates, as explained 
in section 7.3. If you press “Enter” or “tab” you will be asked to select the 
type of printer you will use. “Printer” is the default setting. Press “Up 
arrow key”or “Down arrow key” to move between “Embosser” and 
“Printer.” If you have selected the appropriate printer type, you can press 
“Enter” to start printing. Before you press “Enter” here, please make sure 
the Voice Sense QWERTY is connected to the printer correctly. After the 
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printing is finished, the Voice Sense QWERTY will display the search 
results list. 
 
7.9 Saving Appointments as a File 
 
You can save appointments stored in “Schedule manager” as a 
document file. In the search results list, press “Alt-s,” or call up the menu 
by pressing “Alt,” and then select “Save Schedule As File,” and press 
“Enter,” or press “t” in the menu. Then, the Voice Sense QWERTY will 
ask you to specify the beginning and end date of the appointments to be 
saved just like it did in “Print Schedule.” After setting the beginning and 
end dates, press “Enter” or “tab,” and the “file save” dialog box will be 
displayed to prompt you to enter the name and the format of the file to 
be saved. This dialog box is the same as the “Save As” dialog box in the 
“Word processor.” Please refer to section 5.1.4 for more information 
about the “Save As” dialog box. 
 
7.10 Backing Up and Restoring Your Appointments 
 
7.10.1 Backup Schedule 
 
If a cold reset occurs, or if your battery goes dead, all of the data in the 
schedule manager will be lost. So, it is very important to make a backup 
file every time you change your schedule. To backup your schedule, go 
to “Backup Schedule,” open the menu by pressing “Alt.” Then, use the 
up and down arrows, and find “Backup Schedule.” Then, press “Enter.”  
You can also press “u” while you are in the menu to get to “Backup 
Schedule.” Or, you can press “Ctrl-u” to activate this function without 
calling up the menu. 
 
If you already have a backup file, you will see the message “Backup file 
already exists. Backup anyway? Yes.” If you have made any changes to 
your schedule, press “Enter” here to create a new backup file. If you 
want to keep the previous backup file, press “Down arrow key,” locate 
“No,” and press “Enter” on it. If you make a backup file again in the 
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schedule manager, you will have a new backup file with the extension 
DAT, and you will have another file with the extension BAK (which 
originated from the previous “planner.dat.”) 
 
7.10.2 Restore Schedule 
 
If you want to restore your schedule after a cold reset, press “Alt” to call 
up the menu, and use the up and down arrow keys to find “Restore 
Schedule.” Then, press “Enter” on “Restore Schedule.” Or, you can 
press “r” while you are in the menu to find “Restore Schedule.” You can 
also press “Ctrl-r” to activate this function, without calling up the menu. 
 
If you activate the “Restore Schedule” function, and you already have an 
existing schedule, you will see the message “Schedule file already exists. 
Which do you prefer? Append” If you press “Enter” here, you will have a 
new schedule with the backup file appended. If you press “Down arrow 
key” once and press “Enter” on “Overwrite,” you will have a schedule 
restored from the backup file. For example, let us assume that you have 
a schedule for days 1 - 3 in your schedule and you have a schedule for 
days 1 - 5 in your backup file. If you select “Append,” you will have a 
schedule with 8 days. In this case, three days of the schedule could 
possibly be redundant. If you select “Overwrite,” you will have days 1 – 5 
from your schedule back-up, and days 1 – 3 of the original schedule will 
be deleted. If you don't want to “Append” or “Overwrite,” press “Down 
arrow key” once more, locate “Cancel,” and press “Enter” on it. 
 
7.10.3 Setting Backup Option 
 
To backup your schedule, you can backup your schedule manually by 
activating the “Backup Schedule” function. You can also backup the 
schedule automatically by activating the “Set Backup Options” function.  
To activate the “Set Backup Options” function, press “Alt” to open up the 
menu. Next press “Down arrow key” or “Up arrow key”, repeatedly to 
locate “Set Backup Options.” Then, press “Enter” on “Set Backup 
Options.” Or, while you are in the menu, you can press “e” to jump 
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directly to “Set Backup Options.”You can also activate the “Set Backup 
Options” function without opening up the menu by pressing “Ctrl-e.” 
 
If you activate this function, you will see a dialog box. The dialog box has 
three controls, “Backup mode” radio button, a “Confirm” button, and a 
“Cancel” button. You can switch between controls by pressing “tab” or 
“shift-tab.” To move between the radio buttons, you can press “Up arrow 
key,” “Backspace,” “Down arrow key,” or “Space.” 
 
The “Backup mode” has three radio buttons: “Always backup changes 
when exiting,” “Manual backup”, and “Prompt backup changes when 
exiting.” 
 
1. If you select the “Always backup changes when exiting,” a new 

backup file will be created automatically if you have modified your 
schedule or added other information before exiting the schedule 
manager. 

2. If you select the “Manual backup,” a new backup file will not be 
created, even though there have been changes made to your 
schedule. If you select this option, you can only make a new backup 
file by using the “Backup Schedule” menu. 

3. If you select “Prompt backup changes when exiting,” you will see the 
message “Backup changes? Yes” if you have modified your schedule 
or added other information before exiting the schedule manager. If 
you press “Enter” on “Yes,” a new backup file will be created, and you 
will exit the schedule manager. If you press “Down arrow key” once, 
and press “Enter” on “No,” you will exit the schedule manager, and a 
new backup file will not be created. 

 
You can change the backup mode if you press “Enter” after focusing on 
one of the three radio buttons. Or, press “tab”, and press “Enter” on 
“Confirm.” The default backup mode is set to “Prompt backup changes 
when exiting.” 
 
7.11 Setting Alarm Option 
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You can open the “Set Alarm Options” dialog box by pressing “Ctrl-o,” or 
by pressing “Enter” on “Set Alarm Options” in the menu by pressing “Alt” 
in the “Schedule manager.”This dialog box has a list of alarm option 
fields, a “Confirm” button, and a “Cancel” button. Alarm option fields 
include “Alarm duration,” “Alarm repeat interval” and “Repeat.” You can 
move between these fields by pressing “Up arrow key”or “Down arrow 
key.” You can access the “Confirm” and “Cancel” buttons by pressing 
“tab” or “shift-tab”. 
 
 
 
7.11.1 Alarm Duration 
 
With this option, you can change the duration of the alarm sound. You 
can set this option to a value that is between 5 and 600 seconds.The 
default value is set to 30 seconds. You can enter the number into the 
keyboard. Press “Enter” to save the changes, and exit from the dialog 
box. If you want to set the “Alarm repeat interval” in the next field, you 
should press “Down arrow key” to move to it. 
 
7.11.2 Alarm Repeat Interval Time 
 
When the alarm goes off, if you do not stop it by pressing “Ctrl,” the 
Voice Sense QWERTY will keep giving you a notice about the 
appointment after a specified time interval. The “Alarm repeat interval” 
option allows you to change this interval. You can set the value 
anywhere from 1 to 60 minutes, and the default value is set to 5 minutes.  
You can enter the number into the keyboard. After entering the number, 
press “Enter” to save the changes, and exit from the dialog box.  Or, if 
you press “tab”, the Voice Sense QWERTY will move to the “Repeat” 
edit box. 
 
7.11.3 Repetition Times 
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The alarm will make a sound as the amount of time that you changed 
the alarm duration and it then stops. After a specified time interval, you 
will hear again the alarm sound. 
 
“Repeat” is a field, which allows you to decide how many times the alarm 
will sound. You can set the value from 1 time to 10 times, and the default 
value is set to 3 times. To change the value, you type in a number 
between 1 and 10. After entering the number, you press “tab,” and press 
“Enter” on the “Confirm” button. 
 
Or, if you press “Enter” on the “Repeat” edit box, the changed options 
will be saved, and the dialog box will be closed. 
 
An alarm will repeat according to the number of times that you set for 
this option and will then stop automatically. The LCD on the Voice Sense 
QWERTY will also appear the “date” and “subject” for the alarm. 
 
7.11.4 Confirm 
 
By pressing “Enter” on the “Confirm” button, you will save the changed 
settings, and close the “Set Alarm Options” dialog box. 
 
7.11.5 Cancel 
 
If you press “Enter” on the “Cancel” button, or press “ESC” or “Alt-F4,” 
the previous option settings will be restored and “Set Alarm Options” 
dialog box will be closed. 
 
7.12 Synchronizing With Microsoft Outlook 
 
In XP and earlier version, the “Schedule manager” can be synchronized 
with Microsoft Outlook on your personal computer to help you keep track 
of your appointments. For a more detailed explanation of how to connect 
the Voice Sense QWERTY to your computer, and for more information 
on how to use ActiveSync, refer to chapter 18. You should take the 
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following steps in order to synchronize the Voice Sense QWERTY with 
Microsoft Outlook: 
 

1) Download and install “ActiveSync” on to your personal computer. 
2) Connect the Voice Sense QWERTY to your personal computer, 

using a USB cable. 
3) If the “Partnership” dialog box opens on your PC after you connect 

the Voice Sense QWERTY to your PC, select “Yes,” and press the 
“Next” button on your PC. 

4) Then, you will be asked for a device name. Type in “Voice Sense 
QWERTY” (or whatever you would like to call the Voice Sense 
QWERTY). 

5) Press the “Next” button. Then, the program list dialog box will be 
displayed on your PC. Click on the “check box” that is located next 
to “calendar.” Note that the other check boxes should not be 
checked.  Press the “Next” button. 

6) Then, the synchronization between Microsoft Outlook and the 
Voice Sense QWERTY is complete. Please check the contacts in 
Microsoft Outlook and the Voice Sense QWERTY. 

 
In Vista, the “Schedule manager” can be synchronized with Microsoft 
Outlook on your personal computer to help you keep track of your 
information. For a more detailed explanation of how to connect the Voice 
Sense QWERTY to your computer, and for more information on how to 
use Windows Mobile Device Center, please refer to chapter 18. Please 
take the following steps in order to synchronize the Voice Sense 
QWERTY with Microsoft Outlook: 
 

1) Get the latest version of “Windows Mobile Device Center” 
downloaded and install it on to your personal computer. 

2) Connect the Voice Sense QWERTY to your personal computer, 
using a USB cable. 

3) If the “Windows Mobile Device Center” dialog box opens on your 
PC after you connect the Voice Sense QWERTY to your PC, 
select “Set up your device,” and press the “Enter” on your PC. 
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4) Then, the “Set Up Windows Mobile Partnership” dialog box will be 
displayed on your PC. Click on the “check box” that is located next 
to “Contacts.” Note that the other check boxes should not be 
checked.  Press the “Next” button. 

5) Then, you will be asked for a device name. Type in 
“VoiceSenseQWERTY” (or whatever you would like to call the 
Voice Sense QWERTY). Press “OK” button. 

6) Then, the synchronization between Microsoft Outlook and the 
Voice Sense QWERTY are complete. You can then check the 
contacts in Microsoft Outlook and the Voice Sense QWERTY. 

 
7.13 Hot Keys for the Schedule Manager 
 
1. Add Schedule 

Move between fields 
Move to the next field: Tab 
Move to the previous field: Shift-tab 

 
2. Hot keys for the Commands 

Search schedule: Ctrl-s 
Alarm option: Ctrl-o 
Backup schedule: Ctrl-u 
Restore schedule: Ctrl-r 
Setting backup option: Ctrl-e 
Exit: Alt-F4     

 
3. Search schedule 

Hot keys for the commands 
Add schedule: Ctrl-n 
Alarm option: Ctrl-o 
Backup schedule: Ctrl-u  
Restore schedule: Ctrl-r 
Set backup option: Ctrl-e 
Toggle search mode: Ctrl-F2 
Exit: Alt-F4 
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4. Move keys in the search result list 
1)  Move from a appointment to another in the schedule list: 

Move to the previous a in the same day: Up arrow key 
Move to the next appointment in the same day: Down arrow key 
Move to the first appointment in the same day: Fn-Left arrow key 
Move to the last appointment in the same day: Fn-Right arrow key 

2)  Move from one appointment to another in all the appointments 
registered: 

Move to the previous schedule: Ctrl-Left arrow key 
Move to the next schedule: Ctrl-Right arrow key 
Move to the first schedule: Ctrl-Fn-Left arrow key 
Move to the last schedule: Ctrl-Fn-Right arrow key 

3)  Hot keys for the commands: 
Add schedule: Ctrl-n  
Modify schedule: Ctrl-m 
Delete schedule: Del 
Alarm option: Ctrl-o  
Backup schedule: Ctrl-u 
Restore schedule: Ctrl-r 
Set backup option: Ctrl-e 
Save schedule as file: Alt-s 
Print schedule: Ctrl-p 

 
5. Cancel / Exit 
1) Cancel: ESC 

It cancels the current job or setting like the “esc” key on a personal 
computer. 

2) Exit: Alt-F4 
Exit from the schedule manager. It can be used as cancel key for any 
function. 
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8. E-mail 
 
The e-mail program is used to communicate with others using the 
Internet. In order to use the e-mail program, you must have your own e-
mail account, which has been provided to you by your Internet account 
provider. 
 
The e-mail account that you have should support POP3 (Post Office 
Protocol 3) and SMTP (Simple Mail Transfer Protocol).  You should 
check with your Internet service provider to make sure that your provider 
supports POP3 and SMTP. 
 
Before you use the e-mail program, you will need to setup the Voice 
Sense QWERTY to use the Internet, which is in the “Utilities” menu (see 
chapter 16). 
 
In order to set the “Internet”, follow these steps: 

1) Press “Enter” on the “Utilities” program. 
2) Move to “Internet setup” and Press “Enter”. Or press “I”. 
3) In “Setup internet,” you will find “LAN,” Wireless LAN , “ADSL,” 

and “Bluetooth DUN”. 
4) You can move between the items by pressing “Down arrow key” or 

“Up arrow key.” 
5) Press “Enter” on the item that you want to connect. 
6) Connect to Internet through setting proceed. 

 
When checking the “inbox” in the email program, the menus are different 
from the menus that are used when you are writing an email. You should 
read this chapter carefully, before you use the e-mail program on the 
Voice Sense QWERTY. 
 
8.1 Executing E-mail and E-mail service 
management 
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To use the e-mail program, you have to register your e-mail service 
information. The following is a detailed explanation of how to execute e-
mail, how to register e-mail service information, how to check e-mail 
service information, how to modify e-mail service information and how to 
delete e-mail service information. 
 
8.1.1 Executing e-mail 
 
In order to execute e-mail, follow these steps: 
 

1) Move to the “E-mail” in program menu, pressing “Up arrow key” 
and “Down arrow key”. 

2) Press “Enter” on the “E-mail” or press “E”. 
  
When you launch the e-mail program for the first time, the Voice Sense 
QWERTY will say “MenuYou must create at least 1 mail account from 
the accounts manager in the Tools menu.” Then, the “inbox” will be 
opened. The “inbox” is the main window of the E-mail program.  When 
you run the e-mail program for the first time, this “inbox” is empty and the 
Voice Sense QWERTY displays “no items 0/0.” 
 
Press “Shift-Tab”. It will show mailbox lists of e-mail. 
 
Mailbox lists 
1. Inbox: It is stored received mail. 
2. Sent: It is stored sent mail, after sending mail successfully. 
3. Outbox: It is stored Outbox, when user saves mail in “Outbox” or

 sending mail fails. 
 
By pressing “Up arrow key” and “Down arrow key”, you can move 
between mailbox lists. 
 
If there are any e-mail messages that the Voice Sense QWERTY has 
already received, “Opening inbox...” will be announced in voice and on 
the LCD. Once progress has reached100%, the “inbox” will be opened 
and it will show the received e-mail in the list. Move to “Sent” or “Outbox”, 
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and press “Enter”. If there are any e-mail messages in “Sent” or “Outbox”, 
it will show e-mil lists like the “inbox”.   
 
8.1.2 Management e-mail service information 
 
In “Accounts manager”, you can manage e-mail service information.  
 
To execute e-mail service, follow these steps: 

1) Press “Alt” to call up the menu in “Inbox” mail list. 
2) Pressing “Down arrow key”, move to “Tools”. Press “Enter” on 

“Tools”. Or press “T”. 
3) It will show “Accounts manager”. 
4) Press “Enter”. 
5) It will show “Account name: no items 0/0”. Without calling up menu, 

you can also move to this menu by pressing “Ctrl-m.” 
 

The “Accounts manager” contains the following 6 items. 
1. Service list 
2. Information 
3. Add 
4. Modify 
5. Delete 
6. Close 
 
You can move among these items by pressing “tab” or “shift-tab.” You 
can execute each item by pressing “enter” on the desired item that is 
displayed. 
 
If you want to exit from the “Accounts manager,” move to the “Close” 
button, and then press “enter.” Or, press “ESC” or “Alt-F4.” The following 
is a detailed explanation of each item. 
 
8.1.2.1 Registering e-mail service 
 
To receive e-mail, you have to register e-mail service preferentially. In 
order to register e-mail service, follow these steps: 
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1) Press “Alt” to call up the menu. 
2) Move to “Tools”, pressing “Down arrow key”. 
3) Press “Enter” on the “Tools” or press “T”. 
4) It will show “Accounts manager”. Press “Enter”. 
5) Then it will show “Account name: no items 0/0”. Without calling up 

the menu, you can move to this menu by pressing “Ctrl-m”. 
6) Press “Tab”, move to “Add”. 
7) Press “Enter” on the “Add” or press “A”. 
8) Then, the dialog box will be opened and “Account name:” will be 

appeared. Type in the “Account name” edit box. (Ex: Voice Sense 
QWERTY) 

9) Press “Down arrow key”, move to “Display name”. Type in the 
“Display name” edit. This name will be shown as sender’s name to 
a receiver. 

10) Press “Down arrow key”, move to “Logon username”. Type in 
the “Logon username”. (Ex: Sense or sense@voicesense.com) 

11) Press “Down arrow key”, move to “Password”. Type in the 
“password”.  

12) Press “Down arrow key”, move to “E-mail address”. Type in the 
“E-mail address”. (Ex: sense@voicesense.com) 

13) Press “Down arrow key”, move to “Incoming POP3 server”. Type 
in the “Incoming POP3 server”. (Ex: mail.voicesense.com). Check 
with your Internet service provider or network administrator to find 
out what you should use as the Incoming POP3 server name. 

14) Press “Down arrow key”, move to “Outgoing SMTP server”. Type 
in the “Outgoing SMTP server”. Check with your Internet service 
provider or network administrator to find out what you should use 
as the Outgoing SMTP server name. 

15) Press “Tab”, move to “Confirm” button. 
16) Press “Enter” on the “Confirm” button. 
17) Then, the Voice Sense QWERTY will exit to “Account name list” 

and show the registered account name (Ex: Account name: Voice 
Sense QWERTY 1/1). 

18) When you finish registering the services, press “Alt-F4” to exit to 
the “inbox.” 
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In order to move from a setting item (Ex: ID, password) to the previous 
setting item, press “Up arrow key.” And, in order to move to the 
“Confirm” button or the “Cancel” button, press “Tab” or “Shift-Tab.” 
 
If you made a typo in an item such as account name, ID, or password, 
you can correct the type as follows; 
 

1) In order to delete the letter where the cursor is located, press 
“Del.” 

2) In order to delete the letter in front of the cursor position, press 
“Backspace.” 

3) In order to delete the current line, press “Ctrl-Backspace”. Then, 
the Voice Sense QWERTY will ask “Delete line: Yes.” If you press 
“enter,” the selected line will be deleted. If you do not want to 
delete the current line, press “Space” to change from “Yes” to “No” 
and press “enter.” 

 
8.1.2.1.1Signature and Advanced 
 
While registering your account, you can register signature and set 
advanced options in “Advanced” menu.  

1) Press “Alt” to call up the menu. 
2) Press “Down arrow key”, move to “Tools”. 
3) Press “Enter” on the “Tools” or press “T”. 
4) It will show “Accounts manager” in LCD. 
5) Press “Enter” on the “Accounts manager”.  
6) It will show “Account name”. Without calling up menu, by pressing 

“Ctrl-m” you can move to this menu. 
7) Press “Tab”, move to “Add”. 
8) Press “Enter” on the “Add” or press “A”. 
9) Press “Tab”, move to “Advanced”. 
10) Press “Enter” on the “Advanced”. 
11) It will show “Use secure POP3 (POP-SSL)”. The default value of 

this check box is unselect. If the Incoming POP3 server uses the 
“SSL,” select the check box by pressing “Space.” 
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12) Press “Down arrow key” to move to “POP3 port number: 110” by 
default.  Here you can type in another POP3 port number in the 
computer edit box. 

13) Press “Down arrow key” to move to “SMTP encryption type”. The 
setting values are “None”, “SSL” and “TLS”. If the type of Outgoing 
SMTP server uses the “SSL” or “TLS”, change the value by 
pressing “Space.” 

14) Press “Down arrow key” to move to “SMTP port number: 25”. 
Here you can type in another SMTP port number. 

15) Press “Down arrow key” to move to “SMTP username.”  Here, 
you can add another SMTP username if your Internet service 
provider requires you to use a different SMTP username.  

16) Press “Down arrow key” to move to “SMTP password.”  You 
can type in your password that corresponds to the above ID.  

17) Press “Down arrow key” to move to “Use as default send-from 
account” If you want to use the above new username and 
password select the check box by pressing “Space.” 

18) Press “Down arrow key” to move to “Keep mail copies in server”. 
When you download e-mail from your e-mail server, you can set 
the Voice Sense QWERTY to keep e-mail messages on the server 
or not. Press “Space” to change “Yes” to “No,” and press “enter” if 
you do not want a copy of the email to remain on the e-mail server. 

19) Press “Down arrow key” to move to “Save mail copies in sent 
mailbox”. When you send e-mail, you can set the Voice Sense 
QWERTY to keep e-mail message in sent mailbox or not. Press 
“Space” to change “Yes” to “No”, and press “Enter”. 

20) Press “Tab”, move to “Use signature”. The default value is “No”. 
If you want to attach your signature in mail, press “Space” to 
change “Yes” to “No”. 

21) Press “Tab”, move to “Signature”.  
22) Press “Enter” on the “Signature”. 
23) It will be appeared “Signature:” multi edit box. You can type your 

signature in here that you want to use.  
24) Press “Tab”, move to “Confirm”.  
25) Press “Enter” on the “Confirm”. 
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26) This will save the signature, and you will be returned to the 
“Signature” button. You can cancel by pressing “enter” on “Cancel” 
by pressing “tab” after typing-in a signature. 

27) Press “tab”, and press “enter” on “Confirm.” 
 
If you execute like the above, you can use signature when you send an 
email. And also you can use different server when you send or receive 
emails. 
 
8.1.2.2 Checking registered service list 
 
The following is the method to check the registered service information: 
 

1) Press “Alt to call up the menu. 
2) Press “Down arrow key” move to “Tools”. 
3) Press “Enter” on the “Tools” or press “T” 
4) It will show “Accounts manager”. 
5) Press “Enter” on the “Accounts manager”. 
6) Press “Down arrow key” or “Up arrow key” to move to the desired 

service in the service list. 
7) If the desired service is displayed, press “Enter”. Or “Tab” to move 

to the “Information”, and then press “enter.” 
8) The “Information” dialog box will be opened, and “Account name: 

(Registered account name)” will be displayed (Ex: account name:  
Voice Sense QWERTY). 

9) Press “Down arrow key” or “tab” and check the registered 
information for each item. Pressing “enter” on the “Close” will 
return you to the service list. 

 
You can check all registered information of e-mail service.  
 
The move keys are listed below to move among the items in the dialog 
box: 
 
Move to the previous item: Up arrow key 
Move to the next item: Down arrow key 
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Move to the first item: Fn-Left arrow key 
Move to the last item: Fn-Right arrow key 
Move to the previous control: Shift-Tab 
Move to the next control: Tab 
 
Note: If the information displayed exceeds 32 Braille cells, the remaining 
parts can be checked by pressing the “down scroll button” when Voice 
Sense QWERTY connected to SyncBraille. 
 
8.1.2.3 Modifying registered service list 
 
The following is the method to modify the registered service information: 
  

1) Press “Alt to call up the menu. 
2) Press “Down arrow key” move to “Tools”. 
3) Press “Enter” on the “Tools” or press “T” 
4) It will show “Accounts manager”. 
5) Press “Enter” on the “Accounts manager”. 
6) Press “Down arrow key” or “Up arrow key” to move to the desired 

service in the service list. 
7) When the desired service is displayed, press “Tab” to move to the 

“Modify”, and then press “Enter.” Or, just press “m.” 
8) It will show “Account name”. In this case, it is a “modification,” so 

the Voice Sense QWERTY will show you the current information. 
For example, “Account name: Voice Sense QWERTY.” 

9) The “Modify” dialog box will be opened, and “Account name: 
(Registered account name)” will be displayed (Ex: Account name:  
Voice Sense QWERTY). You can type in here that you want to 
modify. 

10) Press “Down arrow key”, move to “Display name”. You can type 
in here that you want to modify.  

11) Press “Down arrow key”, move to “Logon username”. You can 
type in here that you want to modify. 

12) Press “Down arrow key”, move to “Password”. You can type in 
here that you want to modify. 



156 
 

13) Press “Down arrow key”, move to “E-mail address”. You can 
type in here that you want to modify. 

14) Press “Down arrow key”, move to “Incoming POP3 server”. You 
can type in here that you want to modify. 

15) Press “Down arrow key”, move to “Outgoing SMTP server”. You 
can type in here that you want to modify. 

16) Press “Tab (Space4-5)”, move to “Advanced” and press “Enter”. 
Also you can modify like the above. 

17) Press “Tab”, move to “Confirm” and press “Enter”. 
18) When the modification is complete, it will return to the “service 

list.” 
 
You can move among the items (account name, logon username, 
password…) by pressing “Up arrow key” or “Down arrow key”. You can 
move to the “Confirm” button or the “Cancel” button by pressing “tab” or 
“shift-tab”. 
 
On all of the items, the values that were typed in already will be 
displayed. If you type in new information, the new information will 
replace the old information. If you want to modify part of an item, press 
the “Right arrow key” or “Left arrow key” at the desired position and type 
in the new information. 
If you made a typo in an item (account name, logon username, 
password…), you can modify it using the following process: 
 
1. You can delete the current letter by pressing “Del”. 
2. Press “Backspace” in order to delete the previous letter. 
3. In order to delete the current line, press “Alt-c”. Then, “Delete line: 

yes” will be displayed. Press “enter” in order to delete the line.  
Otherwise, press “Space” to change from “Yes” to “No,” and then 
press “enter.” 

 
8.1.2.4 Deleting registered service list 

 
The following is the method to delete the registered service information: 
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1) Press “Alt to call up the menu. 
2) Press “Down arrow key” move to “Tools”. 
3) Press “Enter” on the “Tools” or press “T”. 
4) It will show “Accounts manager”. 
5) Press “Enter” on the “Accounts manager”. 
6) Press “Down arrow key” or “Up arrow key” to move to the desired 

service in the service list. 
7) When the desired service is displayed, press “Del” or “.” Or, press 

“Tab” to move to the “Delete”, and then press “Enter.” 
8) Then, “Are you sure you want to delete the (Registered account 

name) service? Yes” will be displayed. 
9) Press “enter” in order to delete it. 
10) The Voice Sense QWERTY will delete it, show “Successfully 

deleted,” and return to the “service list.” 
 
If you want to cancel the deletion, press “Space” when “Are you sure you 
want to delete the (Registered account name) account? Yes” is 
displayed in order to change “Yes” to “No,” and then press “enter.” Or, 
just press “ESC” or “Alt-F4”. 
 
8.2 Receiving and Sending E-mail 
 
8.2.1 Receiving E-mail 
 
The Voice Sense QWERTY is capable of receiving plain text email and 
html email messages. 
 
You can receive e-mail messages by doing the following. 

1) Press “Alt to call up the menu. 
2) Press “Down arrow key”, move to “Message”. 
3) Press “Enter” on the “Message” and press “Enter”. Or press “M”. 
4) It will show “Reply”. 
5) Press “Down arrow key”, move to “Check for new mail”. 
6) Press “Enter” on the “Check for new mail”. Or press “N”. 
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7) Then, you will find “Account name” list. You can move to this 
dialog box directly by pressing “Alt-m-n.” This dialog box consists 
of “service list,” a “Confirm”, and a “Cancel”. 

8) When “Account name: (registered account name x/x)” is displayed, 
press “Up arrow key” or “Down arrow key” to move to the desired 
service. 

9) Press “enter” when the desired service is displayed, or press “Tab” 
to move to the “Confirm”, and press “enter.” 

10) Then the Voice Sense QWERTY will display “There are xx 
messages to receive. Now receiving…” “xx/yy mail received;” 
“Successfully received x out of y message” will be displayed. 
When the e-mail messages are downloaded from the server, the 
e-mail list is displayed in the “inbox” (Ex: Subject: (subject of the 
email received) xx/xx). 

 
If the e-mail size is more than the Voice Sense QWERTY can handle, it 
announces “This message is too large to download. Skipping.” and then 
the Voice Sense QWERTY will begin downloading the next e-mail 
message.  
If you want to cancel the download, press “Tab” to move to the “Cancel”, 
and press “enter,” or you can press “ESC”. 
 
8.2.2 Reading the Received E-mail Messages 
 
If you downloaded e-mail from your server, the e-mail messages will be 
listed in the “inbox.” Each e-mail in the “inbox” has the following items. 
 
1. Subject 
2. Date 
3. From (Sender) 
4. CC 
5. Message 
6. Attach (this will be displayed only for an e-mail that has an attac

hed file) 
You can move from one item to the next item or previous item by 
pressing “Tab” or “Shift-tab”, respectively. 
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8.2.2.1 Subject Control 
 
“Subject” shows the title of the e-mail; “Subject: (subject of the e-mail) 
xx/yy.” After the subject of the email, you will find “xx/yy,” which shows 
the number (xx) of the current e-mail out of the total number (yy) of 
received e-mail messages. For example, “11/21” means that the e-mail 
is the 11th e-mail out of a total of 21 e-mail messages. 
 
If there is an attached file to the e-mail, “(X attached)Subject: (subject of 
the e-mail) xx/yy” will be displayed. And it is announced as “X 
attachment,” which indicates the number of the attached files in voice. 
 
The Voice Sense QWERTY also indicates which e-mail messages have 
been read, and which e-mail messages have been unread. E-mail that 
has not been read will be shown as "Unread" in front of the subject. For 
example, let’s suppose there is an email with an attachment that has 
been unread. It would appear as “Unread (X attached) Subject: (subject 
of the e-mail) xx/yy.” 
You can move from one e-mail message to the next e-mail message 
when this subject is displayed. You can move by using the following 
keys; 
 
Move to the next e-mail: Down arrow key 
Move to the previous e-mail: Up arrow key 
Move to the first e-mail in the Inbox: Ctrl-Fn-Left arrow key 
Move to the last e-mail in the Inbox: Ctrl-Fn-Right arrow key 
 
8.2.2.2 Date Control 
 
“Date” shows the date and time when the e-mail was received; “Date: 
(date), (time) xx/yy.” The date is displayed in the following order: day, 
month, date, and year. The time is displayed in the following order:  
hour, minute, and second with the 24 hour system. And, “xx/yy” shows 
the current number of the email out of the total number of e-mail 
messages received. You can also move from one e-mail message to the 
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next e-mail message when the date is displayed. The move keys are 
explained in section 8.2.2.1. 
 
The Voice Sense QWERTY also indicates which e-mail messages have 
been read, and which e-mail messages have been unread. E-mail that 
has not been read will be shown as "Unread" in front of the date. For 
example, let’s suppose there is an email that has been unread. It would 
appear as “Unread Date: (date), (time) xx/yy.” 
 
8.2.2.3 Sender Control 
 
“From” shows the sender information; “From: (sender’s e-mail address) 
xx/yy.” The Voice Sense QWERTY also indicates which e-mail 
messages have been read, and which e-mail messages have been 
unread. E-mail that has not been read will be shown as "Unread" in front 
of the sender. For example, let’s suppose there is an email that has 
been unread. It would appear as “Unread From: (sender’s e-mail 
address) xx/yy” 
 
You can save the e-mail id of the sender using the following sequence: 
 

1) Press “Ctrl-i” when “From: (sender’s e-mail address) xx/yy” is 
displayed. 

2) Then, the “add address” dialog box will be opened, and “Name: 
(sender’s user name or e-mail address)” will be displayed. 

3) Type in the sender’s name with your keyboard, or press “tab” to 
move to “Confirm” and press “enter.” 

 
When you type in the name, you can type it in “Name” edit box directly. If 
the address that was typed in is saved, and the dialog box is closed, the 
Voice Sense QWERTY will show you the “From” item again. 
 
By saving the e-mail ID using the above method, the name and its e-mail 
id will be saved in the Voice Sense QWERTY. The saved e-mail ID can 
be used to send your message. If you want to cancel saving the e-mail 
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ID, press “tab” to move to the “Cancel” button, and press “enter,” or just 
press “ESC.” 
 
8.2.2.4 CC Control 
 
“CC” shows the carbon copy recipient. This control will be shown if the 
email has a "CC". 
You can save the e-mail id of the carbon copy recipient using the 
following sequence: 
 

1) Press “Ctrl-i” when “CC: (carbon copy recipient’s e-mail address) 
xx/yy” is displayed. 

2) Then, the “add address” dialog box will be opened, and “Name: 
(sender’s user name or e-mail address)” will be displayed. 

3) Type in the carbon copy recipient’s name with your keyboard, or 
press “tab” to move to “Confirm” and press “enter.” 

 
When you type in the name, you can type it in “Name” edit box directly. If 
the address that was typed in is saved, and the dialog box is closed, the 
Voice Sense QWERTY will show you the “CC” item again. 
 
8.2.2.5 Message Control 
 
“Message” shows the message body of the selected e-mail. You can 
move to a message by pressing “tab.” Or, you can read a message by 
pressing “enter” when “Subject,” “Date,” or “From” is displayed. In case 
of pressing “enter” on “Subject,” “Date,” “From” controls, you will 
automatically hear the whole message body, if you want to stop this 
reading at this time, just press “Ctrl.” 
 
If you want to move the “Subject” while reading the message, press 
“ESC”. 
When you read the message, all of the control keys are the same as in 
the word processor. 
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8.2.2.6 Attachment Control 
 
You can find and download the attached file at “Attach.” It will show only 
for the e-mail that has an attached file. “Attach” is displayed in the form 
of “Attach: (attached file name) xx/yy.” The “yy” is the total number of the 
attached files to the e-mail and “xx” is the “xxth” attached file. 

 
The following is the procedure to download attachments; 
 

1) Move to the desired fie name in “Attach” by pressing “Down arrow 
key”or “Up arrow key.” 

2) Press “Space” on the file name that you want to download.  
3) Press “enter” to download that file. Then “Attachments will be 

saved to /flashdisk/download. Do you want to change this 
location? No” will be displayed. Press “enter” in here. 

4) By doing so, the selected file will be saved in the “download” folder 
in “flashdisk.” 

 
If you have more than one attachment that you want to download, you 
can press “Ctrl-a.” If you want to download only the attached file that is 
displayed on the LCD, just press “enter” without pressing “Space.” 
 
If you want to change the download path, 

1) When you download an attached file, if you press “enter” while 
“Attachments will be saved to /flashdisk/download. Do you want to 
change this location? Yes” is displayed. 

2) Press “Enter”. 
3) Then, “no items” will be displayed when the “/flashdisk/download” 

folder is empty. But, if the folder has a lower level folder, “(mailbox 
name:) 1/yy” will be displayed. When “Save attachment path” is 
executed, the Voice Sense QWERTY will only show the folder.  
So, if there is no folder in the “download” folder, it will show “no 
items.” 
Move to the desired folder by pressing move keys below: 
Move to the upper level folder: Backspace 
Move to the previous item: Up arrow key 
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Move to the next item: Down arrow key 
4) When you encounter the desired folder, press “Space” to select it, 

and then press “enter.” If a folder is selected, “*” will be displayed 
in front of the selected folder. 

 
In this case, if you select a folder, and press “enter,” the attached file will 
be downloaded into the selected folder and return to the “inbox.” 
 
8.2.2.7 Reading HTML type of e-mail 
 
If you received the html type of e-mail, follow below these steps: 
 

1) You can open it with the Web browser regardless of anywhere of 
received e-mail by pressing “Alt-o.”  

2) Or after calling menu by pressing “Alt,” move to “Message” and 
then press “enter”. You can see menu items of “Message.” Arrow 
down to the “Open Message In Web Browser” and press “enter” 
then the Web browser program is launched and you can see html 
message on the web browser. 

If you have links on the html type of e-mail, you can visit linked site by 
pressing “enter” on it only when your Voice Sense QWERTY is already 
connected to internet. 
 
8.2.3 Writing e-mail 
 
After executing “E-mail” program, the following is the procedure to write 
e-mail. 

 
1) Press “Alt” to call up the menu. 
2) It will show “File” menu. 
3) Press “Enter” on the “File” menu.  
4) It will show “Write new message”. 
5) Press “Enter” on the “Write new message”. 
6) Then “To:” will be displayed on the LCD. Pressing “Ctrl-n” will take 

you directly to this stage. 
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7) Press “shift-tab” to move to “Account” combo box. Move to 
account that you want by using “Up arrow key” or “Down arrow 
key.” Press “tab” to move to “To:.” 

8) Type in the e-mail address of the recipient when “To:” is displayed.  
Please type in the e-mail address (Ex: sense@voicesense.com). 

9) Next, press “tab” to move to “CC:.” 
10) Type in the e-mail address of the other recipient. If you do not 

need to carbon copy a recipient, you can skip to the next step. 
11) Press “tab” to move to “BCC:.” 
12) Type in the e-mail address of another recipient. This e-mail 

address will not be seen by the recipient or the carbon copy 
recipient. If there is no “hidden recipient,” you can skip to next step. 

13) Press “tab” to move to “Subject:.” 
14) Type in the subject of the e-mail message at “Subject:”  
15) When you finish typing in the subject, press “tab” to move to 

“Message body:” 
16) You can write an e-mail message. The input method and the 

editing method are the same as the input and editing method used 
in the word processor.  

17) When you finish writing the e-mail message, press “Alt” to call up 
the “E-mail” menu. Then the “File” menu will be displayed again. 

18) Press “enter.” 
19) Press “Down arrow key” to move to “Send.” 
20) Press “enter” when “Send” is displayed. You can send mail 

pressing “Ctrl-s”, without calling up the menu. 
21) Then, “Sending…” will be displayed, and the e-mail will be sent 

to the recipients. When the Voice Sense QWERTY finishes 
sending e-mail, “Successfully sent new message.” will be 
displayed. If it fails to send the e-mail, the Voice Sense QWERTY 
will display “Unable to sent message.” If this occurs, the e-mail will 
be saved in the “Outbox.” 

 
If the Voice Sense QWERTY completed or failed to send the e-mail, it 
will return to the “Inbox.” 
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While you execute the above steps, if you want to cancel, press “ESC” 
or “Alt-F4”. Then it will return to the “Inbox”. 
 
8.2.3.1 Attaching file 
 
While you are writing e-mail, you can attach file. 
 
The following is the procedure to attach a file. 
 

1) While you are writing e-mail, press “Alt” to call up the menu. Then, 
it will show “File” menu. 

2) Press “Enter” on the “File” menu.  
3) It will show “Attach File”. 
4) Press “Enter” on the “Attach File”. It will be opened “File list”. You 

can attach file pressing “Ctrl-f”, without calling up the menu. 
5) The default folder for the “file list” is the “upload” folder, which is a 

sub folder of “flashdisk.” If there are no folders in the “upload” 
folder of the Voice Sense QWERTY due to any reason, “no items” 
will be displayed. In this case, you have to make a folder in the 
“File manager,” or move to the desired folder with the move keys 
that are explained below. 
 
The move keys in the file list are as follows; 
Move to the upper level folder: Backspace 
Move to previous item: Up arrow key 
Move to next item: Down arrow key 
Move to the beginning of the list: Ctrl-Fn-Left arrow key 
Move to the end of the list: Ctrl-Fn-Right arrow key 
 

6) Move to the desired file, and press “enter.” If you want to attach 
more than one file, move to the desired file, and press “Space” 
repeatedly. Press “enter” if you want to attach the selected files. 

7) If the selected files are attached, the Voice Sense QWERTY will 
announce “xx attached,” and then move to the stage before calling 
the menu. “xx” is the number of the attached files. 
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If there are any files attached to an e-mail, the “Attach” item will be 
displayed after the “Message body” item like the following: “Attach: 
(attached file name) xx/yy (file size).” “yy” is the total number of attached 
files, and “xx” means the “xxth” file out of “yy” files. You can move and 
check the attached files by pressing “Up arrow key” or “Down arrow key.” 
If there is an undesired file in the attached file list, you can delete it from 
the list by pressing “Del.” 
 
If you press “Del,” “Delete (file name) file? Yes” will be displayed. If you 
press “enter,” this file will be deleted from the attached file list. If you 
press “Space” to switch from “Yes” to “No,” and then press “enter,” your 
selection will be cancelled, and the file will remain on the attached file list. 
 
8.2.3.2 Sending E-Mail to Multiple Recipients 
 
You can type in more than one recipient, carbon copy recipient, or 
hidden recipient.  If you type in more than one e-mail address in those 
items, the same e-mail will be sent to all of them at the same time.  
 
For example, sense@voicesense.com; hims@voicesense.com. 
 
8.2.3.3 Searching the Address List 
 
You can type in the recipient at “To,” “CC,” and “BCC” from the address 
list without typing in the e-mail address directly. 
 
The following are the steps to search for e-mail addresses: 
 

1) Press “Alt” to call up the “E-mail” menu at “To,” “CC,” or “BCC.”  
Then, “File” will be displayed. 

2) Press “Enter” on the “File” menu. 
3) Press “Down arrow key” to move to “Lookup Address.” 
4) Press “Enter” on “Lookup Address.” Then “Search for address” will 

be displayed. Pressing “Ctrl-l” will take you to this step directly. 
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5) Type in the last name of the desired recipient at “Search for 
address,” and then press “enter.” Or, press “tab” to move to 
“Confirm,” and then press “enter.” 

6) Then, “xx addresses are found” will be displayed, and the first item 
of the found addresses is also displayed. Here, “xx” is the number 
of the found addresses that have the same name in the address 
list (Ex: HIMS hims@voicesense.com 1/xx). 

7) Press “Up arrow key” or “Down arrow key” to move to the desired 
address, and press “enter” when the desired address is displayed. 
You can select more than one address by pressing “Space.” When 
you have chosen the addresses you want, press “enter.” 

8) Then, the selected addresses are inserted in “To,” “CC” or “BCC.”  
 

If you press “enter” without typing in the desired name, all of the 
addresses in your address list will be displayed. If there is no matching 
address that you want to find, then “No match.” will be announced and 
“Search for address” will be displayed again. 
 
8.2.3.4 Saving E-Mail to the Outbox 
 
There are two kinds of e-mail messages in the “Outbox”. 
1. The e-mail that the user saved in “Outbox”. 
2. The e-mail that was not sent due to a network error or another reason. 
 
The Menu structure and move of “Save Mail In Outbox” is like below. 
 
1. “File name” ECB 
2. “Confirm” Button 
3. “Cancel” Button 
4. “Storage folder” List 
 
You can move between the menu controls by using “Shift-Tab” or “Tab”. 
 
The following describes how to save email in Outbox: 
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1) Press “Alt” after you write the e-mail message. Then, the “File” 
menu will displayed. 

2) Press “enter.” 
3) Press “Down arrow key” to move to “Save Mail In Outbox”. 
4) Press “Enter”.  
5) Then, the dialog box for save will be opened.  
6) “File name: (subject of writing e-mail).txt” will be displayed. You 

can jump to this stage by pressing “Fn-s”. 
7) Press “Enter” on “File name: (subject of writing e-mail).txt,” or 

press “tab” to move to the “Confirm” button.  
8) Then, the message will be saved as “(subject of writing e-mail).txt”.   
9) If you want to name the e-mail message, type in a file name. The 

detailed procedure is the same as “Save As” in the Word 
processor. You can also change the path for saving it.  

10) After the Voice Sense QWERTY saves the e-mail message, it 
will return to the status it was at before calling the menu. 

 
By following the explanation above, the e-mail message will be saved as 
“(subject of writing e-mail).txt” in the “flashdisk/email/storagebox.”  
 
If you do not input the subject in the writing e-mail, it will be displayed as 
“noname” on the “File name.”  
 
If you want to save the file in another folder, and not in 
“flashdisk/email/storagebox,” you will not find the e-mail message when 
you execute “Send Mail From Outbox.” 
 
While you are typing in a “message,” press “ESC” if you want to cancel 
writing the e-mail.  

1) The Voice Sense QWERTY will display “Current writing mail. 
Save? Yes.”  

2) If you want to return to the “inbox” without saving the email, press 
“Space” to change “Yes” to “No,” and then press “Enter.” 
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If you press “Alt-F4” instead of “ESC” while you are writing an e-mail 
message, the Voice Sense QWERTY will return to the “inbox” without 
asking whether it will save the message or not. 
 
8.2.3.5 Saving E-Mail as New Name in the “Outbox” 
 
If you save e-mail in “Outbox”, you can save it under a different file name. 
This “Save Draft” function will save the email as new name, and place it 
in the Outbox. 
 
The Menu structure and move of “Save Mail In Outbox” is like below. 
 
1. “File name” ECB 
2. “Confirm” Button 
3. “Cancel” Button 
4. “Storage folder” List 
 
You can move between the menu controls by using “Shift-” or “Tab”. 
 
The following describes how to save e-mail as new name in the 
“Outbox”: 
 

1) Press “Alt to call up the menu. 
2) It will show “File” menu. 
3) Press “Enter” on the “File menu”. 
4) Press “Down arrow key” move to “Save Draft”. 
5) Press “Enter”. Or Without calling the menu, “Alt-s”. 
6) The dialog box for save will be opened.  
7) It will be displayed “File name: (subject of writing e-mail).txt”. 
8) If you want to change file name, type in a file name.  
9) Press “Enter”. Or press “Tab” move to “Confirm” and press “Enter”. 

 
If you want to cancel, press “Tab” on the “Confirm, move to “Cancel”. Or 
press “Alt-F4” regardless of location. 
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If you want to change the path for saving it, press “Tab” on the “Cancel” 
move to “Storage folder”. The default folder is in the 
“flashdisk/email/storagebox”.  
1. If you want to change folder in “Flashdisk”: By pressing “Space”, 

select folder that you want to save. And press “Enter”.  
2. If you want to change folder in external memory: Press “Backspace”, 

move to “Disk” list. Move to mailbox that you want to save and press 
“Space” for selecting folder. 

If you want to save the file in another folder, and not in 
“flashdisk/email/storagebox,” you will not find the e-mail message when 
you execute “Send Mail From Outbox.” 
 
If you execute the “Save Draft” without typing message in “Message 
body”, it will hear ‘Message body is empty’. And it will return to “Message 
body” control. 
 
While you are typing in “message body” if you press “Alt-F4” to cancel 
writing an e-mail, the Voice Sense QWERTY will display “Currently 
writing mail. Save? Yes”. Pressing “Enter”, it will save the e-mail. And it 
will exit the “E-mail” program.  
If you change “No” to “Yes” by pressing “Space” and press “Enter”, it will 
exit the “E-mail” program without saving the e-mail. 
 
8.2.3.6 Sending E-Mail in “Outbox” 
 
You can send saved e-mail in “Outbox” when you saved mail to “Outbox” 
or you didn’t send mail due to a network error or another reason. 
 
The following describes how to send e-mail In “Outbox”. 
 

1) Execute “E-mail” program. 
2) It will show mail list in “Inbox”. 
3) Press “Shift-Tab”, move to “Mailbox”. 
4) Press “Up arrow key” or “Down arrow key”, move to “Outbox”. 
5) Press “Enter”. 
6) It will show mail list in “Outbox”.  
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7) Press “Up arrow key” or “Down arrow key”, move to the mail that 
you want to send. 
· When you want to send all the emails in the list: Press “Ctrl-a”. 
· When you want to send an email by selection an item by item in 
the list: Press “Space”. 
· When you want to send an email by selection continuously in the 
list: Press “Ctrl-b”. It will show “Start selection”. Move to the mail 
that you want to send.  
For example, when you send 5 mail in 10 mail lists, press “Ctrl-b” 
from the first list of mail. And press “Down arrow key”, move to the 
5th mail. 

8) Press “Alt” to call up the menu. 
9) Press “Enter” on the “File” menu. 
10) Press “Up arrow key” or “Down arrow key”, move to “Send” 

menu. 
11) Press “Enter” on the “Send” menu. 
12) It will execute sending mail. 

 
Without calling the menu, press “Ctrl-s” on the mail that you want to 
send of mail lists of the “Outbox”. 
After sending the mail of the “Outbox”, there is no the mail in “Outbox”. 
The mail will move to “Sent item”. Then, the Voice Sense QWERTY will 
return to “inbox.” 
 
8.2.3.7 Setting Default E-mail account 
 
You can set default e-mail account when you registered two or more e-
mail accounts in Voice Sense QWERTY.  
 
The following describes how to set default e-mail account. 

1) Execute “E-mail” program. 
2) Press “Alt” to call up the menu in mailboxes except “Outbox”. 
3) Press “Down arrow key”, move to “Tools”. 
4) Press “Enter” on the “Tools menu” or press “T”. 
5) It will show the “Accounts manager”. 
6) Press “Enter” on the “Accounts manager”.  
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7) It will show “Account name” lists. 
8) Press “Up arrow key” or “Down arrow key”, move to the e-mail 

account that you want to set the default account. 
9) Press “Tab”, move to “Add”. 
10) Press “Enter” on the “Add” or press “A”. 
11) Press “Tab”, move to “Advanced”. 
12) Press “Enter” on the “Advanced”. 
13) It will show the “Use secure POP3 (POP-SSL)”. 
14) Press “Down arrow key”, move to “Use as default send-from 

account”. 
15) By pressing “Space”, you can change “SCHB” to “UCHB”. 
16) Press “Tab”, move to “Confirm” and press “Enter”. 
17) It will return to the “Advanced”. 
18) Press “Tab”, move to “Confirm” and press “Enter”. 
19) It will move to account name list With “Successfully modified 

service” message. 
 
It will show “default” on the LCD next to the default account. 
 
8.3 Major features of E-mail 
 
8.3.1 Deleting E-mail 
 
You can delete e-mail. You can delete an e-mail message that you have 
selected, or, more than one e-mail by selecting each of them individually. 
 
8.3.1.1 Deleting an e-mail 
 
You can delete an e-mail in the mailbox by following the steps below; 
 

1) Press “Up arrow key” or “Down arrow key” to move to the 
“Subject” of the e-mail that you want to delete. 

2) Press “Del”.  
3) Then it will show “Delete (subject of the selected e-mail) mail? 

Yes”. 
4) Press “Enter” if you want to delete the e-mail. 
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If you want to cancel it, press “Space” to change “Yes” to “No” on the 
“Delete (subject to the selected e-mail) mail?”. And Press “Enter”. 
 
By pressing “ESC” or “Alt-F4”, you can cancel deleting e-mail.  
 
8.3.1.2 Deleting Multiple E-mail Messages 
 
If you want to delete two or more e-mail, delete the e-mail messages 
using the following steps: 
 

1) Press “Up arrow key” or “Down arrow key” to move to the e-mail 
“Subject” that you want to delete. You can select it in “Date 
control,” too. 

2) Press “Space” on the e-mail that you want to delete.   
3) It will show “selected Subject: (subject to the selected e-mail) 

xx/yy” on the LCD. 
4) Move to the other e-mail that you want to delete by pressing 

“Down arrow key” or “Up arrow key.” Then, press “Space.” 
5) Once you finish selecting all of the e-mail you want to delete, 

press “Del”. 
6) It will show “Delete xx mail? Yes”. “Xx” is the total number of 

deleting e-mail.  
7) Press “Enter”. 

 
If you want to cancel this function, press “Space” to change “No” on the 
“Delete xx mail? Yes”. Press “Enter”.  
 
Or you can cancel it by pressing “ESC” or “Alt-F4”. 
 
8.3.1.3 Deleting E-Mail by Making a Selection 
 
If you want to delete multiple e-mail by designating a selection, you can 
delete them as follows: 
 

1) Press “Ctrl-a” on the “Subject” or “Date” control.  
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2) Then, all of the e-mail will be selected.   
3) Press “Del”. 
4) It will show the “Delete xx mail? Yes”. “Xx” is the total number of 

deleting e-mail. 
5) Press “Enter”. 
6) All of the selected e-mail will be deleted. 

 
If you want to delete the successive e-mail, you can delete them using 
the following steps: 
 

1) Press “Ctrl-b” on the first e-mail where you want to start the 
selection. 

2) Press “Down arrow key” to move to the last e-mail that you want to 
delete. 

3) Press “Del.” 
4) It will “Delete xx mail? Yes”. “Xx” is the total number of deleting e-

mail. 
5) Press “Enter”. 

 
You can Press “Ctrl-b” which will make the selection. In front of the e-
mail subjects selected, “*” will be attached.   
 
If you have pressed “Ctrl-a” or “Ctrl-b,” but you want to cancel it, press 
“Space” to change “No” on the “Delete xx mail? Yes”. And press “Enter.”  
 
Or you can cancel it by pressing “ESC” or “Alt-F4”. 
 
8.3.2 Reply And Reply All to a Received E-Mail 
 
When you reply to an email that was received, you can edit or add a 
message to the original message or add another recipient. For example, 
you can reply to an e-mail message that you previously received in your 
“inbox.” Let’s demonstrate with an example. Suppose you received an 
email that had the following information: 
 
Sender’s e-mail address: hims@VoiceSense.com 
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Subject of the e-mail: Welcome to HIMS 
 
You could reply to this e-mail by completing the following steps: 
 

1) Press “Alt” to call up the menu when you are in “Subject,” “Date,” 
or “Message” of the “Inbox”. 

2) It will show the “File”. 
3) Press “Down arrow key” to move to the “Message”. 
4) Press “Enter.”   
5) It will show “Reply”. 
6) Press “Enter” on the “Reply.” 
7) It will show “Message body”.   
8) You can find the original message body of the received email; “–-- 

Original Message –--” followed by the received email message. 
You can get to this stage by pressing “Ctrl-r”. 

9) Press “Shift-Tab” to move to “Subject,” “BCC”,” “CC,” and “To.”  
10) At “Subject,” it will show “Subject: Re: Welcome to HIMS”. And, 

at “To,” it will show “To: hims@voicesense.com“. 
11) Press “Tab” to move to “Message body.”   
12) Type in the “Message body” that you want to add or edit. 
13) Press “Ctrl-s” to send the e-mail. 
  

When you reply the e-mail, after you press “Ctrl-r,” you can add recipient 
or attach file as well as write an e-mail. 
 
You can also save the e-mail that you are writing as a reply. It will be 
saved in the “Outbox”. 
 
You can reply to an email by using “Reply To All,” as well as “Reply.”  
Pressing “Reply” will send en e-mail to only the original sender.  
Pressing “Reply To All” will send an email back to the original sender as 
well as all other recipients to the original email. However, “Reply To All” 
will not send an email to you, even though you were a recipient of the 
original email. 
 
To activate the “Reply To All” function,  
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1) Press “Alt” to call up the menu.  
2) It will show the “File”. 
3) Press “Down arrow key”, move to the “Message”. 
4) Press “Enter” on the “Message”. 
5) It will show the “Reply”. 
6) Press “Down arrow key”, move to “Reply To All”. 
7) Press “Enter” on the “Reply To All”. You can activate the “Reply To 

All” function without calling up the menu by pressing “Alt-r.” 
8) It will show “To: (all email addresses of the original sender and the 

original recipients)” 
9) Then, you can use the same steps to send a message as you 

would when using the “Reply” function. 
 
 
 
8.3.3 Forwarding a Received E-Mail Message 
 
“Forwarding” means that you will send an e-mail that you received to 
another person. You can also add or edit the message and subject.  
You can also attach a file to this e-mail.   
 
Let’s explain how to use “Forward” with an example.   
Let’s suppose there is an e-mail message that you received as follows: 
 
Sender’s e-mail address: hims@voicesense.com 
Subject of the e-mail: Welcome to HIMS 
 
You can forward this e-mail to the others using the following method: 
 

1) Press “Alt” to call up the menu in the “Subject”, “Date”, or 
“Message”. 

2) It will show the “File”. 
3) Press “Down arrow key”, move to the “Message”. 
4) Press “Enter” on the “Message”.   
5) It will show the “Reply”. 
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6) Press “Down arrow key”, move to “Forward.” 
7) Press “Enter” on the “Forward”.  
8) It will show “To:”. You can move to this stage to this stage by 

pressing “Ctrl-f.” Input the e-mail address of the new recipient. 
9) Press “Tab”, move to “CC,” “BCC,” and “Subject.”   
10) At “Subject,” It will show “Subject: Fw: Welcome to HIMS.” 
11) Press “Tab”, move to “Message body.”  
12) You can find the original e-mail message with the following 

message; “----- Forwarded Message -----.” 
13) Type in the “Message body” that you want to add or edit. 
14) Press “Ctrl-s” to send the e-mail. 

 
When you forward an e-mail, the method is the same as write an e-mail.  
So, you can type in additional recipients and attach files to the email that 
you are forwarding. 
 
You can also save the e-mail that you are writing in the “Outbox”.   
 
8.3.4 Saving a Received E-mail as Document 
 
You may need to save an e-mail as a document when you are reading 
an e-mail in the “Inbox”. You can do this by completing the following 
steps: 
 

1) Press “Alt” to call up the menu.   
2) It will show the “File”. 
3) Press “Enter” on the “File”. 
4) Press “Down arrow key”, move to “Save As Text.” 
5) Press “Enter” on the “Save As Text.”   
6) It will open the “save as dialog box”. 
7) And it will show “File name: (subject of e-mail under reading).txt.”  

Without calling up the menu, you can move to this stage directly 
by pressing “Fn-s.” 

8) Press “Enter” on the “File name: (subject of e-mail under 
reading).txt”. Or press “tab”, move to the “Confirm”, and press 
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“Enter.” You can rename the file. The method is the same as 
“Save as” in Word processor. 

9) You will return to where you call the menu automatically if the e-
mail is saved. 

 
The text file will be saved in “flashdisk/My Documents” with the file name 
“(subject of e-mail under reading).txt.”  You cannot change the file 
format.  You can read the saved text file in the word processor. 
 
In order to cancel “Save As Text,” press “Tab” on the “Confirm”, move to 
“Cancel”. And press “Enter.” Or, just press “ESC” or “Alt-F4”. 
 
8.3.5 Printing E-Mail Messages 
 
You may want to print an email that you received or sent in using either 
an embosser or an ink printer. 
In order to print to an ink printer, do the following: 
 

1) Connect the Voice Sense QWERTY to an ink printer with the 
printer cable that was provided by the manufacturer of the printer. 
The printing port must be the same port that was set in the “Print 
port” in the “Global options”. 

2) Press “Alt” to call up the menu.  
3) It will show “File”. 
4) Press “Enter” on the “File”. 
5) Press “Down arrow key”, move to “Print E-mail.” 
6) Press “Enter” on the “Print E-mil”.  
7) It will show the “Print type”. Without calling up the menu, press 

“Alt-p” move to this stage directly. 
8) Press “Space” or “Down arrow key”, you change setting value of 

the “Print type”. Setting value is “Printer” and “Embosser”. 
9) After selecting the “Print type”, press “Enter”. Or press “Tab” move 

to the “Confirm” and press “Enter”. 
10) Then, the selected e-mail will be printed. 
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If you want to cancel printing, press “Tab” on the “Cancel” and press 
“Enter”. Or you can press “ESC” or “Alt-F4”. 
 
8.4 Additional features of E-mail 
 
8.4.1 Find 
 
The “Find” command is used to find text in the current mailbox. Once 
you enter text to find, the “Find” function will look for text that matches in 
“Subject,” “Date,” and/or “From.” This function only works in “Subject,” 
“Date,” or “From” control. 
 
The “Find” dialog box consists of a “Find”:  
1. “Find”: Edit box for text to search 
2. “Search” radio button 
3. “Direction” radio button  
4. “Confirm” button 
5. “Cancel” button.   
 
In the “Find” dialog box, you can move between the five controls by 
pressing “Tab” or “Shift-Tab”. The shortcut key is “f.” You can move to 
this function without calling up the menu by pressing “Ctrl-Shift-f.” 
 
To activate the “Find” function, use the following steps: 
 

1) Press “Alt” to call up the menu.  
2) It will show the “File”. 
3) Press “Down arrow key”, move to the “Edit”.  
4) Press “Enter” on the “Edit.” 
5) It will show the “Select All”. 
6) Press “Down arrow key” or “Up arrow key”, move to “Find”.  
7) Press “Enter” on the “Find”. Or press “f”.  
8) It will show the “Find:” edit box where the user can type the text 

that they want to find. 
9) After typing in the text, press “Tab” , move to the “Search”. Here 

you can select between “All,” “Subject,” “Date,” or “From.” “All” 
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control means “Subject,” “Date,” and “From” controls together. You 
can select an item by pressing “Down arrow key” or “Up arrow 
key.”  By selecting a specific control, you can search the control 
for the text that you want to find. 

10) Press “Tab”, move to the “Direction” which has two choices, 
“Forward” or “Backward”. Pressing “Down arrow key” or “Up arrow 
key” lets you select the searching direction as “Forward” or 
“Backward.” 

11) Press “Tab”, move to the “Confirm”.  
12) Press “Enter” on the “Confirm”.   

 
If you want to cancel, press “Tab” on the “Confirm”, move to the “Cancel”. 
And press “Enter.” Or, you can press “Alt-F4” or “ESC” anywhere in this 
dialog box to cancel. 
 
 
 
8.4.2 Find Again 
 
The “Find Again” command finds the next text according to what you 
found using “Find” dialog box, and it will go to the previous text if you set 
the direction to “Backward” when you used the “Find” function before.   
The “Find Again” function only works in the “Subject,” “Date,” or “From” 
control. 
 
To activate the “Find Again” function, use the following steps: 
 

1) Press “Alt” to call up the menu. 
2) It will show the “File” 
3) Press “Down arrow key”, move to the “Edit” 
4) Press “Enter” on the “Edit.”   
5) It will show the “Select All”. 
6) Press “Up arrow key” or “Down arrow key”, move to “Find Again”. 
7) Press “Enter” on the “Find Again”. Or press “g”. 

 
To activate this function without calling up the menu, press “F3.” 
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8.4.3 Move to Next Unread Message 
 
The “Move To Next Unread Message” option allows you to move to the 
next message that is unread. If you use this function on the last unread 
message in a list, you will be sent to the first unread message in the list.   
 
To activate this function while you are in the “Subject,” “Date,” or “From” 
control,  

1) Press “Alt” to call up the menu.  
2) It will show the “Find”. 
3) Press “Down arrow key”, move to the “Edit”. 
4) Press “Enter” on the “Edit”. 
5) It will show the “Select all”. 
6) Press “Down arrow key”, move to the “Move to Next Unread 

Message”. 
7) Press “Enter” on the “Move to Next Unread Message”. Or press 

“u”. 
 
To use this function without calling up the menu, press “Ctrl-u.” 
 
8.4.4 Copy or Move to mailbox 
 
There are two methods how to copy or move an e-mail to folder. 
 
1. You can copy and move e-mails directly in “Mailbox” lists except 
“Outbox”. 
 
In order to copy and move an e-mail to folder, follow there steps: 

1) Execute “E-mail” program. 
2) Press “Shift-Tab”, move to the “Mailbox” lists. 
3) Press “Up arrow key” or “Down arrow key”, move to the “Mailbox” 

including the e-mail that you want to copy and move. 
4) Press “Enter”. 
5) It will show e-mail lists. 
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6) Press “Up arrow key” or “Down arrow key”, move to the e-mail that 
you want to copy or move. Press “Space”, “Ctrl-b or “Ctrl-a”, select 
the e-mail that you want to copy or move. Or you can select the e-
mail using the “Select All” or “Start Selection” of the “”Edit” menu. 

7) Press “Alt” to call up the menu.  
8) It will show the “File”. 
9) Press “Down arrow key”, move to the “Edit”. 
10) Press “Enter” on the “Edit”. 
11) It will show the “Select All”. 
12) Press “Down arrow key”, move to the “Copy” or “Move”.  
13) Press “Enter”. Or without calling up the menu, by pressing “Ctrl-

c” or “Ctrl-x”, you can execute functions directly. 
14) Press “Shift-Tab”, move to the “Mailbox” lists. 
15) Press “Enter” on the “Mailbox” that you want to paste the e-mail. 
16) Press “Alt” to call up the menu. 
17) It will show the “File”. 
18) Press “Down arrow key”, move to the “Edit”. 
19) Press “Enter” on the “Edit”. 
20) It will show the “Select All”. 
21) Press “Down arrow key”, move to the “Paste” and press “Enter”. 

Or without calling up the menu, press “Ctrl-v”. 
22) It will be copied or moved the e-mail to mailbox. 

 
2. You can copy and move e-mails using the “Copy to mailbox” or “Move 
to mailbox” in the “Edit” menu. 
 
The structure and move of “Copy to mailbox” and “Move to mailbox” 
menu is like below. 
 
1. “Folder” list. 
2. “Create mailbox” Button 
3. “Delete mailbox” Button 
4. “Rename folder” Button 
5. “Confirm” Button 
6. “Cancel” Button 
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You can move between the controls by pressing “Tab” or “Shift-Tab”. 
And you can move between items in the “Folder” list by pressing “Up 
arrow key” or “Down arrow key.”  
 
If you want to cancel while you are in these dialog boxes, press “ESC” or 
“Alt-F4”. 
 
In order to copy and move an e-mail to another folder, follow there steps: 

1) You can select the e-mail by pressing “Space”, “Ctrl-b or “Ctrl-a”. 
Or you can select the e-mail using the “Select All” or “Start 
Selection” of the “”Edit” menu. 

2) Press “Alt” to call up the menu. 
3) It will show the “File”. 
4) Press “Down arrow key”, move to the “Edit”. 
5) Press “Enter” on the “Edit”. 
6) It will show the “Select All”. 
7) Press “Down arrow key”, move to the “Copy to mailbox” or 

“Move to mailbox”. 
8) Press “Enter” on the “Copy to mailbox” or “Move to mailbox”. 
9) It will show “Folder list”. Or without calling up the menu, press 

“Alt-c” or “Alt-x”. 
10) Press “Down arrow key”, move to the folder that you want to 

copy or move.  
11) Press “Enter”. 
12) It will be copied or cut the e-mail in the folder. 
13) It will return to the “Mailbox” before calling the menu. 

 
8.4.4.1 Adding Create mailbox 

 
You can add create mailbox in the e-mail folder of the “File manager”.  
 
In order to execute this function, follow these steps: 

1) Execute “E-mail” program. 
2) Press “Alt to call up the menu in mail lists of “Inbox”. 
3) It will show “File”. 
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4) Press “Down arrow key”, move to “Edit” and Press “Enter”. Or 
Press “e”. 

5) It will show “Select All”. 
6) Press “Up arrow key” or “Down arrow key”, move to “Copy to 

mailbox” or “Move to mailbox”.  
7) Press “Enter”. Or press “Alt-c” or “Alt-x”, without calling the menu. 
8) It will show “Folder” lists. 
9) Press “Tab”, move to the “Create mailbox”. 
10) Press “Enter” on the “Create mailbox”. 
11) It will show “Mailbox name:”. Type the mailbox name. 
12) Press “Enter” or press “Tab, move to “Confirm” and press “Enter”. 
13) It will show the create mailbox in “Folder” list. Also the folder is in 

“Mailbox” and in e-mail folder of “File manager”. 
 
 
 
8.4.4.2 Deleting Folder 
 
You can’t delete “Inbox”, “Sent”, “Outbox”. But you can delete the added 
folders. 
 
In order to delete the folder, follow these steps: 

1) Execute “E-mail” program. 
2) Press “Alt to call up the menu in mail lists of “Inbox”. 
3) It will show “File”. 
4) Press “Down arrow key”, move to “Edit” and Press “Enter”. Or 

Press “e”. 
5) It will show “Select All”. 
6) Press “Up arrow key” or “Down arrow key”, move to “Copy to 

mailbox” or “Move to mailbox”.  
7) Press “Enter”. Or press “Alt-c” or “Alt-x”, without calling the menu. 
8) It will show “Folder” lists. 
9) Press “Up arrow key” or “Down arrow key”, move to the folder 

that you want to delete. 
10) Press “Tab”, move to “Delete mailbox”. 
11) Press “Enter”. 
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12) It will show “Delete (mailbox name) folder? Yes”. 
13) Press “Enter”. 

 
By pressing “Del” on the folder that you want to delete, you can delete 
the folder.  
 
If you want to cancel this function, press “Tab” on the “Confirm”, move to 
“Cancel”. And press “Enter”. 
 
If you attempt to delete the “inbox”, “Sent” and “storagebox,” you will 
hear the warning sound to notify you of the error. 
 
8.4.4.3 Changing Mailbox name 
 
You can’t change mailbox name of the “Inbox” and the “Storagebox”. 
 
In order to change the mailbox name, follow these steps: 

1) Execute “E-mail” program. 
2) Press “Alt to call up the menu in mail lists of “Inbox”. 
3) It will show “File”. 
4) Press “Down arrow key”, move to “Edit” and Press “Enter”. Or 

Press “e”. 
5) It will show “Select All”. 
6) Press “Up arrow key” or “Down arrow key”, move to “Copy to 

mailbox” or “Move to mailbox”.  
7) Press “Enter”. Or press “Alt-c” or “Alt-x”, without calling the menu. 
8) It will show “Folder” lists. 
9) Press “Up arrow key” or “Down arrow key”, move to the folder 

that you want to change. 
10) Press “Tab”, move to “Rename folder”. 
11) Press “Enter”. 
12) It will show “Mailbox name:” 
13) Type the mailbox name that you want to change. 
14) Press “Enter. Or press “Tab” move to “Confirm” and press 

“Enter”. 
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If you attempt to rename the “inbox” and “storagebox,” you will hear the 
warning sound to notify you of the error. 
 
8.5 Use the Tools Menu 
 
You can set path and option of the “E-mail”.  
 
The “Tools” menu has the following four sub menus: 
1. Accounts manager 
2. Set path 
3. Set options 
4. Set spam 

 
Each sub menu except the “Accounts manager” will be explained in 
detail in this section. 
 
8.5.1 Set Path 
 
“Set Path” sets the default download path where file attachments and 
email are stored. You can set the download path using the following 
method: 
 
“Set Path” sets the default download path where file attachments and 
email are stored.  You can set the download path using the following 
method: 
 

1) Press “Alt” to call up the “E-mail” menu in the “Inbox.” 
2) Press “Down arrow key”, move to the “Tools”. 
3) Press “Enter.”  
4) It will show “Accounts manager”. 
5) Press “Down arrow key”, move to “Set Path.” 
6) Press “Enter” on “Set Path.”   
7) It will show “Save attachments path: /flashdisk/download”. You 

can move to this stage by pressing “Ctrl-p”, without calling the 
menu. 
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“Set Path” contains the following three items: 
1. Save attachments path 
2. Send attachments path 
3. Disk to save mail in 
 
You can move among these items by pressing “Down arrow key” and 
“Up arrow key.” Each item consists of “Path,” “Modify,” and “Close.” At 
“Path,” the default path will be displayed. You can move among this 
information by pressing “tab” or “shift-tab.” 
 
“Set Path” will be closed if you press “ESC” or “Alt-F4”. Or, you can close 
it by pressing enter on the “Close” button. 
 
8.5.1.1 Set the Save Attachments Path 
 
The default path for downloaded attached files is “/flashdisk/download.”   
You can set the download path using the following method: 
 

1) Press “Alt” to call up the “E-mail” menu in the “Inbox.” 
2) Press “Down arrow key”, move to the “Tools”. 
3) Press “Enter.”  
4) It will show “Accounts manager”. 
5) Press “Down arrow key”, move to “Set Path.” 
6) Press “Enter” on “Set Path.”   
7) It will show “Save attachments path: /flashdisk/download”. You 

can move to this stage by pressing “Ctrl-p”, without calling the 
menu. 

8) Press “Enter” on “Save attachments path: /flashdisk/download,” 
or press “m.”  Or, press “Tab” to move to the “Modify” button, and 
then press “Enter.” 

9) It will show “download folder xx/yy”. 
 
Move to the desired folder by pressing move keys below: 
Move to the upper level folder:  Backspace 
Move to the previous item:  Up arrow key 
Move to the next item:  Down arrow key 
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10) When you encounter the desired folder, press “Space” to select 
it, and then press “Enter.”  

 
If you press “Enter” to set the path, the Voice Sense QWERTY will show 
the changed path. If you changed the path to the “My Documents” folder 
that is one of the lower level folders located in “flashdisk,” “Save 
attachments path: /flashdisk/My Documents” would be displayed. 
 
8.5.1.2 Set the Send Attachments Path 
 
“Send attachments path” is the path where the files to be attached are 
saved.  The default path is “/flashdisk/upload.”  You can change this 
path to a different path using the following method: 
 

1) Press “Alt” to call up the “E-mail” menu in the “Inbox.” 
2) Press “Down arrow key”, move to the “Tools”. 
3) Press “Enter.”  
4) It will show “Accounts manager”. 
5) Press “Down arrow key”, move to “Set Path.” 
6) Press “Enter” on “Set Path.”   
7) It will show “Save attachments path: /flashdisk/download”. 
8) Press “Down arrow key”, move to “Send attachments path: 

/flashdisk/upload.” 
9) Press “Enter” or “m” on “Send attachments path: 

/flashdisk/upload.” Or, press “Tab”, move to the “Modify” button 
and then press “Enter.” 

10) It will show “upload folder xx/yy”  
 
Move to the desired folder by pressing the following keys: 
Move to the upper level folder:  Backspace 
Move to previous item:  Up arrow key 
Move to next item:  Down arrow key 
 

11) Press “Space” to select the desired folder, and press “Enter.”   
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If you finish setting the path by pressing “Enter,” the Voice Sense 
QWERTY will show the changed path. If you changed the path from the 
“upload” folder to the “music” folder in the “flashdisk,” it would display 
“Send attachments path: /flashdisk/music.” 
 
8.5.1.3 Set the Disk to save E-mail 
 
The e-mail messages that are downloaded from your network are saved 
in the “Email” folder, which is a lower level folder of “flashdisk.” If the size 
of an email you are receiving is so large that it cannot be downloaded 
and stored in the “flashdisk,” you can change to a different disk using the 
following method: 
 

1) Connect the external storage disc to the Voice Sense QWERTY. 
2) Press “Alt” to call up the “E-mail” menu in the “Inbox.” 
3) Press “Down arrow key”, move to the “Tools”. 
4) Press “Enter.”  
5) It will show “Accounts manager”. 
6) Press “Down arrow key”, move to “Set Path.” 
7) Press “Enter” on “Set Path.”   
8) It will show “Save attachments path: /flashdisk/download”. 
9) Press “Down arrow key”, move to “Disk to save mail in: 

/flashdisk.” 
10) Press “Enter” or “m” on “Disk to save mail in: /flashdisk.” Or, 

press “Tab”, move to the “Modify” button, and press “Enter.” 
11) It will show “flashdisk”.   
12) Press “Down arrow key” or “Up arrow key”, move to the disk list. 

If you have connected a USB memory stick, it will show “USB” 
(stick memory). 

13) Press “Enter” on the desired disk name. 
 
It will show the disk name if the disc setting is completed by pressing 
“enter.” If you changed it to “USB memory,” it will show “Disk to save 
mail in: /USB.” If it is changed, the “Email” folder will be created 
automatically in the selected disc, and the e-mail messages will be 
downloaded in this disk. 
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8.5.2 Set Options 
 
In “Set Options”, you can set the “Inbox” with default folder when the “E-
mail program is started and save mail copies in “Sent” folder. 
 
8.5.2.1 Using the “Inbox” with Default Folder 
 
If you set the “Inbox” with default folder, it will move to list of “Inbox” 
whenever the “E-mail” program is started.  
 
In order to use the “Inbox” with default folder, follow these stets: 

1) Execute “E-mail”. 
2) Press “Alt” to call up the “E-mail” menu in the “Inbox.” 
3) Press “Down arrow key”, move to the “Tools”. 
4) Press “Enter.”  
5) It will show “Accounts manager”. 
6) Press “Down arrow key”, move to “Set Options”. 
7) Press “Enter” on the “Set Options”. Or without calling the menu, 

press “Ctrl-o”. 
8) It will show “Use inbox as default mailbox when starting:  Yes”. 

If you don’t Use inbox as default mailbox, press “Space”.  
9) Press “Enter”.  

 
If you want to cancel this function, press “ESC” or “Alt-F4”. 
 
8.5.2.2 Saving Mail Copies in Sent Folder 
 
When you success sending e-mail, you can save mail copies in “Sent 
Item” folder or not.   
 
In order to save mail copies in sent folder, follow these steps: 
 

1) Execute “E-mail”. 
2) Press “Alt” to call up the “E-mail” menu in the “Inbox.” 
3) Press “Down arrow key”, move to the “Tools”. 
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4) Press “Enter.”  
5) It will show “Accounts manager”. 
6) Press “Down arrow key”, move to “Set Options”. 
7) Press “Enter” on the “Set Options”. Or without calling the menu, 

press “Ctrl-o”. 
8) It will show “Use inbox as default mailbox when starting: Yes”. 
9) Press “Tab”.  
10) It will show “Saving mail copies in sent folder? Yes”. If you don’t 

save mail copies in sent folder, press “Space”. 
11) Press “Enter”. 

 
If you want to cancel this function, press “ESC” or “Alt-F4”. 
 
 
8.5.3 Spam Settings 
 
When the Voice Sense QWERTY downloads e-mail from the e-mail 
server, there may be a lot of e-mail messages that are spam. In this 
case, you can avoid downloading these spam e-mail messages by 
registering specified words in the subject or the specified e-mail address. 
 
The spam e-mail messages that are set at “Spam Settings” will not be 
downloaded into the Voice Sense QWERTY, and will remain on the e-
mail server. 
Use the following steps to set up spam e-mail: 
 

1) Press “Alt” to call up the menu while you are in the “inbox.” 
2) Press “Down arrow key”, move to the “Tools”. 
3) Press “Enter.”  
4) It will show “Accounts manager”. 
5) Press “Down arrow key”, move to ““Spam Settings”. 
6) Press “Enter.”  
7) It will show “Type: Subject 1/3”. Without calling the menu, you 

can also execute to this stage directly by pressing “Ctrl-e”. 
 
Now, you are in the “Spam Settings” menu. 
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“Spam Settings” contains the following 6 items; 
 
1. Type 
2. List 
3. Add 
4. Modify 
5. Delete 
6. Close 
 
You can move among the items by pressing “Tab” or “Shift-Tab.”   
 
In order to exit from “Spam Settings,” move to the “Close” button and 
press “enter,” or press “ESC” or “Alt-F4”. “Type” consists of 3 sub items; 
“Subject,” “E-mail address string,” and “Host.” You can move among 
these sub items by pressing “Up arrow key” or “Down arrow key.” The 
“list” will be displayed in a different form according to the sub item of the 
“Type.” 
 
If you have selected “Subject,” the list will be displayed as “Subject: 
(Registered word) 1/xx.” If you selected “E-mail address string,” it will be 
displayed as “E-mail address string: (Registered e-mail address string) 
1/xx.” It will be displayed as “no items 0/0” if there is no registered word 
or e-mail address string. 
 
Now we will explain how to register, modify, and delete the spam 
settings. 
 
8.5.3.1 Add As Spam E-Mail 
 
First, we will explain how to set the e-mail program to sort out spam by 
setting any specified words in the e-mail subject.   
 

1) Press “Alt” to call up the menu while you are in the “inbox.” 
2) Press “Down arrow key”, move to the “Tools”. 
3) Press “Enter.”  
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4) It will show “Accounts manager”. 
5) Press “Down arrow key”, move to ““Spam Settings”. 
6) Press “Enter.”  
7) It will show “Type: Subject 1/3”. Without calling the menu, you 

can also execute to this stage directly by pressing “Ctrl-e”. 
8) Press “a” when “Type: Subject 1/3” is displayed.  Or, press 

“Tab” to move to the “Add” button, and then press “enter.” 
9) Then, the “add dialog box” will be opened and “Subject add:” will 

be displayed. 
10) Type in the words, and press “Enter.”  Or, press “Tab” to move 

to the “Confirm”, and then press “enter” after you type in the words. 
11) Then, “Successfully added spam data.” will be announced and 

you will be returned to the “list.” Then, “Subject: (registered word) 
1/1” will be displayed. 

 
If there is more than one registered word, you can check it by pressing 
“Up arrow key” or “Down arrow key.” 
By adding the word as explained above, if there are any e-mail 
messages that include the words you entered in the subject of the 
message, the Voice Sense QWERTY will download those e-mails from 
the e-mail server, but will delete them automatically. So those e-mails 
will not be in the inbox. 
 
You can also avoid receiving e-mail messages from a specific sender or 
host by registering it. 
 
The following are the steps to register a sender’s e-mail address: 
 

1) Press “Alt” to call up the menu while you are in the “inbox.” 
2) Press “Down arrow key”, move to the “Tools”. 
3) Press “Enter.”  
4) It will show “Accounts manager”. 
5) Press “Down arrow key”, move to ““Spam Settings”. 
6) Press “Enter.”  
7) It will show “Type: Subject 1/3”. Without calling the menu, you 

can also execute to this stage directly by pressing “Ctrl-e”. 
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8) Press “Down arrow key” when “Type: Subject 1/3” is displayed.  
Then, “Type: E-mail address string 2/3” will be displayed. 

9) Press “a” or press “tab” to move to the “Add” button, and press 
“enter.” 

10) Then, the “Add dialog box” will be opened, and “E-mail address 
string: (e-mail address)” will be displayed. The “(e-mail address)” 
is the sender’s e-mail address that was focused. 

11) Press “Enter” on “E-mail address sting: (e-mail address).” Or, 
press “Tab” to move to the “Confirm”, and then press “Enter.” 

12) Then, “Successfully added spam data” will be announced and 
“E-mail address string: (Registered e-mail address) 1/1” will be 
displayed. 

 
If you set it once, the e-mails with the e-mail ids will be downloaded from 
the e-mail server, but the Voice Sense QWERTY will delete those e-
mails automatically. So those e-mails will not be found in the inbox. 
 
You can add an additional e-mail address by modifying the e-mail 
address that you have typed in. If you type in a new e-mail address at 
“E-mail address string: (e-mail address),” the displayed e-mail address 
will be erased, and the new e-mail address will be displayed.  
When “E-mail address string: (registered e-mail address) 1/1” is 
displayed, you can add it by pressing “a” or pressing “Tab” to move to 
the “Add, and press “Enter.” You can check the registered e-mail 
addresses by pressing “Up arrow key” or “Down arrow key.” 
 
If you want to register a specific host as a spam sender, do the following: 
 

1) Press “Alt” to call up the menu while you are in the “inbox.” 
2) Press “Down arrow key”, move to the “Tools”. 
3) Press “Enter.”  
4) It will show “Accounts manager”. 
5) Press “Down arrow key”, move to ““Spam Settings”. 
6) Press “Enter.”  
7) It will show “Type: Subject 1/3”. Without calling the menu, you 

can also execute to this stage directly by pressing “Ctrl-e”. 
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8) Press “Down arrow key” when “Type: Subject 1/3” is displayed in 
order to move to “Type: Host 3/3.” 

9) Press “a” on “Type: Host 3/3,” or press “Tab” to move to the 
“Add” button, and then press “Enter.” 

10) Then, the “Add dialog box” will be opened, and “Host add: (host 
address)” will be displayed. Here, “host address” is the host 
address that was focused on when you executed this command. 

11) Press “Enter” on “Host add: (host address).” Or, press “tab” to 
move to the “Confirm” button, and then press “enter.” 

12) Then, the Voice Sense QWERTY will say “Successfully added 
spam data” and it will show “Host: (registered host address) 1/1.” 

 
If you add the host address as above, the e-mails from the registered 
host will be downloaded from the e-mail server, but the Voice Sense 
QWERTY will delete them automatically. So those e-mails will not be 
found in the inbox. 
 
When “Host: (registered host address) 1/1” is displayed, you can add it 
by pressing “a” or pressing “Tab” to move to the “Add” button, and then 
press “Enter.” You can check the registered host addresses by pressing 
“Up arrow key” or “Down arrow key.” 
 
When you register a subject, e-mail address, or host as spam e-mail, 
you may make a mistake while you are typing in a subject, e-mail 
address, or host. In this case, you need to modify the subject while 
typing them in. 
 
Please refer to the following correction methods: 
 
1. In order to delete the current letter, press “Del” 
2. In order to delete the previous letter, press “Backspace.” 
3. In order to delete the current line, press “Ctrl-Backspace.” Then, 

“Delete line: yes” will be displayed. Press “enter” to delete the line.  
Or, if you do not want to delete the line, press “Space” to toggle “Yes” 
to “No,” and then press “enter.” 
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If you want to cancel setting spam at the “Add dialog box,” press “Tab” to 
move to the “Cancel” button, and press “Enter.” Or, just press “ESC” or 
“Alt-F4”. 
 
8.5.3.2 Modifying Spam Registration 
 
In order to modify a “Subject” that has been registered, do the following: 
 

1) Press “Alt” to call up the menu while you are in the “inbox.” 
2) Press “Down arrow key”, move to the “Tools”. 
3) Press “Enter.”  
4) It will show “Accounts manager”. 
5) Press “Down arrow key”, move to ““Spam Settings”. 
6) Press “Enter.”  
7) It will show “Type: Subject 1/3”. Without calling the menu, you 

can also execute to this stage directly by pressing “Ctrl-e”. 
8) Move to “list” by pressing “tab.”  Then, “Subject: (Registered 

word) 1/xx” will be displayed. 
9) Press “Down arrow key” or “Up arrow key” to move to the word 

to be modified. 
10) Press “m” on the word to be modified.  Or, press “tab” to move 

to the “Modify” button, and press “enter.” 
11) Then, the modify dialog box will be opened, and “Subject modify: 

(selected word)” will be displayed. 
12) If you type in a new word directly, the displayed word will be 

erased, and the new word will be displayed.   
13) Press “enter” after you type in the new word.  Or, press “tab” to 

move to the “Confirm” button, and then press “enter.” 
14) Then “Successfully modified spam data.” will be announced, and 

you will be returned to the “list.” If there is more than one word in 
the list, you can look them up by pressing “Down arrow key” or “Up 
arrow key.” 

 
If you want to modify the e-mail addresses or host addresses that have 
been registered, execute step 1 above. Press “Down arrow key” to move 



197 
 

to “Type: E-mail address string 2/3” and “Type: Host 3/3.”  You can 
modify them with the same method as explained above. 
 
If you want to cancel registration, press “Tab” to move to the “Cancel” 
button, and press “enter.” Or, you can press “ESC” or “Alt-F4”. 
 
8.5.3.3 Deleting Spam 
 
You can delete an item that has been registered in the spam list.   
Let’s start our explanation from “Subject.” 
 

1) Press “Alt” to call up the menu while you are in the “inbox.” 
2) Press “Down arrow key”, move to the “Tools”. 
3) Press “Enter.”  
4) It will show “Accounts manager”. 
5) Press “Down arrow key”, move to ““Spam Settings”. 
6) Press “Enter.”  
7) It will show “Type: Subject 1/3”. Without calling the menu, you 

can also execute to this stage directly by pressing “Ctrl-e”. 
8) Press “tab” to move to the “list.”  Then, “Subject: (Registered 

word) 1/xx” will be displayed. 
9) Press “Down arrow key” or “Up arrow key” to delete the 

registered word. 
10) Press “Del” to delete the selected word.  Or, press “tab” to 

move to the “Delete” button, and press “enter.” 
11) Then, “Successfully deleted” will be announced and “list” will 

show again.  You can check the remaining words by pressing 
“Down arrow key” or “Down arrow key.” 

 
You may delete an “E-mail address string” or “Host” in the spam list, too. 
Press “Down arrow key” to move to “Type: E-mail address string 2/3” or 
“Type: Host 3/3,” and execute. The method is the same as explained 
above. 
 
8.6. Hot Keys for E-Mail 
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1. Hot Keys That Are Used in the Inbox 
Call “Accounts manager”: Ctrl-m  
Check for new mail: Alt-m 
Write new message: Ctrl-n 
Reply: Ctrl-r 
Reply all: Alt-r 
Forward: Ctrl-f 
Call up “set path”: Ctrl-p 
Call up “set option”: Ctrl-o 
Call up “set spam”: Ctrl-e 
Find: Ctrl-Shift-f 
Find again: F3 
Move to unread message: Ctrl-u 
Move to mailbox: Alt-x 
Copy to mailbox: Alt-c 
Add a sender to the address list: Ctrl-i (This is valid only at the “from” 
item of the “inbox”). 
Delete received e-mail: Del (It is valid only at the “Subject” and “date” 
item in the “inbox”). 
Save the received e-mail as text file: Alt-s 
Print the received e-mail: Alt-p 
Cancel: ESC 
Cancel and exit from e-mail program: Alt-F4 
 
2. Hot Keys for Sending E-Mail Including Reply, Forward, and Save in 
the Mail Outbox 
Search address list: Ctrl-l 
Attach file: Ctrl-f 
Send e-mail: Ctrl-s 
Save mail in Outbox: Fn-s 
Cancel: ESC 
Cancel and exit from e-mail program: Alt-F4 
 
3. Hot Keys for Reading E-Mail Messages or Writing an E-mail Message 
Start selection: Ctrl-b 
Select all: Ctrl-a  
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Copy to the clipboard: Ctrl-c  
Cut to the clipboard: Ctrl-x (It is not valid when you are reading e-mail in 
the “inbox”). 
Paste from the clipboard: Ctrl-v (It is not valid when you are reading e-
mail in the “inbox”). 
Delete: Del (It is not valid when you are reading e-mail in the “inbox”). 
Cancel block: ESC 
Check Spelling: Ctrl-k (It is not valid when you are reading e-mail in the 
“inbox”) 
Open mail with web-browser: Alt-o 
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9. Media Player 
 
The Media Player on the Voice Sense QWERTY is a program which you 
can use to play audio files. The Media Player will play the following 
formats, ac3, asf, asx, m3u, mp2, mp3, mp4, mpa, mpg, ogg, pls, wav, 
wax, wma, flac and wmv. Note that you will not be able to see the video 
with “avi” and “wmv” files. 
 
You can control the playing of audio files using either the keyboard 
commands or audio keys that are on the front panel of the Voice Sense 
QWERTY. The Media Player can play back recorded voices as well as 
music files. 
 
9.1 Using the Audio Buttons 
 
There are a series of buttons on the front panel of the Voice Sense 
QWERTY. These buttons can be used to control the Media Player. You 
will find five buttons on the Voice Sense QWERTY. Starting from the left, 
and going to the right, the buttons are called: “previous,” “record,” “stop,” 
“play/pause,” and “next.” These buttons are used for playing and 
recording music or voice quickly and easily. 
 
If the “play/pause” button is pressed while you are using a program other 
than the Media Player, the Voice Sense QWERTY will play the files in 
the play list. If there are no files in the play list, the Voice Sense 
QWERTY says, “There are no items to display.”The other buttons, 
“previous,” “stop,” and “next” are available after you start playing audio 
by pressing the “play/pause” button.  
Even if the Media Player starts when you press the “play/pause” button 
while you are using another program, the Voice Sense QWERTY will not 
stop the program that is currently running. 
 
9.1.1 Play/Pause Button 
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The “play/pause” button has a long, rectangle shape. To locate the 
“play/pause” button, find the button that is furthest to the right on the 
front panel. Then, move one button to the left. This is the “play/pause” 
button. With the “play/pause” button, you can easily play audio files 
registered in the play list. If there are no files that have been registered 
in the play list, the Voice Sense QWERTY will display the message, 
“There are no items to display.” You have to add a file to the play list 
before it can be played. There is a detailed explanation on how to add 
files to the play list in section 9.2.2. If there is more than one file in the 
play list when you press the “play/pause” button, the Voice Sense 
QWERTY will start playing all the files in the list one after another. If you 
press the “play/pause” button again while a file is being played, the 
playback will be paused. If you want to resume playing, press the button 
again. If you press the “play/pause” button while you are in the “record” 
dialog box, the sound that was recorded most recently will be played 
back to you. 
 
9.1.2 Next button and previous button 
 
These buttons have a triangular shape. The “previous” button is the first 
button from the left on the front panel, and it points to the left. The “next” 
button is the button that is farthest to the right on the front panel, and it 
points to the right. If you press the “next” button, the next file in the play 
list will be played, and pressing the “previous” button will play the 
previous file. If you press one of these buttons while an audio file is 
being played, the Voice Sense QWERTY will stop playing the current file, 
and jump to the previous or next file (depending on which button you 
press) in the play list, and start playing it. If you press the “next” button 
(while the last file in the list is being played), or the “previous” button 
(while the first file in the list is being played), it will have no effect, as the 
Voice Sense QWERTY will not stop playing the current file. 
 
9.1.3 Record Button 
 
The “record” button has a circular shape, and is used to record sound 
using the built-in or an external microphone. The “record” button is 
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located directly to the right of the “previous” button. To use this button to 
record sound, you should be either in the “Media Player,” or in the 
“program” menu. If you press the “record” button once, the Voice Sense 
QWERTY will open the “record” dialog box. If you press the “record” 
button again, the Voice Sense QWERTY will resume recording.  When 
you press the “record” button while you are recording, the Voice Sense 
QWERTY will pause your recording. You can resume the recording by 
pressing the “record” button again. The recorded sound will be stored in 
a file, and placed in the “flashdisk/media/record” folder.  See section 
9.3.3 for more information about recorded files. 
 
9.1.4 Stop Button 
 
The “stop” button has a square shape, and is used to stop playing. If you 
press the “stop” button while an audio file is being played, the Voice 
Sense QWERTY will stop playing. The next time the Voice Sense 
QWERTY starts playing, it will start from the first file in the play list.  If 
you press this button while recording, the Voice Sense QWERTY will 
stop recording. If you press the “stop” button in “record” dialog box while 
the Voice Sense QWERTY is not recording, the dialog box will close. 
 
9.1.5 Using the Audio buttons in file open dialog box 
 
You can open “Open File” dialog box by long pressing “stop” button in 
the “Media player” dialog box. And if you long press the “stop” button 
again, this dialog box will close. And then return to the “Media player” 
dialog box. 
“play/pause” button is same function as “Enter” in “Open File” dialog box. 
Also “stop” button, “record” button, “previous” button and “next” button is 
same function as “Backspace”, “Space”, “Up arrow key”and “Down arrow 
key”in “Open File” dialog box.  
Namely, you can move to up and down by pressing “previous” and “next” 
button in file list. And you can select and unselect by pressing “record” 
button. If you press “stop” button, you can move to upper folder. And if 
you press “play/pause” button, you can play the selected file in file list of 
“Open File” dialog box. 
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In order to use this function, you must set the audio mode switch to 
“media mode.” 
 
9.2 Keyboard and Extended Keys 
 
You can use more of the features in the “Media player” with the 
keyboard than with the audio buttons. You can use the keyboard 
commands to control the player in the “Media player” dialog box. To 
open the “Media player,” press “Enter” on “Media player,” or press “m” in 
the “program menu.” The “Media player” is also opened when you play 
audio files by pressing the “play/pause” button on the front panel of the 
Voice Sense QWERTY. This dialog box contains two information tabs: 
“playback information” and “play list.” Press “Tab” or “Shift-tab” to move 
between these tabs. A detailed explanation of these tabs follows in 
sections 9.2.1, 9.2.2, and 9.2.3. 
 
9.2.1 Playback Information Tab 
 
The “playback information” tab displays the track number, the file name, 
and the current playback status such as (play, pause, or stop). If there 
are no files in the play list, the Voice Sense QWERTY will display “Title: 
There are no items to display.” If you press “Down arrow key,” the Voice 
Sense QWERTY will display playback time information.   
First, the elapsed or remaining time will be displayed. You can set 
whether the elapsed time or remaining time will be displayed, using the 
“playback settings” dialog box as explained in section 9.3.6.2. If you 
have selected the “Remaining time” with this option, the - (minus sign), 
will be displayed before the time. Next to the elapsed/remaining time, the 
Voice Sense QWERTY will display the total playback time of the 
currently selected file. 
If there are no files in the play list, “Time: There are no items to display” 
will be displayed. 
 
9.2.2 Play List Tab 
 
The “play list” tab displays all the files in the play list. For each file in the 
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play list, it displays the track number, file name, the current place of the 
file in the list, and the total number of files in the list. If there is no file in 
the play list, the Voice Sense QWERTY will display the message “no 
items.” 
  
For example, if you had the following track on the Voice Sense 
QWERTY: “Track 1 Chopin – Fantasie Impromptu 1/10,” then “Track 1” 
means this file is the first item in the play list. “Chopin – Fantasie 
Impromptu” is the file name. “1/10” means the file is the first of ten files 
in the play list. Whenever you register an audio file using the “File” menu 
(as explained in section 9.3.1), the file is added to the play list. 
 
9.2.3 Hot Keys in the Play Information Tab and the Play List 
Tab 
 
The hot keys that can be used in the “playback information” and the 
“play list” tabs are as follows: 
 

1) Hot keys in the Play Information Tab 
 

Hot key Function 
Down arrow key Move to the next information 
Up arrow key Move to the previous 

information 
Space “Pause” when it is play state 

and “play” when it is pause 
state. 

X or Enter Start playing 
C or Backspace Stop playing 
B or Alt-Right arrow key Play the next file 
Z or Alt-Left arrow key Play the previous file 
Ctrl-Fn-Right arrow key Play the last file 
Ctrl-Fn-Left arrow key Play the first file 
Alt-Down arrow key Play the fifth file after the 

current file 
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Alt-Up arrow key Play the fifth file before the 
current file 

Ctrl-Right arrow key Move to next position by time 
index and play 

Ctrl-Left arrow key Move to previous position by 
time index and play 

Ctrl-Up arrow key or Ctrl-
Down arrow key 

Change time index 

Shift-Left arrow key Speed up 
Shift-Right arrow key Slow down 
Shift-Up arrow key Volume up 
Shift-Down arrow key Volume down 
Alt Open menu 
F1 Open help 
Tab/Shift-tab  Move to “play list” tab 
Alt-F4 Exit “Media player” 
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2) Hot Keys in the Play List Tab 
 

Hot key Function 
Down arrow key Move to the next file 
Up arrow key Move to the previous file 
Fn-Right arrow key Move to the last file 
Fn-Left arrow key Move to the first file 
Space Select/resume current file 

(while playing, it is used as 
play/pause) 

Ctrl-b Start selecting files 
Enter Start playing the selected files 
Backspace Stop playing 
Del Delete the selected files in the 

play list 
Alt-Right arrow key Play the next file 
Alt-Left arrow key Play the previous file 
Ctrl-Fn-Right arrow key Play the last file 
Ctrl-Fn-Left arrow key Play the first file 
Alt-Down arrow key Play the fifth file after the 

current file 
Alt-Up arrow key Play the fifth file before the 

current file 
Ctrl-Right arrow key Move to next position by time 

index and play 
Ctrl-Left arrow key Move to previous position by 

time index and play 
Ctrl-Up arrow key Change time index 
Shift-Left arrow key Speed up 
Shift-Right arrow key Slow down 
Shift-Up arrow key Volume up 
Shift-Down arrow key Volume down 
Alt Open menu 
F1 Open help 
Tab/Shift-tab Move to “playback information” 
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tab 
Alt-F4 Exit “Media player” 

 
9.3 How to Use the Media Player Menu 
 
When you want to open the “Media player” menu, you can press “Alt.” 
This menu contains five items: “File,” “Play,” “Record,” “Position,” “Mark” 
and “Settings.” Using the “File” menu, you can add or delete files in the 
play list. The “Play” menu lists all of the commands related to playing 
files. The “Record” menu opens the “Record” dialog box in which allows 
you to record sound and play it. The “Position” menu contains 
commands related to bookmark and go to position. The “Settings” menu 
allows you to set various Media Player options. A detailed explanation for 
each menu can be found in the section 9.3. 
 
9.3.1 File 
 
When you want to use the “File” menu, you can press “Alt” to call up the 
“Media player” menu, and then press “Enter” on “File,” or press “f”. A 
submenu will appear, which contains “Open File,” “Open Folder,” “Add 
File,” “Add Folder,” “Save Playlist,” “Save as Playlist,” “Delete Item,” 
“Open URL” and “Exit.” You can move between these items by pressing 
“Down arrow key” or “Up arrow key”. Press “Enter” on the item you want 
to execute. If you want to go back to the menu that is one level up, you 
can press “ESC.” Then press, “Alt-F4.” which will close the menu, and 
take you back to the “Media player” dialog box. 
 
9.3.1.1 Open File 
 
You can use the “Open File” menu item to add files to the play list and 
start playing. If you press “Enter” on “Open File,” a dialog box will open, 
just like the “file list” in the “File manager.” You can navigate through the 
file list just like you do in the “file list” in the “File manager.” The audio 
files that can be played in the “Media player” are files that have the 
extensions, ac3, asf, asx, m3u, mp2, mp3, ogg, pls, wav, wax, wma, flac 
and wmv. If you select all the files you want to play, and press “Enter,” 
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the Voice Sense QWERTY will register the files in the play list, and start 
playing the first file. You can select more than one file in the “Open File” 
dialog box by pressing “Space” on the file you want to play, and then 
move to another file to be played, and press “Space.” Once you finish 
selecting all the files you want, press “Enter.” When you open the “Open 
File” dialog box, files in the default folder will be displayed. The default 
folder is set to “/flashdisk/media.” You can also open the “Open File” 
dialog box by pressing “Ctrl-o” in the “Media player” dialog box 
9.3.1.2 Open Folder 

 
This “Open Folder” menu item is used to select all of the audio files in 
the selected folders to the play list and play them one after another.  
 

1) If you press “Enter” on “Open Folder” in “File” menu. Or press 
“Ctrl-f” in the “Media player” dialog box.  

2) “Open Folder” dialog box will be opened. The “Open Folder” dialog 
box is almost the same as the “Open File” dialog box. The 
difference is that only folder names, and not file names will be 
displayed in the “Open Folder” dialog box.  

3) When you open the “Open Folder” dialog box, the default folder 
name will be displayed. The default folder is set to “media folder” 
in “Flashdisk.”  

4) Using “Up arrow key” or “Down arrow key”, move into the folder 
that you want to play. 
■ When you want to move into the folder of “External memory”: 

Using the “Backspace”, move to disk. Move to folder that you 
want to change. 

5) Pressing “Space”, select a folder. 
6) Press “Enter”. 

 

Then, the Voice Sense QWERTY will add all of the audio files, with the 
extensions, “wav,” “mp3,” and “wma,” from the selected folders to the 
play list and start playing the first file. 
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9.3.1.3 Add File 
 
The “Add File” menu item is used to add audio files to the play list. If you 
press “Enter” on “Add File” in the “File” menu, or press “Alt-o” in the 
“Media player” dialog box, the same dialog box that is used for “Open 
File” will be displayed. If you select all of the files that you want, and 
press “Enter” (as in the “Open File” dialog box), then the Voice Sense 
QWERTY will add the selected files to the play list. However, the Voice 
Sense QWERTY will not start playing these files. If you want to start 
playing the files in the play list, press the “play/pause” button on the front 
panel of the Voice Sense QWERTY. Or, you can press “Enter” on “play” 
in the “play” menu. A detailed explanation of the “play” menu can be 
found in section 9.3.2. 
 
9.3.1.4 Add Folder 

 
The “Add Folder” menu item is used to add all of the audio files in a 
selected folder to the play list.  
 

1) Press “Alt” to call up the “Media player” menu.  
2) Then press “Enter” on “File” menu or press “f”. 
3) Using “Down arrow key” or “Up arrow key”, you press “Enter” on 

“Add Folder”. Or press “Alt-f” in the “Media player” dialog box, the 
same dialog box that is used for “Open Folder” will be displayed.  

4) If you select all of the folders, and press “Enter,” the Voice Sense 
QWERTY will add all of the audio files in the selected folders to 
the play list. However, it will not start playing any files. You can 
start playing the files in the play list by pressing the “play/pause” 
button on the front panel of the Voice Sense QWERTY, or press 
“Enter” on “play” in the “play” menu. A detailed explanation of the 
“play” menu can be found in section 9.3.2. 

 
9.3.1.5 Save play list 
 
The “Save Playlist” menu item is used to save the play list to a disk drive.  
If you want to use this function, you can press “Alt” to open the “File” 
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menu and execute the “Save Playlist” command by pressing “Enter” on it, 
or you can press “s”. Otherwise, you can press “Ctrl-s” in the “Media 
player” dialog box. 
 
If you activate the “Media player” program and first execute “Save 
Playlist,” the “Save as Playlist” dialog box will open. You can refer to 
section 9.3.1.6 that explains how to use the “Save as Playlist” dialog box. 
 
If you execute “Save Playlist” after you save the play list for once, the 
Voice Sense QWERTY will save the play list with the same file name 
without using a dialog box. After saving a play list, it will return to “Media 
player” dialog box. 
 
9.3.1.6 Save as play list 

 
The “Save As Playlist” menu item is used to save the play list as a 
different file or on another disk drive. If you want to use this function, you 
can press “Alt” to open the “File” menu and execute the “Save as 
Playlist” command by pressing “Enter” on it, or you can press “l”. 
Otherwise, you can press “Alt-s” in the “Media player” dialog box.  
 
If you execute “Save as Playlist,” “Save as Playlist” dialog box is 
displayed. This dialog box consists of “file list,” “File name,” a “Confirm” 
button, and a “Cancel” button. If the dialog box is opened, “File name:” is 
displayed. You can move from one tab to the other tab by pressing 
“tab”or “shift-tab”. 
The file format of saved play list is always the “m3u.” By default, file is 
saved in “/flashdisk/media.” 
 
If you want to make a new file name, type in the new file name. You 
cannot use the following characters in a file mane. “|, \, <, >, ?, :, *”. 
If you want to change the saving location, move to the “file list” by 
pressing “shift-tab.” And you move to location that you want to save by 
using the navigation keys in “File manager” program. 
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9.3.1.7 Delete Item 
 
If you want to delete a file from the play list, first, locate the file you want 
to delete in the “play list” tab by pressing “Up arrow key”or “Down arrow 
key”repeatedly. Then, bring up the “Media player” menu by pressing “Alt”, 
and press “Enter” on “File.” Now, move to “Delete Item” by pressing 
“Down arrow key”repeatedly, and then press “Enter.” Or, you can press 
“Del” on the file to be deleted in the “play list” tab. You can select more 
than one file in the “play list” tab by pressing “Space” on each file to be 
deleted. “selected” will be displayed before each selected item. If you 
press “Space” on a selected item, the selection will be canceled and the 
“selected” will disappear. Now, let’s explain how to delete multiple files in 
a block from the play list. Press “Ctrl-b” on the first file to be deleted. 
“Ctrl-b” is the start of the block. Next, if you press “Down arrow key”or 
“Up arrow key,” the displayed files will be selected. After selecting the 
files you want to delete, press “Del” in order to delete them. 
 
9.3.1.8 Open URL 

 
The “Open URL” menu item is used to play the audio stream in web 
page. If you press “Enter” on “Open URL” in the “File” menu, or press 
“Ctrl-u” in the “Media player” dialog box. The dialog box will be displayed. 
In this dialog box, type the web address of audio stream and press 
“Enter,” the audio stream will be automatically played. 
 
9.3.1.9 Exit 

 
You can exit from the “Media player” by selecting “Exit” in the “File” 
menu, or by pressing “Alt-F4” in the “Media player” dialog box. Then, the 
Voice Sense QWERTY will stop playing (if it is playing a file), and exit 
from “Media player” to the “program menu.” 
 
9.3.2 Play 
 
The “Play” submenu has all of the commands that can be used to control 
playback.  
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To use this menu, 

1) Press “Alt” to call up the “Media player” menu.  
2) Press the “Down arrow key”. 
3) The Voice Sense QWERTY will then display “Play (p) pulldown”.  
4) Then, press “Enter,” and the “Play” submenu will be displayed.  
5) You can move to any menu item in this menu by pressing “Down 

arrow key”or “Up arrow key”repeatedly.   
 

To go back to the top level in the “Media player” menu, press “ESC.”  
Press “Alt-F4” if you want to close the menu and go back to the “Media 
player” dialog box. All of the commands that can be used in this menu 
will be explained in this section. 
 
9.3.2.1 Play 

 
If you press “Enter” on “Play,” the Voice Sense QWERTY will start 
playing the files in the play list. Also, if you press “Enter” in the “Media 
player” dialog box, the Voice Sense QWERTY will start playing.  
 
9.3.2.2 Previous Track 

 
“Previous Track” is used to play the previous file, while a file is being 
played. You can also do this by pressing “Alt-Left arrow key” in the 
“Media player” dialog box.  
 
9.3.2.3 Next Track 

 
This item is used to play the next file in the play list, while a file is being 
played. You can also press “Alt-Right arrow key” in the “Media player” 
dialog box to do this. 
 
9.3.2.4 Back 5 Tracks 
 
This is used to play the fifth file before the file that is currently being  
played. You can also press “Alt-Up arrow key” in the “Media player” 



213 
 

dialog box to do this. 
 
9.3.2.5 Forward 5 Tracks 

 
This is used to play the fifth file after the file that is currently being played.  
You can also do this by pressing “Alt-Down arrow key” in the “Media 
player” dialog box. 
 
9.3.2.6 First Track 

 
This is used to play the first file in the play list. You can also do this by 
pressing “Ctrl-Fn-Left arrow key” in the “Media player” dialog box. 
 
9.3.2.7 Last Track  

 
This is used to play the last file in the play list. You can also do this by 
pressing “Ctrl-Fn-Right arrow key” in the “Media player” dialog box. 
 
9.3.2.8 Volume Up and Volume Down 
 
These options are used to adjust the audio playback volume. Here, the 
volume level ranges from 0 to 10. You can also adjust the volume level 
by pressing “Shift-Up arrow key (up)” or “Shift-Down arrow key (down)” 
in the “Media player” dialog box. The actual volume level depends on the 
value of “voice volume” that is set in the “Global options” as explained in 
section 2.4. For example, if “voice volume” is set to 5, and the volume 
level in the “Media player” is set to its maximum 10, the actual volume is 
5. If the volume level in the “Media player” is set to 5, the actual volume 
level is 2.5. 
 
9.3.2.9 Speed Up and Slow down 
 
You can use these controls to adjust the audio playback speed. The 
speed level ranges from 1 to 10. You can also adjust the speed level by 
pressing “Shift-Left arrow key” or “Shift -Right arrow key” in the “Media 
player” dialog box. “Shift -Right arrow key” can increase the audio 
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playback speed, and “Shift-Left arrow key” can decrease the audio 
playback speed. 
 
9.3.2.10 Pause 
 
This item is for pausing playback while you are playing a file. If you use 
this command again, the Voice Sense QWERTY will start playing again 
from the position where it stopped playing. You can also do this by 
pressing “Space” in the “Media player” dialog box.  
 
9.3.2.11 Stop 
 
This is used to stop playing the file that is currently being played. You 
can also do this by pressing “Backspace” in the “Media player” dialog 
box. 
 
9.3.2.12 Previous Section  
 
This is used to play the previous section, while Audible file is being 
played. You can also do this by pressing “Ctrl-Page up (Fn-Up arrow 
key)” in the “Media player” dialog box.  
 
9.3.2.13 Next Section  
 
This is used to play the next section, while Audible file is being played. 
You can also do this by pressing “Ctrl-Page down (Fn-Down arrow key)” 
in the “Media player” dialog box.  
 
9.3.3 Record 
 
This menu item is used to open the “Record” dialog box. To open the 
“Record” dialog box, first, press “Alt” to bring up the “Media player” menu.  
Press “Down arrow key” twice to move to “record (r),”and then press 
“Enter,” or you can press “r.”Then, the Voice Sense QWERTY will 
display the “Record” dialog box. You can also open this dialog box by 
pressing “Ctrl-r” in the “Media player” dialog box. The “Record” dialog 
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box contains an “information” tab and five buttons. You can move 
between these by pressing “Tab” or “Shift-tab”. You can press the 
buttons in this dialog box by pressing “Enter” on the button you want to 
use. You can also press the buttons by typing the character displayed 
after the button name. 
 
9.3.3.1 Record/Playback Information Tab 
 
This tab is displayed only when the Voice Sense QWERTY is recording, 
or when there is a file that has just been recorded. It means that the 
dialog box does not show any information when the Voice Sense 
QWERTY is not recording, or if you exit from the dialog box.  The 
information displayed in this tab includes: a file name, the current status, 
and two pieces of time information. The file name is the name of the file 
containing the sound that is currently being recorded or played.  The 
current status can be one of the following: recording, playing, pause, or 
stop. The time information that is displayed first is the elapsed time while 
recording, and the elapsed or remaining time while playing, (depending 
on the “Display time” setting that is in the “Playback Settings” dialog box, 
which is explained in section 9.3.6.2). The time information that is 
displayed last, when you are recording, is the remaining time. The 
remaining time is limited by the remaining space on your flashdisk. While 
playing, the total length of the file in time will be displayed. You can 
move between time information and other information by pressing “Down 
arrow key”or “Up arrow key.” 
 
9.3.3.2 Record 
 
This is used to start recording. You can also start recording by pressing 
the “Record” button on the front panel of the Voice Sense QWERTY. 
While recording, the Voice Sense QWERTY will display the “recording 
information” tab. Whenever you start recording the Voice Sense 
QWERTY will create a file. The file will be named “record01.mp3,” or 
“record02.mp3” etc. The recorded sound will be saved to that file. These 
files are stored in a special folder. By default, these files are saved in 
“/flashdisk/media/record.” You can change the saving folder and 
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recoding file type by using the “Record Settings” option, which is 
explained in section 9.3.6.3. When recording, you can pause the 
recording by pressing “Tab” to move to the “Pause” button, and then 
press “Enter.” You can also pause by pressing the “record” button on the 
front panel of the Voice Sense QWERTY. If you want to resume 
recording, press “Enter” on the “Continue” button, or press the “record” 
button on the front panel of the Voice Sense QWERTY again. To stop 
recording, press “Tab” repeatedly on “Record” to move to the “Stop” 
button, and then press “Enter.” 
 
9.3.3.3 Play 
 
This button is used to play the file that has just been recorded. You can 
also start playing the recorded sound by pressing the “play” button on 
the front panel of the Voice Sense QWERTY. If you have not yet 
recorded a file after opening the “Record” dialog box, pressing “Enter” on 
the “Play” button will not do anything. While playing, the “playback 
information” tab will be displayed. If you want to pause or stop playing, 
press “Enter” after moving to the “Pause” or “Stop” button by pressing 
“Tab” repeatedly. 
 
9.3.3.4 Stop 

 
This is used to stop recording or playing. If you press “Enter” on “Stop” 
while recording, the Voice Sense QWERTY will stop recording and show 
the “recording information” tab. If you press “Enter” on the “Stop” button 
while playing, the Voice Sense QWERTY will stop playing and show the 
“playback information” tab. You can also stop recording or playing by 
pressing the “stop” button on the front panel of the Voice Sense 
QWERTY. 
 
9.3.3.5 Pause 
 
This item is used to pause the recording or playing a file while in the 
Media Player. If you press “Enter” on “Pause,” or press the “play/pause” 
button on the front panel of the Voice Sense QWERTY, recording or 



217 
 

playing will be paused, and the “recording information” or “playback 
information” tab will be displayed. 
 
9.3.3.6 Continue 
 
If you press “Enter” on “Continue” while the current status is “pause,” the 
Voice Sense QWERTY will resume recording or playing. 
 
9.3.3.7 Cancel 

 
If you press “Enter” on “Cancel,” the Voice Sense QWERTY will stop 
recording or playing, close the “Record” dialog box, and return to the 
“Media player” dialog box. If you press “Enter” on “Cancel” while 
recording, the recorded file will not be saved. If you want to save the 
recorded sound to a file, and exit from this dialog box; press “Enter” on 
“Stop,” and then move to the “Cancel” button, and press “Enter.” You 
can also use “ESC” or “Alt-F4” to cancel. 
 
9.3.4 Position Menu 
 
If you want to set a bookmark and delete a bookmark when you are 
listening to music or an audio file, you can execute the “Position” menu.  
This menu will also let you jump to the time you want to go to in an audio 
file. 
The “Position” menu has four submenus: 
 
1. Mark Position 
2. Delete Marked Position 
3. Jump To Marked Position 
4. Go To Time 
5. Go To Percent 
6. Set Start Point 
7. Release Point 
 
You can move between the menus by pressing “Down arrow key”or “Up 
arrow key.” To execute this menu, press “Enter.” 
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9.3.4.1 Mark Position 

 
If you execute this function when you are playing a file, or when a file is 
paused, a bookmark will be set. A bookmark will mark a specific location, 
so that you can come back directly to the spot where you placed the 
bookmark. 
To execute this function, 
 

1) Press “Alt” and move to “Position” by pressing “Down arrow key”. 
2) Press “Enter” on “Position.” 
3) Move to “Mark Position” by pressing “Down arrow key,” and press 

“Enter.” 
4) Or, press “Alt” when playing a file, or when a file is paused. 

 
If you exit the “Media player” after setting a bookmark, the Voice Sense 
QWERTY asks if you want to save the bookmark. 
 
If you select “Yes,” the Voice Sense QWERTY will save the bookmark, 
at your current position, and play from the bookmark position the next 
time that you execute the Media Player. 
 
If you select “No,” the Voice Sense QWERTY will save the bookmark 
that is already set. If you select “erase,” the Voice Sense QWERTY will 
delete the bookmark that is already set. 
 
9.3.4.2 Delete Marked Position 

 
If you execute this function when you are playing a file, or when a file is 
paused, it will delete the bookmark that was created before. 
To execute this function,  
 

1) Press “Alt” and move to “Position” by pressing “Down arrow key”. 
2) Press “Enter” on “Position.” 
3) Move to “Delete Marked Position” by pressing “Down arrow key,” 

and press “Enter.” 
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4) Or, you can press “Ctrl-d” when playing a file, or when a file is 
paused. 

 
If you execute this function in a file that does not have a bookmark, the 
Voice Sense QWERTY will display “There is no bookmark in selected 
file.” 
 
9.3.4.3 Jump to Marked Position 

 
If you execute this function when you are playing a file, or when a file is 
paused, it will find a bookmark that has already been created. 
To execute this function,  
 

1) Press “Alt” and move to “Position” by pressing “Down arrow key”. 
2) Press “Enter” on “Position.” 
3) Move to “Jump to Marked Position” by pressing “Down arrow key,” 

and press “Enter.” 
4) Or, you can press “Ctrl-j” when playing a file, or when a file is 

paused. 
 
If you execute this function in a file that does not have a bookmark, the 
Voice Sense QWERTY will display “There is no bookmark in selected 
file.” 
 
9.3.4.4 Go to Time 
 
If you execute this function when you are playing a file, or when a file is 
paused, it will move to a time that you specify, and begin playing the file. 
To execute this function,  
 

1) Press “Alt” and move to “Position” by pressing “Down arrow key”. 
2) Press “Enter” on “Position.” 
3) Move to “Go to Time” by pressing “Down arrow key,” and press 

“Enter.” 
4) Or, you can press “Ctrl-g” when playing a file, or when a file is 

paused. 
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5) The Voice Sense QWERTY will display “Go to position: 0 minute.” 
6) Type in time that you want to go, and press “Enter.” If you want to 

jump to more than an hour, you can use “Space” or “:” characters 
to distinguish minute from hour. For example, if you wish to type 1 
hour  and 20 minutes, type the “1”, “Space” or “:”, “20” 
sequentially. Also you can input 80 minutes by just typing “80.” If 
there is no “Space” or “:”, the input value is dealt with the minute. 

 
If you type in a longer time than the total playback time, the Voice Sense 
QWERTY will display “invalid time,” and play from the paused location. 
 
9.3.4.5 Go To Percent 
 
While playing or in a pause status of file, you can move to the location 
via a percent in a file. 
 

1) While playing or in a pause status of file, press “Alt” to call up the 
menu. 

2) By pressing “Up arrow key” or “Down arrow key”, move to 
“Position” menu.  

3) Press “Enter”. Or press “a” 
4) By pressing “Up arrow key” or “Down arrow key”, move to “Go to 

percent” menu. 
5) Press “Enter”. Or without calling up the menu, press “Alt-p” while 

playing or in a pause status of file. 
6) Then it will find the edit box asking “Go to percent: XX”.  
7) Enter the percent that you want to move to. Enter the number 

range from 0 to 99. 
8) Press “Enter”.  

9) It will move to the point of the percent has been entered. 

 
9.3.4.6 Set start point 
 
A B repeat mode allows you to play a specific part of an audio file as 
many times as you wish. This can be useful when learning a new 
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language, and you need to hear the same information in a file over and 
over again. A B repeat mode requires setting start and end point. 
 
To execute A B repeat mode, follow these steps: 

1) To set start point, press the “p” at the point where you want to start 
the section while playing. 

2) Also, press “Alt” and move to “Position” by pressing “Down arrow 
key”.  Press “Enter” on “Position.” Move to “Set start point” by 
pressing “Down arrow key” and press “Enter". 

3) You will hear “Set start point” and the file will keep playing. 
4) To set end point, press “p” at the point where you want to end the 

section. 
 
Also you can execute A B repeat mode by using “Record button” while 
playing. 

1) Press “Record button” at the point where you want to start the 
section while playing. 

2) To set end point, press “Record button” at the point where you 
want to end the section. 

 
But it executes record when you press “Record button” while pause and 
stop. 
 
After “Set end point” message, A B repeat mode allows you to play a 
specific part of an audio file as many times as you wish. To set how 
many times a specified region, go to "playback settings" under the 
"settings" menu. 
 
9.3.4.7 Release point 
 
To release point, press “ESC”. Also, press “Alt” and move to “Position” 
by pressing “Down arrow key”. Press “Enter” on “Position.” Move to 
“Release point” by pressing “Down arrow key” and press “Enter". After 
stop playing specified region, the file will keep playing. 
 
9.3.5 Mark 
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You can insert a mark while listening to music or an audio file. The mark 
function is stored, when you exit the program or play other contents.  
If you wish to use the mark function, after calling the menu by press “Alt” 
and move to “Mark” by press “Down arrow key”. And then press “Enter” 
on “Mark.” 
The “Mark” menu has following submenus. 
 
 
9.3.5.1 Set Mark 

 
If you set to mark while listening to audio file, after calling the menu and 
press “Enter” on “Mark.” And then move to “Set Mark” and press “Enter.” 
Also you can run this function by press “Alt-m” without calling the menu. 
Mark can be inserted up to 1000. The number of the mark will be 
automatically identified. 
 
9.3.5.2 Move to Mark 

 
You can move to next or previous mark by pressing “V” or “N”.  You can 
also move to a mark by using menu. Call up the menu by press “Alt” and 
move to “Mark.” And then press “Enter” on “Mark.” And move to the 
“Previous Mark” or the “Next Mark” and press “Enter.” 
You can also move to a mark by the mark number. 
 

1) Call up the menu and press “Enter” on “Mark”. And then move to 
“Move to Mark.” 

2) Press “Enter” on “Move To Mark.” Or press “Alt-j” without calling 
the menu. 

3) Input the mark number in the edit box of “Move to mark:” and 
press “Enter.” 

4) If you input non-existing mark number, it will show “Move to mark” 
edit box after “Mark xx does not exist” message. 
 
 

9.3.5.3 Delete Mark 
 
You can delete a mark. 
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1) Call up the menu and press “Enter” on “Mark”. And then move to 

“Delete mark.” 
2) Press “Enter” on “Delete Mark.” Or press “Alt-d” without calling the 

menu 
3) Input the mark number which will be deleted in the edit box of 

“Enter mark name to delete:” and press “Enter.” 
4) If you input non-existing mark number, the edit box of “Enter mark 

name to delete:” will be displayed again after “input error.” 
message. 

 
9.3.5.4 Mark Manager 

 
You can open mark manager dialog box to check mark information of 
the current audio file by pressing “Alt-k”. You can also open dialog box 
by using the menu. Call up the menu by press “Alt” and move to “Mark.” 
And then press “Enter” on “Mark.” And move to “Mark Manager” and 
press “Enter.” 
The dialog box consists of “mark list”, “Move button”, “Delete button”, 
“Close button”. You can go to each control by pressing “tab” or “shift-
tab.” 
 
There are all marks of the current file in the “mark list” with information of 
“name of mark: setting time of mark”. You can go to the other 
information in the list by pressing “Up arrow key”or “Down arrow key”.  
You can delete a mark in the list by pressing “Enter” or “Del” after going 
to “Delete button” by pressing “tab.”  
Also, you can play the contents from the specific mark by pressing 
“Enter” on the mark name or by pressing “Enter” after going to “Move 
button” by pressing “tab”. The mark dialog box is closed after playing the 
contents.  
 
If you want to close the mark manager dialog box, press “Enter” on 
“Close” button or press “ESC.” 
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9.3.6 Settings 
 
Through this menu, you can change settings about recording, playing, 
and general Media player options. To use the “Settings” menu, press 
“Alt” to call up the “Media player” menu. Press “Down arrow key”three 
times to reach “Settings,” and then press “Enter.” Or, you can press “s” 
in the “Media player” menu. Then, the “Settings” submenu will appear, 
which contains four items: “Configuration,” “Playback Settings,”  
“Record Settings”, and “Effect settings”. 
 
9.3.6.1 Configuration Dialog Box 

 
If you press “Enter” on the first item, “Configuration,” or press “Alt-c” in 
the “Media player” dialog box, the “Configuration” dialog box will be 
displayed, which contains the following: the “Display title” option, the 
“Store position of file if longer than:”, a “Confirm” button, and a “Cancel” 
button. You can move between controls by pressing “tab”or “shift-tab”. 
And you can move between options by pressing “Up arrow key”or “Down 
arrow key”. 
 
The “Display title” option allows you to set whether or not you can hear 
the track title when you move to previous/next track or transfer to next 
track automatically. If this is set to “On,” you can hear the track title. The 
default value is set to “Off,” namely you can’t hear the track title when 
move to previous/next track. You can change the on or off by pressing 
“Space.” 
 
The “Store position of file if longer than:” option allows you to set the last 
position of audio file which have playing time more than you designated.  
The default is set to “Off” and it means the last position will not be saved. 
You can set the value to 5, 10, 30, 60 minutes. If you set the value to 30 
minutes, when you move to another audio file or you exit the Media 
program, you can save the last position of currently playing audio file if 
the audio has playing time over 30 minutes. Sometimes when you don’t 
want to save the position of music but want to save the position of audio 
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books, this option is very useful. Once the last position is saved, from 
that time, you can play the audio from the last position. 
 
To save the changed settings and exit, press “Enter” after you change 
an option, or move to the “Confirm” button by pressing “Tab” repeatedly.  
If you want to cancel the changes you made, and exit this dialog box, 
press “ESC,” or “Alt-F4.”You can also press “Enter” on the “Cancel” 
button to close the dialog box without changing any options. The options 
set in this dialog box only have an effect in “Media player.” If “hold” is set 
to “Off,” you can call up the “program” menu by pressing “Win key,” and 
you can use another program. 
 
9.3.6.2 Playback Settings Dialog Box 
 
If you press “Enter” on “Playback Settings,” or press “p” on the “Settings” 
menu, the “Playback Settings” dialog box will be displayed. In this dialog 
box, pressing “Tab” or “Shift-tab” will circulate among setting options, 
“Confirm” and “Cancel.” The setting options are the “Display time” option, 
the “Repeat” option, the “Playlist” option, the “Shuffle”, The “Times to 
repeat the specified track”, the “Set speed” option and “Time index” 
option. Press “Down arrow key”or “Up arrow key”to move from one 
option to the next or previous option. You can also open this dialog box 
by pressing “Ctrl-p” in the “Media player” dialog box. 
 
The “Display time” option allows you to set which type of time messages 
will be displayed in the “playback information” tab. You can set it to 
either “Elapsed time” or “Remaining time.” You can change its value by 
pressing “Space” on “time.” 
 
The “Repeat” option allows you to set whether all files in the play list will 
be played repeatedly. If it this option is set to “Yes,” all files in the play 
list will be played repeatedly, and if it is set to “No,” the Voice Sense 
QWERTY will stop playing after playing the last file in the play list.  
Again, you can change the value of this option by pressing “Space” on 
“Repeat.” 
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The next option is “Playlist” option. When you want to play audio files 
from File Manager, you can select multiple files by pressing “Space” and 
then play files by pressing “Enter.” At this time, if the play list has had a 
list of audio files, you will be asked if you want to overwrite the play list 
or you want to append the selected files into the play list. The default 
value is “Overwrite” and it means the play list will be filled with the 
selected files. And if you press “Space” then the value will be set to 
“Append” and the play list will be appended with the selected files. 
 
The “Shuffle” option allows you to set the audio playback order. The 
default value is set to “Off” and you can play audio files in the playlist in 
order but if you set “Shuffle” to “On,” The playlist is reorganized in 
random. If you have just one audio file in the playlist and you switch the 
option to “On,” you will encounter message saying “Shuffle mode not 
available.” 
 
“Times to repeat the specified track” allow you to set how many times 
you wish to repeat, when you execute section repetition. “Times to 
repeat the specified track” can be selected the value from 1 to 10 or 
unlimited. The default setting is 3. Pressing “Space” increases the times 
to repeat the specified track and “Backspace” decreases the times to 
repeat the specified track. 
  
The “Set speed” option allows you to set the audio playback speed. 
The speed level ranges from -2 to 5. The default setting is the 0. 
If you change the value, press “Space” or “Backspace.” The higher the 
number, audio playback speed is fast. 
 
The “Time index” option allows you to set time to jump. The default value 
is set to 1 minute.  The values are “5 seconds”, “10 seconds”, “30 
seconds”, “1 minute”, “3 minutes”, “5 minutes”, “10 minutes”, “15 
minutes”, “20 minutes”, “30 minutes” and “1 hour.” You can change the 
value by the “Space” or “Backspace.”  
Also you can change the value of time index by pressing “Ctrl-Up arrow 
key” or “Ctrl-Down arrow key” without calling this option. And if you want 
to check current time index, press “/”.. 
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After changing time index, if you press “Ctrl-Left arrow key” or “Ctrl-Right 
arrow key”, you can jump to previous or next position by time index.  
For example, time index is set to 1 minute. And if you press “Ctrl-Left 
arrow key”, you can jump to previous position by 1 minute. And if you 
press “Ctrl-Right arrow key”, you can jump to next position by 1 minute 
and then listen to audio file. 
 
To save the changed settings and exit from this dialog box, press “Enter” 
after you change all the options you want to change, or move to the 
“Confirm” button by pressing “Tab” or “Shift-tab” repeatedly, and then 
press “Enter.” If you want to cancel the changes, and exit from this 
dialog box, press enter on the “Cancel” button, or press “ESC” or “Alt-
F4.” 
 
9.3.6.3 Record Settings Dialog Box 

 
If you press enter on “Record Settings” in the “Settings” menu, or press 
“Alt-r” in the “Media player” dialog box, the Voice Sense QWERTY will 
display the “Record Settings” dialog box, which contains “Recording 
type,” “Sample rate” option, “Quality” option, “record source” option, “Set 
folder,” “Confirm” button and a “Cancel” button. You can move between 
controls by pressing “tab”or “shift-tab”. And you can move between 
options by pressing “Up arrow key”or “Down arrow key”. 
 
The “Recoding type” allows you to set the default file type of recording 
file. Its default value is set to “mp3.” You can select between “wav” and 
“mp3” the value by pressing “Space.” 
 
The three options are used to control the quality of recorded sound.  
Higher values in “Sample rate” and “Quality” means a better quality of 
recorded sound, as well as a larger file size of recorded files. In other 
words, if you want to record high quality sound, the total time the Voice 
Sense QWERTY can record will be shortened. On the other hand, if you 
set the lower values of these options, the Voice Sense QWERTY can 
record sound longer, although the sound quality may not be as good as 
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when these options are set to higher values. You can change these 
values by pressing “Space.” 
When you record the file using the external microphone, you must set to 
“External Mic” the “record source.” And when you record the file using 
the line-in-cable, you must set to “Line in” the “record source.” And when 
you record the file using internal microphone, you must set to “Internal 
Mic” the “record mode.” 
 
The “Set folder” allow you to set the default folder where the recorded 
files will be saved. Its default value is set to “/flashdisk/media/record.”  
To specify a different folder, press “Enter” on “Set folder,” and the same 
dialog box as the “Open Folder” dialog box will be displayed. Select a 
folder in the same way as in the “Open Folder” dialog box. (Refer to 
section 9.3.1.2 for more information about how to select a folder.)  
 
If you save the changed settings, and exit from this dialog box, press 
“Enter” after changing all of the options you want to change, or move to 
the “Confirm” button, and press “Enter.” If you want to cancel the 
changes you made, press “Enter” on the “Cancel” button, or press 
“ESC.” 
 
9.3.6.4 Effect Settings Dialog Box 

 
Press “Alt” in media player program, move to “Settings” menu and press 
“Enter”. By pressing “Down arrow key”, move to “Effect settings”. Press 
“Enter” on “Effect settings” or press “E”. Or press “Ctrl-e” in “Play list tab” 
or “Playback information tab”. 
“Effect settings” dialog box will be displayed, which contains the 
following: the “Bassboost” option, the “Surround” option, the “3D Effect”, 
the “Reverb” option, the “Echo” option, a “Confirm” button, and a 
“Cancel” button. You can move between controls by pressing “Tab” or 
“Shift-Tab”. And you can move between options by pressing “Up arrow 
key” or “Down arrow key.” 
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The “Bassboost” option is used to emphasize bass sound. The value 
can be entered from 0 to 20 that you want to enter the value in edit box. 
The higher value you enter, the stronger bass sound you will hear. 
 
The “Surround” option is used to hear ambient sound more efficiently. 
The value can be entered from 0 to 100 that you want to enter the value 
in edit box. The higher value you enter, the stronger surround sound you 
will hear. 
 
The “3D Effect” option is used to hear surround effect more efficiently. 
The value can be entered from 0 to 100 that you want to enter the value 
in edit box. The higher value you enter, the stronger 3D sound you will 
hear.  
 
The “Reverb” option is used to hear reverberation sound more efficiently. 
The value can be entered from 0 to 100 that you want to enter the value 
in edit box. The higher value you enter, the stronger reverb sound you 
will hear. 
 
The “Echo” option is used to hear echo sound more efficiently. The value 
can be entered from 0 to 100 that you want to enter the value in edit box. 
The higher value you enter, the stronger echo sound you will hear.  
 
To save the changed settings and exit from this dialog box, press “Enter” 
after you change all the options you want to change, or move to the 
“Confirm” button by pressing “Tab” or “Shift-Tab” repeatedly, and then 
press “Enter.” If you want to cancel the changes, and exit from this 
dialog box, press enter on the “Cancel” button, or press “ESC” or “Alt-
F4.” 
 
9.4 Hot Keys in the Media Player 
 
1. Hot Keys for the Commands for the File Menu 

Open file: Ctrl-o 
Open folder: Ctrl-f 
Add file: Alt-o 
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Add folder: Alt-f 
Save play list: Ctrl-s 
Save as play list: Alt-s 
Delete item: Del 
Open URL: Ctrl-l 
 

2. Hot Keys for Commands While in the Playback menu 
Play: Enter, x, Play button 
Previous track: Alt-Left arrow key, z, Previous button 
Next track: Alt-Right arrow key, b, Next button 
Previous section while playing Audible: Ctrl-Page up (Ctrl-Fn-Up 
arrow key) 
Next section while playing Audible: Ctrl-Page down (Ctrl-Fn-Down 
arrow key)  
Back 5 track: Alt-Up arrow key 
Forward 5 track: Alt-Down arrow key 
First track: Ctrl-Fn-Left arrow key 
Last track: Ctrl-Fn-Right arrow key 
Volume up: Shift-Up arrow key 
Volume down: Shift-Down arrow key  
Speed up: Shift-Right arrow key 
Slow down: Shift-Left arrow key 
Pause/continue: Space, Play button 
Stop: Backspace, Stop button 
Change time index: Ctrl-Up arrow key or Ctrl-Down arrow key 
Move to next position by time index and play: Ctrl-Right arrow key 
Move to previous position by time index and play: Ctrl-Left arrow key 
Delete play list during stop: Del 

 
3. Hot Keys for the Commands in the Record Dialog Box 

Call up the record dialog box: Ctrl-r, Record button 
Record: Record button 
Pause/continue recording: Space, Record button 
Play: Play button 
Pause/continue play: Space, Play button 
Stop: Backspace, Stop button 
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4. Hot Keys for the Commands in the Position Menu 

Set bookmark: Ctrl-m  
Delete bookmark: Ctrl-d 
Jump to bookmark: Ctrl-j 
Go to position: Ctrl-g 
Go to percent: Alt-p 
Set start/end point: p 
Release point: ESC 
 
 
 

8. Hot Keys for the Commands in the Mark 
Set mark: Alt-m 
Move to mark: Alt-j 
Move to previous mark: V 
Move to next mark: N 
Delete mark: Alt-d 
Mark manager: Alt-k 

 
9. Hot Keys for the Commands in the Setting Menu 

Configuration dialog box: Alt-c 
Playback setting dialog box: Ctrl-p 
Record setting dialog box: Alt-r 
Effect settings dialoq box: Ctrl-e 

 
10. Hot keys for toggling options. 

Toggle “display time” between “elapsed time” and “remaining time”: t 
Toggle “repeat” between “Yes” and “No”: r  
Toggle “shuffle” between “On” and “Off”: s 
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10. FM radio 
 
In order to use “FM radio” program in the Voice Sense QWERTY, please 
connect the headphone to the headphone jack of the Voice Sense 
QWERTY. The headphone connected to the Voice Sense QWERTY will 
work as a FM radio antenna. 
 
In the program menu, please press arrow keys to move to the “FM radio” 
and press “Enter,” or just press “r” in order to execute FM radio program. 
Once the FM radio program is executed, your Voice Sense QWERTY 
will announce the FM radio frequency. If you had executed the FM radio 
program, the Voice Sense QWERTY will tune to the frequency that you 
listened to and announce the frequency.  
For your reference, the frequency range of the Voice Sense QWERTY is 
from 87.5MHz to 108MHz. 
 
10.1 Listening to FM radio via internal speakers 
 
When you execute FM radio program after connecting the headphone to 
the headphone jack, sound from the FM radio will output through the 
headphone. If you want to listen to the FM radio through not only the 
headphone but also internal speakers, please set as follows; 
 

1) Press “Alt” to call the FM radio menu and press “Enter” at “File” 
menu and then press “Enter” at “Settings.” 

2) Or without calling menu, press “Ctrl-e” in order to call the dialog 
box. 

3) Then the dialog box will be opened and “Internal speaker: No” is 
announced in voice. 

4) Press “Space” once to switch from “No” to “Yes” and press “Enter.” 
 
Then you can hear the FM radio sound from both headphone and 
internal speakers. 
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This setting is valid only in the FM radio program. If you exit from FM 
radio program and hear the sound through speakers, you have to unplug 
the headphone. 
 
If the external speakers are selected in the “Settings” dialog box and 
“Down arrow key”is pressed, the Voice Sense QWERTY will announce 
“Volume.” You can adjust the FM radio volume. FM radio volume can be 
adjusted without calling dialog box. “Shift-Down arrow key” will decrease 
the volume and “Shift-Up arrow key” will increase the FM radio volume. 
 
10.2 Frequency control 
 
During listening to the FM radio, if you want to tune to the other 
frequency, please press “Alt” to call up the menu. Move to “Frequency” 
and press “Enter.” And then move to “Previous Frequency,” “Next 
Frequency,” “Auto Scan Backward,” or “Auto Scan Forward” and press 
“Enter.” 
 
Without calling the menu, if you press “Ctrl-Left arrow key,” your Voice 
Sense QWERTY will search the previous frequency. If you press “Ctrl-
Right arrow key,” your Voice Sense QWERTY will search the next 
frequency. If you press “Left arrow key,” the frequency will increase by 
0.1MHz. If you press “Right arrow key,” the frequency will decrease by 
0.1MHz. 
 
You can input the frequency directly by pressing “Ctrl-f.” If you press 
“Ctrl-f,” then the dialog box will be opened. You can input the frequency 
in numbers and press “Enter” to move to that frequency. 
 
Besides using the keys on the top panel, you can use audio buttons on 
the front panel. In order to use the audio buttons on the front panel, the 
audio mode switch should be moved to “FM” that is the left side of the 
switch. After setting the audio mode switch, pressing “previous” button 
will search the previous frequency and pressing “next” button will search 
the next frequency. 
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10.3 Registration of the channel and move among 
channels 
 
During listening to the FM radio, you can register the frequency which 
you are listening to. Please do as follows; 
 

1) Press “Alt” to call up the menu and press “Enter” at “Presets” 
2) And then press “Enter” at “Add preset” or press “Ctrl-s” without 

calling menu. 
3) Then Add preset dialog box will be opened and “Frequency: 

(current frequency)” will be announced. 
4) Press “Tab.” 
5) Then “Label:” is announced. Please input the name of the channel 

to be registered. 
6) Press “Tab” to move to “Confirm” and press “Enter.” 

 
If you want to register the frequency other than the frequency which you 
are listening to, input the frequency when “Frequency: (The current 
frequency” is displayed in the dialog box.) 
 
After you register all the desired channels, you can move to the previous 
channel by pressing “Alt-Left arrow key,” and move to the next channel 
by pressing “Alt-Right arrow key.”  
 
In order to delete any channel, move to the channel to be deleted and 
press “Del.” If “Del” is pressed, the selected channel will be deleted 
without any warning message. 
 
You can register and delete channels in the presets manager dialog box. 
Press “Alt” to call menu, press “Enter” at “Presets,” move to the “Preset 
Manager” and press “Enter.” Or you can press “Alt” without calling menu 
to open the preset manager dialog box. 
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Preset manager dialog box consist of “added preset list”, “Add” button, 
“Delete” button, “Modify” button and “Exit” button. You can move from 
one control to the next control by pressing “tab” or “shift-tab.” 
When it presses this Add button of you, as the Add dialog box it is 
explained, from will be opened.You can add the channels as explained 
above. And if you want to change the label of the added channel, move 
to the desired channel item in the added channel list by pressing “Up 
arrow key”or “Down arrow key,” and press “tab” to move to the “Modify” 
button and press “Enter.” Then the “Modify dialog box” will be opened. 
The structure of the “Modify dialog box” is almost the same as that of 
“Add dialog box.” The difference between these two dialog boxes is that 
the channel label and frequency are displayed on the “Modify dialog 
box.”  
If you want to delete any channel from the added channels, select the 
desired channel in the channel list and move to “Delete” button by 
pressing “tab” and press “Enter.” 
In order to exit from the preset manager dialog box, press “Enter” at the 
“Exit” button, or just press “ESC.” 
 
Adding the channel and move among the added channels are available 
using audio buttons on the front panel, too. In order to use the audio 
buttons, audio mode switch should be set to “FM radio.” 
 
If you press “record” button more than 2 seconds, “Add dialog box” will 
be opened. In order to move to the previous channel to be added, press 
“previous” button for more than 2 seconds. Pressing “next” button for 
more than 2 seconds will move to the next channel to be added. 
 
Pressing “stop” button for more than 2 seconds will delete the selected 
channel. 
 
10.4 Recording FM radio sound 
 
If you want to record the FM radio, press “Alt” to call menu, move to 
“Record (r)” and press “Enter.” Or just press “Ctrl-r” without calling menu. 
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Then the record dialog box will be opened and the Voice Sense 
QWERTY starts recording. 
 
The record dialog box consists of as follows. 

1. “Record status” status bar 
2. “Pause/Continue” button 
3. “Stop” button  
4. “Cancel” button 

 
You can move among these controls by pressing “Tab” or “Shift-Tab.” 
 
While recording the FM radio, if you press enter on “Pause” button or 
press “a”, recording will pause, and the name of button is changed to 
“Continue.” If you press “Continue” button or press “g”, recording will be 
continued. “Record status” will show the frequency of the FM radio under 
recording. If you press “Enter” on “Stop” button or press “s”, recording 
FM radio will stop.  
Recorded files will be saved in the “flashdisk/media/FM radio” folder. 
The file name will be “added channel label (frequency)-xx.mp3.” “xx” will 
start from 01 and increased by one when recording the FM radio sound. 
If unregistered channel is recorded, “FM radio” will be used as a file 
name instead of “added channel label.” If you stop recording, the record 
dialog box will be exited automatically. If you press “Enter” at “Cancel” 
button or press “c”, the recorded file will not be saved and exit the dialog 
box.  
 
During recording, you cannot change the channel and frequency. 
 
During listening to the FM radio, you can record without calling the 
record dialog box by pressing the “record” button on the front panel. 
Before you use the “record” button out of the audio buttons on the front 
panel, please set the audio mode switch to the FM radio mode. If you 
press the “record” button, the record dialog box will be opened and 
recording will start. 
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If you press “stop” button on the front panel during recording, recording 
will stop and the recorded audio file will be saved. If you press the 
“pause” button during recording, the “pause” button will be changed to 
the “continue” button. Please press the “continue” button to continue 
recording. Pressing “previous” button or “next” button will move among 
controls in the record dialog box. 
 
10.4.1 Changing record folder 
 
If you want to change the folder for saving recorded files, please do as 
follows; 
 

1) Press “Alt” to call menu and press “Enter” at “File.” 
2) Press “Enter” at “Record Settings.” Or press “Alt-s” without calling 

menu. 
3) Then the record dialog box will be opened and “Recoding type: 

mp3” is announced. 
4) Press “Tab” to move to “Record folder.” 
5) Then “Record folder: /flashdisk/media/FM radio/” is displayed. 

Press “Enter.” 
6) Then the list in the FM radio folder will be displayed. Press 

“Backspace” to move to upper level folder, and press “Up arrow 
key”or “Down arrow key”to move to desired folder. 

7) Press “Space” at the desired folder and press “Enter.” 
8) Then “Record folder: (Changed folder)” is announced. 
9) Press “Tab” to move to “Confirm” button and press “Enter.” 

 
In the Record Settings dialog box, you can set recording type, sample 
rate, bit per channel and channel. In order to change the recording type, 
you press the “Space.” And then you can select between “wav” and 
“mp3.” In order to change the sample rate and bit per channel, press “Up 
arrow key”or “Down arrow key”to move to the desired item to be 
changed when “sampling rate: 8000Hz” is displayed. At the desired item, 
press “Space” and change the value. After you change all items as you 
desire, press “Tab” to move to “Confirm” button and press “Enter.” 
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If the values of sample rate, bit per channel and channels are getting 
higher, the recorded audio quality will be better. But it requires more 
large storage space in the flash memory. So please select proper values 
for your recording purposes. 
10.5 Additional features 
 
1. Sensitivity adjustment 
When you activate the FM radio program, if the Voice Sense QWERTY 
cannot tune to the broadcasting frequency, please adjust the sensitivity. 
In order to adjust the sensitivity, call “Settings dialog box” as explained in 
the Section 10.1. And press “Down arrow key” to move to “Sensitivity” 
and press “Space” or “Backspace” to adjust the sensitivity. Higher value 
will make the Voice Sense QWERTY FM radio be more sensitive. If the 
sensitivity is increased, you can tune to more frequencies. 
 
2. Mute 
During listening to the FM radio, if you want to make it silent for a while, 
press “Space.” This is mute function. Pressing “Space” once again will 
cancel mute mode. Or you can use mute function by pressing “stop” 
button on the front panel and cancel mute mode by pressing “play” 
button on the front panel. If mute mode is activated, FM radio sound will 
not be heard but TTS (text to speech) sound will be heard. 
 
10.6 Hot Keys in the Radio 
 
1. Call up the sets dialog box: Ctrl-e 
2. Call up the menu: Alt 
3. Internal speakers on/off: X or Fn-x 
4. Move to next frequency: Left arrow key 
5. Move to previous frequency: Right arrow key 
6. Auto previous frequency: Ctrl-Left arrow key or short press pevious 
button 
7. Auto next frequency: Ctrl-Right arrow key or short press next button 
8. Go to frequency: Ctrl-f 
9. Move to previous preset: Alt-Left arrow key or long press previous 
button 
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10. Move to next preset: Alt-Right arrow key or long press next button 
11. Registry preset: Ctrl-s or long press record button 
12. Delete the preset: long press stop button 
13. Call up the record dialog box: Ctrl-r 
14. Record start/pause: short press record button 
15. Record stop: short press stop button 
16. Mute on: short press stop button or Space 
17. Muto off: short press play button or Space 
18. Volume up: Shift-Up arrow key 
19. Volume down: Shift-Down arrow key 
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11. Web Browser 
 
You can use the Web browser on the Voice Sense QWERTY to read 
pages on the Internet, as well as reading html books that you have 
saved to disk. In addition, you can download and read books from 
places such as Web Braille, and BookShare. Note that you will need to 
have setup an account in order to access many of the books on these 
sites. 
 
When you want to launch the Web browser, goes “Web browser” in the 
“program” menu, and press “Enter.” Or, you can press “b” in the 
“program” menu. You can also launch the Web browser by pressing “Fn-
w” while you are in the “program” menu. When you press these keys, the 
Voice Sense QWERTY, will open up a computer edit box. You can then 
type in the URL that you want to go to. After you type in you’re the web 
page address, press “Enter,” to open the web page. Then, the Web 
browser will open, and take you to the specific URL that you typed in.  
The Voice Sense QWERTY will connect to the web page that is 
registered as the “home page” in the Web browser. Please note that the 
Web browser supports SSL 1.0 to 3.0. A more detailed explanation of 
the Web browser can be found within this chapter. 
 
11.1 File 
 
The “File” menu can be executed by selecting “File” after pressing “Alt,” 
which calls up the Web browser menu. “File” will appear on the LCD. 
When you press “Enter” on “File,” you can enter into the “File” menu. To 
move from one submenu to another submenu, press the Up arrow key 
or the Down arrow key. The following is a detailed explanation of the 
Web browser “File” menu. 
 
11.1.1 Open URL 
 
Press “Alt” to open the Web browser menu. Then, move to “File,” and 
press “Enter.” The first item that is displayed on the LCD is “Open URL.” 
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Press “Enter” to get into the “Open URL” edit window, or press “Ctrl-l” 
while the Web browser is open. When “Open URL” is executed, the edit 
window for an address will be displayed. On the LCD, you will see the 
current address. You can enter a new web page address that you want 
to connect to. You need to enter the new address such as 
“www.google.com.” Then, press “Enter.” 
 
You can check the addresses that have been entered previously by 
pressing the Down arrow key. Move to the address that you want to 
open using the Up arrow key or the Down arrow key, and press “Enter” 
when the desired URL is displayed. You can go to a specific web page 
either by typing in a new address, or by selecting one of the previously 
entered addresses. 
 
If the Voice Sense QWERTY cannot connect to the desired web page, 
and it only hears progress to TTS , press “ESC” to stop connecting, and 
call up “Open URL” again. You can type in the address and try to 
connect again. You can stop the Web browser from connecting by 
pressing “Alt-F4. Sometimes, this can happen due to network or Internet 
problems. 
 
11.1.2 Open 
 
In order to enter into “Open,” press “Alt” to call up the “menu,” and press 
“Enter” on “File.” Go to “Open” by pressing “Down arrow key,” and press 
“Enter.” Or, you can press “Ctrl-o” when the Web browser is active.  
Then the “Open dialog box” will show up. 
 
“Open dialog box” consists of “file list,” “File name,” “Type,” “Confirm” 
button and “Cancel” button. You can move among those controls by 
pressing “tab” or “shift-tab”. When the “Open dialog box” is opened, “File 
name” will be focused. Type in a file name, and press “Enter,” or press 
“shift-tab”to move to the file list. Select the desired file name, and press 
“Enter.” 
The default folder is “/flashdisk/download,” and it can be changed by the 
same method as explained in the “File manager.” 
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There are three types of files in “Type”; “*.*,” “htm,” “html.” Default is “*.*” 
and it means that all types of files will be shown in the file list. 
At the “Type,” press “Up arrow key”or “Down arrow key”to select the file 
type. 
In order to check the current path, press “Fn-/.” You can use this 
command in the following dialog boxes: “Save As,” “Add to Favorites,” 
and the “Favorites List.” 
 
11.1.3 Save As 
 
In order to execute “Save As,” call up the “menu” by pressing “Alt,” and 
press “Enter” on “File.” Move to “Save As” by pressing “Down arrow 
key”and press “Enter,” or press “Alt-s” while the Web browser is 
activated. When you press “Enter” on “Save As,” the “Save As” dialog 
box will appear. Here you can type in a new file name, and press “Enter” 
to save the file as a new file. “Save As” will give you the opportunity to 
save html files with different file names. This is similar to “Save As” in the 
word processor. 
 
In this dialog box, there are “File name” edit combo box, “Type” combo 
box, “Confirm” button, “Cancel” button and “file list.”You can move 
among these items by pressing “tab” or “shift-tab.” 
 
The first item to be displayed when “Save As” is executed is “File name” 
edit combo box. You can type in the file name to be saved in this edit 
box. 
 
Note: If you want to edit the file name that is displayed on the Braille 
display when Voice Sense QWERTY connected to SyncBraille, press 
the cursor routing key that corresponds with the text that you want to edit.  
 
Please remember that “:” cannot be used in file names. You have to 
delete “:” if there is one in your file name. 
 
If you want to select the file name from the existing file name, press 
“shift-tab” to move to “file list.” The default folder is “/flashdisk/download.” 



243 
 

In order to move to upper level, press “Backspace” and if you want to 
enter the selected folder or select a file, press “Enter” on the folder or file 
that you want to select. And press “Down arrow key”or “Up arrow key”in 
order to move next or previous folder or file.  
 
There is a “Type” option combo box that is the next item of “File name” 
edit combo box. You can move from “File name” to “Type” by pressing 
“Tab.” The available file types are htm, html, brl, brf and txt file format. 
Use “Down arrow key”or “Up arrow key”to select the file type that you 
want. 
 
Press “tab” to move to “Confirm” and press “Enter” to save as the file 
name and type as selected. Or, press “tab” again to move to “Cancel” 
and press “Enter” to cancel “Save As.” 
 
If you do not want to save with a new file name, press “ESC” or “Alt-F4.” 
 
11.1.4 Page Information 
 
“Page Information” shows how many frames, tables, controls and forms 
are in the current page. 
 
In order to enter into “Page Information,” press “Alt” to call up the 
“menu,” and press “Enter” on “File.” Move to “Page Information” by 
pressing “Down arrow key”a few times, and then press “Enter.” Or, you 
can press the letter “I.” 
 
“Page Information” can be shown in one line. However, if there are too 
many characters to be displayed, you will need to press the arrow keys 
to read the additional lines. 
 
11.1.5 Exit 
 
This command terminates the Web Browser, and returns the Voice 
Sense QWERTY to the program list. You can exit from the Web browser 
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by pressing “Alt-F4,” or by selecting “Exit” from the Web browser file 
menu. 
 
11.2 Read 

 
The “Read” menu can read the page generally. In order to call up the 
“Read” menu, press “Alt”,and press “Enter” on “Read” or press “r.” 
The “Read” menu has three submenus: 
 
1. Read From Beginning To Cursor 
2. Read From Cursor To End 
3. Auto Scroll 
 
Note: “Auto Scroll” will appear when Voice Sense QWERTY connected 
to SyncBraille. 
 
You can move between the menus by pressing “Down arrow key”or “Up 
arrow key.” To execute the menu, press “Enter.” 
 
11.2.1 Read from Beginning to Cursor 
 
This function will read the current page from the beginning to the cursor 
location.  
 
To execute this function, press “Enter” on “Read From Beginning To 
Cursor” in the “Read” menu. Or, you can press “Alt-g” when you open a 
web page.   
 
If you want to quit this function before the cursor location, press “Ctrl.”   
 
Note: If you execute this function when Voice Sense QWERTY 
connected to SyncBraille, the Braille display change to correspond with 
the voice output. 
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11.2.2 Read from Cursor to End 
 
This function will read the current page from the cursor to the end of the 
current page. 
 
To execute it, press “Enter” on “Read From Cursor To End” in the “Read” 
menu. Or you can press “Fn-Enter” when you open a web page. 
 
Note: When Voice Sense QWERTY connected to SyncBraille, if you 
want to quit this function before the end of the current page, press “Ctrl.” 
If you execute this function, the Braille display change to correspond 
with the voice output. 
 
11.2.3 Auto Scroll 
 
Note: “Auto Scroll” will appear when Voice Sense QWERTY connected 
to SyncBraille. 
 
This function will scroll the current page from the cursor to the end of the 
current page. 
 
To execute the “Auto Scroll” function, press “Enter” on “Auto Scroll” in 
the “Read” menu. Or, you can press the up and down scroll buttons 
simultaneously when you open a web page. 
 
If you quit this function before the end of current page, you can press 
“Ctrl.”  
 
If you execute this function, the Braille display change to correspond 
with the voice output. 
 
For a faster scroll during scrolling, press “Right arrow key.” For a slower 
scroll during scrolling, press the “Left arrow key.” 
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11.3 Edit 
 
“Edit” menu is used to copy any part of the web page or add it to the 
clipboard. 
In order to call up the “Edit” menu, press “Alt”,and press “Enter” on “Edit” 
or press “e.” 
 
11.3.1 Start selection 
 
This command cannot be used on the controls in the web page, but can 
be used on the text or on the edit box. This means that it cannot be used 
on the links when setting the block, but it can be used to make selection 
to make a block on the text or on the edit box of the bulletin board. 
In order to use this command, press “Alt”, move to “Edit” menu by 
pressing “Down arrow key”and press “Enter” at the starting point of 
selection. And press “Enter” on the “Start Selection.” Then move to the 
end of selection that you want to select.  
You can also set the starting point of the block by pressing “Ctrl-b” 
without calling up the menu. 
 
11.3.2 Copy 
 
The selected part of the web page can be copied to the edit box in the 
web page, word documents or the edit box of the other programs.  
To copy the selected part of the web page, press “Alt”, move to the “Edit” 
menu by pressing “Down arrow key”and press “Enter.” And move to 
“Copy” by pressing “Down arrow key”and press “Enter” on “Copy.” Or 
you can copy the selected part by pressing “Ctrl-c” without calling up the 
menu. 
 
11.3.3 Add to clipboard 
 
You can copy various parts of the web page to the clipboard, and then 
you can copy them to the edit box or the other program at once. 
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In order to add the selected parts of the web page by pressing “Alt”, 
move to “Edit” menu by pressing “Down arrow key”and press “Enter.” 
And press “Down arrow key”to move to the “Add To Clipboard” and 
press “Enter.” Or you can add to the clipboard by pressing “Ctrl-Insert” 
without calling up the menu. 
 
11.3.4 Copy URL 
 
When you use the “Copy URL” function you can copy the address of the 
web page that you are on.   
In order to copy the address of web page, you press the “Alt”, move to 
“Edit” menu by pressing “Down arrow key”and press “Enter.” And press 
“Down arrow key”to move to the “Copy URL” and press “Enter.” Or you 
can copy to URL by pressing “Alt-d” without calling up the menu.  
The web address of the page will then be placed on the clipboard. You 
can paste it to a document, or wherever you can paste text on the Voice 
Sense QWERTY. 
 
11.3.5 Copy Link  
 
The “Copy Link” function allows you to copy a link in the web page that 
you are on. For example, if you tab to a link, and select the “Copy Link” 
function, then the link will be copied to the clipboard.   
In order to copy a link in the web page, you press the “Alt”, move to 
“Edit” menu by pressing “Down arrow key”and press “Enter.” And press 
“Down arrow key”to move to the “Copy Link” and press “Enter.” Or you 
can copy to link by pressing “Alt-l” without calling up the menu. 
The link will then be placed on the clipboard, so that you can paste it to a 
document, or wherever you can paste text in the Voice Sense QWERTY. 
 
11.4 Go To 
 
In order to enter the “Go To” menu, press “Alt”. And go to “Go To” by 
pressing “Down arrow key”. Then, press “Enter.” The sub menus are 
explained in the following sections. 
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11.4.1 Go to Home Page 
 
The first page that your Web browser loads when the Web browser 
opens is called the “home page.” You can set your favorite site as your 
home page. As soon as your “home page” is set, your Web browser will 
show you the same “home page” every time you start the Web Browser. 
 
The default home page is www.braillesense.com. In order to move to the 
home page while you are reading another web page, press “Alt,” and go 
to the “Go To” menu by pressing “Down arrow key,” and press “Enter.”  
The first sub menu in the “Go To” menu is “Go To Home Page.” You can 
activate “Go To Home Page” by pressing “Enter,” or by pressing “Alt-h” 
while your Web browser is opened. 
 
11.4.2 Go to Previous Page  
 
The previous page is the page shown just before the current page. For 
example, when the Web browser is activated, the first page that opens is 
the home page that is set as the default home page on the Voice Sense 
QWERTY. You can search and load the web page of Google, which is 
www.google.com. Then, the Voice Sense QWERTY will connect to the 
Yahoo web page. When “Go To Previous Page” is activated, the Voice 
Sense QWERTY will show you the last position in the previous page (the 
home page) that was displayed before the current page. 
 
In order to move to the previous page, press “Alt” to call up the “menu,” 
and go to the “Go To” menu by pressing “Down arrow key,” and press 
“Enter.” Go to “Go To Previous Page” by pressing “Down arrow key,” 
and then press “Enter.” Or, you can press “Alt” with “Left arrow key”.  
This command does not work on the first page in the Voice Sense 
QWERTY because there is no previous page when you first open the 
Web Browser. 
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11.4.3 Go to Next Page 
 
When you have opened multiple web pages, you can go back and forth 
from the current page to the previous page, or to the next page. For 
example, when you first open the Web Browser, you connect to your 
home page. Then, you connect to the web site of Google, and next, you 
connect to the Lycos web site. In this case, the next page from the 
Google web site is the Lycos web site.   
In order to move to the next page, press “Alt” to call up the menu, and 
then go to the “Go To” menu by pressing “Down arrow key”. Then, press 
“Enter.” Go to the “Go To Next Page” by pressing “Down arrow key,” and 
press “Enter,” or you can press “Alt” with “Right arrow key”. This 
command does not work on the last page because there is no page after 
the last page. 
 
11.4.4 Go to Previous Heading 
 
If you activate the “Go To Previous Heading” function, you can go to a 
heading that is located before your current location. To execute the “Go 
To Previous Heading” function, open the menu by pressing “Alt,” and 
press “Down arrow key”repeatedly to move to the “Go To” menu. Press 
“Enter” on “Go To.” Then, use “Up arrow key”or “Down arrow key” to 
move to “Go To Previous Heading,” and press “Enter.” Or, press “u” in 
the submenu. To activate this function without opening up the menu, 
press “Alt-b” or “Ctrl-F3” while in a web page. 
 
11.4.5 Go to Next Heading 
 
If you activate the “Go To Next Heading” function, you can go forward to 
a heading from your current location. To execute the “Go To Next 
Heading” function, open up the menu by pressing “Alt,” and press “Down 
arrow key”repeatedly to move to the “Go To” menu. Press “Enter” on “Go 
To.” Then, use “Up arrow key”or “Down arrow key”to move to “Go To 
Next Heading.” Then, press “Enter” on “Go To Next Heading.” Or, just 
press “d” in the submenu. You can also activate this function without 
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opening up the menu by pressing “Alt-f” or “Ctrl-F4” while you are in a 
web page. 
 
11.4.6 Go to Previous/Next Text 
 
This menu can be used to go to the next text or the previous text while 
you are reading the web page. 
In order to execute the “Go To Next Text” menu, do the following: 
 

1) Call up the menu by pressing “Alt.” 
2) Move to “Go To” by pressing “Down arrow key”. 
3) Press “Enter” on the “Go To” menu 
4) Press “Down arrow key”until “Go To Next Text” will be displayed. 

Or, you can press “a” in order to move to “Go To Next Text” 
directly. 

5) Press “Enter” on “Go To Next Text.” 
 
Or you can call up the “Go To Next Text” menu by pressing “Ctrl-F6” 
while the web page is being read. 
 
In order to execute “Go To Previous Text” menu, do the following: 
 

1) Call up the menu by pressing “Alt.” 
2) Move to “Go To” by pressing “Down arrow key”. 
3) Press “Enter” on the “Go To” menu 
4) Press “Down arrow key”until “Go To Previous Text” is displayed. 

Or, you can press “b” in order to move to “Go To Previous Text” 
directly. 

5) Press “Enter” on “Go To Previous Text.” 
 
Or, you can call up the “Go To Previous Text” menu by pressing “Ctrl-
F5” while a web page is being read. 
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11.4.7 Refresh 
 
If a web page opens incorrectly due to a network problem, or if you want 
to refresh the current page, press “Alt,” and go to the “Go To” menu by 
pressing “Down arrow key”. Then, press “Enter.” Go to “Refresh” by 
pressing “Down arrow key,” and press “Enter,” or you can press “Ctrl-r” 
without calling up the menu. 
 
11.4.8 History 
 
The “History” is the list of the web page addresses (and their titles) that 
have been visited either by clicking on a link or by typing in the address 
directly. When “History” is executed, the Voice Sense QWERTY will 
display the titles of the web pages in the history list. 
 
If you have visited a web page such as www.google.com previously, the 
history list on the Voice Sense QWERTY will show you the title of the 
page as, “Google.” 
 
In order to visit the Yahoo web site by using the history list, first, press 
“Alt” to call up the “menu,” and go to the “Go To” menu by pressing 
“Down arrow key”. Then, press “Enter.” Go to “History” by pressing 
“Down arrow key,” and press “Enter.” You can always open the history 
list by pressing “Ctrl-h” while the Web browser is running. The Voice 
Sense QWERTY will show the history list. Move to the title of the web 
site that you want to select by pressing “Down arrow key”or “Up arrow 
key.” If you want the “History” list to show the web address, instead of 
the title, of the website, you can press “Fn-i.” If you press “Down arrow 
key,” the display will show the title again, instead of the address. After 
you move to the desired web site, you should then press “Enter” to 
connect to that web site. 
 
In order to delete an undesired item from the history list, select that item 
on the history list, and press the “Del” key.” 
And if you want to delete the all file in history list, press the “Ctrl-a” and 
press “Del.” 
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The maximum number of items in the history list is 300. If the list 
exceeds 300 items, the oldest item will be deleted automatically from the 
history list, and the new item will be added as the first item on the list. 
 
11.4.9 Find 
 
This feature is similar to the function of “Find” in the word processor.  
The “Find dialog box” will allow you to find text on the current web page. 
 
In order to execute the “Find” menu, press “Alt” to call up the menu, and 
go to the “Go To” menu by pressing “Down arrow key”. Then, press 
“Enter.” Go to “Find” by pressing “Down arrow key,” and press “Enter,” or 
you can press “Ctrl-f” while the Web browser is loaded. 
 
When “Find” is executed, the dialog box that contains the edit window for 
entering text and the searching direction will appear. As in any other 
dialog box, you can press the “tab”or “shift-tab”to move from one control 
to another. Enter the text to search for, and select the search direction.  
Then, press “Enter.”The Voice Sense QWERTY will then find the text, 
and move the cursor position to the text. 
 
The default search direction is set to “Forward.” This means that the 
Voice Sense QWERTY will search for the specified text from the current 
cursor position to the end of the page. If you want to change the search 
direction, select “Backward,” and then press “Enter.” The selected 
search direction will remain until the Web browser is closed, unless you 
choose the other direction. 
 
11.4.10 Find Again 
 
The “Find Again” function searches the text again in the direction that 
you have selected. In order to enter into “Find Again,” press “Alt,” and go 
to the “Go To” menu by pressing “Down arrow key”. Then, press “Enter.”  
Move to “Find Again” by pressing “Down arrow key”. Then, press “Enter.”  



253 
 

Or, you can press “F3”, which is the hot key for “Find Again” while the 
Web browser is running. 
 
“Find Again” finds the text that you have entered in “Find.” There is no 
edit box in “Find Again.” If you want to find another key word, you should 
use the “Find” function explained as in section 11.4.9. 
 
11.4.11 Links list 
 
This function will list all the links in the current page. If you want to 
activate it, press “Alt” and press “Enter” on “Links list” in “Go To” menu.  
Or without calling up the menu, press “Insert-Tab”. Then you will see 
“Links list dialog box.” In the dialog box, you can find the following 
controls: “links list,” “Focus link” button, “Activate link” button, and 
“Cancel” button.  You can move control by control by pressing “Tab” or 
“Shift-tab”. In the “links list,” you can move by pressing “Up arrow key”or 
“Down arrow key”. 
If you want to move to the selected page in “links list,” press “Enter” on 
the link of focus in “links list.” Or move to “Activate link” button by 
pressing “Tab” or “Shift-tab” and press “Enter” there. 
If you want to go to the link position selected in “links list,” move to 
“Focus link” button by pressing “Tab”, and press “Enter” there. 
To close the dialog box, move to “Cancel” button, and press “Enter” 
there. Or just press “Alt-F4” or press “ESC.” 
 
11.5 Favorites 
 
In order to enter into “Favorites,” press “Alt,” and move to “Favorites” by 
pressing “Down arrow key”, and press “Enter.” If there are web sites that 
you frequently visit, it would be very inconvenient to enter the long 
address every time. In such a case, you can add these web site 
addresses in the “Favorites” list. Then, you can visit the web sites that 
are stored in your “Favorites” list by simply selecting the address in the 
“Favorites” list. 
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11.5.1 Set Current As Your Home Page 
 
The “home page” is the web site that you connect to automatically when 
the Web browser is opened. The user can set any web site as the home 
page.   
 
In order to set the “home page,” you have to go to the web page that you 
want to register as the home page. While the web page is displayed, 
press “Alt,” and move to “Favorites” by pressing “Down arrow key”.  
Then, press “Enter.” Then “Set Current As Your Home Page” will be 
displayed he LCD and press “Enter.” Then, the current web site will be 
registered as your home page automatically, and the Voice Sense 
QWERTY will say “Saved as home page,” and it displays the current 
web page. Or, you can press “Ctrl-s” without calling up menu. 
 
11.5.2 Add to Favorites 
 
You can add the web page that you are reading now to the “Favorites” 
list. In order to add the web page to the “Favorites” list, press “Alt,” and 
move to “Favorites” by pressing “Down arrow key”. Then, press “Enter.”  
Then, move to “Add to Favorites” by pressing “Down arrow key,” and 
then press “Enter.” You can activate “Add To Favorites” by pressing “Alt-
a” when the Web browser is running. 
 
“Add to Favorites” is a dialog box that contains the following:  a list box 
that shows the current favorites list (including the folders and files of 
your favorites), an edit window for the web page address where you can 
enter, type, confirm, and cancel. You can move from one item to the 
next by pressing “tab”or “shift-tab”. 
 
When you open “Add to Favorites,” the edit window will appear first. In 
this edit window, you can type in the title of the current web page that 
you are reading. The extension name (.URL) will be attached 
automatically to the title name that you have written.   
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The favorites list will be saved in the “/flashdisk/favorites” folder. This 
folder is the default folder, and you cannot make your desired folder 
above this folder (a higher level folder). 
 
If you want to add “Favorites” list to the folder you made, rather than the 
default folder, press “shift-tab”, and select the desired folder by pressing 
“Up arrow key”or “Down arrow key”. Then, press “Enter.” 
 
Note: If you want to edit only a part of the current title name when Voice 
Sense QWERTY connected to SyncBraille, press the cursor routing key 
that is furthest to the left. Then, the current title name will be displayed 
on the LCD. You can press the cursor routing key where you want to edit 
the text, and then modify it. Make sure that you do not use “:” in the title 
name.   
 
11.5.3 Favorites List 
 
You can check the list of the web sites that are saved in “Add to 
Favorites.” The user can copy, delete, or rename the title of the sites in 
the favorites list. 
 
In order to open the “Favorites” list, press “Alt”,and move to “Favorites” 
by pressing “Down arrow key”. Then, press “Enter.” Move to the 
“Favorites List” by pressing “Down arrow key”, and press “Enter.” Or, you 
can press “Ctrl-l” while the Web browser is running. When you press 
these keys, the Voice Sense QWERTY, will display the favorites list 
dialog box. This dialog box contains the following:  the favorites list, an 
edit window for the title, a type combo box, a confirm button, and a 
cancel button. You can move from one item to the next by pressing the 
“tab”or “shift-tab”. 
 
When the “Favorites List” is open, an edit window will appear first.  The 
edit window will display the message, “Name:.” You can enter one of the 
titles that you have entered previously. You can open the web page by 
pressing “Enter” after entering the title. If there are no titles that match 
the one you entered, the Voice Sense QWERTY will say “invalid path” 
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and return to the edit window. If there is a title in the “Favorites list,” the 
Voice Sense QWERTY will connect to the web page. If you do not 
remember the exact title, you can find it from the “Favorites” list, using 
the method that is outlined below. 
 
When the edit window appears, press “shift-tab”in order to move to the 
“Favorites list.” Then the Voice Sense QWERTY will display the “file list.” 
You can move between folders and files by pressing “Up arrow key”or 
“Down arrow key”. 
 
Press “Enter” on the title of the web site that you want to visit. When you 
press “Enter” on the folder, you can get into the folder.   
 
In the favorite list, you can find only the files with the file format that was 
selected in the “Type” combo box. Press “tab” to move to “Type” combo 
box. In the type combo box, there are two kinds of file formats; “*.*” and 
“url.” Press “Up arrow key”or “Down arrow key”select one out of these 
two file formats. If you select “*.*” then all types of files will be shown. 
 
11.6 Options 
 
Using the “Options” menu, you can set the type that is gets the web 
page and change default download folder. Also you can clear cookie in 
the “Options” menu. 
 
In order to execute the “Options” menu, 

1) Press “Enter” on “Web browser”. 
2) Press “Alt” to call up the menu. 
3) Move to “Options” pressing “Down arrow key”. 
4) Press “Enter.” Or you can press “Alt-o” while the Web browser is 

executing. 
 
11.6.1 The Structure and Movement  
 
When you execute the “Options” menu, the below components consist of 
the structure.  
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1. “User agent” list 
2. “Default download folder”  
3. “Clear cookies” button 
4. “Confirm” button 
5. “Cancel” button 

 
By pressing “Up arrow key” or “Down arrow key”, you can move to option 
items: User agent, Show visited links, Default download folder and Clear 
cookies. And by pressing “Tab” or “Shift-Tab”, you can move among 
controls.   
 
11.6.2 Set User Agent 
 

1) Press “Enter” on “Web browser”. 
2) Press “Alt” to call up the menu. 
3) Move to “Options” pressing “Down arrow key”. 
4) Press “Enter.” Or you can press “Alt-o” while the “Web browser” is 

executing. 
5) It will find “User agent: Windows CE” on the LCD. 
6) Using the “Space”, you can select one in the “Windows XP”, 

“Windows CE” and “Pocket PC”. 
7) After you select the value that you want, press “Enter”. 

 
It will open the web page which you chosen type. 
 
11.6.3 Show visited links 
 
“Show Visited link” is the option displaying the link once user visited web 
site. The default setting is “On” and it toggles between “On” and “Off” by 
pressing “Space”. 
This option is set to “On”and “Off” as follows: 

1) Execute “Web browser” by pressing “Enter” on “Web browser” or 
simply pressing hot key “b” from the main menu. 

2) Once the “Web browser” executes, press “Alt-o” and then it will 
say “option dialog box”. 
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3) Move to “Show visited links” by pressing “Down arrow key”. 
4) “Show visited links: On” will be displayed. 

 
If the setting is “On”, “Visited link” will be displayed.  
 
11.6.4 Changing the Default Download Folder 
 
You can change default download folder in “Web browser”.  
 
To change the default download folder, follow these steps: 

1) Press “Enter” on “Web browser”. 
2) Press “Alt” to call up the menu. 
3) Move to “Options” pressing “Down arrow key”. 
4) Press “Enter.” Or you can press “Alt-o” while the “Web browser” is 

executing. 
5) Pressing “Tab”, move to “Default download folder” 
6) It will find “Flashdisk” list. 
· When you change the different folder in “Flashdisk”: Using the 

“Space”, select the folder that you want. 
· When you change the different folder of “External memory”: Using 

the “Backspace”, move to disk. Move to folder that you want to 
change and select it using “Space”. 

7) Press “Enter”. 
8) Press “Tab”, move to “Confirm” button. 
9) Press “Enter”. 

 
If you want to cancel the change, press “Enter” on “Cancel” button. Or 
press “Alt-F4”, regardless of location.  
 
11.6.5 Clear cookies 
 
Cookie contains information which can be read in web application 
whenever user visits the web site. You can clear cookie in “Options” 
menu in Voice Sense QWERTY.  
 
To clear cookie, follow these steps: 
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1) Press “Enter” on “Web browser”. 
2) Press “Alt” to call up the menu. 
3) Move to “Options”, pressing “Down arrow key”. 
4) Press “Enter.” Or you can press “Alt-o” while the “Web browser” is 

executing. 
5) Pressing “Tab”, move to “Clear cookies” 
6) Press “Enter” on “Clear cookies”. 
7) It will announce “Successfully cleared cookies” and clear cookie. 

 
Without calling menu, pressing “Ctrl-d”, it will clear cookie in web page. 
If you want to cancel to clear cookie, press “Enter” on “Cancel” button. 
Or press “Alt-F4”, regardless of location. 
 
 
 
11.7 Read Page 
 
On the web page, there are links, controls, and other various elements, 
as well as text. In order to read web pages properly, the Web browser 
should classify each element, and notify the user with its information. 
 
When reading a web page by moving with “Down arrow key”or “Up 
arrow key”, one element will be displayed on one line. The links and 
controls will be displayed with their respective symbols for the user to 
distinguish each element. 
 
There is a more detailed explanation of this feature within this section. 
 
11.7.1 Moving Between Controls 
 
A control is a link, an edit box, a radio button, or a combo box. These 
same controls are found in Windows on a personal computer. Web 
pages also use various kinds of controls for user input. Each control has 
different purposes. Therefore, the user has to know exactly what type of 
control is being used. For example, in an edit box, the user enters a text 
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string. In a combo box and list box, the user should select one of the 
items listed in the combo box or list box. The Voice Sense QWERTY 
Web browser uses symbols to identify what type of control is being used. 
In order to move from one control to another without reading the text in 
between controls, the Voice Sense QWERTY provides the following 
“move to control” methods: 
 
1. Move to the previous control: “Shift-tab”.  

This command moves to the nearest previous control from the current 
position. If there are no more previous controls, the warning sound 
will be played. 

2. Move to the next control: “Tab” 
This command moves to the next control from the current position.  If 
there are no more controls, the warning sound will be played. 

 
When you find controls in web pages, the Voice Sense QWERTY will 
show control symbols ahead of the contents of the control. The 
followings are a list of control symbols. 
 

Control name Symbol 
Link LN 
Visited link LNV 
Anchor ANC 
Edit box EB 
Multi edit box MEB 
List Box LB 
Combo box CB 
Radio button select SRB 
Radio button 
unselect 

URB 

Check box check SCHB 
Check box uncheck UCHB 
Button BT 

 
1. Link: If you press “Enter” on link, you will move to the page that the 

link is referencing. 



261 
 

2. Visited link: It is the link that you visited last time. 
3. Anchor: If you press “Enter” on anchor, you will move to the 

referenced part of the web page. 
4. Edit box: You can start entering the text at the cursor position. After 

you finish entering the text, press “Down arrow key”to move to the 
next item. If there is any text in the edit box, it will be spoken. 

5. Multi edit box: his is similar to the edit box. It is an edit box that allows 
you to enter plural lines in one edit box. You can start a new line by 
pressing “Enter.” After you finish entering the text, press “tab” in order 
to move to the next item. 

6. List box, combo box: In order to change a selection in the combo box, 
press “Alt-Down arrow key” or “Alt-Up arrow key.” You can move to 
the next item by pressing “Down arrow key”. Also it will renew a page 
automatically when you change combo box in combo box. 

7. Radio button, check box: In order to select or cancel the selection, 
press “Enter.” 

8. Button: If you press “Enter” on a button, you will move to the 
referenced page. 

 
11.7.2 Moving to a Form 
 
A “form” is a page that has all of the controls, except the “link” control.  
The edit windows, buttons, and combo boxes are included in a “form.”  
When you navigate some web pages, if there are many links, it would be 
very cumbersome to navigate to a form because you would have to push 
too many “tab” or “shift-tab” keys to get to a form. In this case, you can 
use the “moving to the form” function. 
 
1. Move to the previous form: Ctrl-F1 

You can move to the previous form by pressing this key. If there are 
no previous forms, the Voice Sense QWERTY will play the warning 
sound. 

2. Move to the next form: Ctrl-F2 
You can move to the next form by pressing this key. If there are no 
more forms. The Voice Sense QWERTY will play the warning sound. 
If there are no forms on a web page, Voice Sense QWERTY will say, 
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“no control.” 
 
11.7.3 Table 
 
At the beginning position of the table, the Voice Sense QWERTY shows 
the table number, and the number of rows and columns on the table. 
 
For example, there are two big tables (we call these “upper level tables”) 
on one web page. Each table has 3 sub tables (we call these “lower 
level tables”) with 3 rows and 2 columns on each. In this case, when the 
Voice Sense QWERTY shows the first sub table on the second big table, 
it displays “table 2-1 3 rows, 2 columns.” At the end of the sub table, the 
Voice Sense QWERTY will display “table 2-1.” 
 
If the table consists of only 1 row and 1 column, or empty space that has 
only border or background, such tables are not considered tables in the 
Voice Sense QWERTY. 
 
The Voice Sense QWERTY provides a way to move table by table, and 
cell by cell, in order for the user to comprehend the structure of the table.  
In order to move cell by cell, the cell position and contents of the cell will 
be displayed. However, the position information will only be announced 
in voice. 
 
For example, if you have move to a cell that is positioned on the second 
row and third column, and the content of the cell is “news,” the Voice 
Sense QWERTY will announce, “row 2 cell 3 news.” In this case, “row 2 
cell 3” will be announced in voice only.. 
 
If a table is included in the cell, the Voice Sense QWERTY will announce 
“table cell.” If there is not a table in the cell, you will hear “empty cell.” 
 
In the “table cell,” if you want to move to any cell within the lower level 
table, press “Down arrow key” to move to the starting line of the lower 
level table.   
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Moving by cell is only valid in the table. If this command is executed 
outside of the table, a warning sound will be played. 
 
1. Move to the previous table: Ctrl-F7 

It moves to the starting position of the previous table. If there are no 
previous tables, the warning sound will be played. 

2. Move to the next table: Ctrl-F8 
It moves to the starting position of the next table. If there are no more 
tables, the warning sound will be played. 

3. Move to the previous cell: Ctrl-Shift-Left arrow key 
It moves to the previous cell. If the current cell is the first cell, it will 
move to the starting line of the table. If this command is pressed on 
the starting line of the table, the warning sound will be played. 

4. Move to next cell: Ctrl-Shift-Right arrow key 
It moves to the next cell. If the current cell is the last cell, it moves to 
the end line of the table. If it is pressed on the end line of the table, 
the warning sound will be played. 

5. Move to upper cell: Ctrl-Shift-Up arrow key 
It moves to the cell in the previous row within the same column. If the 
current cell is on the first row, the warning sound will be played. 

6. Move to lower cell: Ctrl-Shift-Down arrow key 
It moves to the cell in the next line, within the same column. If the 
current cell is on the last row, the warning sound will be played. 

7. Current cell: Ctrl-Shift-c 
It announces and displays the content of the current cell again. 

8. Move to the previous cell in the upper level table: Ctrl-Left arrow key 
It moves to the previous cell from the current cell that contains the 
current table. If the current table cell is the first cell of the highest level 
table, it will show the starting line of the table. It does not work on the 
highest level table. 

9. Move to the next cell of the upper level table: Ctrl-Right arrow key 
It moves to the next cell from the current cell that contains the current 
table. If the current table cell is the last cell in the highest level table, it 
moves to the end line of the table. It does not work on the highest 
level table. 

10. Move to the upper cell of the upper level table: Ctrl-Up arrow key 
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It moves to the previous row, within the same column, to the table cell 
that contains current table. If the cell that contains the current table is 
located on the first row of the upper level table, the warning sound will 
be played.  It does not work on the highest level table. 

11. Move to the lower cell of the upper level table: Ctrl-Down arrow key 
It moves to the next row, within the same column, to the table cell that 
contains the current table. If the table cell that contains current table 
is at the last row of the upper level table, the warning sound will be 
played. It does not work on the highest level table. 

12. Check the position: Fn-s 
It announces the position of the current cell in the table. It shows the 
position in voice, such as “table 2-3 row 3, cell 4.” 

 
11.7.4 Move to the Frame 
 
1. Move to the previous frame: Ctrl-F9 

It moves to the starting position of the previous frame. If there are no 
previous frames, the warning sound will be played. 

2. Move to the next frame: Ctrl-F10 
It moves to the starting position of the next frame. If there are no 
more frames, the warning sound will be played. 

 
11.7.5 Playback of Streaming Audio Files 
 
While you navigate any web page, if you come across a link for 
streaming audio file, you can simply press “Enter” on it. Then the Media 
player program will be launched or activated with lists of address inside 
of the streaming file and the streaming audio file on the first address will 
be played. The possible formats of streaming file are “m3u”, “pls”, “asf”, 
“asx.” 
 
For other formats besides above 4 formats, if you press “Enter” on it, the 
Web browser program will play the streaming audio file directly. When 
you play the streaming audio file in the Web browser, the “Add To 
Favorites” dialog box will be appeared in order to quickly play the file 
later through the File Manager or Web browser program. You can then 
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add the streaming address into “Favorite list” and the streaming file will 
be saved with “ASF-” at the begging of file name. “ASF” denotes that the 
link is a streaming audio file. 
 
While you play a streaming audio file in the Web Browser, if you exit the 
Web browser program or you lost the internet connection, the streaming 
audio file will be stopped playing. 
You can use following playback commands in Web browser while 
playing any streaming audio file. 
 
1. Play: “play” button on the front panel 
2. Stop: “stop” button on the front panel 
3. Turn up the volume: Shift-Up arrow key 
4. Turn down the volume: Shift-Down arrow key 
 
Playback of a streaming audio file does not stop if you switch to another 
program, until you press the “stop” button on the front panel after you 
come back to “Web browser.”  
You can download real audio files but not play them in the Web Browser. 
 
11.8 Hot keys in the Web Browser 
 
1. File Menu 
Open URL: Ctrl-l 
Open: Ctrl-o 
Save as: Alt-s 
Information: Alt-Enter 
Exit: Alt-F4 
 
2. Read Menu 
Read from beginning to cursor: Alt-g 
Read from cursor to end: Fn-Enter  
Auto scroll: Up scroll button-down scroll button (This function executes 
when the Voice Sense QWERTY is connected to SyncBraille.) 
 
3. Edit menu 
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Start selection: Ctrl-b 
Copy: Ctrl-c  
Add to clipboard: Ctrl-Insert 
Copy URL: Alt-d 
Copy link: Alt-l 
 
4. Go to menu 
Go to the home page: Alt-h 
Go to the previous page: Alt-Left arrow key 
Go to the next page: Alt-Right arrow key 
Go to previous heading: Alt-b or Ctrl-F3  
Go to next heading: Alt-f or Ctrl-F4 
Go to previous text: Ctrl-F5 
Go to next text: Ctrl-F6 
Refresh: Ctrl-r 
Open the history list: Ctrl-h  
Check the address of the selected title in the history list: Fn-i  
Find: Ctrl-f  
Find again: F3  
Links list: Alt-i 
 
5. Favorites 
Set current as your home page: Ctrl-s  
Add to favorites: Alt-a  
Favorites list: Ctrl-l 
 
6. Options setting: Alt-o  
Clear Cookies: Ctrl-d 
 
7. Hot Keys When Playing Audio Files in the Web Browser 
Turn up the volume: Shift-Up arrow key 
Turn down the volume: Shift-Down arrow key 
Play: play button of the front panel 
Stop: stop button of the front panel 
 
8. Reading Web Pages 
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Move between controls 
Move to the previous control: Shift-tab  
Move to the next control: Tab 
Select the next item in the combo box (list box): Alt-Down arrow key 
Select the previous item in the combo box (list box): Alt-Up arrow key 
 
Moving to the form 
Move to the previous form: Ctrl-F1 
Move to the next form: Ctrl-F2 
 
Table navigation hot keys 
Move to the previous table: Ctrl-F7 
Move to the next table: Ctrl-F8 
Move to the previous cell: Ctrl-Shift-Left arrow key 
Move to the next cell: Ctrl-Shift-Right arrow key 
Move to the upper cell: Ctrl-Shift-Up arrow key 
Move to the lower cell: Ctrl-Shift-Down arrow key 
Read current cell: Ctrl-Shift-c 
Move to the previous cell of the upper level table: Ctrl-Left arrow key 
Move to the next cell of the upper level table: Ctrl-Right arrow key 
Move to the upper cell of the upper level table: Ctrl-Up arrow key 
Move to the lower cell of the upper level table: Ctrl-Down arrow key 
Check the current position: Fn-s 
 
Move to frame 
Move to the previous frame: Ctrl-F9 
Move to the next frame: Ctrl-F10 
Read the current line: Fn-r 
 
11.9 What the Web browser Does Not Support 
 
1. Images are not supported. 
2. Any executable files on web sites cannot be executed. It is because 

the operating system on the Voice Sense QWERTY is different from 
the operating system on a personal computer. 

3. A web page using flash can be opened, but the flash content may not 
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be read. 
4. Some web pages that use JavaScript cannot be opened. 
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12. DAISY Player 
 
Using the Daisy player, on the Voice Sense QWERTY, you can listen to 
files and read books that use the DAISY format. DAISY is an acronym 
for (DIGITAL ACCESSIBLE INFORMATION SYSTEM). One advantage 
to DAISY books is that you can listen to the audio as well as read the 
associated text with the audio. The Voice Sense QWERTY supports 
DAISY books that are version 3.0 or earlier. When you want to run the 
player, press “Enter” on “Daisy player” in the “program” menu, or press 
the shortcut key “d” in the Voice Sense QWERTY “program” menu. 
When you run the Daisy player, you will see all of the disks available on 
the Voice Sense QWERTY (regardless of whether each disk has DAISY-
formatted files or not). You can navigate through the list with “Up arrow 
key”or “Down arrow key”. You can open a disk containing DAISY-
formatted files by pressing “Enter” on the name of the disk. After opening 
the disk, you will find all of the folders that are on the disk, and any 
DAISY file titles that are on the disk that you have opened. Once you 
find a DAISY file that you want to open, press “Space” to select it. Then, 
press “Enter” to play the file. 
 
If you have DAISY files in a folder on a disk, you can go in to the folder 
by pressing “Enter” on the folder. Make sure that you do not press 
“Space” on the folder. You will find all of the folders on the disk, and you 
can navigate through the disk by using the same navigation keys that 
are used in the file manager. Then, you can go to the folder that has the 
DAISY files that you want to read or listen to. Press “Space” to select the 
folder, and press “Enter” to play the DAISY file. If you only have one 
DAISY file, it will automatically start playing after showing the title. You 
can play the DAISY file by pressing “Enter” on the selected file after 
navigating the file list with “Up arrow key”or “Down arrow key”. If you 
replay a file that you have listened to before, you can start listening to 
the file at the location where you stopped earlier. While playing Text 
Daisy with voice off, “Read from cursor to end” won't work. To stop 
playing a file, press “Alt-F4,” which will move you to the prompt box. 
Once there, you can select “Yes” or “No” with “Space” or “Backspace.” 
When you want to exit from the Daisy player, press “Alt-F4,” which will 
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move you to the prompt box. Once in the prompt box, you can select 
“Yes” or “No” with “Space” or “Backspace.” 
 
You can open the Daisy player menu by pressing “Alt” when you are in 
the Daisy player. In the menu, you will find “File,” “Document,” “Mark,” 
and “Heading.” You can move between these menu items with “Up 
arrow key”or “Down arrow key,” and press “Enter” when you want to 
activate the selected menu item. 
 
You can also play the DAISY contents using the audio buttons on the 
front panel. In order to use the audio buttons to control the Daisy player, 
the audio mode switch that was explained in the Section 2.5 (Switching 
Audio mode) should be set to DAISY mode that is the center of the 
audio mode switch. Once the audio mode is set to DAISY mode, you 
can play the DAISY contents by pressing “play” button on the front panel. 
Also you can pause the Daisy player by pressing “play” button on the 
front panel when playing the DAISY contents. How to use the audio 
buttons to control the Daisy player is explained in the following sections. 
 
12.1 Components of the DAISY Player 
 
While running the Daisy player, you will find four controls components: 
“heading,” “information,” “Play,” and “Pause.” You can move between 
the controls with “tab” or “shift-tab”. While playing a file in the Daisy 
player, you will find a “heading,” which will show you a prefixed heading 
or affixed text if one has been prepared. In “information,” you can find 
the current page, level, phrase, elapsed time, and running time. You can 
move between these items with “Up arrow key”or “Down arrow key”.  
You can press “Enter” on “Pause” or “Play,” which will let you pause or 
play the audio. If you are anywhere in the four control components, you 
can play or pause by pressing “Space.” 
 
12.2 File 
 
When in the “File” menu, you can open a new DAISY file, check file 
information on the file that is currently open, and set voice parameters.  



271 
 

You can open the “File” menu by pressing “Alt,” and then press “Enter” 
on “File.” Or, you can press “f”. In the “File” menu, you will find items 
such as, “Open DAISY,” “Voice Settings,” “Book-Info,” and “Exit.” You 
can move between these items with “Up arrow key”or “Down arrow key”.  
You can activate the selected item by pressing “Enter.” 
 
12.2.1 Open DAISY 
 
You can open another DAISY file with using “Open DAISY.” To get to 
“Open DAISY,” press “Alt” to call up the menu, and then press “Enter” on 
“Open DAISY” in “File” menu. Or, you can use the hot key “Ctrl-o” 
without pressing “Alt”. 
When you activate “Open DAISY,” you can see the disk list while 
pausing or playing a file. Once here, you can open a file, as explained 
above in section 12. 
 
You can open “Open DAISY” dialog box by long pressing “stop” button 
when play or pause the DAISY contents. And if you long press the “stop” 
button again, this dialog box will close. And then return to the previous 
position. 
“Play” button is same function as “Enter” in “Open DAISY” dialog box. 
Also “stop” button, “record” button, “previous” button and “next” button is 
same function as “Backspace”, “Space”, “Up arrow key”and “Down arrow 
key”in “open DAISY” dialog box. 
Namely, you can move to up and down by pressing “previous” and “next” 
button in list of “Open DAISY” dialog box. And you can select and 
unselect by pressing “record” button. If you press “stop” button, you can 
move to upper folder. And if you press “play” button, you can play the 
selected file in file list of “Open DAISY” dialog box. 
In order to use this function, you must set the audio mode switch to 
“DAISY mode.” 
 
12.2.2 Voice Settings 
 
In the “Voice Settings,” you can set the Daisy player voice parameters.   
To execute voice settings, follow these steps: 
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1) Press “Alt” to call up the menu.  
2)  Move to “Voice Settings,” which is located under the “File” menu 

and press “Enter”. Or press “s”. 
3) Also you can directly activate the “Voice Settings” by pressing 

“Ctrl-s”. 
 
It will open the “Voice Settings” dialog box. 
In the dialog box, 

1. DAISY play type(It will show while playing text+audio DAISY) 
2. Voice control 

1) Set speed 
2) Set volume 
3) Set to control information of contents 

3. Confirm 
4. Cancel 

 
You can move between the four controls with “Tab” or “Shift-Tab.” In 
“Voice control,” you can move between “Set speed”, “Set volume” and 
“Set to control information of contents” with “Up arrow key” or “Down 
arrow key”.   
 
If you cancel this function, press “ESC” or “Alt-F4”. 
 
12.2.2.1 DAISY play type 
 

It will show while playing text+audio DAISY. You can use this function 
when you play the text+audio DAISY. The default setting is “Audio”.It will 
play with audio in text+audio Daisy. If you set the “Text”, it will play with 
text in text+audio Daisy. 
To change the setting value, press “Up arrow key” or “Down arrow key”. 
After changing the setting value, press “Enter”. Or press “Tab”, move to 
“Confirm” and press “Enter”. 
Without calling the menu, you can directly this function by pressing “Ctrl-
t”. 
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12.2.2.2 Volume and Speed 
 
You can increase the levels of speed and volume with “Space,” and 
decrease them with “Backspace”.  After setting the levels, press “Enter” 
to confirm your choice.   
Without using the “Voice Settings” menu, you can increase or decrease 
the speed and volume. 
  

1. Increase the speed: Shift-Right arrow key 
2. Decrease the speed: Shift-Left arrow key 
3. Increase the volume: Shift-Up arrow key 
4. Decrease the volume: Shift-Down arrow key 

 
 
12.2.2.3 Set to control information of contents 
 

You can use this function when you play the NIMAS Daisy. The default 
setting value is “On”. To change the setting value, press “Space” or 
“Backspace”. 
 
If you set “On”, it shows symbol of controls and information while playing 
NIMAS Daisy. 
 

NIMAS Daisy control includes “image”, “description”, “caption”, “prodnote, 
“table”. “image” is displayed on the braille display as “img”. “desc” is for 
“description” and “prodnote”. “cap” is for “caption”. “tdt is for “table”. 
 
12.2.3 Book-Info 
 
Using “Book-Info,” you can check the information on the file that is 
currently playing. Press “Alt” and press “Enter” on “File.” Press “Down 
arrow key”repeatedly to move to “Book-Info” and press “Enter” on “Book-
Info.” Or you can activate “Book-Info” by pressing “Alt-Enter”. Activating 
“Book-Info” will open the “Book-Info” dialog box without stopping the 
playing of the file. In the dialog box, you will find one state box that 
contains “running time and pages,” another state box that contains the 
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“mark information,” and “Close.” You can move between the three 
controls with “tab” or “shift-tab”. In the first state box, you will find “Total 
time,” “Read time,” “Remaining time,” “Total pages,” “Current page,” and 
“Remaining pages.” In the other state box, you will find the “Total marks” 
and “Mark page.” You can move between the items with “Up arrow 
key”or “Down arrow key”. If you want to close the dialog box, press 
“Enter” on “Close,” which will return you to the current file. 
 
12.2.4 Exit 
 
When you want to quit the Daisy player, press “Alt,” and press “Enter” on 
“File.” And press “Down arrow key”repeatedly to move to “Exit” and 
press “Enter” on “Exit.” Or, you can press “Alt-F4” without using the “Exit” 
menu. While exiting, you will hear the message “Exit DAISY player. Are 
you sure?” Then, press “Enter” on “Yes,” which is the default; or if you 
do not want to exit, you can select “No” by pressing “Space,” and then 
press “Enter.” 
 
12.3 Document 
 
When in the “Document” menu, you can move by phrase or level while 
playing. If you want to activate the “Document” menu, press “Alt” and 
then press “d”. In this menu, you will find items such as, “Play/Pause,” 
“Previous Phrase,” “Next Phrase,” “Previous Page,” “Next Page,” “Go to 
Page,” “Move down,” “Move up,” “Set to prior level,” and “Set to next 
level.” You can move between these items with “Up arrow key”or “Down 
arrow key”. To activate a menu item, select the menu item, and then 
press “Enter.” 
 
12.3.1 Play and Pause 
 
You can access “Play/Pause” in the menu by pressing “Alt,” and then 
press “Enter” on “Document.” Then, use “Down arrow key” to move to 
“Play/Pause” and press “Enter.” You can also activate “Play/Pause” 
without calling up the menu by pressing “Space.” While playing, you can 
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move to the beginning of a document by pressing “Fn-Left arrow key”. 
You can move to the last phrase by pressing “Fn-Right arrow key”. 
 
12.3.2 Move by Phrase 
 
You can access this command in the menu by pressing “Alt,” and then 
press “Enter” on “Document.” Then, use “Down arrow key”to move to 
“Previous Phrase” or “Next Phrase,” and press “Enter.” You can move to 
the next, previous, next fifth, or previous fifth phrase without calling up 
the menu by pressing “Right arrow key”, “Left arrow key”, “Ctrl-Up arrow 
key”, or “Ctrl-Down arrow key”, respectively. 
Also you can move to the previous or next phrase without calling up the 
menu by a short pressing “previous” button or “next” button in the front 
panel. In order to move by phrase with “previous” or “next” button, you 
must set the audio mode switch to “daisy mode.” 
 
12.3.3 Move by Page 
 
You can access this item in the menu by pressing “Alt,” and then press 
“Enter” on “Document.” Then, use “Down arrow key”to move to “Previous 
Page,” “Next Page,” or “Go to Page,” and press “Enter.” You can move 
to the next or previous page without calling up the menu by pressing 
“Page down” or “Page up” during play or pause. You can jump to 
whatever page you want to go to by pressing “Ctrl-g”. If you activate “Go 
to Page,” you will find an edit box asking “Move to page number” “Here 
you can type in the page number that you want to move to. Press 
“Enter,” and the Voice Sense QWERTY will move you to that page. 
 
12.3.4 Move by Level 
 
You can access this function in the menu by pressing “Alt,” and then 
press “Enter” on “Document.” Then, use “Down arrow key”to move to 
“Move up” or “Move down,” and press “Enter.”Or, you can move up and 
down without calling up the menu by pressing “Alt-Left arrow key” or “Alt-
Right arrow key”. You can set the level by pressing “Alt-Down arrow key” 
or “Alt-Up arrow key”. Namely, if the level is set to 3, you can move 
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through the level 1, 2 and 3 and if the level is set to 1, you can move 
through the level 1 only. 
 
12.3.5 Move by Time Index 
 
You can use this function as follows. 

1. While playing audio DAISY file or in pause status. 
2. While playing with audio in audio+text DAISY or in pause status. 

 
The setting values are “5 seconds”, “10 seconds”, “30 seconds”, 
“1minute”, “3 minutes”, “5 minutes”, “10 minutes”, “15 minutes”, “20 
minutes”, “30 minutes” and “1 hour”. 
 
To set previous time index, follow these steps: 

1) Press “Ctrl-Alt-Up arrow key”. Every time you press “Ctrl-Alt-Up 
arrow key”, Voice Sense QWERTY toggles between 30, 10, or 5 
seconds; 1 hour and 30 minutes. 

2) Choose the setting value you want. 
 
To set next time index, follow these steps: 

1) Press “Ctrl-Alt-Down arrow key”. Every time you press “Ctrl-Alt-
Down arrow key”, Voice Sense QWERTY toggles between 5, 10, 
or 30 seconds: 1 minute, 3 minutes and 5 minutes. 

2) Choose the setting value you want. 
 

The moving mode to move by a specified amount of time is as follows. 
1. Move to previous time: Press “Ctrl-Alt-Left arrow key”. If you set “5 

minutes”, it will move to previous position by 5 minutes. 
2. Move to next time: Press “Ctrl-Alt-Right arrow key”. If you set “5 

minutes”, it will move to next position by 5 minutes. 
 
12.3.6 Move by Text Index 
 
You can use this function as follows. 

1. While playing text DAISY file or in pause status. 
2. While playing with text in audio+text DAISY or in pause status. 
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The setting values are “Phonetic”, “Character”, “Word” and “Sentence”. 
 
To set previous text index, follow these steps: 

1) Press “Ctrl-Alt-Up arrow key”. Every time you press “Ctrl-Alt-Up 
arrow key”, Voice Sense QWERTY toggles between “Sentence”, 
“Word”, “Character” or “Phonetic”. 

2) Choose the setting value you want. 
 
To set next text index, follow these steps: 

3) Press “Ctrl-Alt-Down arrow key”. Every time you press “Ctrl-Alt-
Down arrow key”, Voice Sense QWERTY toggles between 
“Phonetic”, “Character”, “Word” and “Sentence”. 

4) Choose the setting value you want. 
 

When you set the value, to move by the setting value, follow these 
steps: 

1. Move to previous text: Press “Ctrl-Alt-Left arrow key”. If you set 
“Sentence”, it will move to previous position by sentence. 

2. Move to next text: Press “Ctrl-Alt-Right arrow key”. If you set 
“Sentence”, it will move to next position by sentence. 

 
12.4 Mark 
 
When you are in the “Mark” menu, you can put in a mark or jump to a 
mark while you are playing a file. Mark can be inserted up to 1000. You 
can open the “Mark” menu by pressing “Alt”, and then “m”. When you 
are in the “Mark” menu, you will find the following sub-menus: “Previous 
Mark,” “Next Mark,” “Set Mark,” “Move To Mark,” and “Delete Mark.” You 
can move between the sub-menus with “Up arrow key”or “Down arrow 
key”. 
 
12.4.1 Previous Mark 
 
The “Previous Mark” function will allow you to move to a location where 
you have placed a mark. If you have passed a mark while listening to a 
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DAISY Player file, you can move to that mark by using the “previous 
mark” function. You can access the “Previous Mark” by pressing “Enter” 
on “Mark,” and then move to “previous mark” by pressing “Down arrow 
key”and press “Enter.” Or just press “p” to execute “Previous Mark.” 
Then, press “Enter” on “Previous Mark.” You can also move to the 
previous mark by pressing “V” during reading DAISY contents. 
 
12.4.2 Next Mark 
 
The “Next Mark” function will allow you to move to a location where you 
have placed a mark. If you have placed a mark in a DAISY Player file, 
and you have not yet passed it, you can move to that mark by using the 
“Next Mark” function. You can access the “Next Mark” function by 
pressing “Enter” on “Mark” and then move to “Next Mark” by pressing 
“Down arrow key”and press “Enter.” Or just press “n” to execute “Next 
Mark.” Then, press “Enter” on “Next Mark.” You can also move to the 
previous mark by pressing “N” during reading DAISY contents. 
 
12.4.3 Set Mark 
 
You can set a mark anywhere you want while playing a file. You can set 
a mark in the “Set Mark” menu. Otherwise, you can set a mark by 
pressing “Alt”. You can also activate this function by pressing “Alt.”  
Then, press “Enter” on “Mark.” Use “Down arrow key”to move to “Set 
Mark” and then press “Enter.” Or press “m” when you are in the “Mark” 
menu. The “Set Mark” dialog box will then open, which will ask you to 
“Enter mark name:”. Enter the number of the mark that you want to 
insert between 1~1,000. 
 
12.4.4 Move to Mark 
 
Without using the menu, you can move to the next or previous mark by 
pressing “n” or “v” during play/pause. You can also move to the mark 
you want by pressing “Ctrl-j”. You can also access this feature in the 
menu by pressing “Alt”. You can then, use “Down arrow key”to move to 
“Mark,” and press “Enter.” Or, you can press “j” when you are in the 
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“Mark” menu. If you activate the “Move To Mark” function, you will find 
the edit box asking “Mark name to move to:.” Here you can type in the 
mark name that you want to go to. Make sure that you have already set 
a mark. Otherwise, you will not be able to move to a mark. 
 
12.4.5 Deleting a Mark 
 
Without using the menu, you can activate the “Delete Mark” function by 
pressing “Del”. You can also activate this function by pressing “Alt.” 
Then use, “Down arrow key”to move to “Mark” and press “Enter.” Then, 
use “Down arrow key”to move to “Delete Mark” and press “Enter” on 
“Delete Mark.” If you activate the “Delete Mark” function, an edit box will 
appear asking, “Enter mark name to delete:.” Make certain that you want 
to delete the mark that you have entered. If you type in a mark in this 
edit box, the mark name will be deleted without pressing “Enter.” 
 
12.5 Heading 
 
When in the “Heading” menu, you can move in a document by your text 
heading, or you can search a heading while the DAISY Player is playing.  
You can open the “Heading” menu by pressing “Alt” and then press “h”.  
Then, you can see the sub-menu: “Previous Heading,” “Next Heading,” 
“Scan Heading,” “Read Heading,” “First Heading,” “Last Heading,” “Find 
Heading,” and “Find Again.” You can move between the sub-menu items 
with “Up arrow key”or “Down arrow key”. 
 
12.5.1 Move by Heading 
 
While playing a DAISY file, you can move heading by heading without 
using the “Heading” menu. You can move to the next, previous, first, and 
last heading by pressing “Ctrl-F6”, “Ctrl-F5”, “Ctrl-f7”, and “Ctrl-F8”, 
respectively. 
 
Also you can move to the previous or next heading without calling up the 
menu using audio buttons on the front panel. Before you use this feature, 
you have to set the audio mode button on the front panel to “daisy 
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mode.” In order to move to previous or next heading, press “previous” or 
“next” button for about 2 seconds and release it. Then it will move to the 
previous or next heading. 
 
12.5.2 Move to Specific Heading 
 
While playing a DAISY file, you can move specific heading without 
calling the menu. 
 
In order to move to specific heading, follow these steps: 

1) Press “Ctrl-h” while playing a DAISY file. 
2) It shows “Current Heading: xx Total heading: yy. Enter the heading 

number to move to:”. 
3) Type heading number that you want to move. 
4) Press “Enter”. 
5) It will move to the selected heading and the DAISY file will start 

playing. 
 
12.5.3 Find Heading 
 
You can find any heading you want while playing a DAISY file.  Without 
using the “Find Heading” menu, you can activate “Find Heading” by 
pressing “Ctrl-f”. When you have pressed this hot key, you will see a 
dialog box that shows the message, “Heading to find:” You will also see 
a “Search direction:,” a “Confirm” button, and a “Cancel” button. You can 
move between the four items with “tab” or “shift-tab”. 
At the “Heading to find:” edit box, you can input the mark name that you 
want to find. And select the searching direction to “Previous” or “Next” at 
“Search direction” prompt by pressing “Space.” 
 
12.5.4 Scan Heading and Read Heading 
 
While playing a DAISY Player file, you can check your current heading 
(or heading list) from your current location to the last heading.You can 
scan them by activating the “Read Heading” or “Scan Heading” in the 
“Heading” menu. 
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Without using the menu (pressing “Alt” and then “h”), you can check the 
current heading (in the file that is currently being played) by pressing 
“Ctrl-w.” If you activate this function, you will see the current heading 
name and level. By pressing “Ctrl-n,” you can scan the heading list from 
the present to the end. If you activate the “Scan Heading” menu, you will 
see the heading list from the present to the end. In the list, if you find 
one that you want to listen to, press “Enter” or “Space” to play it. Using 
this method, you are able to skip other headings and play what you want.  
If you want to cancel the scan heading function, press “ESC” or “Alt-F4.”  
Then, you will be returned to where you were before. 
 
12.5.5 Find Phrase 
 
You can find phrase that you want to move while playing a DAISY file or 
in a pause status. 
 
To execute this function, follow these steps: 

1) Press “Alt” to call up the menu. 
2) It shows “File”. 
3) Press “Down arrow key”, move to “Heading”. 
4) Press “Enter” on the “Heading”. Or press “h”. 
5) It shows “Previous heading”. 
6) Press “Down arrow key”, move to “Find Phrase”. 
7) Press “Enter” on the “Find Phrase”. Or press “s”. 

 
Without calling the menu, you can execute directly it by pressing “Alt-s”. 
 
While executing the “Find Phrase”, it will open “Find Phrase dialog box”. 
The “Find Phrase dialog box” consists of as follows. 

1. Phrase to find 
2. Search direction 
3. Confirm 
4. Cancel 

 
You can move between 4 controls by pressing “Tab” and “Shift-Tab”. 
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To find Phrase, follow these steps: 

1) You can type phrase that you want to find in “Phrase to find” edit 
box. You don't need to type whole phrase. 
If there is no phrase that you want to find, it will hear “No more 
phrases found”. 

2) Press “Tab”, move to “Search direction”. The default setting is 
“Next”. The options that you can choose from for this setting are, 
“Next” and “Previous”. To change setting value, press “Space”. 
· Next: It will find phrase from the next direction of current location. 
· Previous: It will find phrase from the previous direction of current 
location. 

3) After setting the “Search direction”, press “Enter”. Or press “Tab”, 
move to “Confirm. Press “Enter” on the “Confirm”. 

4) It will play from the searched phrase. 
 

If you want to cancel the “Find Phrase”, press “Enter” on the “Cancel”. 
Or press “Alt-F4”. 
 
12.6 Hot Keys in the DAISY Player 
 
1. Play  
Play/Pause: Space 
Move to the beginning of document: Fn-Left arrow key 
Move to the last phrase: Fn-Right arrow key 
Increase the speed: Shift-Right arrow key 
Decrease the speed: Shift-Left arrow key 
Increase the volume: Shift-Up arrow key 
Decrease the volume: Shift-Down arrow key 
 
2. Move by Phrase 
Move to the next phrase: Right arrow key or short press “next” button 
Move to the previous phrase: Left arrow key or short press “previous” 
button 
Move to the next fifth phrase: Ctrl-Down arrow key 
Move to the previous fifth phrase: Ctrl-Up arrow key 
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3. Move by page 
Move to the next page: Page down 
Move to the previous page: Page up 
Go to the page: Ctrl-g 
 
4. Move by level 
Move up: Alt-Left arrow key 
Move down: Alt-Right arrow key 
Set to prior level: Alt-Up arrow key 
Set to next level: Alt-Down arrow key 
 
5. Move by heading 
Move to the next heading: Ctrl-F6 or long press “next” button 
Move to the previous heading: Ctrl-F5 or long press “previous” button 
Move to the last heading: Ctrl-F8 
Move to the first heading: Ctrl-F7 
Check the currently-reading level and heading: Ctrl-w 
Scan the heading list from the present to the end: Ctrl-n  
Move to Specific Heading: Ctrl-h 
Find Phrase: Alt-s 
 
6. Heading 
Find heading: Ctrl-f 
Find again: F3  
Scan heading: Ctrl-n 
Read heading: Ctrl-w  
 
7. Set mark 
Set mark at current position: Ctrl-m 
Move to the next mark: N 
Move to the previous mark: V 
Delete mark: Del 
 
8. Miscellaneous Hot Keys 
Move to the title list: Shift-Backspace 
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Open DAISY file: Ctrl-o 
Voice setting: Ctrl-s 
Set DAISY play type: Ctrl-t 
Check the book-info: Alt-Enter 
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13. Bluetooth Manager 
 
The Voice Sense QWERTY is Bluetooth capable. Bluetooth is the latest 
in wireless technology that allows for a Personal Area Network (PAN). 
Unlike a traditional Wireless Local Area Network (WLAN), these 
networks are limited to approximately 30 feet or less. Bluetooth enables 
users to exchange various types of information. In order to use Bluetooth 
with the Voice Sense QWERTY, you must change the Bluetooth option 
to “On” in the option menu. Please refer to the section 3.33 in this user 
manual. 
 
Bluetooth on the Voice Sense QWERTY allows you to transfer files from 
the Voice Sense QWERTY to a computer or use the Internet connection 
your computer is usingVoice Sense QWERTY. Voice Sense 
QWERTYPlease note that Bluetooth is currently an evolving standard, 
and you may experience different functionality, depending on the 
operating system that you are using. 
 
The Voice Sense QWERTY uses the built-in Bluetooth manager 
program to allow the user to use the Bluetooth functionality in the Voice 
Sense QWERTY. You can access the Bluetooth manager in several 
ways. To access Bluetooth manager from the program menu, you can 
either press “Up arrow key”or “Down arrow key”until you hear Bluetooth 
manager, or press the “Space” until you get to Bluetooth manager. 
When you hear “Bluetooth manager”, press “Enter” to activate it. Or, you 
can press “l” to open the Bluetooth manager from the “program” menu 
without having to press “Enter” on it. 
 
13.1 Bluetooth Device List 
 
After the Bluetooth manager has been activated, it will begin scanning 
for other Bluetooth devices that are in range, and for the services 
available from the other Bluetooth devices. For example, if you have a 
computer with Bluetooth enabled nearby, then the Voice Sense 
QWERTY will attempt to find it. It may take a while to find all of the 
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Bluetooth devices in range, so expect to wait about 30 to 40 seconds for 
this process to complete. You will hear “Scanning for devices. Please 
wait…” message and beep sound when this process begins. And when 
the Bluetooth device is detected, the Voice Sense QWERTY announces 
“find (Bluetooth device name).” Until the end of scanning all devices, any 
keys on the Voice Sense QWERTY will not work, and you cannot stop 
scanning the device. You have to wait until the completion of the 
scanning devices. 
 
If Bluetooth option in Option menu set to “Off,” or if the Voice Sense 
QWERTY does not recognize it, the VoiceSenseQWERTY will say the 
message, “Bluetooth not activated.” Then, the Voice Sense QWERTY 
will automatically exit the Bluetooth Manager. 
 
Once the Voice Sense QWERTY has found other Bluetooth devices that 
are in range, they will be displayed as “device name(untrusted (or 
trusted)) xx/yy” where xx is the number where the device appears in the 
list, and yy is the total number of devices. And “trusted” means that the 
service has been authenticated and “untrusted” means that the service 
has not been authenticated. 
 
This part of the Bluetooth Manager is known as the Bluetooth Device 
List, and thus, the menu for this section is called the Bluetooth Device 
List menu. If there are no other Bluetooth devices in range, the Voice 
Sense QWERTY will say “no items 0/0.” You can press “Up arrow key”or 
“Down arrow key”to move through the list. To select the device from the 
list, press “Enter” on the device name. 
 
If the Bluetooth device trusted, the device setting will be automatically 
saved in the memory of the Voice Sense QWERTY. If you want to delete 
this setting, you press “Del” on Bluetooth device name in the Bluetooth 
Device List. The Voice Sense QWERTY will say “Device settings 
removed.” Removing this setting will apply only to the current device. 
 
Once the Voice Sense QWERTY has finished searching for other 
Bluetooth devices, you can access the menu by pressing “Alt”. The 
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“Bluetooth Device List menu” has the “Rescan for Devices,” “Device 
Name,” “Delete Pair Information,” and “Exit.”You can navigate the menu 
items with “Up arrow key”or “Down arrow key”. 
 
The first menu item is “Rescan for Devices.” This item allows you to 
rescan for other Bluetooth devices. To activate this item, press “Alt” and 
then press “Enter” on “Rescan for Devices.” You can also access this 
option by pressing “r” while you are in the Bluetooth Device List menu, or 
you can activate it directly without calling up the menu by pressing “Ctrl-
r”. 
 
You can access the next item in the menu by pressing “Alt” and then “Up 
arrow key”or “Down arrow key”until you get to “Device Name,” and press 
“Enter.” You can also press “n” while you are in the Bluetooth Device List 
menu to activate “Device Name.” This item allows you to give the Voice 
Sense QWERTY a specific name. The default name for the Bluetooth 
device name is “Voice Sense QWERTY” You can activate this item by 
pressing “Enter” on it, or you can access it without calling up the menu 
by pressing “Ctrl-n.” After you activate this item, you will find a computer 
edit box that contains your current device name. To modify the name, 
type the new name and then press “Enter.” Once you have entered the 
new name, you should close all programs and reset the Voice Sense 
QWERTY by pressing the reset button with your finger on the rear panel. 
To cancel your changes, press “ESC”. You will then be returned to the 
Bluetooth Device List. 
 
The next menu item is “Delete Pair Information.” This item allows you to 
remove the device setting. To activate this item, press “Alt” and then 
press “Enter” on “Delete Pair Information.” You can also access this 
option by pressing “d” while you are in the Bluetooth Device List menu, 
or you can activate it directly without calling up the menu by pressing 
“Del”. 
 
The next item in the Bluetooth Device List menu is the “Exit” item. This 
item will exit the Bluetooth manager program. To activate this item, 
press “Alt” and then press “Up arrow key”or “Down arrow key” to 
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navigate to “Exit.” Then, press “Enter” on “Exit.” You can also access the 
item while in the menu by pressing “z” while you are in the Bluetooth 
Device List menu or at any time without calling up the menu by pressing 
“Alt-F4.” 
 
13.2 Bluetooth Service List 
 
Once you know which remote Bluetooth device you want to connect to, 
press “Up arrow key”or “Down arrow key” to navigate to the device you 
want to connect to in the Bluetooth Device List, and then press “Enter” 
on the device name. You will then hear, “Scanning for service. Please 
wait…” Please note that no keys will work during scanning the devices.  
The Voice Sense QWERTY will begin scanning services that are 
available from the remote Bluetooth device. The Voice Sense QWERTY 
support the services: LAN, FTP, ActiveSync, Serial port, USB port, 
stereo Headset and Bluetooth DUN. In order to access all of these 
functions, you must make sure that the remote Bluetooth device is in 
Discoverable mode, and that all services are enabled. It is possible to 
have certain services enabled on your remote Bluetooth device, while 
having other services that are disabled. For example, you could have 
LAN and FTP enabled, while having ActiveSync and Serial Port disabled. 
If this is the case, then the Voice Sense QWERTY will only display LAN 
and FTP. 
 
Once the Voice Sense QWERTY has found all of the available services, 
it will display the services in a list in the following format:  “service name 
xx/yy” where xx is the number of the service that you are on, and yy is 
the number of total available services. You can move through the 
available services by pressing “Up arrow key”or “Down arrow key”. You 
can press “Backspace” to return to the Bluetooth Device List. 
Once Voice Sense QWERTY has finished searching service, you can 
access the menu by pressing “Alt”. The “Bluetooth Service List menu” 
has the “Device Name,” “Open FTP,” “Disconnect” and “Exit.” You can 
navigate the menu items with “Up arrow key”or “Down arrow key”. 
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How to use “Device Name” and “Exit” in the “Bluetooth Service List” 
menu are the same as how to use them in the “Bluetooth Device List” 
menu. Please refer to Section 13.1 (Bluetooth Device List). 
 
The “Open FTP” menu item allows you to open a direct FTP connection 
with a remote Bluetooth device without having to select the device and 
then the service. However, you must have connected the service first 
before the Voice Sense QWERTY will allow you to transfer files.  If you 
have not connected the FTP service already, and you activate this 
function, you will hear, “FTP service disconnected.” You can access 
“Open FTP” by pressing “Alt” and then “Up arrow key”or “Down arrow 
key”to navigate to “Open FTP.” Once you are at “Open FTP,” press 
“Enter” to activate it, and the Voice Sense QWERTY will say, 
“Connecting service.” You can also activate it by pressing “t” while you 
are in the Bluetooth Device List menu, or by pressing “Ctrl-t” without 
calling up the menu. This chapter will cover connecting various 
Bluetooth services later in more detail. 
 
The “Disconnect” menu item will allow you to disconnect services that 
are connected to other Bluetooth devices. You can access this item by 
pressing “Alt” and then “Up arrow key”or “Down arrow key”. Then, press 
“Enter” to activate it. You can also activate this item while you are in the 
Bluetooth Service List menu by pressing “d”, or you can activate it 
without calling up the menu by pressing “Ctrl-d”. 
In order to disconnect any service, press “Up arrow key”or “Down arrow 
key”at the Bluetooth Service List to move to the service that you want to 
disconnect, and execute the “Disconnect” command. 
You can disconnect the currently focused service only. This means that 
you can disconnect only one service at one time. You cannot disconnect 
plural services at once. 
If there are no services connected to other Bluetooth devices, and you 
activate this function, you will hear, “There is no service connected.” 
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13.2.1 Connecting Service 
 
To authenticate a service and connect to it, press “Enter” on the service.  
Once you have pressed “Enter” on the service, you will hear “Connecting 
service.” Then, you will hear “PIN code:”. On the This edit box will only 
appear when you have pressed enter on a service that not say 
“Connected” after the service name. You can exit the edit box or cancel 
any text you have typed in by pressing “Alt-F4.”  You will then be 
returned to the Bluetooth Service List. 
 
If you have typed in a pin code, and have pressed “Enter,” you will hear, 
“Please wait for authentication.” If the remote device is setup correctly, 
and has not been set up to allow this device to always connect, then the 
remote device will ask for a pin code. If the remote Bluetooth device pin 
code matches the pin code that was typed in the Voice Sense QWERTY, 
then the service will authenticate. If this occurs, you will hear, 
“Connection succeeded.” Then, while the service connects, you will hear, 
“Please wait. Access permission.” If the remote Bluetooth device does 
not give access permission, then you will hear, “Connection failed,” and 
you will be returned to the Bluetooth Services List. If the remote 
Bluetooth device gives you access permission, then the Voice Sense 
QWERTY will say “Connection succeeded.” If the connection succeeds, 
then you will see “Connected” after the services that have successfully 
connected. Some of the service may be connected without inputting pin 
code depending on the Remote Bluetooth device settings. 
 
After you have connected to a service, you can press “Ctrl-d” to 
disconnect the service, and the Voice Sense QWERTY will say “Service 
disconnected.” You will then be returned to the Bluetooth Service List. If 
you disconnect a service, “Connected” will disappear from the Bluetooth 
Service List. 
 
If you connect to the FTP service, you will see a list of files and folders 
that are on the remote Bluetooth device. The rest of this chapter will 
discuss each service in detail. 
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13.2.2 LAN Service 
 
With the LAN service, you can connect to the Internet through your 
computer. If you connect this service, you can use the Web browser and 
email program, just like if you were connected to the Internet via 
ethernet or wireless LAN card. However, you must setup Internet 
Connection Sharing (ICS) on your remote Bluetooth device. Without ICS 
properly setup, you will not be able to connect to the Internet using the 
LAN service. For information on how to setup ICS for your remote 
Bluetooth device, please refer to the documentation that came with your 
Bluetooth adapter. Setting up ICS requires knowledge of network 
architecture, so it may be a good idea to contact a local network 
technician or your network administrator for help to set up ICS. 
 
13.2.3 FTP Service 
 
This service will work similar to using FTP on the Internet. It will allow 
you to transfer folders and files to and from the Voice Sense QWERTY 
between it and the remote Bluetooth device. When referring to the FTP 
service, we will refer to the file/folder list in the remote Bluetooth device 
as “remote folder list” and the file/folder list of the Voice Sense QWERTY 
as the “local folder list.” 
 
After you have successfully connected to the FTP service, the Bluetooth 
Manager will take you to the remote folder list. The remote folder list that 
you are taken to is determined by the remote Bluetooth device.  
Typically, this folder is called the Bluetooth Exchange Folder on the 
remote Bluetooth device, but you should check your remote Bluetooth 
device for information on this folder. 
 
The remote folder list is very similar to the File Manager. With the FTP 
service, you can perform the following functions: 
1. Copy 
2. Paste 
3. Send To 
4. Retrieve File 
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5. New Folder 
6. Delete File/Folder 
7. Open Local Folder. If you press “Enter” on this, you will be taken to 

the local folder list. If you are in the local folder list, this menu will be 
changed to “move remote folder.” 

8. Select All 
9. Information 
 
In the next few sections, we will discuss the various FTP functions.  
Please note that while sending data to and from the remote Bluetooth 
device, the remote Bluetooth device may still need to give access 
permission to the Voice Sense QWERTY. Please consult the 
documentation for the remote Bluetooth device for details. 
 
13.2.3.1 Copy and Paste 

 
These functions will allow you to copy and paste files between the local 
folder and the remote folder. 
You can use the following steps to move files from a local folder to the 
remote folder: 
 

1) After you connect to the FTP service, you will be in the remote 
folder list. While in the remote folder list, you should press “Alt” to 
open the FTP menu. Then, you should press “Up arrow key”or 
“Down arrow key”to navigate to “Open Local Folder,” and press 
“Enter.” You can also press “o” while in the menu, or you can 
press “Ctrl-o” without having to call up the menu. After activating 
this function, you will hear, “Open Local Folder.” Then, you will be 
taken to the Disk list that appears in file manager. You will be 
taken to “flashdisk” by default, but if you have a SD memory card 
or USB memory stick inserted, you can navigate to them by 
pressing “Up arrow key”or “Down arrow key”. 

2) Just like navigating in the File manager, you can access a disk by 
pressing “Enter” on it. Use the exact same navigation keys as the 
File manager to navigate the local folder. You can refer to chapter 
4 of this manual to find the various file manager commands. Note 
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that you cannot select folders. You can only select files. If you try 
to select a folder, the Voice Sense QWERTY will say 
“Deactivated.” 

3) Once you have selected files by pressing the “Space,” you can 
copy them by pressing “Alt,” and then navigate to “Copy” by 
pressing “Up arrow key”or “Down arrow key” and press “Enter.” Or, 
you can press “Ctrl-c” to activate the function without calling up the 
menu. 

4) After you have activated the copy function, you will hear, 
“Copying” and then “Open Remote Folder.” You will then be 
moved to the remote folder list. 

5) In the remote folder list, you can navigate to the folder where you 
want to paste the file. Once you are in the folder where you want 
to paste the file, press “Ctrl-v”. Or, you can press “Alt”,and then 
use “Up arrow key”or “Down arrow key”to get to the “Paste” 
function, and press “Enter.” While pasting, you will hear a sound 
that indicates that the Voice Sense QWERTY is working. If the file 
is larger than 300 KB, you will also hear the progress meter each 
time an additional 10% has been completed. If the file is less than 
300 KB, then you will only hear the sound, and not the progress 
meter. 

6) When the file has been pasted successfully, you will see the 
message, “xxx file sent,” where xxx is the name of the file. If the 
file is not pasted successfully, you will hear, “xxx file not sent.” 
After the file is pasted successfully, you will also hear, 
“successfully sent,” and you will be returned to the remote folder 
list. 

 
The following steps should be used to copy a file from the remote folder 
list to the local folder list: 
 

1) After the FTP service has connected, you can navigate through 
the remote folder, just like in the file manager. If you need to 
reference the navigation keys for the File manager, please refer to 
chapter 4 in this manual. 
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2) Once you have selected the files that you want to copy by 
pressing the “Space,” you can open the FTP menu by pressing 
“Alt”, and then use “Up arrow key”or “Down arrow key”to navigate 
to “Copy,” and press “Enter.” You can also activate this function 
without calling up the menu by pressing “Ctrl-c”. Note that you 
cannot copy folders to send to the local folder. 

3) Next, it will open the “Local folder”. You will see the Disk list, just 
like when you open the file manager. You will be taken to 
“flashdisk” by default. However, if you have a SD memory card or 
USB memory stick inserted, you can navigate to those disks by 
pressing “Up arrow key”or “Down arrow key”. Please refer to 
chapter 4 in this manual regarding navigation keys in the File 
manager. 

4) After entering a disk, open the menu by pressing “Alt.” Then, move 
to “Paste” with “Up arrow key”or “Down arrow key” and press 
“Enter.”  You can also activate this function without calling up the 
menu by pressing “Ctrl-v.” While pasting, you will hear a sound 
that indicates that the Voice Sense QWERTY is working. If the file 
is larger than 300 KB, you will also hear the progress meter each 
time an additional 10% has been completed. If the file is less than 
300 KB, then you will only hear the sound, and not the progress 
meter. 

5) When the file has been pasted successfully, you will see the 
message, “xxx file retrieved,” where xxx is the name of the file. If 
the file is not pasted successfully, you will hear, “xxx file not 
retrieved.” After the file is pasted successfully, you will also hear, 
“Retrieve completed,” and you will be returned to the local folder 
list. 

 
13.2.3.2 Send To 
 
This function will allow you to send files from the local folder list to the 
remote folder list. It is only available in the local folder list. This is very 
similar to the copy and paste function. The difference is that you do not 
have to paste the file to the remote folder. It is done as soon as you 
activate the “Send To” function. When you activate this function, the file 
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can only be sent to the root of the remote folder list. To activate the 
“Send To” function, perform the following steps: 
 

1) After the FTP service is connected, you can press “Alt” while you 
are in the remote folder list to open the menu. Then, press “Up 
arrow key”or “Down arrow key”to move to “Open Local Folder,” 
and press “Enter.” You can also activate this function without 
calling up the menu by pressing “Ctrl-o”. 

2) After you have activated this function, you will see the disk list, just 
like when you open the file manager. You will be taken to 
“flashdisk” by default. However, if you have a SD memory card or 
USB memory stick inserted, you can navigate to those disks by 
pressing “Up arrow key”or “Down arrow key”. Please refer to 
chapter 4 in this manual regarding navigation keys in the File 
manager. 

3) Then, select a file by pressing “Space” on the file. You can only 
select files and not folders. 

4) After you have selected a file, press “Alt”,and then press “Up arrow 
key”or “Down arrow key”to move to “Send To,” and press “Enter.”  
Or, you can press “Ctrl-s” to activate the “Send To” function 
without having to call up the menu. 

5) Just like copying and pasting, you will hear a sound that indicates 
that the Voice Sense QWERTY is working. If the file is larger than 
300 KB, you will also hear the progress meter each time an 
additional 10% has been completed. If the file is less than 300 KB, 
then you will only hear the sound, and not the progress meter. 
When the transfer has completed, you will hear, “xxx file sent,” 
where xxx is the name of the file. If the file does not transfer, you 
will hear, “xxx file not sent.”  Once all of the files have been 
transferred completely, you will hear, “Successfully sent,” and you 
will be returned to the remote folder list. 

 
13.2.3.3 Retrieve File 
 
The “Retrieve File” function will allow you to retrieve a file from the 
remote folder list, and move it to the local folder. This function is 
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available while in the remote folder list. You can only save files to the 
“flashdisk/download” folder with this function. Perform the following steps 
to activate the “Retrieve File” function: 

1) After you have connected the FTP service, you will be connected 
to the remote folder list. You can navigate through the list using 
the same commands as in the File manager. You can reference 
these commands by referring to chapter 4 of this manual. 

2) Select the file that you want to retrieve by pressing the “Space” on 
it.  Note that you cannot select folders. 

3) After you have selected the file, press “Alt” to open the menu, and 
then use “Up arrow key”or “Down arrow key” to move to “Retrieve 
File,” and press “Enter.” You can also activate this function without 
calling up the menu by press “Ctrl-r”. 

4) Just like copying and pasting, you will hear a sound that indicates 
that the Voice Sense QWERTY is working. If the file is larger than 
300 KB, you will also hear the progress meter each time an 
additional 10% has been completed. If the file is less than 300 KB, 
then you will only hear the sound, and not the progress meter. 
When the transfer has completed, you will hear, “xxx file 
retrieved,” where xxx is the name of the file. If the file does not 
transfer, you will hear, “xxx file not retrieved.” Once all of the files 
have been transferred completely, you will hear, “Retrieve 
completed,” and you will be returned to the remote folder list. 

 
13.2.3.4 New Folder 
 
The “New Folder” function will allow you to create a new folder in the 
local folder list or the remote folder list. To create a new folder, perform 
the following steps: 
 

1) After the FTP service has connected, navigate to the local or 
remote folder list and move to the folder where you want to make 
new folder.  You can move between the “remote folder list” and 
“local folder list” by pressing “Ctrl-o.” And how to move among the 
items in the folder list is the same as how to move in the File 
manager. 
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2) Press “Alt” to open the menu, and then use “Up arrow key”or 
“Down arrow key”to navigate to “New Folder,” and press “Enter.” 
Or, you can activate this function without calling up the menu by 
pressing “Ctrl-f” in “Remote folder”. Also you can activate, pressing 
“Alt-f” without calling up the menu in “Locol folder”.    

3) You will then see an edit box that says, “New folder name:.” Type 
in the new folder name, and then press “Enter.” If the folder is 
created successfully, you will hear, “Folder successfully 
created”. ,” You will then be automatically returned to the list that 
you were in, whether it was the remote or local folder list. 

4) To cancel any changes that you made, press “Alt-F4,” and you will 
be returned to the previous list. 

 
13.2.3.5 Delete File/Folder 
 
This function will allow you to delete files or folders in the remote or local 
folder list. Note that if a folder contains folders, you will not be able to 
delete the folder. To activate this function, perform the following steps: 
 

1) After you have connected to the FTP service, navigate to the local 
or remote folder list, and select the file(s) or folder(s) that you want 
to delete by pressing the “Space” on them. The navigation keys 
are exactly the same as when using the file manager. To 
reference these keys, please refer to chapter 4 of this manual. You 
can move to between “remote folder list” and “local folder list” by 
pressing “Ctrl-o.” 

2) Once you have selected the file(s) or folder(s), press “Alt”,and then 
use “Up arrow key”or “Down arrow key”to move to “Delete 
File/Folder,” and press “Enter.” You can also activate this function 
without calling up the menu by pressing “Del”. 

3) If the file(s) or folder(s) is/are deleted successfully, you will hear, 
“Sucessfully deleted.” 
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13.2.3.6 Information 
 
This function will allow you to check information regarding files or folders 
that are located in the remote or local folder list. You can activate this 
function by performing the following steps: 
 

1) After you have connected to the FTP service, navigate to the local 
or remote folder list, and select the file or folder that you want to 
know information about. The navigation keys are exactly the same 
as when using the file manager. To reference these keys, please 
refer to chapter 4 in this manual. 

2) Then, press “Alt” to open the menu, and then use “Up arrow key”or 
“Down arrow key”to move to “Information,” and press “Enter.” Or, 
you can activate this function without calling up the menu by 
pressing “Ctrl-i.” 

3) After you have activated the function, you will see the “Information 
dialog box,” which consists of “Type,” “Size,” “Date,” “Attribute,” 
“Confirm,” and “Cancel.” You can move between these controls by 
pressing “tab” or “shift-tab”. If you select multiple files, the 
“Information” function will display the number of selected files and 
size. 

 
13.2.4 ActiveSync Service 
 
This service works the same way as when you connect the Voice Sense 
QWERTY to a computer via a USB cable, and use ActiveSync. If the 
connection succeeds when activating it by pressing “Enter” on 
ActiveSync, you will hear the sound that ActiveSync makes when there 
is a successful connection. Just as with all of the Bluetooth services, the 
remote Bluetooth device may need to authorize the Voice Sense 
QWERTY. You will then be returned to the Bluetooth Service list. Just 
like using ActiveSync via USB, you can copy and paste files from the 
Voice Sense QWERTY from the remote Bluetooth device to the Voice 
Sense QWERTY and visa versa. 
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If you want to disconnect the service, you can press “Ctrl-d” while in the 
Bluetooth Manager, and the Voice Sense QWERTY will say, 
“Disconnect from service” and you will be returned to the Bluetooth 
Service list. You will no longer see the word “Connected” after 
ActiveSync in the Bluetooth Service List. 
You cannot use ActiveSync via USB and Bluetooth at the same time. If 
the remote Bluetooth device is connected via USB and using ActiveSync, 
you must disconnect the remote Bluetooth device in order to use the 
ActiveSync service via Bluetooth. 
 
13.2.5 Serial Port 
 
If you connect this service, you should not connect the other services. 
The Serial Port service is used with GPS receiver. Through this service, 
the Voice Sense QWERTY brings required information from GPS 
receiver. Please refer to “SenseNavigation Manual” for more information. 
 
13.2.6 Bluetooth keyboard service 
 
If you use this service, you can connect a Bluetooth keyboard.  
In order to use this service, you must turn on the Bluetooth keyboard. 
You can connect a Bluetooth keyboard by doing the following. 

1) Move to Bluetooth keyboard and press “Enter” in device list. 
2) And then “Keyboard” service will displayed. 
3) Press “Enter” on “Keyboard” service. 
4) And then you will be prompted to input PIN code if Bluetooth 

keyboard require you to input PIN code. Otherwise, you don’t need 
to input PIN code. 

5) Input PIN code on the Voice Sense QWERTY and press “Enter.” 
And then you need to input PIN code on the Bluetooth Keyboard. 
(The PIN code of Bluetooth keyboard may be referred to the 
Bluetooth keyboard manual.) 
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13.2.7 Bluetooth Headset Service 
 
Using Bluetooth headset, you can hear the voice of Voice Sense 
QWERTY through the Bluetooth headset. To use a Bluetooth headset, 
you need to turn on the Bluetooth headset first. And by executing the 
Bluetooth program, Voice Sense QWERTY search for Bluetooth headset 
through the device search. From the list of device, press “Enter” on the 
Bluetooth headset. Then, it will search service of Bluetooth headset. If 
Bluetooth headset supports “A2DP”, it will show “headset” in service list. 
Press “Enter” on “headset”. It will be proceeded authorization to use 
between the Bluetooth headset and Voice Sense QWERTY.  
 
Once the authorization is completed, you can hear the voice Voice 
Sense QWERTY through the Bluetooth headset. 
 
Note: We highly recommend using Bluetooth 2.0 headset. If you use 
below Bluetooth 2.0 headset, discontinuous playing might be occurred. 
 
13.2.8 Bluetooth Printer service 
 
You can print the documents connecting the printer to Voice Sense 
QWERTY through the “Bluetooth”. To use this function, you need to use 
the printer that supports Bluetooth or has a capability connecting 
Bluetooth receiver. To set, follow these steps below: 

1) Press “F9” to turn on the Bluetooth. 
2) Execute “Bluetooth” program. 
3) Bluetooth device has been detected. 
4) By pressing “Up arrow key” or “Down arrow key”, move to 

“Bluetooth printer device”  
5) Press “Enter”. 
6) It will show “Service list”, after scanning service. 
7) By pressing “Up arrow key” or “Down arrow key”, move to “Printer”. 
8) Press “Enter”  

 
Then the printer will have been connected to Voice Sense QWERTY. 
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13.2.9 Using Multiple Services Simultaneously 
 
You can use the LAN, FTP, and ActiveSync Bluetooth services all at the 
same time. However, if you plan to use any of these services at the 
same time, you should connect the FTP service before connecting the 
LAN and ActiveSync services. Otherwise, you may experience problems.  
However, if you want to connect to the Serial  
Port, you should not connect to any of the other Bluetooth services in the 
Bluetooth Service list. 
 
13.3 Hot keys in Bluetooth Manager 
 
1. Hot keys in Bluetooth manager 
Scanning Bluetooth device: Ctrl-r 
Connecting device: Enter on the device name 
Connecting service: Enter on the service name 
Disconnect service in Bluetooth service list: Ctrl-d  
Move to Bluetooth device list in service list: Backspace 
Remove device setting in Bluetooth device list: Del  
 
2. FTP service in Bluetooth manager 
Open local folder/move remote folder: Ctrl-o  
Copy: Ctrl-c 
Paste: Ctrl-v  
Send to: Ctrl-s 
Retrieve file: Ctrl-r 
New folder: Ctrl-f 
Delete file/folder: Del 
Information: Ctrl-i 
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14. MSN messenger 
 
The MSN messenger program on the Voice Sense QWERTY is very 
similar in its operation to that which runs on a Personal computer.   
This is because we have made every attempt to keep the structure and 
features the same as those that are found in the MSN messenger 
program that runs on a PC. Using MSN messenger, you can chat online 
with other registered users of MSN messenger. Note that you will need 
to setup your MSN messenger account with Microsoft before using this 
service.  To start MSN messenger, in the program menu, press “Down 
arrow key”repeatedly until you get to “MSN messenger,” and press 
“Enter.” Or you can just press its shortcut key, “n”. 
 
14.1 Getting Started with MSN Messenger 
 
Please, before execute messenger, encourage Windows messenger use. 
Windows live messenger does not encourage use. 
 
When you first launch MSN messenger, the Voice Sense QWERTY will 
display for the network status, and if a network connection is available, a 
log-in dialog box will be displayed. 
 

1) When the log-in dialog box appears, you will be placed in the “E-
mail address” computer edit box. Here, you should type the email 
address that you have registered for your MSN passport.   

2) Press “tab” to move to the “Password” computer edit box. Now, 
Type the password that you have setup for your MSN messenger 
account.   

3) Press “tab” to move to the “Remember me” check box. By default, 
this check box is unchecked. You can check the check box by 
pressing “space.” Next time when you run the messenger program, 
the email address will be displayed automatically for you. 

4) Press “tab” to move to the “Save password” check box. By default, 
this will be unchecked. You can check this option by pressing 
“space.” Then, next time you run the messenger program, the 
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password will be entered automatically, and it will be displayed in 
the password edit box as “****”. To use this feature, you should 
also check the “Remember me” check box. Otherwise, the 
password will not be stored even if you have checked the “Save 
password” check box. 

5) Press “tab” to move to the “Confirm” button. Pressing “Enter” here 
will log you in to your Messenger account. Once you are logged in, 
a contact list will appear. If you want to cancel logging in, press 
“tab” once more at the “Confirm” button, to move to the “Cancel” 
button.  Then press “Enter.” Or you can also press “Alt-F4.” Then 
the messenger program will close. 

 
If you have successfully logged in and checked “Remember me” and 
“Save password” check boxes, you can log in by just pressing “Enter” 
when you are at the “email” edit box the next time you want to log in.   
When the Voice Sense QWERTY is not connected to the Internet, if you 
execute the MSN messenger and try to log in, the Voice Sense 
QWERTY will announce “Connection failed. Display Network Status.” 
and return to the log-in dialog box. 
 
14.2 Using a Contact List 
 
If you have successfully logged in, a list box containing your contact list 
will appear. In this list, the contact information for those who are online 
and for those who are offline will be grouped together. You can move 
through the entire list by pressing “Down arrow key”or “Up arrow 
key”repeatedly. When this list box appears, the number of people who 
are online will be displayed first. Then, the list of people who are online 
will be shown in the format, “nickname (current status) xx/yy” in LCD, 
and “nickname, current status, xx/yy” in speech. Where “yy” is the 
number of people who are online or offline, and “xx” is the order of the 
current item in the online or offline group. In LCD, the current status, 
“online”, is displayed as “nln”, and “offline” as “fln”. In speech, they are 
announced as “online” and “offline”, respectively. When the status is 
“idle”, it is displayed as “idl” in LCD, and “idle” in speech. If the status of 
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a person changes after you log in, you will hear different sound 
depending on their status. 
The hotkeys you can use in this list box is as follows. 
 
1. Move to the previous item : Up arrow key  
2. Move to the next item : Down arrow key  
3. Move between online and offline groups :Ctrl-Down arrow key 
You can have the received message stay on the LCD until you are done 
reading it. When in the Contacts list box you can press “Ctrl-l.”  When 
you are asked to “Confirm the received message: No,” select “Yes” by 
press the “Space.”  
 
Note: If SyncBraille is connected and received the message, it will stay 
on the Braille display until you close it with “ESC.”  
 
If you want to close the messenger program, press “Enter” on “Close” in 
the file menu. Or you can press “Alt-F4.” 
 
14.2.1 Instant Messaging 
 
When you want to have a conversation with a person in your list of 
contacts, move to the list item corresponding to the person you want to 
contact, and press “Alt” to open the menu. Move to “Actions” and press 
“Enter.” Press “Enter” again on “Send Instant Message.” Or instead of 
using the menu, you can press “Enter” or “Ctrl-s” at the contact item.  
Then, the “Instant message” dialog box will appear, where you can have 
a conversation with your contact online. The “Instant message” dialog 
box will be described in more detail in 14.3. 
 
14.2.2 Adding, Deleting, or Viewing Contact Information 
 
You can add a contact by doing the following. 
 

1) Press “Alt” to open the menu. Move to “Contacts” by pressing 
“Down arrow key,” and then press “Enter.” Press “Enter” on “Add 
Contact.”  You could also press “Ctrl-a” instead of using the menu. 
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2) Then, the “Add Contact” dialog box will be displayed, and you will 
be placed in the “E-mail address” edit box. You input the email 
address of the person you want to add on keyboard. 

3) Press “tab” to move to the “Confirm” button, and press “Enter.” 
Then, the contact information will be stored and you will be placed 
back in the contact list box. If you want to cancel adding the 
contact information, press “tab” to move to the “Cancel” button, 
and press “Enter.” 

 
The added contact will be displayed as offline until the person accepts 
your request for adding him or her to your contact list. As soon as the 
request is accepted, their status will be changed to online. 
 
You can delete a contact that you have registered by doing the following. 
 

1) Move to the contact you want to delete, by pressing “Up arrow 
key”or “Down arrow key”repeatedly. 

2) Press “Alt” to open the menu. Press “Down arrow key”to move to 
“Contacts,” and press “Enter.” Move to “Delete Contact” by 
pressing “Down arrow key,” and press “Enter.” Or instead of using 
the menu, just press “Ctrl-d.” 

3) Then, the “Delete Contact” dialog box will be displayed, showing 
the email address of the person to be deleted in the “E-mail 
address” edit box. Make sure that the address is correct, and if not, 
make a change to it. 

4) Press “tab” to move to the “Confirm” button, and press “Enter.” 
Then, the item will be deleted and the contact list box will appear 
again. If you want to cancel deleting, press “tab” once more at the 
“Confirm” button, to move to the “Cancel” button. Then press 
“Enter.” 

 
You can delete a contact regardless of whether he/she is online or 
offline. 
 
You can view information of a contact by doing the following. 
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1) Move to the item whose information you want to know, by pressing 
“Down arrow key”or “Up arrow key.” 

2) Press “Alt” to open the menu. Press “Down arrow key”to move to 
“Contacts,” and press “Enter.” Move to “Contact Information” by 
pressing “Down arrow key”, and press “Enter.” Or instead of using 
the menu, just press “Ctrl-v.” 

3) Then, you will be placed the “Contact Information” dialog box. First, 
“Nickname” is focused. Press “tab” to move to the email address 
of the contact. Press “tab” again to move to his/her status. 

4) After you have read all the information about the contact, press 
“tab” to move to the “Close” button, and press “Enter.” Or you can 
just press “ESC.” Then, the dialog box will be closed and the 
contact list box will appear again. 

 
14.2.3 Changing Your Nickname, Status and Viewing Your 
Information 
 
You can change your nickname as follows. 
 

1) Press “Alt” to open the menu. Press “Down arrow key”repeatedly 
to move to “Tools,” and press “Enter.” Press “Enter” on 
“Nickname.” Or instead of using the menu, just press “Ctrl-p.” 

2) Then, the “Change Nickname” dialog box will appear, and the 
“Nickname” edit box will be focused. Type the nickname you like.  
You can use alphabets, numbers, and other symbols in the 
nickname. 

3) Press “tab” to move to the “Confirm” button, and press “Enter.” 
Then your nickname will be changed and you will be placed back 
in the contact list box. 

 
To view your nickname or email address, you can use “my status” as 
follows. 
 

1) Press “Alt” to open the menu. Press “Enter” on “File.”Then, move 
to “My Status” by pressing “Down arrow key” and then press 
“Enter.”  Or instead of using the menu, just press “Ctrl-m.” 
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2) Then, the dialog box will appear, and your nickname will be 
displayed.  Press “tab” to move to your email address, and “tab” 
again to move to “Status,” and so on. 

3) When you have read through all of the information, you can press 
“tab” to move to the “Close” button, and then press “Enter.” Or you 
can just press “ESC.” Then, the information dialog box will be 
closed and you will be placed in the contact list box. 

 
You can change your status by doing the following. 

 
1) Press “Alt” to open the menu. Press “Enter” on “File.” Move to “Set 

My Status” by pressing “Down arrow key,” and press “Enter.” Or 
instead of using the menu, just press “Ctrl-t”. 

2) Then, the “Set My Status” dialog box will appear, and the “Status” 
combo box will have focus. Move to the status item that you want 
by pressing “Down arrow key”or “Up arrow key.” 

3) Press “tab” to move to the “Confirm” button, and press “Enter.” 
Then your online status will be changed and you will be placed in 
the contact list box. 

 
14.2.4 Additional Features 
 
1. Sign out 

When you are logged in and you want to log in to another account, 
you will need to log out first, and then log in to the other account.  
Press “Alt” to open the menu. Press “Enter” on “File.” Press “Down 
arrow key”repeatedly to move to “Sign Out” and press “Enter.” Then, 
you are logged out, and the Sign In dialog box will appear again. In 
the “E-mail address” and “Password” edit box, the email address and 
password used in the previous login will be displayed by default. To 
log in to another account, you first need to delete the log in 
information from the first account, and type the log in information of 
the other account. 

 
2. Save account 
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If you did not check the “Remember me” and “Save password” check 
boxes in the Sign In dialog box, later, you may want to save the 
account information once you are logged in. You can use the “Save 
Account” option for this. It is exactly the same as checking the two 
check boxes in the login dialog box. To use “Save Account,” you 
should press “Alt” to open the menu. Press “Down arrow 
key”repeatedly to move to “Tools,” and press “Enter.” Press “Down 
arrow key”to move to “Save account,” and press “Enter.” Then, you 
will hear “Save account? Yes.” In here, you press “Enter” and then 
you will be placed back in the contact list box. 

 
3. View chat and last message 

When you are having a conversation with more than one person 
simultaneously, you can view a list of messages that you have 
received previously. You can use the “Last Message” option, or when 
using “View Chat” go back to the instant message dialog box which 
you have used recently in the current instant message dialog box. 

 
To use “View Chat,” you should press “Alt” to open the menu and 
press “Enter” on “File” menu. Press “Down arrow key” to move to 
“View Chat,” and press “Enter.” Or you press “Ctrl-r” without call up 
menu. 

 
To use “Last Message,” you should press “Alt” to open the menu.  
Press “Down arrow key”repeatedly to move to “Actions,” and press 
“Enter.” Press “Down arrow key”to move to “Last Message,” and 
press “Enter.” Or you press “Alt-r” without call up menu. When 
executing “Last Message” you can see the “list of messages.” In this 
list, you can move through the messages by pressing “Up arrow 
key”or “Down arrow key”repeatedly. If you press “Enter” on a 
message, then the focus will move to the corresponding instant 
message dialog box. 

 
4. Play keyboard sound 

You can select whether your message input is converted into the 
sound or not to use “Play Keyboard Sound” when you are writing your 



309 
 

message to a person in the instant message dialog box. In other 
words, you can choose whether you will hear a person’s message 
input while inputting your message or your message input 
continuously when a person send you a message. You need to take 
the following steps for this function. 
1) Press “Alt” to call up the menu. 
2) Press “Down arrow key”to move to the “Tools” and press “Enter.” 
3) Press “Down arrow key”to move to the “Play Keyboard Sound” 

and press “Enter.” Or, you can press “Ctrl-k” to move to the “Play 
Keyboard Sound” directly. Then, you can see “Play keyboard 
sound: Yes” message. 

4) If you press “Enter,” you can hear your input message even if a 
person send you a message. 

If you press “Down arrow key”first and then press “Enter,” you can 
hear a person’s input message even if you are writing your message. 

 
5. Message sound notification while in current window 

You can select whether you use beep sound for the messages or not 
to use “Message Sound Notification While In Current Window” when 
you are communicating with a person in the instant message dialog 
box. You need to take the following steps for this function. 
1) Press “Alt” to call up the menu. 
2) Press “Down arrow key”to move to the “Tools” and press “Enter.” 
3) Press “Down arrow key”to move to the “Message Sound 

Notification While In Current Window” and press “Enter.” Or, you 
can press “Fn-s” to move to the “Message Sound Notification 
While In Current Window” directly. Then, you can see “Play 
message sound notification while in current window: Yes” 
message. 

4) If you press “Enter,” you can hear beep sound when you 
communicate with a person. 

5) If you press “Down arrow key”first and then press “Enter,” you 
can’t hear beep sound when you communicate with a person. 

However, if you are not in instant message dialog box, but in contact 
list, you will hear beep sound even if you selected no option of “notify 
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message sound in current window” because it is applied for current 
messaging window only. 

 
6. Message sound notification while messenger is in the background 

You can select whether you use beep sound for receipt of the 
messages or not to use “message sound notification while messenger 
is in the background” when you are using another program like as 
word processor. You need to take the following steps for this function. 
1) Press “Alt” to call up the menu. 
2) Press “Down arrow key”to move to the “Tools” and press “Enter.” 
3) Press “Down arrow key”to move to the “Message Sound 

Notification While Messenger Is In The Background” and press 
“Enter.” Or, you can press “Alt-m” to move to the “Message Sound 
Notification While Messenger Is In The Background” directly.  
Then, you can see “Play message sound notification while 
messenger is in the background: Yes” message. 

4) If you press “Enter,” you can hear beep sound when a person 
send you a message. 

If you press “Down arrow key”first and then press “Enter,” there is no 
beep sound and you can’t find out new message before you check 
messenger program. 

 
14.3 Instant Message Dialog Box 
 
If you press “Enter” on an item in the contact list box, the instant 
message dialog box will appear. The instant message dialog box 
consists of “history” window, “input” edit box, “Send” and “Close” buttons.  
The “history” window lists all the messages that have been sent to and 
from other contacts. In the “input” edit box, you can type your message 
to be sent to another person. You can move between these controls by 
pressing “tab” or “shift-tab.” When you are sending an instant message, 
the “input” edit box will be focused when the dialog box appears. On the 
other hand, if the dialog box was opened to read received messages, 
the “history” window will be focused. In the “input” edit box, you can type 
one line, and by pressing “Enter,” you can send the message. You can 
also move to the “Send” button, and press “Enter” to send the message.  
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Then the message will also be added to the “history” window. In the 
“history” window, for each message, the nickname of the person who 
wrote the message will be displayed first, and then the content of the 
message will be displayed. Each message is considered as a paragraph.  
When you are in the instant message dialog box, if the other person 
sends a message, the message will be displayed in LCD and announced 
in speech immediately. If you receive a message while the focus is at 
the “input” edit box, the focus will not be changed. If the focus is at the 
“history” window, the content of the window will not be updated until you 
move to another control and go back to the “history” window. 
 
While you are in the instant message dialog box, you can move to the 
contact list box by pressing “Page up or Page down”. If you press the 
key again, you will go back to the instant message dialog box. More than 
one instant message dialog box can be opened at the same time. For 
example, while you are in an instant message dialog box, if you go to the 
contact list box by pressing “Page up” and press “Enter” on another 
contact, another instant message dialog box will be opened. 
 
If you want to close the instant message dialog box, press “Enter” on the 
“Close” button, or press “ESC.” Then, the dialog box will be closed, and 
you will be placed back in the contact list box. 
  
14.3.1 Inviting Others to Start a Conversation 
 
You can invite others to have a conversation together at the same time.  
That is, you can have a conversation with more than one person in one 
instant message dialog box. You can invite or add another participant as 
follows. Press “Alt” to open the menu. Move to “Actions” by pressing 
“Down arrow key”repeatedly, and press “Enter.” Press “Enter” on “Invite 
A Contact.” Or instead of using the menu, you can just press “Ctrl-i.” 
Then, the list of people who are online will be displayed. Press “Up 
arrow key”or “Down arrow key”repeatedly to move to the contact you 
want to invite. Press “Enter.” Then you will get a message that says the 
person has been invited, and you will be placed back in the current 
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instant message dialog box. Now, you are able to have a conversation 
with more than one person in one dialog box.   
 
14.3.2 Saving and Printing Your Messages 
 
You can save or print the messages that are shown in the “history” 
window. If you want to save the messages, press “Alt” to open the menu.  
Press “Enter” on “File.” Move to “Save As” and press “Enter.” Or instead 
of using the menu, you can just press “Alt-s.” Then, the save dialog box 
will appear and the “File name” edit box will be focused. This dialog box 
has the same controls, and you can use it in the same way as the “Save 
As” dialog box in “Word processor.” 
 
If you want to print the messages, first, press “Alt” to open the menu.  
Then, press “Enter” on “File.” Move to “Print” by pressing “Down arrow 
key”repeatedly, and press “Enter.” Or instead of using the menu, you 
can just press “Ctrl-p”. Then, the “Print” dialog box will be displayed.  
This dialog box is the same as the “Print” dialog box in the “Word 
processor.” The messages can be printed or embossed in Braille. 
 
14.3.3 Copying and Pasting Instant Messages 
 
You can copy, paste, and delete the messages in the “history” window or 
“input” edit box, as you can do in the “Word processor.” However, since 
the “history” window is read only, you cannot paste, cut, and delete the 
messages in the “history” window. To select a block of text, move the 
cursor to the starting point, and press “Ctrl-b.” Then, move to the end 
point of the text to be selected. Press “Ctrl-c” to copy, “Ctrl-x” to cut. 
Then, move the cursor to the place where you want to insert the copied 
text (the “input” edit box, or an edit box of another program), and press 
“Ctrl-v” to paste the text. If you press “Ctrl-a,” you can select all the text 
in the current control.  You can perform these functions using the “Edit” 
menu. 
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14.3.4 Searching Messages 
 
You can search the messages in the “history” window for text. This is 
very useful especially when you have exchanged a lot of messages.  
The “Find” dialog box is used for this, and it works the same as the one 
in the “Word processor.” Press “Alt” to open the menu. Press “Down 
arrow key”to move to “Edit,” and press “Enter.” Press “Down arrow 
key”repeatedly to move to “Find,” and press “Enter.” Or instead of using 
the menu, just press “Ctrl-f.” Then, the “Find” dialog box will appear, and 
the “Text to find” edit box will be focused. Type the string to look for and 
set the searching direction, and then press “Enter.” Then, the focus will 
move to the message that contains the text. If you want to find it again in 
the same direction, press “F3.” If the text is not found, you will get the 
message, “Not found,” and the cursor will be located where you invoked 
the “Find” dialog box. 
 
14.4 Hot Keys in MSN Messenger 
 
1. Log-in dialog box 

Move to the next control: Tab 
Move to the previous control: Shift-tab  
Check or uncheck a check box: Space 

2. The contact list box 
Move to the previous item: Up arrow key  
Move to the next item: Down arrow key  
Move between online and offline groups: Ctrl-Down arrow key 
Open the menu: Alt 
Logout: Ctrl-n  
View chat: Ctrl-r 
My status: Ctrl-m  
Close: Alt-F4 
Add contact: Ctrl-a  
Delete contact: Ctrl-d 
Contact information: Ctrl-v 
Send instant message: Ctrl-s  
Last message: Alt-r 
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Play keyboard sound: Ctrl-k 
Message sound notification while in current window: Fn-s  
Message sound notification while messenger is in the background: Alt-
m  
Nickname: Ctrl-p 
Save account: Ctrl-o  
Confirm the received message: Ctrl-l 

3. Instant message dialog box 
Move to the next control: Tab  
Move to the previous control: Shift-Tab  
Move between the instant message dialog box and the contact 
 list box: Page up or Page down 
Save as: Alt-s 
Print: Ctrl-p 
Close: ESC 
Cut: Ctrl-x  
Copy: Ctrl-c  
Delete: Ctrl-d 
Paste: Ctrl-v  
Select all: Ctrl-a 
Start selection: Ctrl-b 
Find: Ctrl-f 
Find again: F3  
Invitation: Ctrl-i 
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15. Database Manager 
 
The Database manager is a program that can be used to create a 
database in the form that you specify. You can use the Database 
manager to add records and search for data in your records. A table 
contains at least one record, and a record consists of at least one field.  
You can specify attributes for each of the fields. In other words, a record 
is made up of a group of one or more fields. 
 
When the Database manager is started, it will check whether or not a 
table has been registered or created already. If no table has been 
registered yet, a “Table Manager” dialog box will appear to help you to 
register a new table. If there is at least one table already registered, a 
“Search Records” dialog box will appear and the “Search” edit box will 
be focused, so that you can search for data records in the tables. If you 
want to close the program while you are adding or searching a table, 
press “Alt-F4.” Or you can use the menu. Press “Alt” to open the menu.  
Move to “Exit” by pressing “Up arrow key”or “Down arrow key” 
repeatedly, and press “Enter.” Or you can type “z” in the menu. 
 
The major navigation keys that can be used in this program are as 
follows. 
 
1. Moving by controls 

Move to the previous control: Shift-Tab 
Move to the next control: Tab 

2. Moving in a list box 
Move to the previous list item: Up arrow key  
Move to the next list item: Down arrow key  

3. Changing the selection in a prompt box 
Select the next value: Space or Down arrow key 
Select the previous value: Backspace or Up arrow key 

 
The menu in the database manager consists of the following items.  
You can open this menu by pressing “Alt”  
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1. Table manager: Here you can create, delete, and modify tables, 
records, and their fields. When you run the database manager for the 
first time, the “table manager” dialog box will appear. 

2. Add record: You can add records to the current table. 
3. Search records: You can search records in the current table. You can 

also search each field in the table. 
4. List of records found: You can use this menu item to go through a list 

of records found in the table by the previous search. Here, you can 
delete or modify each record in the list. If you didn’t search for 
anything before you use this function, the message, “no items 0/0,” 
will be displayed. 

5. Setting backup option: You can select the method to back up the 
database. 

6. Backup database: You can backup all database files that are used in 
the database manager. 

7. Restore database: You can restore the database files that are backed 
up already. 

8. Exit: It is used to close the database manager. 
 
Each of these menu items will be discussed in the following sections 
below. 
 
15.1 Table Manager 
 
The “Table Manager” dialog box is where you can create, delete, or 
modify a table. This dialog box contains the following controls. 
 
1. Table name list: It displays the name of registered tables, and their 

order in the list. 
2. Add table button: Using this option, you can create a new table. 
3. Modify table button: Using this option, you can change the name of a 

table, or modify the structure of the table, by adding or deleting fields. 
4. Delete table button: Using this option, you can delete the table that 

you have selected in the table name list. 
5. Set default table button: Using this option, you can set the table that 

opens by default when you run the program. 
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6. Close button: After closing the “Table Manager” dialog box, it will take 
you back to where you were before you started the “Table Manager” 
dialog box. When there is no registered table, if you press “Enter” at 
the “Close” button, the database manager program will be closed. 

 
You can move between each of these controls by pressing “tab” or “shift-
tab.” 
 
15.1.1 Add Table 
 
“Add table” is a dialog box where you can create a new table. This dialog 
box contains “Table name” edit box, “registered fields” list, “Add field” 
button, “Modify field” button, “Delete field” button, “Previous field” button, 
“Next field” button, “Confirm” button and “Cancel” button. You can move 
between these controls by pressing “tab” or “shift-tab.” 
 
Suppose you want to create a table called “addressbook” which contains 
4 fields: name, telephone, address, and memo. You can create this table 
as follows. 
 

1) In the “Table Manager” dialog box, press “tab” to move to the “Add 
table” button, and press “Enter.” Or you can just press “a” in the 
dialog box. 

2) Then, the “Add Table” dialog box will appear, and the “Table 
name” edit box will be focused. 

3) Type “addressbook” and then press “tab.” 
4) Then, the “registered fields” list will be focused. At first, “no items 

0/0” will be displayed in the list. As you add fields to this table, they 
will be added to this list box. 

5) Press “tab” to move to the “Add field” button, and press “Enter.” Or 
you can just press its shortcut key, “a.” 

6) Then the “Add field” dialog box will be opened, and the “Field 
name” edit box will be focused. 

7) Type “name” here, and then press “tab.” 
8) Then, the “Field type” combo box will be focused. Press “Down 

arrow key”or “Up arrow key”to move to “edit box,” and press “tab.” 
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9) The “Set primary key” check box will be focused. If you want to set 
the current field as the primary key, press “Space” in order to 
check it. 

10) Press “tab” to move to the “Confirm” button, and press “Enter.”  
Now, the “name” field has been added to the “addressbook” table. 

 
If you want to cancel adding the field, press “tab” once more to move to 
the “Cancel” button, and press “Enter.” If you have added a new field, 
you will get a message saying that a new field has been added. Then, 
the “registered fields” list will be shown again. Now, “name” field appears 
in the list, with the form, “name (edit box, pri) 1/1”. Since only one 
primary key exists in a table, if you have set a field as the primary key, 
the “Set primary key” check box will not be shown in the “Add field” 
dialog box when you add another field. Add the “telephone”, “address”, 
and “memo” fields by repeating the step 5 through 10 above. Once you 
have added all of the fields you want, press “tab” to move to the 
“Confirm” button, and press “Enter.” 
 
If you need to change a name of a field that is registered, move to a field 
name that you want to change on a “registered fields” list. Then press 
“m” or “tab”, and enter on a “Modify field.” It appears as “Field name: 
(selected filed name)”, here you type the Name you want, and press 
“Enter.” Even though you can change a name of a field, it is not possible 
to change the property of that field. 
 
If you want to delete an already registered field, press “Up arrow key”or 
“Down arrow key”repeatedly in the “registered fields” list to move to the 
name of the field you want to delete. And then press “tab” repeatedly 
move to “Delete field” button and press enter or press “d,” the shortcut 
key for the “Delete field” button. Or you can also press “tab” repeatedly 
to move to the “Delete field” button and press “Enter.” 
 
To change the order of a field, which is in your table, you can move to 
the field that you want to change. This can be done when you are in the 
“registered fields” list. Once you are on the field, press “p” or “n.” Or you 
press “tab” and enter on a “Previous field” button or “Next field” button. 
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Then, the “Add Table” dialog box will be closed, and the “table name” list 
box will be shown again. The newly created table will be added to this 
list, and “address book 1/1” will be shown in the list. To close the “Table 
Manager” dialog box, press “tab” to move to the “Close” button, and 
press “Enter.” Or you can just press “Alt-F4” to close the dialog box.  
Then, the “Search Records” dialog box will be opened, and the “name” 
field, the first field of the “address book” table, will be shown. Here, you 
can type the name you want to search for. 
 
15.1.2 Modify Table 
 
“Modify table” is used to modify the name or structure of a registered 
table. It contains the same controls as in the “Add Table” dialog box.  
To modify a table, press “Alt” to open the menu, and press “Enter” on 
“Table Manager.” Or you can just press the hotkey for “Table Manager”, 
“Ctrl-t.” The “table name” list will be focused when the “Table Manager” 
dialog box is opened. Press “Up arrow key”or “Down arrow key”to move 
to the table that you want to modify, and press “m,” the shortcut key for 
the “Modify table” button. Or you can press “tab” repeatedly to move to 
the “Modify table” button, and press “Enter.” Then, a dialog box where 
you can modify the table will appear. This table is same as the “Add 
Table” dialog box. The only difference is that the “Table name” edit box, 
and “registered fields” list contain the information already stored in the 
table. You can not change the name of table. 
If you want to add additional fields, press “tab” to move to “Add field” and 
press “Enter.” And then type in the new field name and press “Enter.” If 
you want to delete an already registered field, press “Up arrow key”or 
“Down arrow key”repeatedly in the “registered fields” list to move to the 
name of the field you want to delete. And then press “tab” repeatedly 
move to “Delete field” button and press enter or press “d,” the shortcut 
key for the “Delete field” button. Or you can also press “tab” repeatedly 
to move to the “Delete field” button and press “Enter.” 
 
To change the order of a field, which is in your table, you can move to 
the field that you want to change. This can be done when you are in the 
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“registered fields” list. Once you are on the field, press “p” or “n”.  Or 
you press “tab” and enter on a “Previous field” button or “Next field” 
button. 
 
If you need to change a name of a field that is registered, move to a field 
name that you want to change on a “registered fields” list. Then press 
“m” or “tab”, and enter on a “Modify field.” It appears as “Field name: 
(selected filed name)”, here you type the Name you want, and press 
“Enter”. 
Even though you can change a name of a field, it is not possible to 
change the property of that field. 
 
15.1.3 Delete table 
 
This option is used when you want to delete a table. To delete a table, 
Press “Alt” to open the menu, and press “Enter” on “Table Manager.”  
Or you can press “Ctrl-t,” the hotkey for “Table Manager.” When the 
“Table Manager” dialog box is opened, the “Table name” edit box will be 
focused. In this list box, you can move to the name of the table you want 
to delete by pressing “Down arrow key”or “Up arrow key”repeatedly, and 
press “d”, the shortcut key for the “Delete table” button. Or you can press 
“tab” repeatedly to move to the “Delete table” button, and press “Enter.” 
Then, “Delete table? Yes” will be displayed. If you want to delete, press 
“Enter,” and if you want to cancel, press “Space” to select “No,” and 
press “Enter.” 
 
15.1.4 Set Default Table 
 
When you set a table as the default table, whenever the database 
manager is started, the table will be activated and you will be placed in 
the search dialog. You can search and add fields on this table. If you 
have registered more than one table and there is a table you use more 
frequently than the others, it may be convenient for you to set this table 
as the default table. However, if no table has been set as the default 
table, the table that was used the last time will be activated when the 
database manager is started. To set a table as the default table, press 
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“Alt” to open the menu, and press “Enter” on table manager. Or you can 
also press “Ctrl-t,” the hotkey for “Table Manager.” Then, the “Table 
Manager” dialog box will appear, and the “table name” list will be 
focused. In this list, press “Down arrow key”or “Up arrow key”repeatedly 
to move to the name of the table you want to set as the default table.  
Then press “s,” the shortcut key for the Set default table,” or press “tab” 
repeatedly to move to the “Set default table” button and press “Enter.”  
Or you can press “Enter” on the name of the table in the “table name” list.  
Then, you will get a message saying that the table is set as the default 
table, and the “Table Manager” dialog box will be closed. 
 
15.2 Add Record 
 
You can use this option to add information to a table that you have 
created. When the database manager is started, the “Search Records” 
dialog box will be opened at first. To open the “Insert a New Record” 
dialog box, press “Alt” to open the menu, and press “Enter” on “Insert a 
New Record.” Or instead of using the menu, you can just press “Ctrl-n.”  
You can think of a record as a collection of information (fields) for an 
object (record). Let’s consider the “addressbook” table you created in the 
previous section. Adding records to this table can be performed as 
follows. 
 

1) Press “Alt” to open the menu, and press “Enter” on “Insert a New 
Record.” Or instead of using the menu, just press “Ctrl-n.” 

2) Then the “name” field, the first field in the “addressbook” table, will 
be shown. Here, you type the name you want to add, and press 
“tab.” 

3) Then, the “telephone” field will be focused. Here, type the phone 
number. Since this field is of “number” type, you can type only a 
limited set of characters such as numbers and hyphen. If you 
press “Space” instead of – (hyphen), the hyphen will be entered. 

4) Press “tab” to move to the “address” field. Type the address. 
5) Press “tab” to move to the “memo” field. Since this field is of “multi 

edit box” type, you can type multiple lines. To start a new line, 
press “Enter.” 
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6) Press “tab” to move to the “Confirm” button. If you press “Enter” 
here, the one record that you have just entered will be added to 
the table.  If you do not want to save the record you have just 
typed in, press “tab” once more to move to the “Cancel” button, 
and press “Enter.” Or you can just press “ESC.” 

 
If you have added a record, the “name” field will be focused again so 
that you can add another record. If you press “shift-tab” at a field, the 
focus will be moved to the previous field. 
 
To go back to the “Search Records” dialog box, press “Ctrl-f.” To open 
the “Table Manager” dialog box, press “Ctrl-t.” If you open these dialog 
boxes while you are entering a record, you will be asked if you want to 
save the record. Select “Yes” or “No” by pressing “Space” or 
“Backspace,” and press “Enter.” If you select “Yes”, the record will be 
saved, and if you select “No”, it will not be saved and open the specified 
dialog box. If you select “Cancel,” the dialog box will not be opened. 
 
15.3 Search Records 
 
After you have added your records, if you want to search for   
information that is in your records, you can use the “Search Records” 
dialog box. To open the “Search Records” dialog box, press “Alt” and 
press “Enter” on “Search Records.” Or instead of using the menu, just 
press “Ctrl-f.” Then, the “Search Records” dialog box will be opened, and 
the first field of the table will be focused. Here, you can type the text that 
you want to search for. If you want to search for records using content 
from more than one field, press “tab” to move to another field.  Type the 
text to search for, and press “Enter.” Then, the “List of Records Found” 
will be opened and the search result will be shown in the “List of 
Records Found.” Being able to search in more than one field can be 
useful if you are searching for those who have the same first and last 
name.  
 
In the “List of Records Found,” each record will be shown in the following 
form. “(the name of the first field) : (other information in the record) xx/yy”.  
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“yy” is the total number of records found, and “xx” is the order of the 
current record in the list. If no record has been found, you will get the 
message “No records found,” and the current field will be shown again, 
so that you can type another text to search for. You can move through 
the “List of Records Found” as follows. 
 
1. Move by records 

Move to the next record: Down arrow key  
Move to the previous record: Up arrow key  
Move to the last record: Ctrl-Fn-Right arrow key 
Move to previous same field different record: Left arrow key 
Move to next same field different record: Right arrow key 
Move to the first record: Ctrl-Fn-Left arrow key 

2. Move between the fields in a record 
Move to the next field: Ctrl-Right arrow key 
Move to the previous field: Ctrl-Left arrow key 
Move to the last field: Fn-Right arrow key 
Move to the first field: Fn-Left arrow key 

 
In the “List of Records Found,” if you want to search for different text, 
you can press “Ctrl-f” again to open the “Search Records” dialog box.  
Then, type the new text that you want to search for. 
 
If you want to delete a record found, press “Up arrow key”or “Down 
arrow key”to move to the record, and press “Del” in any of the fields in 
the record. Then, you will be asked if you really want to delete the record.  
Here, you can select “Yes” or “No” by pressing “Space” or “Backspace.”  
If you press “Enter” after selecting “Yes,” the record will be deleted, and 
if you select “No,” the deletion will be canceled. If you want to search for 
records in another table, press “Ctrl-t” to open the “Table Manager” 
dialog box, and press “Enter” on the name of the table that you want to 
activate.   
If you want to change the content of a record, select the record by 
pressing “Up arrow key”or “Down arrow key”repeatedly. And press “Ctrl-
m” at any field in the record. Then, the same dialog box as the “Insert a 
New Record” dialog box will be opened. To change the content of some 
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fields, move to the fields by pressing “tab,” type the new content of the 
fields, and press “Enter.” To save the modified content of a record, press 
“Enter” after typing the contents of all the fields that you want to change.  
Or you can move to the “Confirm” button by pressing “tab” repeatedly, 
and press “Enter.” If you want to cancel modifying the record, press “tab” 
once more to move to the “Cancel” button and press “Enter.” 
 
15.4 List of Records Found 
 
The “List of Records Found” will appear when the “Search Records” was 
performed successfully. While you are using the “Insert a New Record” 
or “Search Records” dialog box, if you want to go to the “List of Records 
Found,” press “Alt” to open the menu, and press “Enter” on “List of 
Records Found”. Or instead of using the menu, you can just press “Ctrl-
r.” 
 
15.5 Setting Backup Option 
 
To backup your database file, you can do it manually using the “Backup 
Database” function. You can also backup your database file 
automatically by using the “Set Backup Option.” To activate the “Set 
Backup Option” function, press “Alt” to open up the menu. Then press 
“Down arrow key”or “Up arrow key”repeatedly to move “Set Backup 
Option.” Then press “Enter” on it. Or, you can press “e” in the menu to 
go to “Set Backup Option.” You can also activate the function without 
opening up the menu by pressing “Ctrl-e.” 
 
If you activate the function, you will see a dialog box. The dialog box has 
three controls: “Backup mode” radio button, a “Confirm” button, and a 
“Cancel” button. You can switch between controls by pressing “tab” or 
“shift-tab.” To switch between radio buttons, you can press “Up arrow 
key,” “Backspace,” “Down arrow key,” or “Space.” 
 
The “Backup mode” has three radio buttons: “Manual backup,” “Always 
backup changes when exiting,” and “prompt to backup changes when 
exiting.” 
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1. If you select the “Manual backup,” it will not create a new backup file 

even though there may be changes in the database. In this case, you 
can only make a new backup file by using the “Backup Database” 
menu. 

2. If you select the “Always backup changes when exiting,” a new 
backup file will be automatically created if you modify the database or 
add other information when you exit the Database manager. 

3. If you select the “Prompt to backup changes when exiting,” you will 
see the message “Backup changes? Yes” when you exit the 
database manager, if you have modified the database or added other 
information. If you press “Enter” on “Yes,” it will automatically create a 
new backup file and exit the database manager. If you press “Down 
arrow key”once and press “Enter” on “No,” it will exit without making a 
new backup file. 

 
You can change the backup mode if you press “Enter” after focusing on 
one of the three radio buttons. Or, you can press “Enter” on “Confirm” by 
moving to it by pressing “tab.” The default backup mode is set to 
“Prompt to backup changes when exiting.” 
 
15.6 Backup Database 
 
If a cold reset occurs, or if your battery goes dead, all of the data in the 
Database manager will be lost. So, it is very important that you make a 
backup file every time you make a change to the Database file. To go to 
“Backup Database,” open the menu by pressing “Alt.” Then, use the “Up 
arrow key”or “Down arrow key,” and find “Backup Database.” Then, 
press “Enter.” You can also press “u” while you are in the menu to get to 
“Backup Database.” Or, you can press “Ctrl-u” to activate this function 
without calling up the menu. 
 
If you already have a backup file, you will hear the message “Backup 
changes? Yes.” If you have made any changes to your database file, 
press “Enter” to create a new backup file. If you want to keep the 
previous backup file, press “Space,” locate “No,” and press “Enter” on it.  
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When you make a backup file in your database manager, you will always 
have a new backup file with the extension SDF. The name of backup file 
is “UserDatabase.sdf” 
 
15.7 Restore Database 
 
If you want to restore the database file after a cold reset, press “Alt” to 
call up the menu, and use the up and down arrow keys to find “Restore 
Database.” Then, press “Enter” on “Restore Database.” Or, you can 
press “r” while you are in the menu to find “restore database.” You can 
also press “Ctrl-o” to activate this function, without calling up the menu. 
 
If you activate the “Restore Database” function, and you already have an 
database file, you will hear the message, “Database file already exists. 
Restore? Yes.” If you press “Enter,” the backup database file will be 
restored to the current database file. If you want to cancel, you press 
“Space” and press “Enter.”  
 
15.8 Hot Keys for Database Manager 
 
Add record: Ctrl-n 
Search records: Ctrl-f 
Table manager: Ctrl-t 
List of records found: Ctrl-r  
Setting backup option: Ctrl-e  
Backup database: Ctrl-u  
Restore database: Ctrl-o 
 
1. Move by controls 

Move to the next control: Tab  
Move to the previous control: Shift-Tab  

2. Move in a list box 
Move to the next list item: Down arrow key  
Move to the previous list item: Up arrow key  

3. Select your answer in the prompt box 
Move to the next answer: Space or Down arrow key 
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Move to the previous answer: Backspace or Up arrow key 
4. Move in the “list of records found” 

Move to the next record: Down arrow key  
Move to the previous record: Up arrow key  
Move to the last record: Ctrl-Fn-Right arrow key 
Move to the first record: Ctrl-Fn-Left arrow key 
Move to the next field: Ctrl-Right arrow key 
Move to the previous field: Ctrl-Left arrow key 
Move to the last field: Fn-Right arrow key  
Move to the first field: Fn-Left arrow key 
Move to previous same field different record: Left arrow key 
Move to next same field different record: Right arrow key 
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16. Contents 
 
16.1 Sense Bible Help 
 
16.1.1 Composition of Bible 
 
Sense Bible consists of 5 volumes in Voice Sense QWERTY 
 
King james version 
New king james version 
New international version 
New living translation 
New revised standard version 
 
16.1.1.1 Executing of Bible 
 
Sense Bible is located inside of Contents from the main menu. 
When you execute the Sense Bible, 5 volumes of Bible will be displayed.  
If you are not reading the bible, list of bible will be focused as always. 
For each bible is indivisual, it can be loaded more than one at the same 
time and can be switched using window's 'move to previous window' or 
'Move to next window'. 
 
16.1.2 Open book dialog box 
 
16.1.2.1 Composition of dialog box 
 
Open book dialog box consists of list box, edit box, moving to a 
bookmark, confirm, and cancel. 
The default is list box. 
 
Following is explainning with regard to search the data, and use for each 
window.  
 
16.1.2.1 Bible lists edit box 
 
Generally to search bible lists, abbreviation is an essential element. 
But we provide the list for novice and especially unsure abbreviation. 
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66 books will be displayed on the list. If you are not sure abbreviation, 
you can select from the list. 
After selecting the book from the list, press TAB or Enter to move to next 
edit box. 
 
16.1.2.3 Edit box 
 
User type the value that he/she wants to search for abbreviation, chapter 
and verse. 
'Book name, Chapter and Verse? GE1:1' will be displayed as a default. 
 
If you are fully aware of the abbreviation, you can type the chapter and 
verse following the abbreviation. 
Between chapter and verse, it requires to enter '-'. For instance, if you 
search for chapter 5 and verse 7 you need to type 'MT5-7'. 
To search promptly,  
 
If you are not aware of the abbreviation, press 'Shift-Tab' to move to list 
box and select from the list,  
or press F3 or Sp+4+5 to move back to edit box and type the chapter 
and verse following the abbreviation.  
Press Enter to search then the data will be displayed. 
 
16.1.2.4 Moving to a bookmark 
 
If you have set a mark, you can move to the bookmark by using 
navigation button.  
 
16.1.3 Menu 
 
While reading the bible, you can call a variety of features by using menu 
key. 
The menu of Sense bible consists of following items such as File, Edit, 
Read, Move, Bookmark, Window, abd Help. 
 
16.1.4 Navigating 
 
While seeing bible status, following keys are used to navigate through 
the list. 
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16.1.4.1 Bible lists dialog 
 
By pressing 'Alt-b' to open the dialog to move to the list. 
 
16.1.4.2 Navigation keys 
 
Up arrow: Move to previous line  
Down arrow: Move to next line 
Ctrl-up arrow: one line (or verse) Move to previous item by unit 
Ctrl-down arrow: one line (or chapter) Move to next item by unit 
Fn-r or Fn-c: Display the current contents with voice 
Ctrl-left arrow: Move to previous word 
Ctrl-right arrow: Move to next word 
Fn-x: Display current word with voice. Every time you press the hot key, 
it will say word, character, and phonetic with voice. 
Left arrow: Move to previous character 
Right arrow: Move to next character 
Fn-z: Display the phonetic 
 
16.1.4.3 Bookmark 
 
The definition of bookmark is to remember and set the current location. 
But one bookmark can be saved in a file.  
If you try to set a bookmark that has already been set, it will ask you to 
modify. So you can save as new bookmark or just keep the old one. 
 
Following keys are used to set bookmark. 
Ctrl-m: Set a bookmark. If there is any set mark, it will ask you to modify 
or not.  
Ctrl-j: Move to the bookmark 
Del: Delete the set bookmark 
 
16.1.4.4 Temporary mark 
 
You can set at the current location, delete the set mark,  
In a file, you can set several temporary marks, and move to the location 
back and forth by mark.  
 
Navigating keys are as follows. 
 
Alt-m: Set temporary mark 
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Alt-left arrow: Move to previous mark 
Alt-right arrow: Move to next mark 
Ctrl-d: Delete all the set mark 
 
16.1.4.5 Navigating through documents 
 
Home: Move to previous document  
End: Move to next document  
 
16.1.5 Find & Search 
 
16.1.5.1 Find a word 
 
By pressing "Ctrl-f" to oepn the search dialog box. 
1. Edit box 
Following 'Word to find?'you can type the word that you want to search. 
2. Range  
You can choose the range that the word you typed before. 
- Range to search? Current book 
- Range to search? The new testament 
- Range to search? The old testament 
- Range to search? Holy bible 
* If you do not select the range, it will execute to search the current book. 
3. Confirm 
To execute the search, press Enter on 'Confirm'. 
You can also execute to search in 'edit box' or 'range' by pressing Enter. 
4. Cancel  
To cancel the value that you typed or the setting that you selected. 
 
16.1.5.2 If at least one word searched, pressing enter (find next) and 

backspace (find previous) to execute the search. 
 
16.1.6 Search 
 
To search a verse from the bible that includes the word that you 
searched. 
Press hot key'Ctrl-s'to display search dialog box from the main menu 
and while reading the file. 
Search dialog box consists of 6 search dialog box. 
1) Edit box 
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'Search word?'you can type the word that you want to search. 
2) Select the search range 
You can select which range you would like to select the word typed in 
edit box. 
You need to select one of them or type the book that you want to search. 
 (1) Enter the book name to search:  
User can type the abbreviation to search the bible. Type the abbreviation 
and press enter. Then press TAB to move to next control to select the 
option. 
There are 3 options. Using navigation key (up or down arrow) to select 
through the search list and press TAB to move to next control. 
 (2) Search range: The new testament 
 (3) Search range: The old testament 
 (4) Search range: Holy bible 
 
Note: You can select 3 search range options if you don't select to search 
directly.  
If you do not want to assign the search range, you can search the bible 
using 'enter the book name to search'. 
 
3) Output type  
There are 3 types of dispaly output.  
You can select the display type that you searched the word by pressing 
up or down button to select the type. 
 
Display by Braille: Display the result by Braille one after another. Move 
to the word which you searched.  
If the word searched by this option, you can use 2 key strokes. 
Press enter to move to the next word and press backspace to move to 
the previous word. 
After searching, you can search related word by using enter and 
backspace.  
Display by file: Display the result by Braille and also it can be saved 
under the 'work\sbible001.txt file' 
Note: the number which comes after file name increases the number of 
search times 
Display by number: how many times the word searched   
 
4) Search: Press Enter to execute the search based on setting condition.  
 
5) Close: To exit search dialog box. 
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16.1.7 Setting the block (Ctrl-b) 
 
You can set a block while reading bible and copy the block that you set 
by pressing Ctrl-c. 
Also you can capture by pressing ‘Alt-s’.  
Once you capture the contents, it can be saved under 'sbible_cap.txt' 
and you can add memo. 
 
16.1.8 Read from cursor to end  
 
In bible mode, pressing Fn-Ent to read from cursor to end with voice and 
Braille automatically. 
  
While reading from cursor to end, pressing Esc to cancel it. 
 
16.1.9 Auto scroll  
 
Note: This function will appear when the Voice Sense is connected to 
SyncBraille. 
 
The “Auto Scroll” command scrolls automatically. The speed of the “Auto 
Scroll” is set in the “Settings” menu, which is located in the “File” menu, 
which was explained in section 5.1.7. The auto scroll mode does not 
read the document using the voice. It is only displayed on the Braille 
display. It reads the document line by line automatically. To execute this 
command, press “Alt,” and move to the “Read” menu by pressing “Down 
arrow key.” Then, press “Enter.” Move to “Auto Scroll” by pressing 
“Down arrow key,” and then press “Enter,” or you can press “a” on the 
read menu, which is the short cut. You can turn the auto scroll feature on 
and off by pressing the up and down scroll buttons simultaneously. For 
faster scrolling, press the “Right arrow key”. For slower scrolling, press 
“Left arrow key”. If you want to read a line again that you have already 
scrolled past, you can read it again by pressing the up scroll button or 
“Up arrow key” until you can get to what you want to read. Similarly, if 
you want to skip some lines that you do not wish to read, you can skip 
them by pressing the down scroll button or “Down arrow key.” You can 
also access this function without opening the menu by pressing both 
scroll buttons at the same time when in your document. 
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16.1.10 Check the current bible information 
 
If you are unsure the current bible information, you can check the type of 
bible, book, chapter, and verse by pressing Fn-/. 
 
* Appendix (Bookname of Bible, abbreviation) 
Common abbreviations for books of the Bible1: 
MLA Style 
*Old Testament (OT)  
Abbreviation: 
Book: 
 
Gen. : GE 
Genesis 
 
Exod.: EX 
Exodus 
 
Lev. : LE 
Leviticus 
 
Num. : NU 
Numbers 
 
Deut.: DE 
Deuteronomy 
 
Josh.: JS 
Joshua 
 
Judg.: JU 
Judges 
 
Ruth : RU 
Ruth 
 
1 Sam. : 1S 
1 Samuel 
 
2 Sam. : 2S 
2 Samuel 
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1 Kings : 1K 
1 Kings 
 
2 Kings : 2K 
2 Kings 
 
1 Chron. :1C 
1 Chronicles 
 
2 Chron. :2C 
2 Chronicles 
 
Ezra : EZ 
Ezra 
 
Neh. : NE 
Nehemiah 
 
Esth. : ES 
Esther 
 
Job : JB 
Job 
 
Ps. : PS 
Psalms 
 
Prov. : PR 
Proverbs 
 
Eccles. : EC 
Ecclesiastes 
 
Song of Sol. (also Cant.) : SS 
Song of Solomon (also Canticles) 
 
Isa.  : IS 
Isaiah 
 
Jer. : JE 
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Jeremiah 
 
Lam. : LA 
Lamentations 
 
Ezek. : EK 
Ezekiel 
 
Dan.  : DA 
Daniel 
 
Hos.  : HO 
Hosea 
 
Joel  : JL 
Joel 
 
Amos  : AM 
Amos 
 
Obad. : OB 
Obadiah 
 
Jon. : JN 
Jonah 
 
Mic. : MI 
Micah 
 
Nah. : NH 
Nahum 
 
Hab. : HA 
Habakkuk 
 
Zeph. : ZE 
Zephaniah 
 
Hag. : HG 
Haggai 
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Zech. : ZC 
Zechariah 
 
Mal. : ML 
Malachi 
 
*New Testament (NT) 
Abbreviation: 
Book: 
 
Matt. : MT 
Matthew 
 
Mark : MR 
Mark 
 
Luke : LU 
Luke 
 
John : JH 
John 
 
Acts : AC 
Acts 
 
Rom. : RO 
Romans 
 
1 Cor. : 1R 
1 Corinthians 
 
2 Cor. : 2R 
2 Corinthians 
 
Gal. : GA 
Galatians 
 
Eph. : EP 
Ephesians 
 
Phil. : PH 
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Philippians 
 
Col. : CO 
Colossians 
 
1 Thess. : 1T 
1 Thessalonians 
 
2 Thess. : 2T 
2 Thessalonians 
 
1 Tim. : 1I 
1 Timothy 
 
2 Tim. : 2I 
2 Timothy 
 
Tit. : TI 
Titus 
 
Philem. : PL 
Philemon 
 
Heb. : HE 
Hebrews 
 
Jas. : JA 
James 
 
1 Pet. : 1P 
1 Peter 
 
2 Pet. : 2P 
2 Peter 
 
1 John : 1J 
1 John 
 
2 John : 2J 
2 John 
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3 John : 3J 
3John 
 
Jude : JD 
Jude 
 
Rev. (also Apoc.) : RE 
Revelation (also Apocalypse) 
 
16.2 Sense Dictionary 
 
Sense dictionary is the electronic dictionary to search the keyword. 
It provides global hot key that can be called anywhere which is 'Fn-d'.  
  
16.2.1 Execute and exit of dictionary  
 
16.2.1.1 Execute 
 
Sense dictionary is located inside of contents from the main menu.  
To execute the Sense dictionary, press 'c'(execute contents) and then 
'd'(execute Sense dictionary). 
Also you can move to Sense dictionary from contents and press enter to 
execute the program. 
 
16.2.1.2 Exit 
 
To exit the Sense dictionary, you just need to press Alt-F4. 
  
16.2.2 Using Sense dictionary 
 
16.2.2.1 Basic structure of Sense dictionary 
 
Sense dictionary consists of dialog form for each control such as 
keyword, entries, contents, search, and close etc.  
 
By pressing TAB or SHIFT-TAB, you can move to between each control. 
Once the Sense dictionary executes, 3 types of control will be displayed 
such as keyword, search, and close if no word has been searched. 
After searching the word, two controls such as entries and contents will 
be activated.  
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* Feature of each control 
- keyword : Type the word that you want to search in edit box, you can 
search the word. 
- entries : The word list, related to the search word, will be displayed (it 
will be activated after search the word) 
- contents : The status box which is displayed explanation of the word (it 
will be activated after search the word) 
- search : Type the word and move to 'search' button and then press 
enter to search 
- close : To exit the Sense dictionary 
  
16.2.2.2 Search word 
 
When the Sense dictionary execute, the first control will be keyword. 
Type the word that you want to search in keyword edit box and press 
Enter 
You can also search the word using 'search' button, after typing the word 
in keyword edit box and press TAB to move to 'search' button.  
If the keyword does not exist in dictionary data,'the word not found' will 
be announced and move back to the keyword edit box to type different 
word. 
If the keyword exists, you can check the explanation of the word that you 
want to search. If there are more than 2 related words, 'entries' will be 
focused.  
In this case, you can move to the item by pressing Up arrow or Down 
arrow and you can also check the explanation of the word by pressing 
TAB.  
  
16.2.2.3 Navigating through each control in Sense dictionary 
 
1) Following keys are used to navigate each control 
- Move to next control: TAB 
- Move to previous control: SHIFT-TAB 
  
2) Navigating through list in entries control 
- Move to next item: Down arrow 
- Move to previous item: Up arrow 
- Move to the end of item: End or CTRL-End 
- Move to the beginning of item: Home or CTRL-Home 
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3) Following keys are used to navigate in contents status box 
- Move to next character: Right arrow 
- Move to previous character: Left arrow 
- Move to next word: CTRL-Right arrow 
- Move to previous word: CTRL-Left arrow 
- Move to next line: Down arrow 
- Move to previous line: Up arrow 
- Move to the beginning of line: Home 
- Move to the end of line: End 
- Move to the end of contents: CTRL-End 
- Move to the beginning of contents: CTRL-Home 
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17. Utilities 
 
The “Utilities” menu provides several special functions for use with the 
Voice Sense QWERTY. The “Utilities” menu has the following items: 
 
1. Calculator  
2. Set time and date 
3. Display time and date 
4. Wake up alarm 
5. Calendar 
6. Pronunciation Dictionary 
7. Stopwatch  
8. Setup internet  
9. Display network status 
10. Check power status 
11. Backup/ Restore option settings 
12. Format 
13. Sleep Timer 
14. Upgrade Voice Sense QWERTY Firmware 
 
To access the menu items, 

1) Press “Up arrow key” or “Down arrow key” in the “program menu”. 
2) Press “Enter” on the “Utilities” menu. Or, you can press “u” in the 

“program menu” to open the utilities menu.   
3) The “Utilities” menu has several submenus under each of the 

menu items.    
 
The following sections will discuss each of these menu options and their 
functions in greater detail. 
 
17.1 Calculator 
 
Using the calculator on the Voice Sense QWERTY you can do simple 
math equations as well as complex scientific calculations. The results 
and formulas will be displayed in LCD, and spoken by the Voice Sense 
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QWERTY. While using the calculator, you can refer to the “help” menu 
by pressing “F1.” The “help” menu is very useful as you can quickly 
access hot key information for the various programs on the Voice Sense 
QWERTY. 
 
When you want to use the calculator you can press “c” from within the 
“Utilities” menu. You can initialize your calculation line by pressing “Alt-
c.” If you insert numbers or a function into a result, the result will 
disappear; and if you put in operators, you can get to the next step. In 
addition, you can keep your result in the calculator’s memory, and you 
can recall it when you need the result. You can use the function and 
operators via the calculator menu or you can use the hot keys 
depending on which method works best for you. 
All of these functions are explained in greater detail below. 
 
17.1.1 General Functions 
 
“General functions” is a dialog box that contains the “general function 
list,” a “Confirm” button, and a “Cancel” button. In the dialog box, you 
can navigate through the items with “tab”and “shift-tab”. In the general 
function list, you can navigate the operators using “Up arrow key”or 
“Down arrow key”. Or, in the list, you can press the first letter of the 
operator that you want to go to. In the “Calculator,” you can open the 
menu by pressing “Alt,” and press “Enter” on “General Functions.” Or, 
you can press “g” in the menu to access “General Functions.” After 
starting the calculation, 0 will be displayed. On the calculation line, you 
can access the “General Functions” by pressing “Ctrl-g.” If the dialog box 
pops up first, you will be placed on the general function list. Once in the 
list, you can select what you want, and press “Enter” on it to run the 
operator since the default is set to the “Confirm” button in the dialog. In 
the dialog box, you can cancel the operator selection by pressing “Enter” 
on “Cancel,” “Alt-F4,” or “ESC.” You can use hot keys of the operators 
for convenient access. 
The hot keys of the operators are as follows: 
 
Plus: + 
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Minus: - 
Divided by: / 
Multiply by: * 
Percent: % 
Power: ^ 
Square Root: Ctrl-q 
Decimal point: . 
Left parenthesis: ( 
Right parenthesis: ) 
PI: Ctrl-p  
Exponential:Ctrl-e  
If you want to enter in negative numbers, you should type in minus and 
the number together in parentheses. For example, you should type in 
minus 2 in the following manner:  (-2). 
 
For the percent operation, you can get the result when you put in the 
numbers first and the percent sign (%) just after typing in the numbers.  
Immediately after you have typed in the percent sign (%), the number 
that you have typed in will be converted into a percent value. For 
example, 90 + 20% equals 90 + 18. You will see the number 18 on 
pressing the % sign since 18 is 20% of 90. So, you get 108 for your 
answer. 
 
17.1.2 Variable Calculators 
 
The “Variable Calculators” will keep your resulting answers and 
calculations in the memory. The “Variable Calculators” menu has four 
submenu items: “Recall Item,” “Delete All Saved Items,” “Save Item,” 
and “Statistics Functions.” You can move between these items by 
pressing “Down arrow key”or “Up arrow key”repeatedly, and then press 
“Enter” on the desired feature. To access these menu items, press “Alt” 
to call up the menu, and press “Enter” on “Variable Calculators.” Or, you 
can press “v” when you are in the menu. 
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17.1.2.1 Recall Items 
 
“Recall Items” is a dialog box, that has the following items “list,” “Delete,” 
“Display detail,” a “Confirm” button, and a “Cancel” button. You can 
navigate through each of these items by pressing tab or shift-tab. You 
can access “Recall Items” by pressing “r” in the “Variable Calculators” 
menu. Otherwise, you can access the dialog box by pressing “Alt-r” in 
the calculation line. The “item list” displays “an item name: the result 
value,” and you can move in the item name list by pressing “Up arrow 
key”or “Down arrow key”. You can insert the item’s result into your 
calculation if you press “Enter” on the item name. You can also copy 
each item in the “item list.” Press the “Space” to select an item in the 
“item list.” Then, press “Ctrl-Insert” to copy the selected items to the 
clipboard. The “Display detail” shows the item name and its result with 
the default set to “No.” If you want to review the detailed information, 
press “Space” to switch to “Yes.” Then, it will display “item name: the 
formula = its result value” in voice. “Delete” is used to get rid of your 
registered item. If you want to delete an item, first, you should select the 
item that you want to be deleted, and then press “Enter” on “Delete.”  
You can find the deleted item in “item list” by pressing “tab.” Or, you can 
press “Del” on what you want to delete in the item name list. If you want 
to delete all of the items, you can select all of them by pressing “Ctrl-a,” 
and press “Del.” If you only want to delete some of them, you can select 
the items by pressing “Space,” and press “Del” on the selected items. 
 
17.1.2.2 Delete All Saved Items 

 
When you use this function, you can delete all of the saved items that 
are stored in the “Recall Items.” To activate it, you can call up the menu 
by pressing “Alt.” Then, use the “Up arrow key”or “Down arrow key”to get 
to the “Variable Calculators” menu, and press “Enter.” Next, use the up 
and down arrows to go to “Delete All Saved Items,” and press “Enter.”  
You can also press “Ctrl-d” while you are in the calculation line. 
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17.1.2.3 Save Items 
 
“Save Items” is a dialog box that has an edit window for typing in the 
item name, a “Confirm” button and a “Cancel” button. You can move 
between the control items by pressing “tab”or “shift-tab”. In the “Variable 
Calculators” menu, you can access “Save Items” by pressing “s.” When 
you are in the calculation line, you can press “Alt-s” to open the save 
items dialog box. When you are on the calculation line if you type in the 
item name, and formula, “a=2+sin(30),” followed by pressing “Enter,” the 
calculation will be saved automatically. In your calculating result, you 
can access “Save Items” to type in an item name in the edit box, and 
then you can save it by pressing “Enter” directly or by pressing “Enter” 
on the “Confirm” button. If you type in function names like “sin,” “cos,” or 
“pi” as an item name, you will see the message “Invalid item name,” and 
if you type in names that have already been saved, you will see a 
message that says, “Replace variable xx with current value? Yes.” If you 
want to change the value, press “Enter” on “Yes.” And if you do not want 
to change the value, press “Enter” on “No.” Press “Space” to toggle 
between “Yes” and “No.” 
 
17.1.2.4 Statistics Function 
 
If you select this menu item, a dialog box opens, which consists of a list 
box containing all the stored variables, a list box displaying the results of 
several functions, and a “Close” button. You can move between these 
elements by pressing “tab,” or “shift-tab.” You can bring up this dialog 
box by pressing “Alt-t” in the calculator line, or by pressing “t” in the 
“Variable Calculators” menu. In the variable list, the variable names and 
their current values are displayed. You can move between these 
variables by pressing “Down arrow key”or “Up arrow key.” In order to 
select a variable to be used in the calculation, press “Space” on it. This 
list is the same as the one in the “Recall Items” dialog box. The only 
difference is that this dialog box always displays variable names and 
values, regardless of the value of “Detail display” option. After you select 
all of the variables to be used in the calculation, you can press “tab” to 
move to the “result” list. The “result” list displays the sum, average, 
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variance, and standard deviation of selected variables. You can move 
between these items by pressing “Down arrow key”or “Up arrow key.” If 
you want to copy some results in the list to the clipboard, first press 
“Space” on the items to be copied, and then press “Ctrl-Insert.” 
(However, “Copy To Clipboard” in the menu cannot be used.  Only this 
hotkey will work.) Once they are copied to the clipboard, they can be 
pasted in the Word processor or other programs. To close the dialog box, 
press “Alt-F4” or press “Enter” on the “Close” button. To get the statistics 
about another set of variables after reading the result, press “shift-tab” to 
go back to the variable list. Then, press “ESC” to cancel all the 
selections. Now, select all the variables to be calculated in the same way 
as you did before, and press “tab” to read the result. 
 
17.1.3 Sine Functions 
 
The “Sine Functions” menu will be activated when you press “Enter” on 
“Sine Functions,” or press “s” in the menu. You can open the menu by 
pressing “Alt.” Or, you can activate the “Sine Functions” menu by 
pressing “Ctrl-s” in your calculation line. The “sine function” list consists 
of “Sine,” “Arc sine,” and “Hyperbolic sine.” If you press “Enter” on one of 
the three functions while moving with “Up arrow key”or “Down arrow 
key,” or if you press “Enter” on “Confirm” on one of the functions while 
moving with tab, you can insert it into your calculation line after selecting 
one of the sine functions. Or, you can insert one of the three sine 
functions by pressing the first letter of each in the list. 
 
17.1.4 Cosine Functions 
 
You can activate the “Cosine Functions” by pressing “Enter” on “Cosine 
Functions,” or if you press “c” in the menu. You can open the menu by 
pressing “Alt”. Or, in your calculation line, you can open the “Cosine 
Functions” by pressing “Ctrl-c.” The “cosine function” list consists of 
“Cosine,” “Arc cosine,” and “Hyperbolic cosine.” If you press “Enter” on 
one of the three functions while moving with “Up arrow key”or “Down 
arrow key,” or if you press “Enter” on “Confirm” while moving with tab, 
you can insert it into your calculation line after selecting one of the three 
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cosine functions. Or, you can insert one of the three cosine functions by 
pressing the first letter of each in the list. 
 
17.1.5 Tangent Functions 
 
You can activate the “Tangent Functions” when you press “Enter” on 
“Tangent Functions,” or if you press “t” in the menu. You can also open 
the menu by pressing “Alt.” Or, in your calculation line, you can open the 
“Tangent Functions” by pressing “Ctrl-t.” The “tangent functions” list 
consists of “Tangent,” “Arc tangent,” and “Hyperbolic tangent.” If you 
press “Enter” on one of the three functions while moving with “Up arrow 
key”or “Down arrow key,” or if you press “Enter” on “Confirm” on one of 
the functions while moving with tab, you can insert it into your calculation 
line after selecting one of the three tangent functions. Or you can insert 
one of the three tangent functions by pressing the first letter of each in 
the list. 
 
17.1.6 Logarithm Functions 
 
The “Logarithm Functions” is a dialog box, which contains the following:  
“function list,” a “Confirm” button, and a “Cancel” button. You can move 
between the three items by pressing “tab”or “shift-tab”. The function list 
consists of “Common logarithm” and “Natural logarithm,” in which you 
can move by pressing “Up arrow key”or “Down arrow key”. 
 
You can activate the “Logarithm Functions” menu by pressing “Enter” on 
“Logarithm Functions,” or if you press “l” in the menu. Of course, you can 
open the menu by pressing “Alt.” Or, in your calculation line, you can 
activate the “Logarithm Functions” by pressing “Ctrl-l.” 
 
When running the “Logarithm Functions,” If you press “Enter” on one of 
the functions while moving with “Up arrow key”or “Down arrow key,” or if 
you press “Enter” on “Confirm” on one of the functions while moving with 
“tab”,” you can insert it into your calculation line after selecting one of the 
logarithm functions. Or, you can insert “Natural logarithm” by pressing 
“e” in the list. You can insert “Common logarithm” by pressing “n.” 
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17.1.7 Copy to Clipboard 
 
The “Copy To Clipboard” function is used to copy your formula or result 
into the clipboard for pasting your formula or result in a document of the 
word processor. You can activate it by pressing “Enter” on the “Copy To 
Clipboard,” or by pressing “i” in the menu. You can open the menu by 
pressing “Alt” while running the calculator. Or, in the calculation line, you 
can press “Ctrl-Insert” for the quick copy of your calculation into the 
clipboard directly. After copying, you can paste it in your document of the 
word processor. 
 
When you activate “Copy To Clipboard,” you will hear “Copy completed,” 
and the Voice Sense QWERTY will return to your calculation line.  
 
17.1.8 Option Settings 
 
“Option Settings” is a dialog box, which contains the following: “setting 
list,” a “Confirm” button, and a “Cancel” button. You can move between 
the three items by pressing “tab”or “shift-tab”. The “setting list” consists 
of “Radian” and “Degree,” in which you can move by pressing “Up arrow 
key”or “Down arrow key”. 
 
If you select “Radian,” you can get the PI value while using the 
trigonometric function. If you select “Degree” and activate PI, you will get 
a wrong answer. You can activate the “Option Settings” if you press 
“Enter” on it, or if you press “o” in the menu. Of course, you can open the 
menu by pressing “Alt. Or, in your calculation line, you can activate the 
“Option Settings” by pressing “Ctrl-o.” 
 
When running the “Option Settings,” if you press “Enter” on what you 
want in the setting list while moving with “Up arrow key”or “Down arrow 
key,” or if you press “Enter” on “Confirm” on what you want in the setting 
list, while moving with “tab”,” you will set the option. 
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17.1.9 Exit 
 
This is used to exit the calculator. You can quit a calculation if you press 
“Enter” on “Exit Calculator,” or if you press “z” in the menu. Of course, 
you can open the menu by pressing “Alt”. Or, in your calculation line, you 
can exit by pressing “Alt-F4”. 
 
17.1.10 Sample Math Calculations 
 
The following are examples for each of the math functions that you can 
perform when using the calculator on the Voice Sense QWERTY. 
 
General functions: 
 
1. Addition Plus 

For Plus press “+” 
For example, to add the numbers 10 and 20, you would enter: 10+20. 
The result is displayed as 30. 

 
2. Subtraction Minus 

For Minus, press “-” 
For example, to add the numbers 10 and 20, and then subtract 5, you 
would enter: 10+20-5. The result is displayed as 25. 

 
3. Multiplication 

For multiplication, press “*” 
For example, to multiply 10 by 20, you would enter: 10*20. 
The result is displayed as 200. 

 
4. Division 

For Division, press “/” 
For example, to divide 20 by 10, you would enter: 20/10.  The result 
is displayed as 2. 

 
5. Percent 

For Percent, press “%” 
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If you want to calculate, what a 10 percent mark-up of 20 would be, 
enter the following, 20+10% which gives you the result 22. You get 
this answer because, 2 is 10percent of 20. 

 
To calculate a 10 percent mark-down on 20, press: 20-10% which 
gives the result 18. 
You get this answer because, 2 is 10 percent of 20. 

 
To calculate what percentage 20 is of 10, press: 20/10% which gives 
you the result 200.   

 
To calculate 10 percent of 20, press: 20*10% which gives the result 2. 
That is, 10 percent is 0.1. 20*0.1 = 2. 

 
6. Power 

For Power, press “^” 
For example, to calculate 2 to the power of 10, you would press: 2^10.  
The answer will be given as 1024. 

 
7.  Calculating Square Root 

To perform the Square root function, you can press “Ctrl” with “q” 
For example, to calculate the square root of 16, you press: “Ctrl” with 
q, 16 “)”. Then, press enter. 
Your answer will be given as 4. 

 
8. Exponential 

For Exponential you can press “Ctrl” with “e” 
For example, to calculate the Exponential of 2, you would press: Ctrl 
with e then 2, followed by the “)” and “Enter.” That is, exp (2) which 
gives the result 7.3890561. 

 
9. Trigonometric Functions 
 
Sine Functions: 
 
For Sine, press “Ctrl” with “s,” and then “s.” This is shown on the LCD as, 
sin(. 
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For Arc Sine, press “Ctrl” with “s,” then “a.” This is displayed as asin(. 
 
For Hyperbolic sine, press “Ctrl” with “s,” then “h.” This is displayed as 
sinh(. 
In order to calculate the sine of a 30 degree angle you would type the 
following:  Ctrl with s, then “s,” 30 and then” ).” Press “Enter” and your 
answer is displayed as 0.5. 
 
Cosine Functions: 
 
For Cosine, you would press “Ctrl” with “c,” and then you would press 
“c.” This is displayed as cos(. 
 
For Arc cosine, press “Ctrl,” with “c,” then, “a.” This is displayed as acos(. 
 
For Hyperbolic cosine, press “Ctrl” with “c,” then, “h.” This is displayed as 
cosh(. 
For example, to calculate the cosine of the 30 degree angles, you press: 
Ctrl with c, C, 30 and then “)”. Then, press “Enter.”  Your answer will be 
given as 0.8660254. 
 
Tangent Functions: 
 
For Tangent, press “Ctrl” with “t” and then “t.” This is displayed as tan(. 
For Arc tangent, press “Ctrl” with “t” then “a.” This is displayed as atan(. 
For Hyperbolic tangent, press “Ctrl,” with “t,” then, “h.” This is displayed 
as tanh(. 
For example, to calculate the tangent of the 30 degree angles, you 
press: Ctrl with t, T, 30 and then “)”. That is, tan(30) which gives you the 
result of 0.57735027. 

 
Logarithm Functions: 
 
Common logarithm 
For Common logarithm, press “Ctrl” with “l,” and then “n.” This is 
displayed as log(. 
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For example, to calculate the common logarithm of the 100, you press: 
Ctrl with l, N, 100 and then “)”. That is, log(100) which gives the result 2. 
 
Natural Logarithm 
For Natural logarithm, press “Ctrl” with “l,” and then, “e.” This is 
displayed as ln(. 
For example, to calculate the natural logarithm of the 100, you press: 
Ctrl with l, E, 100 and then “)”. That is, ln(100) which gives the result 
4.60517019. 
 
17.2 Display Compass Heading 
 
You can display compass in Voice Sense QWERTY. You can execute 
this function regardless of location. 
 
In order to display compass, follow these steps: 

1) Press “Fn-Space”, regardless of location. 
2) It will show current status of compass. 

 
Also you can execute this function in the “Utilities” program. 

1) Press “Enter” on the “Utilities” program or simply press “b” from 
the main menu. 

2) Move to “Display Compass Heading” by pressing “Down arrow 
key”. 

3) Press “Enter” on the “Display Compass Heading” or simply press 
“h”. 

 
If you want to check current compass, press “Space”. You will hear 
current compass. 
 
To exit this function, press “ESC”. 
 
Note: It will take about 15 minutes to initialize the unit as following cases: 
1. Far away from the original location with the unit being discharged. 
2. Leave the unit being discharged for more than a month  
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17.2.1 Options of gyrocompass 
 
There are 2 options in gyrocompass. 

· Refreshing time 
· Compass display type 
 

· Refreshing time 
You can set the interval of announcement. To set, follow these steps: 

1) Execute the “Display Compass Heading”. 
2) It will show current status of compass. 
3) Press “Tab”. 
4) It will show “Refreshing time” edit box. 

 
By default, it is set to “0”. You can set from 0 to 120. Please enter the 
value for seconds. 
 
· Compass display type 
 
You can set the type of the compass display. To set, follow these steps: 

1) Execute the “Display Compass Heading”. 
2) It will show current status of compass. 
3) Press “Tab” and move to “Compass display type”. 
 

By default, it is set to “cardinal and degrees”. The setting values are 
“cardinal and degrees”, “cardinal only” and “degrees only”. By pressing 
“Space”, you can change setting value. 
 
 
17.3 Set time and date 
 
If you want to set the Voice Sense QWERTY internal clock, you can set 
it by pressing “Enter” on “Set time and date” in the “Utilities” menu.  In 
the “Utilities” menu, you can locate the set time and date by pressing “t,” 
or you can find it by navigating the “Utilities” menu with “Up arrow key”or 
“Down arrow key”. 
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The set time and date is a dialog box, which consists of “Time zone,” 
“Use daylight saving,” “Time format,” “Time,” “Date,”, “Synchronize with 
time server”, a “Confirm” button, and a “Cancel” button. You can move 
between each of these items by pressing “tab” or “shift-tab”. 
 
If you activate “Set time and date” for the first time, you may see “Time 
zone? Pacific Time (US & Canada); Tijuana (GMPT-08:00)” which is set 
as the default. In “Time zone,” you can review the “time zone” list by 
pressing “Down arrow key”or “Up arrow key,” or by typing in the first 
letter of represented cities. If you selected one of the time zones, you 
can move to the next item by pressing “tab”,” or you can move to the 
previous item by pressing “shift-tab”. 
 
The “Use daylight saving” will display according to “Time zone.” 
Namely if daylight saving time is used in selected time zone, this item 
will display. If not so, this item is not display. You can check and 
uncheck this item by using “Space.” 
 
The next item is “Time format,” where you can switch between 12 hour 
and 24 hour time. You can toggle between which time to use with “Up 
arrow key”or “Down arrow key”.   
 
Once you select a time, you can move to the next “Time” by pressing 
“tab”.” In “Time,” you can set your time. If you select 12 hour clock in the 
“Time format,” you can see A.M. or P.M. after the hour and minute. In 
the 12 hour clock, you can set the time after selecting A.M. or P.M. by 
pressing “Fn-x.” In the 24 hour clock setting, you can type in a 24-hour-
system number regardless of A.M. or P.M. When you put numbers in the 
time, you need to put a “Space” or “: (colon)” between the hour and the 
minute. To set your time, you can move to the “Date” by pressing “tab.”  
In the “Date,” you should put in the month, date, and year in that order.  
You should use a 2-digit number for the month, a 2-digit number for the 
date, and a 4-digit number for the year while typing in a “Space” or “/ 
(slash)” between them. 
The next item is “Synchronize with time server”, where you can 
synchronize time and date. This function is extremely useful when the 
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date and time of Voice Sense QWERTY is faster or slower than current 
time. First of all, to execute this function, you have to connect the 
internet to your Voice Sense QWERTY. Once the internet is connected, 
press “Enter” on “Synchronize with time server” button. After the 
synchronizing, it will show synchronized time in “Time” edit combo box. 
Also when you press “Tab” it will show synchronized date in “Data” edit 
combo box. 
 
 After you have completed the necessary information, you can press 
“Enter” on “Confirm” by moving with “tab,” and then you will return to “set 
time and date.” Or, you can press “Enter” when you have completed 
entering all of the information because the default is set to “Confirm.” 
 
17.4 Display time and date 
 
You can check the current date and time here. To activate this function, 
press “Down arrow key”or “Up arrow key”in the “Utilities” menu, and then 
press “Enter” on “Display time and date.” Or, you can activate this 
function by pressing “d” in the menu. Anywhere in the Voice Sense 
QWERTY, you can press “Fn-t” to check the time. If you press “Fn-t,” the 
Voice Sense QWERTY will say the time, and the Voice Sense QWERTY 
will display the current time in LCD. Then, if you press tab, the Voice 
Sense QWERTY will say and display today’s date. 
 
17.5 Wake up alarm 
 
If you have set up the “Wake up alarm” function, an alarm will sound on 
the Voice Sense QWERTY at the specified time every day.  
If you want to open “Wake up alarm,”  
 

1) Go to the “program” menu, move to “Utilities,” and then press 
“Enter.”  

2) Then, use the “Up arrow key”or “Down arrow key”to find “Wake up 
alarm,” and then press “Enter” on “Wake up alarm.”  
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If this is the first time you have opened “Wake up alarm,” and you have 
not yet set the time or date in the Voice Sense QWERTY, theVoice 
Sense QWERTY will then say, “Set time:” After you set the time, the 
Voice Sense QWERTY will display the “Wake up alarm” dialog box. The 
Voice Sense QWERTY will then say, “Set time:” The “Wake up alarm” 
dialog box contains the following: “Set time,” “Bell,” “Term,” “Alarm 
duration,” “Repeat interval,” “Wake up call times” a “Confirm” button, and 
a “Cancel” button. You can move among these by pressing “tab”and 
“shift-tab”. If you want to check the wakeup call settings, open this dialog 
box again. It will show you the current wakeup call settings. When the 
alarm sounds, the LCD on the oice Sense QWERTY will also display the 
message “Wake up call. Press “Ctrl” to stop the alarm.” If you want to 
stop the alarm, press “Ctrl.” After you press “Ctrl,” the Voice Sense 
QWERTY will remain on, even though the power switch is turned to 
“Off.” In order to turn the Voice Sense QWERTY off, you must turn the 
power switch to “On,” and then back to “Off” after you hit “Ctrl.” Then, the 
Voice Sense QWERTY will be turned off, and the alarm will not sound 
again until you set it again. If you do not plan on being able to turn the 
unit off and on, you should turn on the “Power saving mode” in the 
“Global options” (as explained in chapter 3) to avoid draining the battery. 
 
17.5.1 Set Time 
 
When you open the “Wake up alarm” dialog box, the Voice Sense 
QWERTY will display the “Set time” field. The value is set to the current 
time or the time specified previously. Here you can directly type in the 
time, or set the time using the shortcut keys, as explained in section 7.3.  
After you set the time, you should press “tab” to move to the next field.  
While you are anywhere in the Voice Sense QWERTY, you can check 
the time by pressing “Fn-t” to check the time. 
 
17.5.2 Alarm Sound 
 
You can select an alarm sound for the wake up alarm. If you press 
“tab”on “Set time,” you will hear the alarm sound that is currently set.  
Press “Up arrow key”or “Down arrow key”to change the alarm sound, 
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and you will hear the different alarm sounds. Select one of the three 
alarm sounds that are available. If you have selected the sound that you 
want, press “tab” to move to the next field. 
 
17.5.3 Term 
 
In this field, you can set which day of the week the alarm will go off.  
There are four options: “Off,” “Once,” “Week days,” and “Every day.”  
Move between these options by pressing “Up arrow key”or “Down arrow 
key”. If “Term” is set to “Off,” the alarm will not go off at the specified 
time at all. If “Term” is set to “Once,” the alarm will go off only once. If 
“Term” is set to “Week day,” the alarm will go off at the same time every 
weekday, Monday through Friday. If “Term” is set to “Everyday,” the 
alarm will go off at the specified time 7 days a week, even on weekends.  
When you have selected the option you like, press “tab”to move to the 
next field. 
 
17.5.4 Ringing Duration 
 
This option sets the amount of time that the alarm will sound. The 
options are 1 minute, 2 minutes, or 3 minutes. Move between these 
options by pressing “Up arrow key”or “Down arrow key”. If you set the 
ringing duration to “1 minute,” the alarm will sound for one minute, and 
then the alarm will be silent. To stop the alarm, press “Ctrl.” 
 
17.5.5 Repeat Interval 
 
This option sets the amount of time that will be between the times that 
the alarm sounds. For example, after the alarm has stopped sounding, it 
will ring again in 3 minutes, if you set the repeat interval to three minutes.  
The available settings are 1, 3, 5, 10, 15, or 20 minutes. Move between 
these options by pressing “Up arrow key”or “Down arrow key”.   
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17.5.6 Wakeup Call Times 
 
This option allows you to decide how many times the alarm will sound.  
The available settings are anywhere from 1 to 10 times. For example, if 
the alarm is not turned off by pressing “Ctrl,” it will repeat according to 
the number of times that you set for this option. Move between these 
options by pressing “Up arrow key”or “Down arrow key”.   
 
17.5.7 Confirm Cancel 
 
If you press “Enter” on the “Confirm” button, the changed options will be 
saved, and the dialog box will be closed. If you do not want to save the 
changes you have made, press “Enter” on the “Cancel” button. The 
Voice Sense QWERTY will keep the previous “wakeup call” settings, 
and close the dialog box. 
 
17.6 Calendar 
 
You can activate the calendar by pressing “Enter” on “Calendar” in the 
“Utilities” menu, or by pressing “l.” The following options will be available 
when you are using the calendar. “Solar calendar,” “Lunar calendar,” 
and “Day of week.” In the calendar, you can check the three kinds of 
information starting from the year 1841 to the year 2043. If you type in a 
date that is not in the range and press “Enter,” you will get the message, 
“Invalid date,” and return to where you where you were typing in the date. 
 
17.6.1 Using the Calendar 
 
The “Calendar” is composed of the “Solar calendar,” “Lunar calendar,” 
and “Day of week.” In the “Lunar calendar,” a leap month will display the 
month with “l.” The calendar works according to a date unit. The default 
is the date that the Voice Sense QWERTY was set to the last time the 
date was set. You can check the date in two ways. 
The following is an explanation of how to check the dates. 
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1. Moving items 
You can switch between “Solar calendar,” “Lunar calendar,” and “Day 
of week” by pressing “tab”or “shift-tab”. 

2. Typing in date 
In the calendar, you can type in a month, date, and year. For the year, 
you should type in a 4-digit number, and for the month and date, you 
should type in 2-digit numbers. You can put “Space” or “/ (slash)” 
between the month, date, and year. If you press “Enter” after typing in 
a date, you can hear the date once, and go to the next item. For 
example, if you put the date in the “Solar calendar,” you will be on the 
“Lunar calendar.” 

3. Hotkeys for switching dates 
After putting in a date, you can check the “Solar calendar,” “Lunar 
calendar,” and “Day of week” by pressing “tab” or “shift-tab.” 

Move to the next day: Right arrow key 
Move to the previous day: Left arrow key 
Move to the next week: Ctrl-Right arrow key 
Move to the previous week: Ctrl-Left arrrow key 
Move to the next month: Down arrow key 
Move to the previous month: Up arrow key 
Move to the next year: Ctrl-Down arrow key 
Move to the previous year: Ctrl-Up arrow key 

 
17.7 Pronunciation Dictionary 
 
The “Pronunciation dictionary” is used to register or modify the Voice 
Sense QWERTY’s pronunciation while it is speaking. You can activate it 
by pressing “p” in the “Utilities” menu. 
 
The “Pronunciation dictionary” is composed of the list, “Add Word” 
button, “Modify Word” button, “Delete Word” button and “Close” button.  
You can move through those controls by pressing “tab” or “shift-tab.”   
The list will be shown as “word: xx – yy” where “xx” is the original word 
and “yy” is the word you wanted to hear instead of the original word.  
For example, if you wanted to hear “world health organization” for the 
original word “WHO” and added the word, the list will be listed as “word: 
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WHO – world health organization.” If there are many items on the list, 
you can move up or down through lists by pressing “Up arrow key”or 
“Down arrow key”. Also when Voice Sense QWERTY connected to use 
with SyncBraille, you can click the cursor routing key corresponding to 
the item position you want to focus. For example, if there are 10 items in 
the list and you want to focus the 5th item, you can just click the 5th 
cursor routing key and you will focus on the 5th item on the list. The list 
will not be listed by the alphabetical order and it will be listed by the 
sequential order to be added. 
 
If you want to add new word, you can add the word by pressing “Enter” 
on “Add Word” button or you can press “Alt-i.” Then you will meet “Add 
entry:” Here you can type in the word you want to change its 
pronunciation and press “tab” then you will meet “Replacement:”  Here 
you can type in the word you want to hear the pronunciation and then 
press “Enter” or press “tab” to move to “Confirm” button and then press 
“Enter.” The word will be added completely and the focus will be 
returned to “Add Word” button. In case of adding the word by pressing 
“Alt-i,” newly added word will be displayed. If you want to cancel this 
modification, you can press “Enter” on “Cancel” button or press “ESC” or 
press “Alt-F4.” 
 
If you want to modify the registered word, in the list, you can move up or 
down by pressing “Up arrow key”or “Down arrow key”so that you focus 
the item you want to modify. And after moving to “Modify Word” button 
by pressing “tab,” press “Enter.” Or on the item you want to modify, just 
press “Alt.” Then you will meet “Modify entry: (focused word).”  At this 
time, if you press “tab” once, you will meet “Replacement: (new 
pronunciation).” Here you can type in the pronunciation you want to 
change and then press “Enter.” Or press “tab” again to move to 
“Confirm” button and then press “Enter.” Then the word will be modified 
completely and the focus will be returned to “Modify Word” button. In 
case of modifying the word by pressing “Alt”, the modified word will be 
displayed. If you want to cancel this modification, you can press “Enter” 
on “Cancel” button or press “ESC” or press “Alt-F4.” 
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If you want to delete the registered word, in the list, you can move up or 
down by pressing “Up arrow key”or “Down arrow key”so that you focus 
the item you want to delete. And after moving to “Delete Word” button by 
pressing “tab,” press “Enter.” Or on the item you want to delete, just 
press “Del.” Then you will meet the prompt, “Delete? Yes.” If you are 
sure to delete the item, press “Enter.” Otherwise press “Space” to switch 
to “No” and then press “Enter.” 
 
If you want to exit “Pronunciation dictionary,” you can press “Enter” on 
“Close” button or press “Alt-F4.” 
 
17.8 Stopwatch 
 
When you press “Enter” on the “Stopwatch,” you will show “00:00:00.”  
If you press “Enter,” the stopwatch will start. If you press “Enter” again, it 
will pause, and the Voice Sense QWERTY will say the elapsed time, and 
display it in LCD. Pressing “Enter” again will restart the stopwatch from 
where it paused. 
 
If you press “Backspace” on “work” or “pause,” it will let you know the 
elapsed time and will clear into “00:00:00.” While the stopwatch is 
working, pressing “Space” will make the Voice Sense QWERTY say the 
elapsed time at the moment. In this case, the LCD is still just displaying 
the clock. 
  
While the stopwatch is running, pressing “Fn-Space” will stop displaying 
the time while the stopwatch is still running. If you press “Fn-Space,” the 
time will be displayed again. 
 
If you press “tab”or “shift-tab”before the start of the stopwatch or while it 
is running, you can switch to the “Countdown timer.” If you activate the 
“Countdown timer,” you will be asked to put in hours, minutes, and 
seconds. If you press “Enter” without typing in any numbers, the 
“Countdown timer” will start with the default, which is set to one minute. 
When started, the “Countdown timer” will display “count down xx 
minute,” and it will start running. If you press “Enter” in the “Countdown 
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timer,” the Voice Sense QWERTY will tell you the remaining time, and 
then it will pause. If you press “Enter” again, it will restart. Pressing 
“Backspace” will clear the “Countdown timer.” If the timer reaches zero, 
you will hear a 10-second alarm, and the “Countdown timer” will clear. If 
you press “Ctrl” while the alarm is sounding, the alarm will stop and your 
timer will clear, and will be ready to accept a new time. 
 
If you press “tab” or “shift-tab” again anywhere in the count down timer, 
the stopwatch will be ready. If you want to exit the “Stopwatch” or 
“Countdown timer,” press “Alt-F4” anywhere within the “Stopwatch” or 
“Countdown timer,” and you will return to the “Stopwatch” menu. 
 
17.9 Setup Internet 
 
The “Setup internet” function is used to set up your IP configuration.   
 
17.9.1 “Setup internet” list  
 
1. LAN 
2. Wireless LAN 
3. Bluetooth DUN 
4. ADSL 

 
You can move between the four items by pressing “Down arrow key”or 
“Down arrow key.” The “LAN” setup should be used if you are 
connecting to the Internet via a network or router. The “Modem” setup 
should be used if you are connecting to the Internet via a dial-up modem. 
The “ADSL” setup should be used if you are connecting to the Internet 
via a DSL modem. To connect to the Internet via a wireless network, use 
the “Wireless LAN” function. 
 
If you want to activate “Setup internet,” press “Enter” on “Setup internet” 
in the “Utilities” menu, or press “I” in the “Utilities” menu. You can move 
through the “Utilities” menu items with “Up arrow key”or “Down arrow 
key”. 
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If you want to access to Internet with the Voice Sense QWERTY, you 
must set the Internet settings at “Setup internet” that is one of the 
submenus of “Utilities” menu. 
Or, if the PC in which the Active Sync program is installed is connected 
to Internet and the Voice Sense QWERTY is connected to that PC, then 
you can connect the Voice Sense QWERTY to Internet. 
 
The functions of this menu are explained in greater detail in the following 
sections. 
 
17.9.2 LAN Setup 
 
If you are going to set up a LAN, you should first connect a LAN cable to 
the Voice Sense QWERTY. In this setup, you can decide whether you 
will use the automatic or manual setup to setup your IP configuration.  If 
you want to set it up automatically, press “Enter” on “Setup IP: 
Automatic.” Then, it will be set up automatically. For the automatic setup, 
your host server should provide DHCP service (Dynamic Host 
Configuration Protocol). 
 
If you want to set up your IP configuration manually, move to “Manual” 
by pressing “Down arrow key”from the “setup IP: Automatic,” and press 
“Enter.” Then, you will find the following: “IP,” “Subnet mask,” “Gateway,” 
and “Primary DNS.” These settings require specific information. Please 
contact your Internet service provider for the right information. And after 
typing in the information, you can move to the next item by pressing 
“Down arrow key”. Finally after completing the “Primary DNS,” press 
“Enter.” Then, you will see the message “setting completed.” You will be 
returned to “Setup internet” with your information saved. You can then 
use E-mail, MSN messenger or the Web browser. 
 
17.9.3 Wireless LAN 
 
If you want to connect to a wireless network, you should use the “setup 
wireless LAN” function. In order to use the “setup wireless LAN” function, 
you must change the wireless option to “On” in the option menu. 
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Go to the “Utilities” menu that is located in the “program” menu by 
pressing “Win key,” and then press “Down arrow key”repeatedly to move 
to the “Utilities” menu. Then, press “Enter” on “Utilities.” Next, move to 
“Setup internet” by pressing “Up arrow key”or “Down arrow key,” and 
then press “Enter” on “Setup internet.” And then press “Enter” on 
“Wireless LAN.” 
 
The “Wireless LAN” dialog box consists of the “access point” list, 
“Advanced” button and “Close” button. You can move between these 
controls by pressing “tab”or “shift-tab”. If you do not have a wireless LAN 
turned on, you will hear “no item” when you press “Enter” on “Wireless 
LAN.” 
 
When you first open the “Wireless LAN” dialog box, the focus is on the 
“access point” list. The list has the information of wireless access points 
which is searched.  
 
“Access point” list will let you know the “access point name,” 
“encryption,” and “sensitivity” of each item. (Ex: linksys, encryption: WEP, 
sensitivity: good.) If there is more than one access point in the list, you 
can move between them by pressing “Up arrow key”or “Down arrow key”. 
Move to the “access point” that you want to connect to. And press 
“Enter.” And then you will hear the “Trying to Connecting with (access 
point name)” message and connecting sound. If you are using network 
key in Access Point when you press “Enter,” “Network key” edit box will 
be displayed. In edit box, you have to input the encrypted key and press 
“Enter.” And if your settings are correct, then you will hear “Completed 
setting profile” with connecting sound.  
 
The “Advanced” common dialog box is used to modify the added profile 
or add new profile or check the existed profile. If you press “Enter” on 
the “Advanced” button while wireless LAN turned off, “no item” will be 
displayed. Pressing “Enter” on the “advanced” button, while wireless 
LAN turned on. The “Advanced” dialog box has 5 controls. You can 
navigate among these controls by pressing “tab”or “shift-tab”. 
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The “Advanced” common dialog box contains “profile list,” “Add” 
common dialog button, “Remove” button, “Properties” common dialog 
button and “Close” button controls. 
 
1. “profile list”: Here you will see the profile lists that you have added. 

You can move through the list by pressing “Down arrow key”or “Up 
arrow key.” 

 
2. “Add” common dialog button: You can add a profile here. “Add 

common dialog” has the 10 controls. 
(1) “Setup IP: Automatic” combo box: You can switch between 

automatic and manual by pressing “Down arrow key”or “Up arrow 
key” If you select “Manual,” you will need to enter your IP address, 
subnet mask, gateway IP address, and DNS IP address by 
yourself. You can move between these computer edit boxes by 
pressing “Down arrow key”or “Up arrow key.” Press “tab”to move 
to the next control. 

(2) “Network name (SSID)” computer edit box: The edit box is empty 
and you can type in network name you prefer. 

(3) “Network mode” combo box: Here you can select between 
“Infrastructure,” and “802.11 ad-hoc” mode by pressing “Up arrow 
key”or “Down arrow key”. 

(4) “Network authentication mode” combo box: Here you can select 
between “Open,” “Shared,” “WPA-PSK,” and “WPA2-PSK” by 
pressing “Up arrow key”or “Down arrow key”. 

(5) “Data encryption” combo box: Here you can select the data 
encryption method by pressing “Up arrow key”or “Down arrow key”. 
If you select “Open” or “Shared” in network authentication mode, 
you can choose between “Disable” and “WEP.” And if you select 
“WPA-PSK” or “WPA2-PSK” in network authentication mode, you 
can choose “TKIP.” 

(6) “The key is provided automatically” check box: If the “access point” 
does not provide a key for users automatically, uncheck this check 
box by pressing “Space.” The default is that the check box is 
checked. 
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(7) “Network key” computer edit box: This is a computer edit box to 
type the network key if the key is not provided automatically. 

(8) “Key index” edit box: This is an edit box to type the key number of 
the wireless access point that matches the network key input. 

(9) “Confirm” button: Pressing this button applies the changes. 
(10) “Cancel” button: You can press this button to cancel the setup. 

 
Selecting “Open” in “Data encryption” skips numbers 6 through 8, and 
checking “The key is provided automatically” check box will omit the 
numbers 7, 8. 

 
3. “Remove” button: If you want to delete a profile item in the profile list, 

select the profile item you wish to delete, and then press “r” or go to 
the “Remove” button by pressing “tab”, and then press “Enter” on 
“Remove” button. 

 
4. “Properties” common dialog button: If you want to get information 

about a selected profile item in the profile list, press “Enter” on the 
“Properties” common dialog button after focusing on a profile item by 
using “tab”. You can reconfirm the added information in each item.  
You can modify an item here directly. 

 
In order to exit from “Advance” dialog box, you can press “ESC” or “Alt-
F4”. 
 
17.9.4 Bluetooth DUN setup 
 
If you wish to connect to Mobile network using Bluetooth DUN, you can 
move to “Setup internet” in the “Utilities” menu and select “Bluetooth 
DUN” and enter on it.  
The Bluetooth DUN setup contains the following: “connect list,” “Default,” 
“Add,” “Modify,” “Delete,” and “Close.” You can move between these by 
pressing “tab”or “shift-tab”. Within each item, you can move by pressing 
“Down arrow key”or “Up arrow key.” 
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The “connect list” has added connection names.  You can move 
between these by pressing “Down arrow key”or “Up arrow key.” 
 
The “Default” is to set to the default connection name in the Internet 
setup. If you want to choose a connection as the default, go to the 
“connect list,” and move to “Default” by pressing “tab”.” Then, press 
“Enter.” 
 
“Add” is a dialog box where you can set up the environment regarding 
the connect group names. It has “connect name list,” a “Confirm” button, 
and a “Cancel” button. You can move between these by pressing “tab”or 
“shift-tab”. The “connect name list” has “Connect name,” “Connect 
number,” “ID,” “Password,” and “Modem speed.” In “Connect name,” you 
can type in the host name to connect with, and in the “Connect number,” 
you can type in the number of the host. Here you can type in numbers 
and commas (,) only. In case of Bluetooth DUN, you can make the 
connection to Mobile network without any password according to Mobile 
server. In the “Modem speed,” select one from the list by pressing 
“Backspace” or “Space.” After completing each item, you can move to 
the next item by pressing “tab”. Finally, with “Modem speed” completed, 
you can press “Enter” to save your registration.  Before saving it, you 
can cancel your choices by moving to “Cancel” by pressing “tab,” and 
press “Enter” on it. 
 
“Modify” is used to modify the connect group. You can do this by moving 
to what you want to select in the “connect list,” and then press “Enter.”  
You can also press “tab”to locate “Modify.” Otherwise, you can press 
“Ctrl-m” on the “Connect name” in the “connect list” directly.  “Modify” 
has the same items as “Add,” and you use the menus in the same way. 
In “Delete,” if you want to delete an item, you can move to what you 
want to delete in the “connect list,” and then press “Enter” on “delete.”  
Use “tab”to move between the items. Or, you can delete an item by 
pressing “Del” on what you want to delete in the “connect list.” 
 
If you want to exit the “Modem setup,” you can press “Alt-F4,” or you can 
press “Enter” on “Close” by moving to it by pressing “tab”. 
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17.9.5 ADSL Setup 
 
If you want to connect the Voice Sense QWERTY to the Internet via a 
DSL connection, you should use the ADSL setup. First, you should plug 
in a LAN cable to the Voice Sense QWERTY’s LAN port. If you press 
“Enter” on “Setup internet,” you will first see “CB LAN 1/54.”  Then, go 
to ADSL by pressing “Down arrow key”repeatedly. Press “Enter” on 
“ADSL.” It contains the following controls: connect list, default, add, 
modify, delete, and close. You can move between the controls by 
pressing “tab”or “shift-tab”. Within each control, you can move item by 
item by pressing “Down arrow key”or “Up arrow key.” 
 
In the “connect list,” you will see the added connect names. Select one 
by pressing “Enter” on it. In “Default,” you can make one of the added 
connect names the default connection. If you make a connection the 
default connection, that will be the connection that is used to connect to 
the Internet first. In “Add,” you can manage the connect names in the list. 
It has three controls: edit field, a Confirm button, and a Cancel button. 
You can move between the three controls by pressing “tab”or “shift-tab”. 
The edit field contains the following:  Connect name, ID, and Password. 
You can move between the controls by pressing ‘“Down arrow key”or 
“Up arrow key.” When in the “Connect name” control, type in the server 
host name. After completed filling in the appropriate information, press 
“Enter” or press “Enter” on “Confirm” after pressing “tab”moving. To 
cancel everything that has been typed in to the edit field, go to “Cancel,” 
and press “Enter.” 
In “Modify,” you can modify a connect name. If you want to modify a 
connection in the “connect list,” select the connect name you want to 
modify in the list. Then, press “Enter” on “Modify.” Or, after you have 
selected the connect name, press “Ctrl-m.” “Modify” contains the same 
items as “Add,” and the text is typed in the same way. 
 
Using “Delete,” you can delete selected connect names. If you want to 
delete a connect name in the “connect list,” select the connect name you 
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want to delete in the list, and then press “Enter” on “delete.” Or, after you 
have selected the connect name, press “Del.” 
 
If you want to exit the ADSL setup, press “Alt-F4,” or press “Enter” on 
“Close.” 
 
 
17.10 Display network status 

 
Using this program, you can check if the Voice Sense QWERTY is 
currently connected to the Internet. This program provides you with the 
information about the current connection type, the current IP of the unit, 
subnet mask, gateway, and MAC address. To run this program, press 
“Enter” on “Display network status,” or press “n” in the “Utilities” menu. If 
you start the program, a list of information about the connection type and 
address will be displayed. If you press “tab,” the Voice Sense QWERTY 
will display a “Renew” button. If you press “tab” again, “exit” will be 
displayed.  If you press “shift-tab” ,the Voice Sense QWERTY will move 
between these elements in the opposite direction. The first item in the 
information list (status) shows if the Voice Sense QWERTY is currently 
connected to the Internet (online/offline), and what the current 
connection type is (LAN, Modem, ADSL, or Wireless LAN). The next 
item is the “current IP address,” followed by “Subnet mask,” and then 
“Gateway,” and finally “MAC address.” You can move between these 
items by pressing “Down arrow key”or “Up arrow key.” If the Voice 
Sense QWERTY is not currently connected to the Internet, the status 
information shows that the Voice Sense QWERTY is offline.  If you 
press “Enter” on the “Renew” button, it tries to connect to Internet using 
the parameters specified in “Setup internet” once again, and displays 
on/offline status. To end this program, press “Alt-F4” at any time in the 
program. Or pressing “Enter” on the “exit” button will close the program 
too. You can also press “Fn-n” while you are in the “program” menu to 
open display network status. 
 
17.11 Check Power Status 
 



371 
 

You can activate “Check power status” function by pressing “b” or press 
“Enter” on the “Check power status” in the “Utilities” menu. You can 
move to it by pressing “Down arrow key”or “Up arrow key”in the “Utilities” 
menu.  Anywhere in the Voice Sense QWERTY, you can activate this 
function by pressing “Fn-b.” In “check power status,” you can check two 
kinds of information regarding the Voice Sense QWERTY's power.  It 
will let you know the recharging percentage and if the Voice Voice 
Sense QWERTY is using the AC adapter or the battery. If you activate 
this function, you will see “xx% charged, using battery or AC power.” 
After checking it, you can exit by pressing “Alt-F4,” which will return you 
to the menu. 
 
17.12 Backup/Restore Personalized settings 
 
“Backup/Restore Personalized settings settings” is a program where you 
can backup/restore the option settings for each program in the Voice 
Sense QWERTY all at once. This program can be found in the “Utilities” 
menu. You can run this program by pressing “k” in the “Utilities” menu. If 
you run this program, a dialog box will be opened. This dialog box 
contains: “program option check box list”, “Select all” button, “Backup” 
button, “Restore” button, and “Cancel” button. You can move between 
the check boxes in the “program option check box list”, by pressing “Up 
arrow key”or “Down arrow key”. You can move between these controls 
by pressing “tab” or “shift-tab”. The “program option check box list” 
contains “Options settings”, “File manager options”, “Word processor 
options”, “Address manager options”, “Schedule manager options”, 
“Media player options”, “Web browser options”, “E-mail options”, 
“Bluetooth manager options”, “MSN messenger options” and “Database 
manager options”. 
 
In this list, you move to the program option and check it by pressing 
“Space.” If you want to uncheck it you can do so by pressing “Space” 
again. After you select all the options you want to backup or restore, 
press “Enter” on the “Backup” or “Restore” button. If you want to select 
all of the programs in the list, press “Enter” on the “Select all” button. If 
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you press “Enter” on “Backup” or “Restore” button, the dialog box will be 
closed. 
 
If you press a “Backup” button, it lets you see a list in which you can 
select a path where to store a backup file. It shows up “flashdisk” as 
default values. Here you move to disk or folder where you want to store 
a file, by using navigation key in a “File manager” program. And you 
select a folder or disk by pressing “Space,” press “Enter”, it turns up that 
a backup file is stored in selected folder. Each one of these options has 
its own backup file. This means that when you backup each of the 5 
options, it will generate 5 backup files. If you need to store a backup file 
in a root of disk, refer to this way. When it comes out a name of disk, you 
press “Enter” after selecting a disk by pressing “Space.”  
If you press a “Restore” button, it lets you see a list in which you can 
select a path where to restore a backup file. A way how to move or 
select a folder or disk is the same as “Backup.” If you select a folder that 
is not back upped, you can be seen a message which tells that there is 
no backup option file. 
 
If you cold reset your Voice Sense QWERTY, or its battery is fully 
discharged, the main option settings and settings for each program will 
be lost, and cleared to the default values. If you backup options using 
this program right before you cold reset, you can restore the option 
settings you set previously. 
 
 
17.13 Format 
 
To use the Voice Sense QWERTY, you may need to format. This 
program can be found in the “Utilities” menu. You can execute this 
program by pressing “f” in the “Utilities” menu. When you format Voice 
Sense QWERTY, all information is erased. Therefore, before you format 
Voice Sense QWERTY, you are advised to backup important data. 
 
17.13.1 Formatting the disk 
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To execute format the disk, two methods are discussed separately 
below.  
 
First, you can format the disk in utilities program. 

1) Go to the “Format” in utilities program. 
2) Pressing “Enter”, it will be focused in the “Disk: flashdisk”. 
3) Press “Enter”. 
4) “Format flashdisk memory? Yes” will appear on the LCD. 
5) Press “Enter”. 
6) “All data will be lost. Continue? Yes” will appear on the LCD. 
7) “Now formatting flashdisk memory.” will appear on the LCD and 

format is started. 
8) After you have completed the format, return to the “Disk” list. 

 
If you want to cancel the format, press the “Space”, press the “Enter” on 
“No” in step 4) or 6) 
 
Also, Format of SD, USB memory is available in the same method. If you 
inserted the SD card or USB memory in SD card slot or USB port, SD 
card and USB memory will be listed on “Disk” list. Any of the disks can 
be moved by using the up and down arrows. As above, you can format 
in the same process.  
 
Second, you can format the disk in program menu. 
 

1) Press “Fn-f” in program menu. 
2) While holding down “Fn-f,” quickly press and release the reset 

button. 
3) Continue pressing “Fn-f” until you hear the disk formatting. 
4) After you have completed the format, return to the “File manager” 

program. 
 
17.14 Set Sleep Timer 
 
You can set “Sleep Timer” in Voice Sense QWERTY. The sleep timer 
will turn the unit off at a specified time regardless of what you are doing. 
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Please follow these steps; 

1) Press “Fn-j”, regardless of location. 
2) It will find the edit box asking “Sleep timer: 0”. 
3) Enter the number of minutes for the sleep timer. Enter the number 

range from 0 to 90. 
4) Press “Enter”. 

 
Once the sleep timer is set, even if the device is active, it will power off. 
If you set the sleep timer for “5” minutes and press “Fn-j” after 2 minutes, 
you will find “3” in edit box. It means the power will be turned off after “3” 
minutes. 
 
17.15 Upgrade Voice Sense QWERTY Firmware 
 
If you activate this function, you can update the Voice Sense QWERTY 
either through an Internet connection or from a disk that contains the 
upgrade file. If you decide to upgrade using an Internet connection, you 
must first complete the “Setup internet” function. If you update the Voice 
Sense QWERTY, all of the settings will be returned to their default status. 
Data in the flashdisk will be protected.  However, we recommend that 
you backup your files before updating the Voice Sense QWERTY 
Firmware. 
 
While updating, you cannot cancel the update. Note that you must not 
press the reset button while updating, and you should avoid power 
failure.  We recommend that you do not touch the Voice Sense 
QWERTY while it is updating. It may take up to 30 minutes to update the 
Voice Sense QWERTY, though it depends on the speed of your Internet 
connection. On completing the setup, the Voice Sense QWERTY will 
reboot again to finish the update. 
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17.15.1 Upgrading the Voice Sense QWERTY 
FirmwareUsing the Internet 
 
To upgrade the Voice Sense QWERTY Firmwarevia the Internet, 
complete the following steps: 
 

1) Make sure an Internet connection is available. Press “Enter” on 
“Upgrade Voice Sense QWERTY OS” in the “Utilities” menu.  
Then, “Upgrade: Online” will appear. 

2) Now, press “Enter” on “Upgrade: Online.” The Voice Sense 
QWERTY will connect to the HIMS server, and your current 
software version will be compared to the HIMS server version. You 
will then be asked if you want to continue to upgrade. 

3) If you press “Enter” on “No,” the upgrade will be cancelled. Press 
“Space” to toggle between “Yes” and “No.” If you press “Enter” on 
“Yes,” the Voice Sense QWERTY will download the upgrade file, 
the upgrade will stop. If the upgrade fails, it will give you the 
message “Internet connection is not available. Check your cable 
and try again.”  To try the upgrade again, press “Alt-F4” to cancel, 
and then activate upgrade Voice Sense QWERTY Firmwareagain. 
If the connection is successful, the updated files will be 
downloaded, and the Voice Sense QWERTY will start upgrading. 
If you do not have enough memory available on the flashdisk, the 
Voice Sense QWERTY will be unable to update until you make 
room for the upgrade files by deleting any unnecessary files from 
the Voice Sense QWERTY. 

4) After downloading the upgrade file,Voice Sense QWERTY will 
automatically start the upgrading process. Please remember that 
you must not do anything to the Voice Sense QWERTY until the 
upgrade is complete. When the upgrade is complete, you will be 
returned to the “program” menu, and you will hear “File manager.” 

5) After you have completed the upgrade, you should check the 
software version by pressing “Fn-v” while you are in the “program” 
menu. 
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17.15.2 Upgrading the Voice Sense QWERTY Firmwarefrom 
a Disk 
 
To upgrade the Voice Sense QWERTY Firmwarefrom a disk, complete 
the following steps: 
 

1) Connect a disk (such as a compact flash card, SD card or USB 
memory stick) to the Voice Sense QWERTY. The disk must have 
the upgrade file stored on it. Then, press “Enter” on “Upgrade 
Voice Sense QWERTY OS.” 

2) Then, “Upgrade: Online” will appear. Press “Down arrow key”to go 
to the “Upgrade: Offline.” Then, press “Enter.” Then, you will see 
the disk list. Press “Down arrow key”repeatedly to go to the disk 
that contains the upgrade file. Then, press “Enter.” 

3) You will then be asked if you want to continue to upgrade. If you 
press “Enter” on “No,” the upgrade will be cancelled. Press 
“Space” to toggle between “Yes” and “No.” If you press “Enter” on 
“Yes,” the Voice Sense QWERTY will start upgrading. This step 
will not appear when your current software version is not the latest 
version. 

4) The Voice Sense QWERTY will automatically start the upgrading 
process. Please remember that you must not do anything to the 
Voice Sense QWERTY until the upgrade is complete.  When the 
upgrade is complete, you will be returned to the “program” menu, 
and you will hear “File manager.” 

5) After you have completed the upgrade, you should check the 
software version by pressing “Fn-v” while you are in the “program” 
menu. 

 
17.16 Hot Keys for Utilities 
 
1. Calculator:  c 

Calculator clear: Alt-c 
Delete numbers or operators: Backspace 

 
2. General function: Ctrl-g 
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Plus: + 
Minus: - 
Division: / 
Multiplication: * 
Percent: % 
Power: ^ 
Square Root: Ctrl-q 
Decimal Point: . 
Left Parenthesis: ( 
Right Parenthesis: ) 
PI: Ctrl-p  
Exp: Ctrl-e 

 
3. Variable Function: 

Recall Items: Alt-r 
Delete all saved items: Ctrl-d  
Save Items: Alt-s  

 
4. Trigonometric Function: Ctrl-s  

Sine:  Ctrl-s, s  
Arc Sine: Ctrl-s, a 
Hyperbolic Sine: Ctrl-s, h  
Cosine: Ctrl-c, c 
Arc Cosine: Ctrl-c, a  
Hyperbolic Cosine: Ctrl-c, h  
Tangent: Ctrl-t, t 
Arc Tangent: Ctrl-t, a 
Hyperbolic Tangent: Ctrl-t, h  
 

5. Logarithm Function: Ctrl-l  
Natural Logarithm: Ctrl-l, e  
Common Logarithm: Ctrl-l, n  

 
6. Copy to Clipboard: Ctrl-Insert 
 
7. Option Setting: Ctrl-o  
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8. Check compass: Fn-Space 
 
9. Setting date and time: t  

Move to the next day: Right arrow key 
Move to the previous day: Left arrow key 
Move to the next week: Ctrl-Right arrow key 
Move to the previous week: Ctrl-Left arrow key 
Move to the next month: Down arrow key 
Move to the previous month: Left arrow key 
Move to the next year: Ctrl-Down arrow key 
Move to the previous year: Ctrl-Up arrow key 
Move to 1 hour after: Down arrow key 
Move to 1 hour before: Up arrow key 
Move to 10 minutes after: Ctrl-Right arrow key 
Move to 10 minutes before: Ctrl-Left arrow key 
Move to 1 minute after: Right arrow key 
Move to 1 minute before: Left arrow key 
Switch Between a.m. and p.m.: Fn-x 

 
10. Checking date and time: Fn-t 
 
11. Calendar: l  

Move items 
Move to the previous item: Tab  
Move to the next item: Shift-tab 

 
11.1 Move key for date in calendar 

Move to the next day: Right arrow key 
Move to the previous day: Left arrow key 
Move to the next week: Ctrl-Right arrow key 
Move to the previous week: Ctrl-Left arrow key 
Move to the next month: Down arrow key 
Move to the previous month: Up arrow key 
Move to the next year: Ctrl-Down arrow key 
Move to the previous year: Ctrl-Up arrow key 
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12. Pronunciation dictionary: p  

Move to the previous control: Tab 
Move to the next control: Shift-tab  
Move to the previous item in entry: Up arrow key 
Move to the next item in entry: Down arrow key 
Add word: Alt-i  
Modify word: Alt-m  
Delete word: Del 

 
13. Stopwatch: w  

Stopwatch start, pause, restart: enter 
Check the elapsed time:  Backspace 
Switch between stopwatch and count down timer: “tab”or “shift-tab” 
Count down timer pause or restart: enter 
Count down timer Clear: Backspace 
Exit stopwatch or count down timer: Alt-F4 

 
14. Format: Fn-f 
 
15. Check power status: Fn-b 
 
16. Display Networg Status: Fn-n 
 
17. Backup/Restore Personalized settings: k  

Move to previous item: Up arrow key  
Move to next item: Down arrow key  
Move to previous control: Shift-tab  
Move to next control: Tab  
 

18. Set sleep timer: Fn-j 
 
19. Upgrade Voice Sense QWERTY Firmware: u  

Check download information: Space 
Cancel download and exit:  Alt-F4 
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18. Using the help menu 
 
The help section consists of various text files that will allow you to read 
about the many functions of the Voice Sense QWERTY. You will find the 
following help sections: 
 
1. Help overview 
2. Basic functions help 
3. Option menu help 
4. File manager help 
5. Word processor help 
6. Address manager help 
7. Schedule manager  help 
8. Email help 
9. Media player help 
10. FM radio help 
11. Web browser help 
12. Daisy player help 
13. Bluetooth manager help 
14. MSN messenger help 
15. Database manager help 
16. Utilities help 
17. Using the help menu 
18. Using activesync 
19. Command summary 
20. Command summary for USB keyboard 
21. Troubleshooting guide 
22. Accessories 
23. Information about the Voice Sense QWERTY 
 
The section, “Help overview,” gives an entire overview of the Voice 
Sense QWERTY. This section covers all of the functions of the Voice 
Sense QWERTY. To access the help file, press “Win key” to go to the 
“program” menu, and use “Down arrow key”repeatedly until you find 
“Help.” Then, press “Enter” on “Help.” Then, press “Enter” on “Help 
overview.” The navigation keys are the same as in the word processor. 
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For a list of the navigation keys, please see section 20.3.2.  When you 
are reading the manual on the Voice Sense QWERTY, you can search 
for text in the various sections by pressing “Ctrl-f,” type the text you wish 
to find, and then press “Enter.”  You can find the next occurrence of the 
particular text that you have previously searched for by pressing “F3.” 
 
The section, “Basic functions help,” gives an explanation of the “Global 
options” functions and common function, and how to use them. To 
access the help file, press “Win key” to go to the “program” menu, and 
use “Down arrow key”repeatedly until you find “Help.” Then, press 
“Enter” on “Help.” Then, press “Enter” on “Basic functions help.” The 
navigation keys are the same as in the word processor. For a list of the 
navigation keys, please see section 20.3.2. Remember that when you 
are reading the manual on the Voice Sense QWERTY, you can search 
for text in the various sections by pressing “Ctrl-f,” type the text you wish 
to find, and then press “Enter.” 
You can find the next occurrence of the particular text that you have 
previously searched for by pressing “F3.” 
 
The remaining sections cover each of the functions of the Voice Sense 
QWERTY in detail. To access these help files, press “Win key” to go to 
the “program” menu, and use “Down arrow key”repeatedly until you find 
“Help.” Then, press “Enter” on “Help.” Then, press “Enter” on the section 
that you want to read. The navigation keys are the same as in the word 
processor. For a list of the navigation keys, please see section 20.3.2. 
Remember that when you are reading the manual on the Voice Sense 
QWERTY, you can search for text in the various sections by pressing 
“Ctrl-f,” type the text you wish to find, and then press “Enter.” Also, you 
can find the next occurrence of the particular text that you have 
previously searched for by pressing “F3.” 
 
The “Miscellaneous Hot Keys” section 20.3.2, lists the various hot keys 
that are available in the Voice Sense QWERTY. To access this section, 
press “Win key” to go to the “program” menu, and use “Down arrow 
key”repeatedly until you find “Help.” Then, press “Enter” on “Help.”  
Then, press “Enter” on “Command summary.” The navigation keys are 
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the same as in the word processor. For a list of the navigation keys, 
please see section 20.3.2. Remember that when you are reading the 
manual on the Voice Sense QWERTY, you can search for text in the 
various sections by pressing “Ctrl-f,” type the text you wish to find, and 
then press “Enter.” You can find the next occurrence of the particular 
text that you have typed previously by pressing “F3.” 
 
The “Information about the Voice Sense QWERTY” section gives the 
copyright and version of the Voice Sense QWERTY, as well as the 
version of Windows CE that the Voice Sense QWERTY is using. To 
access “Information about the Voice Sense QWERTY” section, press 
“Win key” to go to the “program” menu, and use “Down arrow 
key”repeatedly until you find “Help.” Then, press “Enter” on “Help.”  
Then, press “Enter” on “Information about the Voice Sense QWERTY.” 
 
If you want to save the information about the Voice Sense QWERTY, 
press “Enter” on “Information about the Voice Sense QWERTY” of “Help” 
and press “tab”. Voice Sense QWERTY will display “Save button.” You 
press “Enter” on this button. Then Voice Sense QWERTY will display 
“Successfully saved.” and return to “Save” button.  
The saving file is named “bs-information.txt.” And this file is stored in 
“flashdisk.” 



383 
 

19. Using ActiveSync 
 
19.1 What is ActiveSync? 
 
ActiveSync is a program that allows mobile devices to connect to a 
personal computer. This program enables file transfers from a personal 
computer to a mobile device and vise versa. Also this program is able to 
synchronize the Voice Sense QWERTY with Microsoft Outlook.  
ActiveSync is not shipped with the Voice Sense QWERTY. If you would 
like to use ActiveSync, you will have to download it from the Internet on 
to your personal computer. 
 
19.2 Connecting the Voice Sense QWERTY to a PC 
 
Before connecting the Voice Sense QWERTY to your personal computer 
for the first time, make sure that the Voice Sense QWERTY is turned off. 
Once you have ActiveSync installed in XP and earlier version, you will 
need to plug a USB cable in to the USB OTG port on the right panel of 
the Voice Sense QWERTY. Then, plug the other end of the USB cable 
in to a USB port on your personal computer. Now, turn on the Voice 
Sense QWERTY. You will hear several sounds. First, on the Voice 
Sense QWERTY, you will hear chimes. Then, you will hear a “ding-
dong” sound on your computer, which lets you know the computer is 
connected properly to the Voice Sense QWERTY. You will again hear 
chimes on the Voice Sense QWERTY, and then on your computer. 
 
In Vista, You have to install Windos Mobile Device Center. Once you 
have Windows Mobile Device Center installed in PC, to executing it. You 
will need to plug a USB cable in to the USB OTG port on the right panel 
of the Voice Sense QWERTY. Then, plug the other end of the USB 
cable in to a USB port on your personal computer. 
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19.3 Setting up the Voice Sense QWERTY in the 
ActiveSync Program 
 
After you have turned on the Voice Sense QWERTY, and you have 
heard all of the sounds, a screen will come up on your computer that has 
the heading, “Set Up a Partnership.” You have a “Yes” option and a “No” 
option on this screen. If you select “Yes” on this screen, the next time 
you connect the Voice Sense QWERTY to your computer, you will be 
able to have it synchronize with Microsoft Outlook automatically. If you 
select “No,” the “Set Up a Partnership” screen will come up every time 
you connect the Voice Sense QWERTY to your computer. 
 
If you want to be able to synchronize the Voice Sense QWERTY with 
Microsoft Outlook, select “Yes,” and then press the “next” button.  Then, 
you will be asked to select a name that you want to call the mobile 
device. You can only use the following characters:  _, A-Z, or 0-9.  You 
cannot use spaces. Once you have entered an appropriate name, press 
“next.” Then, a list of functions will appear on your computer.  Each 
function has a check box located next to it. Make sure that only the 
“Contacts” check box (that corresponds with Microsoft Outlook) is 
checked. Then, press “next.” Then, the next dialog box that appears will 
say, “setup complete.” Then, press “finish.” ActiveSync will then look for 
changes, and synchronize with Microsoft Outlook. For more information 
on how to use ActiveSync or Microsoft Outlook, please visit 
www.microsoft.com. 
 
In Vista, a screen will come up on your computer that has the heading, 
“Windows Mobile Device Center”. You have a “Connect without setting 
up your device” option and a “Set up your device” option on this screen. 
If you select “Set up your device” on this screen, you will be able to have 
it synchronize with Microsoft Outlook automatically.  
 
If you want to be able to synchronize the Voice Sense QWERTY with 
Microsoft Outlook, select " Set up your device,” and then press the 
“Enter”. Then, a list of functions will appear on your computer. Each 
function has a check box located next to it. Make sure that only the 
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“Contacts” check box (that corresponds with Microsoft Outlook) is 
checked. Then, press “next.” Then, you will be asked to select a name 
that you want to call the mobile device. You can only use the following 
characters:  _, A-Z, or 0-9. You cannot use spaces. Once you have 
entered an appropriate name, press “OK” button. Windows Mobile 
Device Center will then look for changes, and synchronize with Microsoft 
Outlook. For more information on how to use ActiveSync or Microsoft 
Outlook, please visit www.microsoft.com. 
 
19.4 Transferring Files to the Voice Sense QWERTY 
Via ActiveSync 
 
In order to transfer files to the Voice Sense QWERTY from your 
computer, you will first need to find the file(s) on your PC that you want 
to transfer. Once you have found the file(s) that you want to transfer, 
make sure the files have been selected by using the “space.” After you 
have selected the file(s), press “Ctrl-c” on your PC to copy the file(s).  
Then, go to the desktop on your computer by pressing “Windows-key-d.”  
Press the letter “m” until you find “My computer.” Press “Enter” on “My 
computer.” Then, press the letter “m” until you hear “mobile device,” and 
press “Enter.” The mobile device is the Voice Sense QWERTY.  After 
you have opened “mobile device,” you will get into the file list on the 
Voice Sense QWERTY. One of the items in the list is “my computer.” 
Press the letter “m” until you hear “my computer,” and press “Enter.” 
Then, another file list will open. In this list, you will find the folder called 
“flashdisk.” This is the same “flashdisk” that you hear under “file 
manager.” Press “f” until you hear “flashdisk,” and then press “Enter.”  
You will notice that all of the folders that you find in the “flashdisk” under 
“file manager” are located here. You can paste the file(s) here directly by 
pressing “ctrl-v,” or you can paste the file(s) in to one of the folders by 
pressing enter on one of the folders, and then pressing “ctrl-v” to paste 
the file(s). 
 
In Vista, you will first need to find the file(s) on your PC that you want to 
transfer. Once you have found the file(s) that you want to transfer, make 
sure the files have been selected by using the “space.” After you have 
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selected the file(s), press “Ctrl-c” on your PC to copy the file(s).  Then, 
go to the desktop on your computer by pressing “Windows-key-d.”  
Press the letter “m” until you find “Computer.” Press “Enter” on 
“Computer.” Then, press the letter “m” until you hear “Voice Sense 
QWERTY,” and press “Enter.”After you have opened “Voice Sense 
QWERTY”, you will get into the file and folder list on the Voice Sense 
QWERTY. Then, another file and folder list will open. In this list, you will 
find the folder called “flashdisk.” This is the same “flashdisk” that you 
hear under “file manager.” Press “f” until you hear “flashdisk,” and then 
press “Enter.” You will notice that all of the folders that you find in the 
“flashdisk” under “file manager” are located here. You can paste the 
file(s) here directly by pressing “ctrl-v,” or you can paste the file(s) in to 
one of the folders by pressing enter on one of the folders, and then 
pressing “ctrl-v” to paste the file(s). 
 
If you want to copy folders from the Voice Sense QWERTY to your PC 
via ActiveSync, follow the same steps; except, you will need to copy files 
from the Voice Sense QWERTY, and paste the file(s) to your PC in the 
directory where you want to store the file(s). 
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20. Command Summary 
 
20.1 Common Combination Keys 
 
Call up the program menu: Win key 
Key help mode: Ctrl-ESC 
Run the individual program in the program menu Win key-”shortcut key” 
(varies for each program) 
Call up the Task Name list: Fn-F10 
Switch to previous program: Alt-Shift-tab 
Switch to next program: Alt-Tab 
Call up the menu in the individual program: Alt 
Exit: Alt-F4 
Escape: Esc 
Move to the next control in a dialog box: Tab 
Move to the previous control in the dialog box: Shift-tab 
Move to the previous character: Left arrow key 
Move to the next character: Right arrow key 
Move to the previous line/item: Up arrow key 
Move to the next line/item: Down arrow key 
Move to the beginning of line/item: Fn-Left arrow key 
Move to the end of line/item: Fn-Right arrow key 
Move to the top of a document or to the first item: Ctrl-Fn-Left arrow key 
Move to the bottom of a document or to the last item: Ctrl-Fn-Right arrow 
key 
Move to the previous page or to the first item of the previous 32-item 
group: Page up (Fn-Up arrow key) 
Move to the next page or to the first item of the next 32-item group:  
Page down (Fn-Down arrow key) 
Move the cursor to each cell or move to an item: The corresponding 
cursor routing key 
Capital sign: Capa lock 
Read the current item again: Fn-r 
Say current time: Fn-t  
Check power status: Fn-b 
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Call up the “Global options”: F10 
Online help: F1 
Check software version: Fn-v in the Voice Sense QWERTY “program” 
menu. 
Display Networg Status: fn-n in the Voice Sense QWERTY “program” 
menu 
 
Increase the voice volume: F6 
Decrease the voice volume: Shift-F6 
Increase the voice rate: F7 
Decrease the voice rate: Shift-F7 
Increase the voice pitch: F8 
Decrease the voice pitch: Shift-F8 
 
One-handed mode on/off: Fn-h 
Bluetooth on/off: F9 
Wireless LAN on/off: F11 
Ethernet port on/off: Fn-F11 
LCD on/off: Fn-F2 
 
Selection control information: Fn-F1 
Open txt help: Win key-F1 while executing program 
Check gyrocompass: Fn-Space 
 
Voice on/off: F5 (This function executes when the Voice Sense 
QWERTY is connected to SyncBraille.) 
Scroll voice on/off: Fn-F5 (This function executes when the Voice Sense 
QWERTY is connected to SyncBraille.) 
Select Braille cursor: Fn-F3 (This function executes when the Voice 
Sense QWERTY is connected to SyncBraille.) 
Eight dot mode on/off: Fn-F4 (This function executes when the Voice 
Sense QWERTY is connected to SyncBraille.) 
 
20.2 File Manager 
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20.2.1 Navigation keys on the file list and menu list 
 
Move to previous item: Up arrow key  
Move to next item: Down arrow key  
Move to the beginning of the list: Ctrl-Fn-Left arrow key 
Move to the end of the list: Ctrl-Fn-Right arrow key 
 
20.2.2 Navigation Keys for the File List 
 
Fast move to folder list or move to file list: Ctrl-Down arrow key 
Move between file list and address window: Tab / shift-tab 
Enter into selected folder or open the selected file: Enter 
Move to the upper level folder: Backspace 
Fast move to the top level disk: Shift-Backspace 
 
20.2.3 Item (folder or File) Selection Key 
 
Select item by item: Space 
Continuous selection: Ctrl-b 
Select all Ctrl-a 
 
20.2.4 Hot Keys for the Commands 
 
Open: Ctrl-o  
Open with: Ctrl-h 
Zip: Ctrl-z  
Unzip: Ctrl-u 
Send: Ctrl-s 
Copy: Ctrl-c 
Cut: Ctrl-x 
Paste: Ctrl-v 
Delete: DEL 
Rename: F2 
New document: Ctrl-n 
New folder: Alt-f  
File conversion: Ctrl-t 
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Select all: Ctrl-a  
Sort files by: Ctrl-g 
Set file info: Ctrl-i 
Display only files of type: Ctrl-w  
Search for file: Ctrl-f  
Information: Alt-Enter 
 
20.3 Word Processor 
 
20.3.1 Hot Keys for the Commands 
 
New document: Ctrl-n 
Open: Ctrl-o 
Save: Ctrl-s  
Save as: Alt-s 
Close current document: Ctrl-F4 
Print: Ctrl-p  
Settings: Ctrl-e  
Exit: Alt-F4 
 
Start selection: Ctrl-b 
Copy: Ctrl-c 
Cut: Ctrl-x  
Paste: Ctrl-v 
Delete: Del 
Delete blank lines: Alt-e 
Add to clipboard: Ctrl-Insert 
Clear clipboard: Ctrl-Del or Ctrl-d 
Select All: Ctrl-a  
Insert from file: Ctrl-i 
Insert date: Ctrl-w 
Toggle insert/overwrite mode: Insert 
Check spelling: Ctrl-k 
Check spelling of the current word: Alt-k 
 
Find: Ctrl-f 
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Find again: F3 
Replace: Ctrl-r  
Go to location: Ctrl-g 
Go to previous page: Page up (Fn-Up arrow key) 
Go to next page: Page down (Fn-Down arrow key) 
Set mark: Ctrl-m  
Go to mark: Ctrl-j 
Go to previous document: Shift-tab 
Go to next document: Tab 
 
Read selected text: Alt-b 
Read beginning of selected text: Ctrl-u  
Read from beginning to cursor: Alt-g 
Read from cursor to end: Fn-Enter 
Auto scroll: up-down scroll buttons (This function executes when the 
Voice Sense QWERTY is connected to SyncBraille.) 
Read status: Fn-/ 
 
Braille document layout: Alt-F5 
Print document layout: Alt-F6 
Braille paragraph layout: Alt-F7 
Print paragraph layout: Alt-F8 
 
20.3.2 Miscellaneous Hot Keys 
 
Move to previous character: Left arrow key 
Move to next character: Right arrow key 
Move to previous word: Ctrl-Left arrow key 
Move to next word: Ctrl-Right arrow key 
Move to the beginning of the line: Fn-Left arrow key 
Move to the end of the line: Fn-Right arrow key 
Move to previous line: Up arrow key 
Move to next line: Down arrow key 
Move to previous paragraph: Ctrl-Up arrow key  
Move to next paragraph: Ctrl-Down arrow key 
Move to the beginning of the document: Ctrl-fn-Left arrow key 
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Move to the end of the document: Ctrl-fn-Right arrow key 
Read current paragraph: Fn-v 
Read current line: Fn-c 
Read current word: Fn-x 
Read current character: Fn-z 
Delete current paragraph: Alt-Del 
Delete current line: Ctrl-Backspace 
Delete current word: Alt-Backspace 
Delete current character: Del 
Confirm current cursor position: Fn-s 
Set view format character: Ctrl-5 
Set reading unit: Ctrl-3 
Set read only: Ctrl-2 
Set reading mode: Ctrl-4 
 
20.4 Address Manager 
 
20.4.1 Move keys for adding an address or in the menu 
 
Move to the previous field or menu item: Left arrow key 
Move to the next field or menu item: Right arrow key 
Move to the first field or menu item: Fn-Left arrow key 
Move to the last field or menu item: Fn-Right arrow key 
 
20.4.2 Move Keys in the Search Result List 
 
Move to the previous field: Ctrl-Left arrow key 
Move to the next field: Ctrl-Right arrow key 
Move to the first field: Fn-Left arrow key 
Move to the last field: Fn-Right arrow ey 
Move to the previous record: Up arrow key 
Move to the next record: Down arrow key 
Move to the first record: Ctrl-Fn-Left arrow key 
Move to the last record: Ctrl-Fn-Right arrow key 
Move to previous same field different record: Left arrow key 
Move to next same field different record: Right arrow key 
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20.4.3 Hot keys for the Commands 
 
Add address: Ctrl-n 
Find address: Ctrl-f 
Modify address: Ctrl-m 
Delete address: Del 
Select all: Ctrl-a 
Save as a file: Alt-s  
Print address: Ctrl-p 
Backup address list: Ctrl-u 
Restore address list: Ctrl-r 
Setting backup option: Ctrl-e 
Setting add/searching address fields: Ctrl-o 
Import from CSV: Alt-i 
Export to CSV: Alt-x 
 
20.4.4 Miscellaneous Hot Keys 
 
Cancel: ESC  
Exit: Alt-F4 
 
20.5 Schedule Manager 
 
20.5.1 Hot keys for the commands 
 
Move to the next field: Tab  
Move to the previous field: Shift-tab  
Add schedule: Ctrl-nn 
Modify schedule: Ctrl-m 
Delete schedule: Del 
Alarm option: Ctrl-o  
Backup schedule: Ctrl-u 
Restore schedule: Ctrl-r 
Set backup option: Ctrl-e 



394 
 

Save schedule as file: Alt-s 
Print schedule: Ctrl-p 
 
20.5.2 Move Keys in the Search Result List 
 
1. Move from an appointment to another in the schedule list 
Move to the previous a in the same day: Up arrow key 
Move to the next appointment in the same day: Down arrow key 
Move to the first appointment in the same day: Fn-Left arrow key 
Move to the last appointment in the same day: Fn-Right arrow key 
2. Move from one appointment to another in all the appointments 

registered 
Move to the previous schedule: Ctrl-Left arrow key 
Move to the next schedule: Ctrl-Right arrow key 
Move to the first schedule: Ctrl-Fn-Left arrow key 
Move to the last schedule: Ctrl-Fn-Right arrow key 
 
20.6 E-mail 
 
20.6.1 Hot keys that are used in the inbox 
 
Call “Accounts manager”: Ctrl-m  
Check for new mail: Alt-m 
Write new message: Ctrl-n 
Reply: Ctrl-r 
Reply all: Alt-r 
Forward: Ctrl-f 
Call up “set path”: Ctrl-p 
Call up “set option”: Ctrl-o 
Call up “set spam”: Ctrl-e 
Find: Ctrl-f 
Find again: F3 
Move to unread message: Ctrl-u 
Move to mailbox: Alt-x 
Copy to mailbox: Alt-c 
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Add a sender to the address list: Ctrl-i (This is valid only at the “from” 
item of the “inbox”). 
Delete received e-mail: Del (It is valid only at the “Subject” and “date” 
item in the “inbox”). 
Save the received e-mail as text file: Alt-s 
Print the received e-mail: Alt-p 
Cancel: ESC 
Cancel and exit from e-mail program: Alt-F4 
 
20.6.2 Hot keys for Sending E-Mail Including Reply, 
Forward, and Save in the Mail Outbox 
 
Search address list: Ctrl-l 
Attach file: Ctrl-f 
Send e-mail: Ctrl-s 
Save in mail Outbox: Fn-s 
Cancel: ESC 
Cancel and exit from e-mail program: Alt-F4 
 
20.6.3 Hot Keys for Reading E-Mails or Writing an E-Mail 
Message 
 
Start selection: Ctrl-b 
Select all: Ctrl-a  
Copy to the clipboard: Ctrl-c  
Cut to the clipboard: Ctrl-x (It is not valid when you are reading e-mail in 
the “inbox”). 
Paste from the clipboard: Ctrl-v (It is not valid when you are reading e-
mail in the “inbox”). 
Delete: Del (It is not valid when you are reading e-mail in the “inbox”). 
Cancel block: ESC 
 
20.7 Media Player 
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20.7.1 Hot keys for commands 
 
Open file: Ctrl-o 
Open folder: Ctrl-f 
Add file: Alt-o 
Add folder: Alt-f 
Save play list: Ctrl-s 
Save as play list: Alt-s 
Delete item: Del 
Open URL: Ctrl-l 

 
Play: X or Enter, Play button 
Previous track: Z or Alt-Left arrow key, Previous button 
Next track: Alt-Right arrow key, Next button 
Previous section while playing Audible: Ctrl-Page up (Ctrl-Fn-Up arrow 
key) 
Next section while playing Audible: Ctrl-Page down (Ctrl-Fn-Down arrow 
key)  
Back 5 track: Alt-Up arrow key 
Forward 5 track: Alt-Down arrow key 
First track: Ctrl-Fn-Left arrow key 
Last track: Ctrl-Fn-Right arrow key 
Volume up: Shift-Up arrow key 
Volume down: Shift-Down arrow key  
Speed up: Shift-Right arrow key 
Slow down: Shift-Left arrow key 
Pause/continue: Space, Play button 
Stop: Backspace, Stop button 
Change time index: Ctrl-Up arrow key or Ctrl-Down arrow key 
Move to next position by time index and play: Ctrl-Right arrow key 
Move to previous position by time index and play: Ctrl-Left arrow key 
Delete play list during stop: Del 
 
Call up the record dialog box: Ctrl-r, Record button 
Record: Record button 
Pause/Continue recording: Space, Record button 
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Play: Play button 
Pause/Continue play: Space, Play button 
Stop: Backspace, Stop button 
Set bookmark: Ctrl-m  
Delete bookmark: Ctrl-d 
Jump to bookmark: Ctrl-j 
Go to position: Ctrl-g 
Go to percent: Alt-p 
Set start/end point: p 
Release point: ESC 
Set mark: Alt-m 
Move to mark: Alt-j 
Move to previous mark: V 
Move to next mark: N 
Delete mark: Alt-d 
Mark manager: Alt-k 
 
Configuration dialog box: Alt-c 
Playback setting dialog box: Ctrl-p 
Record setting dialog box: Alt-r 
Effect setting dialog box: Ctrl-e 
 
20.7.2 Hot Keys in the Play Information Tab 
 
Move to the next information: Down arrow 
Move to the previous information: Up arrow 
“Pause” when it is play state and “play” when it is pause state: Space 
Start playing: Enter 
Stop playing: Backspace 
Play the next file: Alt-right arrow 
Play the previous file: Alt-Left arrow key 
Play the last file: Ctrl-Fn-Left arrow key 
Play the first file: Ctrl-Fn-Right arrow key 
Play the fifth file after the current file: Alt-Down arrow key 
Play the fifth file before the current file: Alt-Up arrow key 
Volume up: Shift-Up arrow key 
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Volume down: Shift-Right arrow key 
Speed up: Shift-Left arrow key 
Slow down: Shift-Right arrow key  
Change time index: Ctrl-Up arrow key or Ctrl-Down arrow key 
Move to next position by time index and play: Ctrl-Right arrow key 
Move to previous position by time index and play: Ctrl-Left arrow key 
Open menu: Alt 
Open help: F1 
Move to “play list” tab: Tab/Shift-tab 
Exit “media player”: Alt-F4 
 
20.7.3 Hot Keys in the Play List Tab 
 
Move to the next file: Down arrow key 
Move to the previous file: Up arrow key 
Move to the last file: Fn-Right arrow key  
Move to the first file: Fn-Left arrow key 
Select/resume current file (while playing, it is used as play/pause):  
Space 
Start selecting files: Ctrl-b 
Start playing the selected files: Enter 
Stop playing: Backspace 
Delete the selected files in the play list: Del 
Play the next file: Alt-Right arrow key 
Play the previous file: Alt-Left arrow key  
Play the last file: Ctrl-Fn-Right arrow key 
Play the first file: Ctrl-Fn-Left arrow key 
Play the fifth file after the current file: Ctrl-Down arrow key 
Play the fifth file before the current file: Ctrl-Up arrow key 
Volume up: Shift-Up arrow key 
Volume down: Shift-Down arrow key 
Speed up: Shift-Left arrow key 
Slow down: Shift-Right arrow key 
Change time index: Ctrl-Up arrow key 
Move to next position by time index and play: Ctrl-Right arrow key 
Move to previous position by time index and play: Ctrl-Left arrow key 
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Open menu: Alt 
Open help: F1 
Move to “playback information” tab: Tab/Shift-tab 
Exit “media player”: Alt-F4 
 
20.8 FM radio 
 
Call up the sets dialog box: Ctrl-e 
Call up the menu: Alt 
Internal speakers on/off: X or Fn-x 
Move to next frequency: Ctrl-Up arrow key 
Move to previous frequency: Ctrl-Down arrow key 
Auto previous frequency: Ctrl-Left arrow key or short press pevious 
button 
Auto next frequency: Ctrl-Right arrow key or short press next button 
Go to frequency: Ctrl-f 
Move to previous preset: Alt-Left arrow key or long press previous button 
Move to next preset: Alt-Right arrow key or long press next button 
Registry preset: Ctrl-s or long press record button 
Delete the preset: long press stop button 
Call up the record dialog box: Ctrl-r 
Record start/pause: short press record button 
Record stop: short press stop button 
Mute on: short press stop button or Space 
Muto off: short press play button or Space 
Volume up: Shift-Up arrow key 
Volume down: Shift-Down arrow key 
 
20.9 Web Browser 
 
20.9.1 Hot keys for the command 
 
Open URL: Ctrl-l 
Open: Ctrl-o 
Save as: Alt-s 



400 
 

Information: Alt-Enter 
Exit: Alt-F4 
 
Read from beginning to cursor: Alt-g 
Read from cursor to end: Fn-Enter  
Auto scroll: Up scroll button-down scroll button (This function executes 
when the Voice Sense QWERTY is connected to SyncBraille.) 
 
Start selection: Ctrl-b 
Copy: Ctrl-c  
Add to clipboard: Ctrl-Insert 
Copy URL: Alt-d 
Copy link: Alt-l 
 
Go to the home page: Alt-h 
Go to the previous page: Alt-Left arrow key 
Go to the next page: Alt-Right arrow key 
Go to previous heading: Alt-b or Ctrl-F3  
Go to next heading: Alt-f or Ctrl-F4 
Go to previous text: Ctrl-F5 
Go to next text: Ctrl-F6 
Refresh: Ctrl-r 
Open the history list: Ctrl-h  
Check the address of the selected title in the history list: Fn-i  
Find: Ctrl-f  
Find again: F3  
Links list: Alt-i 
 
Set current as your home page: Ctrl-s  
Add to favorites: Alt-a  
Favorites list: Ctrl-l 
 
Options setting: Alt-o  
Clear Cookies: Ctrl-d 
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20.9.2 Hot Keys When Playing Audio Files in web browser 
 
Turn up the volume: Shift-Up arrow key 
Turn down the volume: Shift-Down arrow key 
Play: play button of the front panel 
Stop: stop button of the front panel 
 
20.9.3 Hot Keys for Reading Web Pages 
 
Move between controls 
Move to the previous control: Shift-tab  
Move to the next control: Tab 
Select the next item in the combo box (list box): Alt-Down arrow key 
Select the previous item in the combo box (list box): Alt-Up arrow key 
 
Moving to the form 
Move to the previous form: Ctrl-F1 
Move to the next form: Ctrl-F2 
 
Table navigation hot keys 
Move to the previous table: Ctrl-F7 
Move to the next table: Ctrl-F8 
Move to the previous cell: Ctrl-Shift-Left arrow key 
Move to the next cell: Ctrl-Shift-Right arrow key 
Move to the upper cell: Ctrl-Shift-Up arrow key 
Move to the lower cell: Ctrl-Shift-Down arrow key 
Read current cell: Ctrl-Shift-c 
Move to the previous cell of the upper level table: Ctrl-Left arrow key 
Move to the next cell of the upper level table: Ctrl-Right arrow key 
Move to the upper cell of the upper level table: Ctrl-Up arrow key 
Move to the lower cell of the upper level table: Ctrl-Down arrow key 
Check the current position: Fn-s 
 
Move to frame 
Move to the previous frame: Ctrl-F9 
Move to the next frame: Ctrl-F10 



402 
 

Read the current line: Fn-r 
 
 
20.10 Daisy Player 
 
Move to the title list: Shift-Backspace 
Open DAISY file: Ctrl-o 
Voice setting: Ctrl-s 
Check the book-info: Alt-Enter 
Exit:  Alt-F4 
Play/Pause: Space 
Move to the beginning of document: Fn-Left arrow key 
Move to the last phrase: Fn-Right arrow key 
Increase the speed: Shift-Right arrow key 
Decrease the speed: Shift-Left arrow key 
Increase the volume: Shift-Up arrow key 
Decrease the volume: Shift-Down arrow key 
Move to the next phrase: Right arrow key or short press “next” button 
Move to the previous phrase: Left arrow key or short press “previous” 
button 
Move to the next fifth phrase: Ctrl-Down arrow key 
Move to the previous fifth phrase: Ctrl-Up arrow key 
Move to the next page: Page down (Fn-Up arrow key) 
Move to the previous page: Page up (Fn-Down arrow key) 
Go to the page: Ctrl-g 
Move up: Alt-Left arrow key 
Move down: Alt-Right arrow key 
Set to prior level: Alt-Up arrow key 
Set to next level: Alt-Down arrow key 
Move to the next heading: Ctrl-F6 or long press “next” button 
Move to the previous heading: Ctrl-F5 or long press “previous” button 
Move to the last heading: Ctrl-F8 
Move to the first heading: Ctrl-F7 
Check the currently-reading level and heading: Ctrl-w 
Scan the heading list from the present to the end: Ctrl-n  
Find heading: Ctrl-f 
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Move to Specific Heading: Ctrl-h 
Find again: F3  
Scan heading: Ctrl-n 
Read heading: Ctrl-w  
Set mark at current position: Ctrl-m 
Move to the next mark: N 
Move to the previous mark: V 
Delete mark: Del 
 
20.11 Bluetooth Manager 
 
Scanning Bluetooth device: Ctrl-r 
Connecting device: Enter on the device name 
Connecting service: Enter on the service name 
Disconnect service in Bluetooth service list: Ctrl-d  
Move to Bluetooth device list in service list: Backspace 
Remove device setting in Bluetooth device list: Del  
 
1) FTP service 
Open local folder/move remote folder: Ctrl-o  
Copy: Ctrl-c 
Paste: Ctrl-v  
Send to: Ctrl-s 
Retrieve file: Ctrl-r 
New folder: Ctrl-f (in “Remote folder”)/ Alt-f (in “Local folder”) 
Delete file/folder: Del 
Information: Ctrl-i 
 
20.12 MSN messenger 
 
1. Log-in dialog box 
Move to the next control: Tab 
Move to the previous control: Shift-tab  
Check or uncheck a check box: Space 

 
2. The contact list box 
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Move to the previous item: Up arrow key 
Move to the next item: Down arrow key 
Move between online and offline groups: Ctrl-Down arrow key 
Open the menu: Alt 
Logout: Ctrl-n  
View chat: Ctrl-r 
My status: Ctrl-m  
Close: Ctrl-z 
Add contact: Ctrl-a  
Delete contact: Ctrl-d 
Contact information: Ctrl-v 
Send instant message: Ctrl-s  
Last message: Alt-r 
Play keyboard sound: Ctrl-k 
Message sound notification while in current window: Alt-s  
Message sound notification while messenger is in the background: Alt-m  
Nickname: Ctrl-p 
Save account: Ctrl-o  
Confirm the received message: Ctrl-l 

 
3. Instant message dialog box 
Move to the next control: Tab  
Move to the previous control: Shift-Tab  
Move between the instant message dialog box and the contact  list box: 
Page up or Page down 
Save as: Alt-s 
Print: Ctrl-p 
Close: ESC 
Cut: Ctrl-x  
Copy: Ctrl-c  
Delete: Ctrl-d 
Paste: Ctrl-v  
Select all: Ctrl-a 
Start selection: Ctrl-b 
Find: Ctrl-f 
Find again: F3  
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Invitation: Ctrl-i 
 
20.13 Database Manager 
 
Add record: Ctrl-n 
Search records: Ctrl-f 
Table manager: Ctrl-t 
List of records found: Ctrl-r  
Setting backup option: Ctrl-e  
Backup database: Ctrl-u  
Restore database: Ctrl-o 
 
1. Move by controls 

Move to the next control: Tab  
Move to the previous control: Shift-Tab  

2. Move in a list box 
Move to the next list item: Down arrow key 
Move to the previous list item: Up arrow key 

3. Select your answer in the prompt box 
Move to the next answer: Space or Down arrow key 
Move to the previous answer: Backspace or Up arrow key 

4. Move in the “list of records found” 
Move to the next record: Down arrow key 
Move to the previous record: Up arrow key 
Move to the last record: Ctrl-Fn-Right arrow key 
Move to the first record: Ctrl-Fn-Left arrow key 
Move to the next field: Ctrl-Right arrow key 
Move to the previous field: Ctrl-Left arrow key 
Move to the last field: Fn-Right arrow key  
Move to the first field: Fn-Left arrow key 
Move to previous same field different record: Left arrow key 
Move to next same field different record: Right arrow key 

 
20.14 Utilities 
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20.14.1 Calculator 
 
Calculator clear: Alt-c 
Delete numbers or operators: Backspace 
 
General function: Ctrl-g 
Plus: + 
Minus: - 
Division: / 
Multiplication: * 
Percent: % 
Power: ^ 
Square Root: Ctrl-q 
Decimal Point: . 
Left Parenthesis: ( 
Right Parenthesis: ) 
PI: Ctrl-p  
Exp: Ctrl-e 
 
Recall Items: Alt-r 
Delete all saved items: Ctrl-d  
Save Items: Alt-s  
 
Trigonometric Function: Ctrl-s  
Sine: Ctrl-s, s  
Arc Sine: Ctrl-s, a 
Hyperbolic Sine: Ctrl-s, h  
Cosine: Ctrl-c, c 
Arc Cosine: Ctrl-c, a  
Hyperbolic Cosine: Ctrl-c, h  
Tangent: Ctrl-t, t 
Arc Tangent: Ctrl-t, a 
Hyperbolic Tangent: Ctrl-t, h  
 
Logarithm Function: Ctrl-l  
Natural Logarithm: Ctrl-l, e  
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Common Logarithm: Ctrl-l, n  
 
Copy to Clipboard: Ctrl-Insert 
 
Option Setting: Ctrl-o  
 
20.14.2 Setting Date and Time 
 
Move to the next day: Right arrow key 
Move to the previous day: Left arrow key 
Move to the next week: Ctrl-Right arrow key 
Move to the previous week: Ctrl-Left arrow key 
Move to the next month: Down arrow key 
Move to the previous month: Left arrow key 
Move to the next year: Ctrl-Down arrow key 
Move to the previous year: Ctrl-Up arrow key 
Move to 1 hour after: Down arrow key 
Move to 1 hour before: Up arrow key 
Move to 10 minutes after: Ctrl-Right arrow key 
Move to 10 minutes before: Ctrl-Left arrow key 
Move to 1 minute after: Right arrow key 
Move to 1 minute before: Left arrow key 
Switch Between a.m. and p.m.: Fn-x 
 
20.14.3 Checking Date and Time 
 
Checking date and time: Fn-t 
 
20.14.4 Calendar 
 
Move to the previous item: Tab  
Move to the next item: Shift-tab  
 
Move to the next day: Right arrow key 
Move to the previous day: Left arrow key 
Move to the next week: Ctrl-Right arrow key 
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Move to the previous week: Ctrl-Left arrow key 
Move to the next month: Down arrow key 
Move to the previous month: Up arrow key 
Move to the next year: Ctrl-Down arrow key 
Move to the previous year: Ctrl-Up arrow key 
 
20.14.5 Pronunciation dictionary 
 
Move to the previous control: Tab 
Move to the next control: Shift-tab  
Move to the previous item in entry: Up arrow key 
Move to the next item in entry: Down arrow key 
Add word: Alt-i  
Modify word: Alt-m  
Delete word: Del 
 
20.14.6 Stopwatch 
 
Stopwatch start, pause, restart: enter 
Check the elapsed time: Backspace 
Switch between stopwatch and count down timer: “tab”or “shift-tab” 
Count down timer pause or restart: enter 
Count down timer Clear: Backspace 
Exit stopwatch or count down timer: Alt-F4 
 
20.14.7 Display Networg Status 
 
Display Networg Status: Fn-n 
 
20.14.8 Check Power Status 
 
Check power status: Fn-b 
 
20.14.9 Backup/Restore Personalized settings 
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Move to previous item: Up arrow key 
Move to next item: Down arrow key 
Move to previous control: Shift-tab  
Move to next control: Tab  
Select/unselect check box: Space 
 
20.14.10 Format 
 
Disk format: Fn-f 
 
20.14.11 Upgrading the Voice Sense QWERTY OS 
 
Check download information: Space 
Cancel download and exit: Alt-F4 
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21. Command Summary for USB Keyboards 
 
21.1 Common Combination Keys 
 
Call up the program menu: Win key 
Call up the Task Name list: Ctrl-Shift-F10 
Call up the menu in the individual program: Alt  
Run the individual program in the program menu: Win key-”shortcut key” 
(varies for each program) 
Switch to previous program: Alt-shift-tab 
Switch to next program: Alt-tab 
Exit: Alt-F4 
Escape: ESC key 
Move to the next control in a dialog box: Tab 
Move to the previous control in the dialog box: Shift-tab 
Move to the previous character: Left arrow key 
Move to the next character: Right arrow key 
Move to the previous line item: Up arrow key 
Move to the next line item: Down arrow key 
Move to the beginning of line item: Home key 
Move to the end of line item: End key 
Move to the top of a document or to the first item: Ctrl-home  
Move to the bottom of a document or to the last item: Ctrl-end  
Move to the previous page or to the first item of the previous 32-item 
group: Page up 
Move to the next page or to the first item of the next 32-item group:  
Page down 
Read the current item again: Ctrl-shift-r 
Say current time: Ctrl-shift-t 
Check power status: Ctrl-shift-b 
Print spool: Alt-shift-p 
Call up the “Global options”: F10 
Online help: F1 
Check your version: Ctrl-shift-v in the Voice Sense QWERTY “program” 
menu. 
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Display Networg Status: Ctrl-shift-n in the Voice Sense QWERTY 
“program” menu 
Voice volume up: F6 
Voice volume down: Shift-F6 
Voice rate up: F8 
Voice rate down: Shift-F8 
Voice pitch up: F7 
Voice pitch down: Shift-F7 
Voice on/off: F5 
Set sleep timer: Fn-j 
Check gyrocompass: Fn-Space 
 
21.2 File Manager 
 
21.2.1 Navigation keys on the file list and menu list 
 
Move to previous item: Up arrow key 
Move to next item: Down arrow key 
Move to the beginning of the list: Ctrl-home 
Move to the end of the list: Ctrl-end 
 
21.2.2 Navigation Keys in the File List 
 
Fast move to folder list or move to file list: Ctrl-Down arrow key 
Move between file list and address window: Tab / shift-tab 
Enter into selected folder or open the selected file: Enter 
Move to the upper level folder: Backspace 
Fast move to the top level disk: Shift-Backspace 
 
21.2.3 Item (Folder or File) Selection Keys 
 
Select item by item: Space 
Continuous selection: Ctrl-b 
Select all: Ctrl-a 
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21.2.4 Hot Keys for the Commands 
 
Open: Ctrl-o 
Open with: Ctrl-h 
Zip: Ctrl-z 
Unzip: Ctrl-u 
Send: Ctrl-s 
Copy: Ctrl-c 
Cut: Ctrl-x 
Paste: Ctrl-v 
Delete: DEL 
Rename: F2 
New document: Ctrl-n 
New folder: Alt-f 
File conversion: Ctrl-t 
Select all: Ctrl-a 
Sort files by: Ctrl-g  
Set file info: Ctrl-i 
Display only files of type: Ctrl-w 
Search file: Ctrl-f 
Information: Alt-Enter 
 
21.3 Word Processor 
 
21.3.1 Hot keys for the command 
 
New document: Ctrl-n 
Open: Ctrl-o 
Save: Ctrl-s 
Save as: Alt-s 
Close current document: Ctrl-F4 
Print: Ctrl-p 
Settings: Ctrl-e 
Exit: Alt-f4 
Start selection: Ctrl-b 
Copy: Ctrl-c  
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Add to the clipboard: Ctrl-Insert 
Clear clipboard: Ctrl-Del 
Delete: Del  
Cut: Ctrl-x 
Paste: Ctrl-v 
Delete blank lines: Alt-e 
Select All: Ctrl-a 
Insert from file: Ctrl-i  
Insert date: Ctrl-w 
Change insert/overwrite mode: Insert 
Check spelling: Ctrl-k 
Check spelling of the current word: Alt-k 
 
Find: Ctrl-f 
Find again: F3 (No use Ctrl-f) 
Replace: Ctrl-r 
Go to location: Ctrl-g 
Go to previous page: Page up key 
Go to next page: Page down key 
Set bookmark: Ctrl-m 
Go to bookmark: Ctrl-j 
Go to previous document: Shift-tab 
Go to next document: tab 
  
Read selected text: Alt-b 
Read beginning of selected text: Ctrl-u 
Read from beginning to cursor: Alt-g 
Read from cursor to end: Ctrl-Shift-enter 
Auto scroll: Ctrl-shift-a (This function executes when the Voice Sense 
QWERTY is connected to SyncBraille.) 
Read status: Ctrl-shift-/ 
Braille document layout: Alt-F5 
Print document layout: Alt-F6 
Braille paragraph layout: Alt-F7 
Print paragraph layout: Alt-F8 
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21.3.2 Miscellaneous Hot Keys 
 
Move to previous character: Left arrow key 
Move to next character: Right arrow key 
Move to previous word: Ctrl-Left arrow 
Move to next word: Ctrl-Right arrow 
Move to the beginning of the line: Home key 
Move to the end of the line: End key 
Move to previous line: Up arrow key 
Move to next line: Down arrow key 
Move to previous paragraph: Ctrl-Up arrow key 
Move to next paragraph: Ctrl-Down arrow key 
Move to the beginning of the document: Ctrl-home 
Move to the end of the document: Ctrl-end 
 
Read current paragraph: Ctrl-shift-v 
Read current line: Ctrl-shift-c 
Read current word: Ctrl-shift-x 
Read current character: Ctrl-shift-z 
 
Delete current paragraph: Alt-Del 
Delete current line: Ctrl-Backspace 
Delete current word: Alt-Backspace 
Delete current character: DEL 
 
Confirm current cursor position: Ctrl-shift-s 
Set view format character: Ctrl-5 
Set reading unit: Ctrl-3 
Set read only: Ctrl-2 
 
21.4 Address Manager 
 
21.4.1 Move keys for moving from field to field in the 
record or in the menu 
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Move to the previous field or menu item: Left arrow key 
Move to the next field or menu item: Right arrow key 
Move to the first field or menu item: Home 
Move to the last field or menu item: End 
 
21.4.2 Move Keys for Moving from Record to Record 
  
Move to the previous record: Up arrow key 
Move to the next record: Down arrow key 
Move to the first record: Ctrl-Home 
Move to the last record: Ctrl-End 
 
21.4.3 Hot Keys for the Commands 
 
Add address: Ctrl-n 
Find address: Ctrl-f 
Modify address: Ctrl-m 
Delete address: DEL 
Select all: Ctrl-a 
Save as a file: Alt-s 
Print address: Ctrl-p 
Backup address list: Ctrl-u 
Restore address list: Ctrl-r 
Backup option: Ctrl-e  
 
21.4.4 Miscellaneous Hot Keys 
 
Cancel: ESC 
Exit: Alt-f4 
 
21.5 Schedule Manager 
 
21.5.1 Hot keys for the commands 
 
Move to the next field: Tab 
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Move to the previous field: Shift tab 
Add schedule: Ctrl-n 
Modify schedule: Ctrl-m 
Delete schedule: DEL 
Alarm option: Ctrl-o 
Save schedule as file: Alt-s 
Print schedule: Ctrl-shift-p 
Backup schedule list: Ctrl-u 
Restore schedule list: Ctrl-r 
Backup option: Ctrl-e  
 
21.5.2 Movement Keys for the Search Result List 
 
1. Move from an appointment to another in the schedule list 
Move to the previous appointment in the same day: Up arrow key 
Move to the next appointment in the same day: Down arrow key 
Move to the first appointment in the same day: Home 
Move to the last appointment in the same day: End 
2. Move from one appointment to another in all the appointments 

registered 
Move to the previous schedule: Ctrl-Left arrow key 
Move to the next schedule: Ctrl-Right arrow key 
Move to the first schedule: Ctrl-Home 
Move to the last schedule: Ctrl-End 
 
21.6 E-mail 
 
21.6.1 Hot keys for reading e-mails 
 
Call “Accounts manager”: Ctrl-m 
Check for new mail: Alt-m 
Write new message: Ctrl-n 
Reply: Ctrl-r 
Reply all: Alt-r 
Forward: Ctrl-f 
Call up “set path”: Ctrl-p 
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Call up “set option”: Ctrl-o 
Call up “set spam”: Ctrl-e 
Find: Ctrl-shift-f 
Find again: f3  
Move to mailbox: Alt-x 
Copy to mailbox: Alt-c 
Add a sender to the address list: Ctrl-i (This is valid only at the “from” 
item). 
Delete received e-mail: DEL (It is valid only at the “Subject” and “date” 
item). 
Save the received e-mail as text file: Alt-s 
Print the received e-mail: Alt-p 
Move to unread message: Ctrl-u (It is valid only at the “Subject” and 
“date” item) 
Cancel: ESC 
Cancel and exit from e-mail program: Alt-f4 
 
21.6.2 Hot Keys for Sending E-mail Including Reply, 
Forward, and Save in the Pail Outbox 
 
Search address list: Ctrl-l 
Attach file: Ctrl-f 
Send e-mail: Ctrl-s 
Save in mail Outbox: Fn-s 
Cancel: ESC 
Cancel and exit from e-mail program: Alt-f4 
 
21.6.3 Hot Keys for Reading E-mail messages or Writing an 
E-mail Message 
  
Start selection: Ctrl-b 
Select all: Ctrl-a 
Copy to the clipboard: Ctrl-c 
Cut to the clipboard: Ctrl-x (It is not valid when you are reading e-mail). 
Paste from the clipboard: Ctrl-v (It is not valid when you are reading e-
mail). 
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Delete selection and delete a letter: DEL (It is not valid when you are 
reading e-mail). 
Cancel block: ESC 
 
21.7 Media Player 
 
21.7.1 Hot keys for commands 
 
Open file: Ctrl-o 
Open folder: Ctrl-f 
Add file: Alt-o 
Add folder: Alt-f 
Save play list: Ctrl-s 
Save as play list: Alt-s 
Delete time: DEL 
 
Play: Enter 
Previous track: Alt-Left arrow key 
Next track: Alt-Right arrow key 
Previous section while playing Audible: Ctrl-Page up 
Next section while Playing Audible: Ctrl-Page down 
5th previous track: Alt-Up arrow key 
5th next track: Alt-Down arrow key 
First track: Ctrl-home key 
Last track: Ctrl-end key 
Move to backward by time index and play: Ctrl-Right arrow key  
Move to forward by time index and play: Ctrl-Left arrow key 
Change time index: Ctrl-Up arrow key or Ctrl-Down arrow key 
Volume up: Shift-Up arrow key 
Volume down: Shift-Down arrow key 
Speed up: Shift-Right arrow key 
Slow down: Shift-Left arrow key 
Pause/Continue: Space 
Stop: Backspace 
Delete play list during stop: DEL 
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Record: Ctrl-r 
Play: Enter 
Stop: Backspace 
Pause/Continue recording: Space 
 
Configuration dialog box: Alt-c 
Set bookmark: Alt-m 
Delete bookmark: Alt-d 
Jump to bookmark: Alt-j 
Go to position: Ctrl-g 
 
Playback setting dialog box: Ctrl-p 
Record setting dialog box: Alt-r 
 
21.7.2 Hot Keys in the Play Information Tab 
 
Move to the next information: Down arrow key 
Move to the previous information: Up arrow key 
Pause/Play when it is pause state: Space 
Start playing: Enter 
Stop playing: Backspace 
Play the next file: Alt-Right arrow key 
Play the previous file: Alt-Left arrow key 
Play the last file: Ctrl-end key 
Play the first file: Ctrl-home key 
Play the fifth file after the current file: Alt-Down arrow key 
Play the fifth file before the current file: Alt-Up arrow key 
Move to backward by time index and play: Ctrl-Left arrow key 
Move to forward by time index and play: Ctrl-Right arrow key 
Change time index: Ctrl-Up arrow key or Ctrl-Down arrow key 
Volume up: Shift-Up arrow key 
Volume down: Shift-Down arrow key 
Speed up: Shift-Left arrow key 
Slow down: Shift-Right arrow key 
Open menu: Alt 
Open help: F1  
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Move to “play list” tab: Tab/Shift-tab 
Exit “media player”: Alt-F4  
 
21.7.3 Hot Keys in the Play List Tab 
 
Move to the next file: Down arrow key 
Move to the previous file: Up arrow key 
Move to the last file: End key 
Move to the first file: Home key 
Select resume current file (while playing, it is used as plays/pause):  
Space 
Start selecting files: Ctrl-b 
Start playing the selected files: Enter 
Stop playing: Backspace 
Delete the selected files in the play list: DEL 
Play the next file: Alt-Right arrow key 
Play the previous file: Alt-Left arrow key 
Play the last file: Ctrl-end key 
Play the first file: Ctrl-home key  
Play the fifth file after the current file: Ctrl-Down arrow key 
Play the fifth file before the current file: Ctrl-Up arrow key 
Move to backward by time index and play: Ctrl-Left arrow key 
Move to forward by time index and play: Ctrl-Right arrow key 
Change time index: Ctrl-Up arrow key or Ctrl-Down arrow key 
Volume up: Shift-Up arrow key 
Volume down: Shift-Down arrow key 
Speed up: Shift-Left arrow key 
Slow down: Shift-Right arrow key 
Open menu: Alt 
Open help: F1 
 
Move to “playback information” tab: Tab/shift-tab 
Exit “media player”: Alt-f4  
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21.8 FM radio 
 
Call up the sets dialog box: Ctrl-e 
Call up the menu: Alt 
Internal speakers on/off: Ctrl-shift-x 
Move to next frequency: Ctrl-Down arrow key 
Move to previous frequency: Ctrl-Up arrow key 
Auto previous frequency: Ctrl-Left arrow key 
Auto next frequency: Ctrl-Right arrow key 
Go to frequency: Ctrl-shift-f 
Move to previous preset: Alt-Left arrow key 
Move to next preset: Alt-Right arrow key 
Registry preset: Ctrl-s  
Call up the record dialog box: Ctrl-r 
Mute on/off: Space 
Volume up: Shift-Up arrow key 
Volume down: Shift-Down arrow key 
 
21.9 Web Browser 
 
21.9.1 Hot keys for the command 
 
Open URL: Ctrl-l  
Open: Ctrl-o  
Save as: Alt-s 
Page information: Alt-Enter 
Exit: Alt-f4  
 
Read from beginning to cursor: Alt-g 
Read from cursor to end: Ctrl-Shift-Enter 
Auto scroll: Up-down scroll buttons (This function executes when the 
Voice Sense QWERTY is connected to SyncBraille.) 
 
Copy selection: Ctrl-b 
Copy: Ctrl-c 
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Add clipboard: Ctrl-Insert 
Copy URL: Alt-d  
Copy link address: Alt-l 
 
Go to the home page: Alt-h 
Go to the previous page: Alt-Left arrow key 
Go to the next page: Alt-Right arrow key 
Go to previous text: Ctrl-F5 
Go to next text: Ctrl-F6 
Go to previous heading: Alt-b or Ctrl-F3 
Go to next heading: Alt-f or Ctrl-F4 
Refresh: Ctrl-r 
Open the history list: Ctrl-h 
Check the address of the selected title in the history list: Ctrl-shift-i  
Find: Ctrl-f 
Find again: F3 
Links list: Alt-i 
 
Register as your home page: Ctrl-s 
Add to favorites: Alt-a 
Favorites list: Ctrl-l 
 
21.9.2 Hot Keys When Playing Audio Files in web browser 
 
Turn up the volume: Shift-Up arrow key 
Turn down the volume: Shift-Down arrow key 
 
21.9.3 Hot Keys for Reading Web Pages 
 
Move to the previous control: Shift-tab 
Move to the next control: Tab 
Select the next item in the combo box (list box): Alt-Down arrow key 
Select the previous item in the combo box (list box): Alt-Up arrow key 
 
Move to the previous form: Ctrl-F1 
Move to the next form: Ctrl-F2 
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Move to the previous table: Ctrl-F7 
Move to the next table: Ctrl-F8 
Move to the previous cell: Ctrl-shift-Left arrow key 
Move to the next cell: Ctrl-shift-Right arrow key 
Move to the upper cell: Ctrl-shift-Up arrow key 
Move to the lower cell: Ctrl-shift-Down arrow key 
Read current cell: Ctrl-shift-c 
Move to the previous cell of the upper level table: Ctrl-Left arrow key 
Move to the next cell of the upper level table: Ctrl-Right arrow key 
Move to the upper cell of the upper level table: Ctrl-Up arrow key 
Move to the lower cell of the upper level table: Ctrl-Down arrow key 
Check the current position: Ctrl-shift-s 
 
Move to the previous frame: Ctrl-F9  
Move to the next frame: Ctrl-F10 
 
Read the current line: Ctrl-shift-r  
 
21.10 Daisy Player 
 
Play/Pause: Space  
Move to the beginning of document: Home or ctrl-home 
Move to the last phrase: End or ctrl-end 
Increase the speed: Shift-Right arrow key 
Decrease the speed: Shift-Left arrow key 
Increase the volume: Shift-Up arrow key 
Decrease the volume: Shift-Down arrow key 
 
Move to the next phrase: Right arrow key 
Move to the previous phrase: Left arrow key 
Move to the next fifth phrase: Ctrl-Down arrow key 
Move to the previous fifth phrase: Ctrl-Up arrow key 
Move to the next page: Page down key 
Move to the previous page: Page up key 
Go to the page: Ctrl-g 
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Move to the upper-level: Alt-Up arrow key 
Move to the down-level: Alt-Down arrow key 
Move to the next level at the preset level: Alt-Right arrow key 
Move to the previous level at the preset level: Alt-Left arrow key 
 
Move to the next heading: Ctrl-F6 
Move to the previous heading: Ctrl-F5 
Move to the first heading: Ctrl-F8 
Move to the last heading: Ctrl-F7 
Check the currently-reading level and heading: Ctrl-w 
Scan the heading list from the present to the end: Ctrl-n 
Find heading: Ctrl-f 
Find again: F3 
 
Set mark at current position: Ctrl-m 
Move to the next mark: N 
Move to the previous mark: V 
Delete mark: DEL key  
 
Move to the title list: Shift-Backspace 
Open daisy file: Ctrl-o 
Check the book-info: Alt-Enter 
Voice setting: Ctrl-s 
 
21.11 Bluetooth Manager 
 
Scanning bluetooth device: Ctrl-r 
Connecting device: enter in the device name 
Connecting service: enter in the service name 
Disconnect the service: Ctrl-d 
Move to Bluetooth device list in service list: Backspace 
 
1. FTP service 

Open local/remote folder: Ctrl-o 
Copy: Ctrl-c 
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Paste: Ctrl-v 
Send to: Ctrl-s 
Retrieve file: Ctrl-r 
New folder: Ctrl-f 
Delete file/folder: DEL 
Information: Ctrl-i 

 
21.12 MSN messenger 
 
1. Log-in dialog box 

Move to the next control: Tab 
Move to the previous control: Shift-tab 
Check or uncheck a check box: Space 
 

2. The contact list box 
Move to the previous item: Up arrow key 
Move to the next item: Down arrow key 
Move between online and offline groups: Ctrl-Down arrow key 
Open the menu: Alt 
Logout: Ctrl-n 
View chat: Ctrl-r 
My status: Ctrl-m 
Exit: Ctrl-z 
Add contact: Ctrl-a 
Delete contact: Ctrl-d 
Contact information: Ctrl-v 
Send instant message: Ctrl-s 
Last message: Alt-r 
Play keyboard sound: Ctrl-k 
Message sound notification while in current window: Alt-s 
Message sound notification while messenger is in the background: Alt-
m 
Nickname: Ctrl-p  
Save account: Ctrl-o 
Confirm the Received Message: Ctrl-l 
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3. Instant message dialog box 
Move to the next control: Tab  
Move to the previous control: Shift-Tab 
Move between the instant message dialog box and the contact listbox: 
Page up, Page down 
Save as: Alt-s 
Print: Ctrl-p 
Close: ESC or Alt-F4 
Cut: Ctrl-x 
Copy: Ctrl-c 
Delete: Del 
Paste: Ctrl-v  
Select all: Ctrl-a 
Start selection: Ctrl-b  
Find: Ctrl-f 
Find again: F3 
Invitation: Ctrl-i 

 
21.13 Database Manager 
 
Add record: Ctrl-n 
Search records: Ctrl-f 
Table manager: Ctrl-t 
List of records found: Ctrl-r 
Setting backup option: Ctrl-e 
Backup database: Ctrl-u 
Restore database: Ctrl-o 
 
1. Move by controls 

Move to the next control: Tab 
Move to the previous control: Shift-Tab 

2. Move in a list box 
Move to the next list item: Down arrow key 
Move to the previous list item: Up arrow key  

3. Select your answer in the prompt box 
Move to the next answer: Space, or Down arrow key 



427 
 

Move to the previous answer: Backspace, or Up arrow key 
4. Move in the “list of records found” 

Move to the next record: Down arrow key 
Move to the previous record: Uparrow key 
Move to the last record: Ctrl-end 
Move to the first record: Ctrl-home 
Move to the next field: Ctrl-Right arrow key 
Move to the previous field: Ctrl-Left arrow key 
Move to previous same field different record: Left arrow key 
Move to next same field different record: Right arrow key 
Move to the last field: End key 
Move to the first field: Home key 

 
21.14 Utilities 
 
21.14.1 Calculator 
 
Calculator clear: Alt-c 
Delete numbers or operators: Backspace 
 
General function: Ctrl-g 
Plus: + 
Minus: - 
Division: / 
Multiplication: * 
Percent: % 
Power: ^ 
Square Root: Ctrl-q  
Decimal Point: . 
Left Parenthesis: ( 
Right Parenthesis: ) 
PI: Ctrl-p 
Exp: Ctrl-e 
 
Recall Items: Alt-r 
Delete all saved items: Ctrl-d 



428 
 

Save Items: Alt-s 
 
Trigonometric Function: Ctrl-s 
Sine: Ctrl-s, s  
Arc Sine: Ctrl-s, a 
Hyperbolic Sine: Ctrl-s, h 
Cosine: Ctrl-c, c 
Arc Cosine: Ctrl-c, a 
Hyperbolic Cosine: Ctrl-c, h 
Tangent: Ctrl-t, t 
Arc Tangent: Ctrl-t, a 
Hyperbolic Tangent: Ctrl-t, h 
 
Logarithm Function: Ctrl-l 
Natural Logarithm: Ctrl-l, e 
Common Logarithm: Ctrl-l, n 
 
Copy to Clipboard: Ctrl-insert 
Option Setting: Ctrl-o 
 
21.14.2 Setting the Date and Time 
 
Move to the next day: Right arrow key 
Move to the previous day: Left arrow key 
Move to the next week: Ctrl-Right arrow key 
Move to the previous week: Ctrl-Left arrow key 
Move to the next month: Down arrow key 
Move to the previous month: Up arrow key 
Move to the next year: Ctrl-Down arrow key 
Move to the previous year: Ctrl-Up arrow key 
 
Move to 1 hour after: Down arrow key 
Move to 1 hour before: Up arrow key 
Move to 10 minutes after: Ctrl-Right arrow key 
Move to 10 minutes before: Ctrl-Left arrow key 
Move to 1 minute after: Right arrow key 
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Move to 1 minute before: Left arrow key 
Switch Between A.M. and P.M.: Ctrl-shift-x 
 
21.14.3 Checking the Date and Time 
 
Display time and date: Ctrl-shift-t  
 
21.14.4 Calendar 
 
Move to the previous item: Tab 
Move to the next item: Shift-tab 
 
Move to the next day: Right arrow key 
Move to the previous day: Left arrow key 
Move to the next week: Ctrl-Right arrow key 
Move to the previous week: Ctrl-Left arrow key 
Move to the next month: Down arrow key 
Move to the previous month: Up arrow key 
Move to the next year: Ctrl-Down arrow key 
Move to the previous year: Ctrl-Up arrow key 
 
21.14.5 Pronunciation dictionary 
 
Move to the previous control: Tab 
Move to the next control: Shift-tab 
Move to the previous item in entry: Up arrow key 
Move to the next item in entry: Down arrow key 
Add word: Alt-i  
Modify word: Alt-m  
Delete word: Del 
 
21.14.6 Stopwatch 
 
Stopwatch start, pause, restart: Enter 
Check the elapsed time: Space 
Switch between stopwatch and count down timer: Tab 
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Count down timer pause or restart: Enter 
Count down timer Clear: ESC 
Exit stopwatch or count down timer: Alt-f4 
 
21.14.7 Display Networg Status 
 
Display Networg Status: Ctrl-shift-n 
 
21.14.8 Check Power Status 
 
Check power status: Ctrl-shift-b 
 
21.14.9 Backup/Restore Personalized settings 
 
Move to previous item: Up arrow key 
Move to next item: Down arrow key 
Move to previous control: Shift-tab 
Move to next control: Tab 
Select/unselect check box: Space 
 
21.14.10 Upgrading Voice Sense QWERTY OS 
 
Check download information: Space 
Cancel download and exit: Alt-f4 
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22. Troubleshooting Guide 
 
If you are having trouble with the Voice Sense QWERTY, please try the 
following suggestions according to your problem: 
 
22.1 The Voice Sense QWERTY Will Not Turn On 
 
1. Check to make sure that the battery is inserted in to its compartment 

properly. 
2. If the battery is inserted properly, connect the AC adapter, and plug 

the AC adapter in to an electrical outlet. The battery may need to be 
charged. 

3. Or, Check the location of keyboard lock switch. If this switch put on 
“lock,” power switch does not work. 

 
22.2 The Voice Cannot Be Heard 
 
1. Make sure the volume is turned up. Press “F6” to turn up the volume. 
2. Make sure the voice is turned on. Press “F10” to open the “Global 

options”. Press “v” once. Then, press “space.” Then, press “enter.”  
This will turn on the voice. 

 
22.3 The Voice is Too Fast to Understand 
 
1. Press “Shift-F7” to slow down the voice rate. 
 
22.4 The Voice Pitch Is Too Low or Too High to 
Understand 
 
1. Press “Shift- F8” to lower the pitch, or press “F8” to raise the voice 

pitch. 
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22.5 Lost Your Place 
 
1. If you have lost your place in the Voice Sense QWERTY, and cannot 

remember where you are press “Win key” to access the “program” 
menu. Then, press “Alt-Tab” to switch between programs that are 
open. If you are in the word processor, pressing “Fn-s” will give you 
your current location. 

 
22.6 No Internet Connection 
 
1. If you are using a LAN, make sure that the Ethernet cable is 

connected.  
2. Check if the Ethernet port is activated by pressing “Fn-F11”. 
3. If you are using a DSL connection, make sure that that the Ethernet 

cable is connected. 
 
22.7 Email 
 
1. If you are having trouble downloading email, please contact your 

Internet service provider to make sure that you have the correct 
POP3 and SMTP settings. 

 
 
22.8 The Voice Sense QWERTY Does Not Respond 
 
1. If the Voice Sense QWERTY does not respond to keystrokes or 

commands, it may be necessary to reset the unit. To reset the Voice 
Sense QWERTY. Press the reset button Do NOT hold the reset 
button for more than 5 seconds. 
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23. Accessories 
 
For information on available accessories for the Voice Sense QWERTY, 
please contact HIMS. You can contact HIMS at hims@himsintl.com.  Or, 
you can contact HIMS by phone at +82-42-864-4460.  You can also 
visit HIMS on the web at www.himsintl.com. 
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24. Obtaining Support  
 
If you are having any problems with your Voice Sense QWERTY, please 
contact the dealer from whom you bought your unit. If you require further 
assistance, please contact us at hims@himsintl.com.  Or, you can 
contact HIMS by phone at +82-42-864-4460. 
 


